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Copyright  

© Copyright MediaKind 2018. All rights reserved. No part of this document may be reproduced in any form without the 

written permission of the co pyrig ht owner.  

Disclaimer  

No part of this document may be reproduced in any form without the written permission of the copyright owner.  

The contents of this document are subject to revision without notice due to continued progress in methodology, design 

and man ufacturing. MediaKind shall have no liability for any error or damage of any kind resulting from the use of this 

document.  

 

 

SVENSKA  -  LÄS DETTA FÖRST!  

Om Ni inte förstår informationen i denna handbok. ARBETA DÅ 
INTE MED DENNA UTRUSTNING .  En ö versättning till detta språk 

av denna handbok kan också anskaffas, på Er bekostnad.  

 

SVENSKA  -  LÄS DETTA FÖRST!  

Om Ni inte förstår informationen i denna handbok. ARBETA DÅ 
INTE MED DENNA UTRUSTNING .  En översättning till detta språk 

av denna handbok ka n ock så anskaffas, på Er bekostnad.  

ENGLISH (UK) -  READ THIS  FIRST!  

If you do not understand the contents of this manual. DO NOT 
OPERATE THIS EQUIPMENT .  Also, translation into any EC official 

language of this manual can be made available, at your cost.  

 

ENGLIS H (UK) -  READ THIS FIRST!  

If you do not understand the c ontents of this manual. DO NOT 
OPERATE THIS EQUIPMENT .  Also, translation into any EC officia l 

language of this manual can be made available, at your cost.  

ǨǭǭǪǯǫǬǥ -ǧǫǥǦǥǴǵǨ ǲǳǹǵǥ ǥǶǵǱ! 

ǥȊŭŮȊ ȇŬŰŬȈǼȁŮŰŮ ŰȌ ɸŮȍȆŮȐȕȉŮȊȌ ŬȏŰȌȖŰȌȏ 
ȁȌȄȅǾȉŬŰȌȎ/ŮȂȐŮȆȍȆŭǿȌȏ. ǮǪǯ ǭǨǫǵǱǶǳũǪǴǨǵǨ ǥǶǵǱǯ ǵǱǯ 
ǨǰǱǲǭǫǴǮǱ. ǨɸǿůȄȎ, ŬȏŰȕŰȌŮȂȐŮȆȍǿŭȆȌŮǿȊŬȆ ŭȆŬȅǽůȆȉȌ 

ůŮȉŮŰǼűȍŬůȄ ůŮ ŬȏŰǾŰȄȂȈȗůůŬ ȇŬȆ ȉɸȌȍŮǿŰŮ ȊŬ ŰȌ ŬȂȌȍǼůŮŰŮ. 

 

ǨǭǭǪǯǫǬǥ -ǧǫǥǦǥǴǵǨ ǲǳǹǵǥ ǥǶǵǱ! 

ǥȊŭŮȊ ȇŬŰŬȈǼȁŮŰŮ ŰȌ ɸŮȍȆŮȐȕȉŮȊȌ ŬȏŰȌȖŰȌȏ 
ȁȌȄȅǾȉŬŰȌȎ/ŮȂȐŮȆȍȆŭǿȌȏ. ǮǪǯ ǭǨǫǵǱǶǳũǪǴǨǵǨ ǥǶǵǱǯ ǵǱǯ 
ǨǰǱǲǭǫǴǮǱ. ǨɸǿůȄȎ, ŬȏŰȕŰȌŮȂȐŮȆȍǿŭȆȌŮǿȊŬȆ ŭȆŬȅǽůȆȉȌ 

ůŮȉŮŰǼűȍŬůȄ ůŮ ŬȏŰǾŰȄȂȈȗůůŬ ȇŬȆ ȉɸȌȍŮǿŰŮ ȊŬ ŰȌ ŬȂȌȍǼůŮŰŮ. 

DEUTSCH  -  LESEN SIE ZUERST DIESEN HINWEIS!  

Sollte Ihnen der Inhalf dieses Handbuche s nic ht klar verständlich 

sein, dann. BEDIENEN SIE DIESE GERÄ TE NICHT! Eine 

Übersetzung des Handbuches in diese Sprache ist gegen 

Berechnung lieferbar.  

 

 

DEUTSCH  -  LESEN SIE ZUERST DIESEN HINWEIS!  

Sollte Ihnen der Inhalf dieses Handbuches nicht klar verstä ndlic h 

sein, dann. BEDIENEN SIE DIESE GERÄTE NICHT! Eine 

Über setzung des Handbuches in diese Sprache ist gegen 

Berechnung li eferbar.  

 

ESPAÑOL  -  LEA ESTE AVISO PRIMERO!  

Si no entiende el contenido de este manual. NO OPERE ESTE 
EQUIPO. Podemosasimismosumini strar leunatraducción de este 

manual al (idioma) previopago de  unacantidadadicional que 
deberáabonarustedmismo.  

 

ESPAÑOL  -  LEA ESTE AVISO PRIMERO!  

Si no entiende el contenido de este manual. NO OPERE ESTE 
EQUIPO. Podemosasimismosuministrarleunatraducción de  este  

manual al (idioma) previopago de unacantidadadicional q ue 
deberáabonarustedmismo.  

FRANÇAIS  -  AVANT TOUT , LISEZ CE QUI SUIT!  

Si vous ne comprenez pas les instructions 
contenuesdanscemanuel. NE FAITES PAS FONCTIONNER CET 

APPAREIL. Enoutre, nous pouvon svous  proposer, à vosfrais, une 
version française de cemanuel .  

 

FRANÇAIS  -  AVANT TOUT, LISEZ CE QUI SUIT!  

Si vous ne comprenez pas les instructions 
contenuesdanscemanuel. NE FAITES PAS FONCTIONNER CET 

APPAREIL. Enoutre, nous pouvonsvous proposer, à vosfrai s, un e 
version française de cemanuel.  

ITALIANO -LEGGERE QUESTO AVVISO PER PRIMO!  

Se non sicapisceilcontenu to del presentemanuale.  
NON UTILIZZARE LôAPPARECCHIATURA. . È anchedisponibile  

la versioneitaliana di questomanuale, ma ilcosto è a 
caricodellôutente.  

 

IT ALIANO -LEGGERE QUESTO AVVISO PER PRIMO!  

Se non sicapisc eilcontenuto del presentemanuale.  
NON UTILIZZ ARE LôAPPARECCHIATURA. . È anchedisponibile  

la versioneitaliana di questomanuale, ma ilcosto è a 
caricodellôutente. 

PORTUGUÊS  -  LEIA O TEXTO ABAIXO A NTES  
DE MAIS NADA!  

Se nãocompreende o textodeste manual. NÃO  UTILIZE O 
EQUIPAMENTO. O utilizadorpoderátambémobterumatradução do 

manual para o português à própriacusta.  

 

PORTUGUÊS  -  LEIA O TEXTO ABAIXO ANTES  
DE MAIS NADA!  

Se nãocompreende o textodeste man ual. NÃO UTILIZE O 
EQUIPAMENTO. O utilizadorpoderátambémobter umatradução do 

manual para  o português à própriacusta.  

NEDERLANDS -LEES DIT EERST!  

Als u de inhoud van deze handleiding niet begrijpt. STEL DEZE 
APPARATUUR DAN NIET IN WERKING. U kunt tevens, op  eige n 

kosten, een vertaling van deze handleiding krijgen.  

 

NEDERLANDS -LEES DIT EERST! 

Als u de inhoud van deze handleiding niet begrijpt. STEL DEZE 
APPARATUUR DAN NIET IN WERKING. U kunt tevens, op eigen 

kosten, een vertaling van deze handleiding krijgen . 

DA NSK  -  LÆS DETTE FØRST!  

Udstyret må ikke betjenes. MEDMIN DRE DE TIL FULDE FORSTÅR 
INDHOLDET AF DENNE HÅNDBOG. Vi kan også for Deres regning 

levere en dansk oversættelse af denne håndbog.  

 

DANSK  -  LÆS DETTE FØRST!  

Udstyret må ikke betjenes. MEDMINDRE DE  TIL FULDE FORSTÅR 
INDHOLDET AF DENNE HÅNDBOG. Vi kan også fo r Deres reg ning 

levere en dansk oversættelse af denne håndbog.  

SUOMI  -  LUE ENNEN KÄYTTÖÄ!  

Jos et ymmärrä käsikirjan sisältöä. ÄLÄ KÄYTÄ LAITETTA. 
Käsikirja voidaan myös suomentaa asiakkaan kustannuksella.  

 

SUOMI  -  LUE ENNEN KÄYTTÖÄ!  

Jos et ymmärrä käsikirjan sisältöä. ÄLÄ KÄYTÄ LAITETTA. 
Käsikirja voidaan myös suomentaa asiakkaan kustannuksella .  
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Introduction  
The AVP is a flexible platform consisting of a base unit or chassis into which various option cards 
can be plugged.  
The base unit provides an Ethernet control i nterface, Ethernet dat a interfaces, and basic transport 
stream processing functionality. Other functionalities such as video encoding, audio encoding, and 
additional input or output interfaces are provided by the addition of option cards.  

The AVP is design ed for flexibility, mo dularity, multi -codec capabilities, and multiple independent 
outputs. Please ensure that you are familiar with the operation of the unit by reading this guide 
carefully.  

This Reference Guide should be kept in a safe place for referenc e for the life of the equipment. 
This Reference Guide will be not be amended by the issue of individual pages. Any revision will be 
by a complete reissue. Further copies of this Reference Guide can be ordered from the address 
listed in Customer Services. I f passing the equipmen t to a third party, also pass the relevant 
documentation.  

Revision History  

Issues of this Reference Guide are listed below:  

 

Issue  Date  Software 
Version  

Comments  

A Jan 2013  9.2.x  Separate online help files combined for AVP  2000 (1553 -FGC 101 

1788 Uen B), AVP  3000 (1553 -FGC 101 1789 Uen B) and AVP 4100 
(1553 -FGC 101 1790 Uen B). Updated to software version 9.2.x  

B Apr 2013  9.4.x  Updated to software version 9.4.x  

New supported features added  

C Jul 2013  9.5.x  Updated to software version 9.5.x  

New supported features added  

Included details of support for Contribution Encoder  and Voyager II  

D Nov 2013  9.6.x  Updated for software version 9.6.x  

New supported features added  

E Jan 2014  9.7.x  Updated for software version 9.7.x  

New supported features added  

Section added to introduce Voyager GUI  

F Apr 2014  9.8.x  Updated for softwar e version 9.8.x  

AVP 4100 removed  

G Aug 2014  9.10.x  Updated for software version 9.10.x.  

Roll -off factors of 5, 10 and 15 percent supported for DVB -S2.  
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Issue  Date  Software 

Version  
Comment s 

H Dec 2014  9.11.x  Updated for software version 9.11.x.  

Adds support for DVB RF Carrier ID Voyager II/AVP3000.  

Adds option to include EIT and TDT tables in output streams for 
ETR290 Level 3 compliance.  

J May 2015  9.13.x  Updated for software version 9.12 .x and 9.13.x.  

Adds AVP 1000 (1RU).  

Adds support for DVB -S2X for  
Voyager II/AVP3000.  

K Aug 2015  9.15.x  Updated for software version 9.15.  

Support for Voyager Dashboard has been superseded by the Simplified 
View, which extends supported outputs to IP and ASI and is available for 
AVP 2000 as well as AVP 3000.  

Note: 9.15.x is the last software release to support the Contribution 
Encoder and Voyager II products.  

L Aug 2016  9.22.x  Updated for software version 9.22.  

Adds information for AVP1000 product.  

Adds d etails of H.264 fixed latency buffer mode for CE -x option cards.  

BISS encryption per component within a service.  

Adds details for CE -HEVC option module, introduced in thi s release.  

M Jan 2017  9.24.x  Updated for software version 9.24.  

Adds supports for sup port for closed captions and timecode for CE -HEVC. 

Adds support for loading a stored configuration when a change of SDI 
input is detected to update video and VBI configuration.  

N Mar 2017  9.25.x  Updated for software version 9.25.  

Adds support for remote l ogging, CE -x and HDR/WSS signaling for CE -

HEVC. 

S Apr 2017  9.26.x  Updated for software version 9.26.  

Adds support for SCTE -104 to SCTE -35 message translation on HEVC Card, 
In -band Control via Data Output ports, Generic ANC and Teletext on HEVC 
Card.  

T Jun 2017  9.27.x  Updated for software version 9.27.  

Adds support for Super Low Delay video on CE -HEVC Cards with LPCM 
Passthrough audio (licensed feature) and ALC on CE -HEVC Cards (licensed 
feature).  

U Sep 2017  9.29.x  Updated for software version 9.28 and 9. 29.  

Adds support for AVP 1000 Network Adapter, HEVC Explicit P frame 
support, HEVC Card HD multichannel (HEVC and H.264 encoding), HE VC 
super low latency: Dolby E P/T and ALC enhancements.  
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Asso ciated Documents  

The following manuals/guides are also associated with this equipment:  

 

Useful Links:  

Installation, Safety and Compliance Information ï Generic Product Information -  Reference Guide 
can be viewed found on the MediaKind website:  

www.MediaKind.com  

Trademarks  

All best endeavors have been m ade to acknowledge registered trademarks and trademarks used 
throughout this Reference Guide. Any notified omissions will be rectified in the next issue of this 
Reference Guide. Some trademarks may be registered in some jurisdictions but not in others.  

Issue  Date  Software 
Version  

Comments  

V Jan 2018  9.31.x  Updated fo r software version 9.31.  

Adds support for four -slice encoding in HEVC UHD 4K, automatic switching 
to CALVC (bitrates above 50 Mbps, HEVC encoding), MGP support on 
systems using different subnet outputs and remux of PCR - less components 
arriving over IP . 

W Apr 2018  9.32.x  Updated for software version 9.32.  

Adds support for MPEG -H Audio for Contribution.  

X Aug 2018  9.35.x  
Updated for software version 9.35.  

Adds support for PMT changes, SFP+ modules for SMPTE 2022 -6 ingest on 
CE-HEVC Cards, automated handlin g of HDR/SDR signaling on CE -HEVC 
Cards, automated MPRG -H group labeling, reservation for bit rate for 
MPEG-H side inf ormation, MPEG -H audio pass - thru for contribution feeds, 
transcode of 1080i2997 to 720p2997 on CE -HEVC Cards, Super Low 
Latency buffer mod e on CE -HEVC Cards for H.264 encoding, supporting 
LPCM pass - thru and Dolby E pass - thru audio standards, VANC filtering  of 
DID/SDID pairs on CE -HEVC Cards.  

Y May 2019  9.37.x  
Updated software version 9.3 7. 
All user interfaces re -branded to MediaKind  

MediaKind  Document Identity  Title  

1/1553 -FGB 101 752  Video Processing/Stream Processing  

Products ï Generic Product Information -  Quick Guide  

174 02 -FGB 101 348  Insta llation, Safety and Compliance Information 
Generic Product Information -  Reference Guide  

http://www.mediakind.com/
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Registered trademarks and trademarks used are acknowledged below and marked with their 
respective symbols. However, they are not marked within the text of this Referenc e Guide.  

Registered Trademarks  

Dolby ®   Registered trademark of Dolby Laboratories.  

GuideBuilder ®  Registered trademark of Triveni Digital Inc.  

Trademarks  

ReflexÊ Trademark of MediaKind.  

Patents  

The feature ñPhase Aligned Audioò is patented MediaKind functionality.  

Warnings, Cautions and Notes  

Heed Warnings  

All warnings on th e product and in the operating instructions should be adhered to. The 
manufacturer cannot be  held responsible for injuries or damage where warnings and cautions have 
been ignored or taken  lightly.  

Read Instructions  

All the safety and operating instructions should be read before this product is operated.  

Follow Instructions  

All operating and use instructions should be followed.  

Retain Instructions  

The safety and operating instructions shoul d be retained for future reference.  

 

 

Warning!  

Warnings give information which, if strictly observed, will prevent personal injury or death, or 
damage to property or the environment. They are highlighted for emphasis, as in this example, 

and are placed im mediately preceding the point at which the reader require s them.  

Caution!  

Cautions give information which, if strictly followed, will prevent damage to equipment or other 
goods. They are highlighted for emphasis, as in this example, and are placed immedia tely 
preceding the point at which the reader requires them.  
 

 

Note:  Notes provide supplementary information. They are highlighted for emphasis, as in this 

example, and are  placed immediately after the relevant text.  
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EMC Compliance  

This equipment is certif ied to the EMC requirements detailed in the I nstallation, Safety and 
Compliance Information for MediaKind  Compression Products Reference Guide supplied with your 
product. To maintain this certification, only use the leads supplied or if in doubt contact Cu stomer 
Services.  

Contact Information  

Support Services  

MediaKind  understands that our products are ñmission-criticalò, providing services that influence 
customer perception and impact your revenue. Our objective is to ensure that you realize 
maximum utility  and achieve the highest levels of availabili ty from our products. To realize that 
objective, we offer a variety of Service Level Agreements designed to meet your business needs 

and budget.  

Warranty  

All MediaKind  products and systems are designed and built  to the highest standards and are 
covered under a comprehensive 12 -month warranty.  
 

Service Level Agreements  

Customers may choose one of several Support packages, either as an enhancement during the 
standard 12 -m onth warranty or as an extension after the w arranty has expired.  

For standalone equipment, customers may choose either MediaKind ôs Extended Hardware 
Warranty or  Secure Basic Support . Extended Hardware Warranty provides hardware repair of 
covered equipment after the expiration of the standard warrant y. Secure Basic Support provides 

hardware repair, remote diagnostics and support, and 24x7x365 remote support for emergencies.  

For systems, along with Secure Basic Support, customers have the option of either Sec ure 
Advanced Support  or Secure Superior Supp ort . These support packages provide higher 
committed response and resolution times, onsite support where necessary, service performance 
review and a host of other proactive services to help you get the maximum re turn on your 
investment in MediaKind  solutio ns. Call MediaKind  Sales for more details.  

Customer Services  

For customer service regional telephone numbers please visit the MediaKind support contact 
details web page:  

https://www.mediakind.com/ services -contacts/  

You can also email us at:  

support@mediakind.com  

Technical Training  
 
MediaKind provides a wide range of training courses on the operation and mainte nance of our 
products and on their supportin g technologies. MediaKind can provide both regularly scheduled 
courses and training tailored to individual needs. Courses can be run either at your premises or at 

one of our dedicated training facilities.  For mor e details contact:  

support@mediakind.com  

 

https://www.mediakind.com/services-contacts/
mailto:support@mediakind.com
mailto:support@mediakind.com
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Customer Services and Technical Training Postal Address  
 
MediaKind 
Unit 2  
Strategic Park 
Comines Way 
Hedge End 
Southampton 
Hampshire 
SO30 4DA 
United Kingdom 

 

Return of Equipment  
 
If you need to return equipment for repair please contact your local MediaKind  Customer Services 
Department.   
Please refer to the Customer Services Contact Information on Page  8. 

You will then be directed to return the faulty equipment to  a repair center  wi th 

the  appropriate  facilities for that equipment. A tracking number will be issued that should be used 
if you need to enquire about the prog ress of the repair. The equipment should be  properly packed, 
and the  tracking number should be clearly marked on the  outside of the packaging . 

 

Technical Publications  

If you need to contact MediaKind  Technical Publications regarding this publication,  

e-mail: support@mediakind.com . 

mailto:support@mediakind.com
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1.1  Introduction  

1.1.1  Who Should Use this Reference Guide  

This Reference Guide is written for operators / users of the Advanced Video Processor  (AVP) . It 
describes the unit ôs functions and operation. The Reference Guide is written to assist in the 
installation and day - to -day operation and care of the unit. Mainte nance information requiring the 
covers to be removed is not included.  

Warning!  

Do not remove the top cover  of this equipment. Hazardous voltages are present within this 
equipment and may be exposed if the top cover is  removed. Only MediaKind  trained and a pproved 
service engineers are permitted to service this equipment.  

Caution!  

Unauthorized maintenance or the use of non -approved replacements may affect the equipment 
specification and invalidate any warranties.  

1.1.2  Software Version  

This  Reference Guide cover s the functions of software version 9. 3 7 .  

To verify the installed version either:  

¶ Access the front panel, see Chapter 4, Front Panel Control.  

¶ Access the Web Browser screens, see Chapter 5, Web GUI Control . 

This manual continues to be relevant to subsequen t build versions where the functionality of the 
equipment has not changed. Where the build standard changes the functionality, a new issue of 
this manual will be provided.  The appropriate number should be quoted in all correspondence with 
MediaKind . 

1.1.3  New Fe atures in this Release  

This Reference Guide has been updated to capture new features introduced since software version 
9.32 up to version 9.3 7:  

¶ Login security improvements . 

¶ Tolerance of incoming PMT changes if its versi on changes but structure remains the same.  

¶ Support for SFP+ modules for SMPTE 2022 -6 ingest on CE -HEVC cards.  

¶ Automated handling of incoming HDR / SDR signalling on CE -HEVC cards.  

¶ Automated MPEG -H group labelling.  

¶ Reservation for bit rate for MPEG -H side i nformation.  

¶ MPEG-H audio pass - thru fo r contribution feeds.  

¶ Transcode of 1080i2997 to 720p2997 on CE -HEVC cards.  

¶ Super Low Latency buffer mode on CE -HEVC cards for H.264 encoding, supporting LPCM 
pass - thru and Dolby E pass -thru audio standards.  

¶ VANC filteri ng of DID/SDID pairs on CE -HEVC cards . 

1.1.4  What Equipment is Covered by this Reference Guide  

This Reference Guide covers the following three main units  and options listed in the following 
tables:  
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¶ AVP 1000 (1RU) Stream Processor  

The AVP 1000 supports pass - thru of Transport Streams and remultiplexi ng of services from 
any  input to any output. The number of inputs and type of outputs available depend upon the 
option cards fitted in the chassis.  
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Table 1.1 AVP 1000 (1RU) IP and ASI Support  

Input  Functiona lity  Output  

IP ASI  

Option card 
required  

G.703  

Option card 
required  

IP TS pass - thru  Yes No No 

Service remux  No No No 

ASI  

Option Card required  

TS pass - thru  Yes Yes Yes 

Service remux  Yes Yes Yes 

G.703  

Option Card required  

TS pass - thru  Yes Yes Yes 

Service remux  Yes Yes Yes 

¶ AVP 2000 Contribution Encoder  
The AVP 2000 Contribution Encoder supports  a comprehensive range of video processing and 
input/output modules, offering flexibility and allowing encoder functionality to be upgraded 
incrementally and on -site.  

¶ AVP 3000 Voyager  

The AVP 3000 Voyager provides the same encoding flexibility and performance as the AVP 
2000 with the addition of a Satellite Modulat or output as standard.  

1.1.4.1  Base Chassis Options  

The AVP chassis consists of a base chassis, single  or dual AC mains input and up to six option 
cards. The base chassis is a 1RU 19 inch rack mount chassis that contains control interfaces and 
two pairs of dual re dundant Ethernet ports for data output.  

Additionally, the AVP  3000 includes a Satellite Modula tor option card as standard.  

Option cards are responsible for video, audio , data processing, and for producing output through 
various interfaces. The option cards  are óHot Swappableô, that is, they can be inserted or removed 
while the chassis is powered on , within the limitations described in Chapter 7, Options, Licenses 
and Upgrades.  

The base chassis options available are described in the following table.  
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Table 1.2 Base Chassis Options  

Marketing Code  Price Obj ect 

Number  

Supply Object 

Number  
Description  

AVP1000/1RU/BAS/1AC/A  FAZ 101 0196/223  KDU 137 909/4  AVP 1000 (1RU) Stream Processor with 
single AC input  

AVP1000/1RU/BAS/2AC/A  FAZ 101 0196/224  KDU 137 909/5  AVP 1000 (1RU) Stream Processor with 

dual AC input  

AVP1000/1RU/BAS/2ACFL/A  FAZ 101 0196/225  KDU 137 909/6  AVP 1000 (1RU) Stream Processor with 
dual AC Flying Leads  

AVP2000/BAS/1AC/A  FAZ 101 0196/226  KDU 137 910/6  AVP 2000 Contribution Encoder with 

single AC input  

AVP2000/BAS/2AC/A  FAZ 101 0196/227  KDU 1 37 910/8  AVP 2000 Contribution Encoder with 
dual AC input  

AVP2000/BAS/2ACFL/A  FAZ 101 0196/228  KDU 137 910/3  AVP 2000 Contribution Encoder with 
dual AC Flying Leads  

AVP2000/BAS/1DC/A  FAZ 101 0196/229  KDU 137 910/9  AVP2000 Contribution Encoder Single 
DC i nput  

AVP2000/BAS/2DC/A  FAZ 101 0196/230  KDU 137 910/10  AVP2000 Contribution Encoder Dual DC 
input  

AVP3000/BAS/1AC/A  FAZ 101 0196/231  KDU 137 911/4  AVP 3000 Voyager with single AC input  

AVP3000/BAS/2AC/A  FAZ 101 0196/232  KDU 137 911/5  AVP 3000 Voyager w ith dual AC input  

AVP3000/BAS/2ACFL/A  FAZ 101 0196/233  KDU 137 911/6  AVP 3000 Voyager with dual AC Flying 

Leads  

The AVP base chassis offer the following capabilities as standard:  

¶ Remux  

¶ BISS encryption  

¶ PROFEC (SMPTE 2022 -1) on output  

¶ Pass- thru of audio  

1.1.4.2  Op tion Cards  

The option cards, which are available to purchase with the base chassis  are described the following 
table.  

Table 1.3 Option Cards  

Marketing Code  Price Object 
Number  

Supply Object 
Number  

Description  

CE/HWO/ASI/IO/A  FAZ 101 0196/234  ROA 128 6475  ASI Input/Output Card with 2x Inputs 
and 2x Outputs  

CE/HWO/EXTSYNC/A  FAZ 101 0196/235  ROA 128 6476  External Sync Module  

CE/HWO/G703/A  FAZ 101 0196/236  ROA 128 6477  G703 Input/Output C ard  with 1x Inputs 
and  1x Outputs  

CE/HWO/CE -a/J2K/A  FAZ 101 0196/237  ROA 128 6478  JPEG-2000 SD/HD encoder card  

CE/HWO/GPI/A  FAZ 101 0196/238  ROA 128 6479  General Purpose Input Card  

CE/HWO/CE -a/A  FAZ 101 0196/239  ROA 128 6480  CE-a Video Compression Module  

CE/HWO/CE -x/A  FAZ 1 01 0196/292  ROA 128 6554  CE-x Video Compression Module  
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Marketing Code  Price Object 

Number  

Supply Object 

Number  
Description  

CE/HWO/CE -xA/A  FAZ 101 0196/240  ROA 128 6481  CE-xA Video Compression Module with 
analogue input  

CE/HWO/CE -HEVC/BNC/A    HEVC Media Processing module with 

BNC Inputs  

CE/HWO/CE -HEVC/SFP/C/A    HEVC Medi a Processing module with SFP 
inputs -  Fiber  receive module  

CE/HWO/CE -HEVC/SFP/F/A    HEVC Media Processing module with SFP 
Inputs ï BNC receive module  

CE/HWO/BLNK  FAZ 101 0119/3  SXA 215 2475/1  Blanking Plate  

1.1.4.3  Field Upgrade Option Cards  

Option cards may be  added to an AVP as a field upgrade and are shown in the following table . 

Table 1.4 Field Upgrade  Option  Cards  

Marketing Code  Price Object 

Number  

Supply Object 

Number  
Description  

CE/UPH/ASI/IO/A  FAZ 101 0196/ 241  ROA 128 6482  ASI Input/Output Card with 2x Inputs 
and 2x Outputs  

 

CE/UPH/EXTSYNC/A  FAZ 101 0196/242  ROA 128 6483  External Sync Module  

CE/UPH/G703/A  FAZ 101 0196/243  ROA 128 6484  G703 Input/Output Card with 1x Inputs 

and 1x Outputs  

CE/UPH/CE -a/J2K/ A FAZ 101 0196/244  ROA 128 6485  JPEG-2000 SD/HD encoder card  

CE/UPH/GPI/A  FAZ 101 0196/245  ROA 128 6486  General Purpose Input Card  

CE/UPH/CE -a/A  FAZ 101 0196/246  ROA 128 6487  CE-a Video Compression Module  

CE/UPH/CE-x/A  FAZ 101 0196/29 3 ROA 128 655 5 CE-x Video Compression Module  

CE/UPH/CE -xA/A  FAZ 101 0196/247  ROA 128 6488  CE-xA Video Compression Module with 

analogue input  

CE/UPH/CE -HEVC/BNC/A    HEVC Media Processing module with 
BNC Inputs  

CE/UPH/CE -HEVC/SFP/C/A    HEVC Media Processing module with SFP 

inputs -  Fiber  receive module  

CE/UPH/CE -HEVC/SFP/F/A    HEVC Media Processing module with SFP 
Inputs ï BNC receive module  

CE/UPG/HWO/BLNK  FAZ 101 0119/78  SXA 215 2475/2  Blanking Plate  

1.1.4.4  AVP Software Value Packs  

The functionality of these AVP option cards c an be augmented by purchasing software value 
packs, as listed in the following tables . 
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Table 1.5 Software Value Packs Purchased with Chassis and Option Cards  

Marketing Code  Price Object 

Number  

Supply 

Object 
Nu mber  

Description  Applicable 

to Option 
Card  

AVP/SWO/VP/a/SD  FAZ 101 
0196/252  

FAT 102 3782  Standard Definition value pack 
offering:  

¶ SD MPEG-2 encode  
¶ SD MPEG-4 encode  
¶ MCTF 
¶ Remux  
¶ DPI  
¶ Additional 1 channel pair of MPEG -

1 Layer II encode  (total of 2 pairs)  

CE-a 

AVP/SWO/VP/a/HD  FAZ 101 

0196/253  
FAT 102 3783  High Definition value pack offering:  

¶ MPEG-2 encode SD & HD  
¶ MPEG-4 encode SD & HD  
¶ MCTF 
¶ Remux  
¶ DPI  
¶ Additional 3 channel pairs of 

MPEG-1 Layer  II encode (total of 4 
pairs)  

CE-a 

AVP/SWO/VP/x/SD  FAZ 101 
0196/26 8 

FAT 102 3798  Standard Definition value pack 
offering:  

¶ SD MPEG-2 encode  
¶ SD MPEG-4 encode  
¶ MCTF 
¶ Remux  
¶ DPI  
¶ Additional 1 channel pair of MPEG-

1 Layer II encode  (total of 2 pairs)  

CE-xA 

CE-x 

AVP/SWO/VP/x/HD  FAZ 101 
0196/269  

FAT 102 3799  High Definition val ue pack offering:  

¶ MPEG-2 encode SD & HD  
¶ MPEG-4 encode SD & HD  
¶ MCTF 
¶ Remux  
¶ DPI  
¶ Additional 3 channel pairs of 

MPEG-1 Layer  II encode   (total of 4 
pairs)  

CE-xA 

CE-x 

AVP/SWO/VP/x/CONT  FAZ 101 

0196/264  
FAT 102 3794  Contribution value pack offering:  

¶ 4:2:2 10 bi t encode  

CE-x  

CE-xA 

CE-a 

AVP/SWO/VP/x/CONT/A

DV 

FAZ 101 

0196/265  
FAT 102 3795  Advanced contribution value pack 

offering:  

¶ 3D synchronization to support 3D 
or 4K operation  

¶ 1080p encoding  
¶ Stripe Refresh low latency mode  

CE-x  

CE-xA 

CE-a 

CE/SWO/VP/HEVC/HEV
C/ HD 

FAZ 101 
0196/278  

FAT 102 3822  High Definition HEVC value pack 
offering:  

¶ 1 channel of HD HEVC  
¶ 4 channels of MPEG -1 Layer  II 

audio encode  

CE-HEVC 

CE/SWO/VP/HEVC/HEV

C/4K  

FAZ 101 

0196/279  
FAT 102 3823  Ultra High Definition HEVC value pack 

offering:  

¶ UHD HE VC 
¶ 16 channels of MPEG -1 Layer II 

audio encode  

CE-HEVC 
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Marketing Code  Price Object 

Number  

Supply 

Object 
Nu mber  

Description  Applicable 

to Option 
Card  

CE/SWO/VP/HEVC/MP4
/HD  

FAZ 101 
0196/304  

FAT 102 3945  High Definition H264 value pack 
offering:  

¶ 1 channel of HD H264  
¶ 4 channels of MPEG -1 Layer II 

audio encode  

CE-HEVC  

CE/SWO/VP/HEVC/MP4

/X4  

FAZ 10 1 

0196/305  
FAT 102 3946  Contribution value pack offering:  

¶ 4 channels of 4:2:2 encode for HD 
video  

CE-HEVC 

CE/SWO/VP/HEVC/HEV
C/CONT  

FAZ 101 
0196/280  

FAT 102 3824  Contribution value pack offering:  

¶ 1 channel of 4:2:2 encode for HD 
video  

CE-HEVC 

CE/SWO/VP/ HEVC/HEV

C/CONT/x4  

FAZ 101 

0196/281  
FAT 102 3825  Contribution value pack offering:  

¶ 4 channels of 4:2:2 encode for 
UHD video  

CE-HEVC 

CE/SWO/VP/MPEGH  FAZ 101 
0196/317  

FAT 102 4009  Audio value pack for:  

¶ One MPEG-H Contribution stream 
comprising up to 10 chann els of 
audio.  

CE-HEVC 

CE/SWO/VP/CONT/AUDI
O 

FAZ 101 
0196/254  

FAT 102 3784  Contribution audio value pack offering:  

¶ Additional 4 channels of MPEG -1 
Layer  II encode  

¶ Phase Aligned Audio (6 channel)  

CE-a 

CE-xA 

CE-HEVC 

CE/SWO/VP/M1L2  FAZ 101 
0196/255  

FAT 102 37 85  Audio value pack for :  

¶ MPEG-1 Layer  II encode of up to 2 
channels of audio (e.g. stereo).  

CE-a,  

CE-xA 

CE-HEVC 

CE/SWO/VP/AAC  FAZ 101 

0196/256  
FAT 102 3786  Audio value pack for :  

¶ AAC-LC or HE -AAC encode of up to 
2 channels of audio (e.g. stereo).  

Note 3 packs required for surround 
encoding.  

CE-a,  

CE-xA 

CE-HEVC 

CE/SWO/VP/DOLBY/AC

3 

FAZ 101 

0196/257  
FAT 102 3787  Audio value pack for :  

¶ Dolby Digital encode of up to 2 
channels of audio (e.g. stereo).  

Note 3 packs required for surround 
encoding.  

CE-a,  

CE-xA 

CE-HEVC 

AVP/SWO/VP/MOD  FAZ 101 
0196/248  

FAT 102 3778  Basic modulation value pack offering:  

¶ DVB-DSNG 8PSK & 16QAM  
¶ DVB-S2 QPSK & 8PSK 
¶ Extended symbol rate range  

SATMOD 

AVP/SWO/VP/MOD/AD
V 

FAZ 101 
0196/249  

FAT 102 3779  Advanced modulation value pack 
offering :  

¶ DVB-S2 QPSK, 8PSK, 16APSK & 
32APSK 

¶ DVBS-2X Extensions  

SATMOD 

CE/SWO/CE -HEVC/SLD  FAZ 101 
0196/295  

FAT 102 3889  Ultra High Definition HEVC value pack 
offering:  

Enables 1 UHD HD channel for Super 
Low Delay  

CE-HEVC 
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Marketing Code  Price Object 

Number  

Supply 

Object 
Nu mber  

Description  Applicable 

to Option 
Card  

CE/SWO/CE -
HEVC/SLD/  
4K 

FAZ 101 
0196/296  

FAT 102 3890  Ultra High Definition HEVC value pack 
offering:  

Enables 1 UHD 4k channel for Super 
Low Delay  

CE-HEVC 

1.1.4.5  Field Upgrade Software Value Packs  

Further value packs may be added to the AVP after the equipment has been shipped via the field 
upgradable  options as listed below . 

Table 1.6 Value Pack Upgrade Optio ns 

Marketing Code  Price Object 

Number  

Supply 

Object 
Number  

Description  Applicable 

to Option 
Card  

AVP/UPS/VP/a/SD  FAZ 101 
0196/258  

FAT 102 3788  Stand ard Definition value pack 
offering:  

¶ SD MPEG-2 encode  
¶ SD MPEG-4 encode  
¶ MCTF 
¶ Remux  
¶ DPI  
¶ Additional 1 channel pair of MPEG -

1 Layer II encode (total of 2 pairs)  

CE-a 

AVP/UPS/VP/a/HD  FAZ 101 

0196/259  
FAT 102 3789  High Definition value pack offering:  

¶ MPEG-2 en code SD & HD  
¶ MPEG-4 encode SD & HD  
¶ MCTF 
¶ Remux  
¶ DPI  
¶ Additional 3 channel pairs of 

MPEG-1 Layer II encode (total of 4 
pairs)  

CE-a 

AVP/UPS/VP/x/SD  FAZ 101 
0196/27 0 

FAT 102 380 0 Standard Definition value pack 
offering:  

¶ SD MPEG-2 encode  
¶ SD MPEG-4 encode  
¶ MCTF 
¶ Remux  
¶ DPI  
¶ Additional 1 channel pair of MPEG -

1 Layer II encode (total of 2 pairs)  

CE-xA 

CE-x 

AVP/UPS/VP/x/HD  FAZ 101 

0196/271  
FAT 102 3801  High Definition value pack offering:  

¶ MPEG-2 encode SD & HD  
¶ MPEG-4 encode SD & HD  
¶ MCTF 
¶ Remux  
¶ DPI  
¶ Additional 3 channe l pairs of 

MPEG-1 Layer II encode (total of 4 
pairs)  

CE-xA 

CE-x 

AVP/UPS/VP/x/CONT  FAZ 101 
0196/266  

FAT 102 379 4 Contribution value pack offering:  

¶ 4:2:2 10 bit encode  

CE-xA 

CE-x 
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Marketing Code  Price Object 

Number  

Supply 

Object 
Number  

Description  Applicable 

to Option 
Card  

AVP/UPS/VP/x/CONT/AD
V 

FAZ 101 
0196/26 5 

FAT 102 379 5 Advanced contribution val ue pack 
offering:  

¶ 3D synchronization to support 3D 
or 4K operation  

¶ 1080p encoding  
¶ Stripe Refresh low Additional 4 

channels of MPEG -1 Layer  II 
encode  

¶ Phase Aligned Audio (6 
channel) latency mode  

CE-xA 

CE-x 

CE/UPS/VP/HEVC/HEV

C/HD  

FAZ 101 

0196/283  
FAT 102 382 7 High Definition HEVC value pack 

offering:  

HD HEVC 

¶ 4 channels of MPEG -1 Layer II 
audio encode  

CE-HEVC 

CE/UPS/VP/HEVC/HEVC/4

K 

FAZ 101 

0196/284  
FAT 102 3828  Ultra High Definition HEVC value pack 

offering:  

¶ UHD HEVC 
¶ 16 channels of MPEG -1 Layer II 

audio enco de 

CE-HEVC 

CE/UPS/VP/HEVC/MP4/H
D 

FAZ 101 
0196/306  

FAT 102 3947  High definition MPEG -4 value pack 
offering:  

HD MPEG-4 AVC  

4 channels of MPEG -1 Layer II audio 
encode  

CE-HEVC 

CE/UPS/VP/HEVC/MP4/X
3 

FAZ 101 
0196/308  

FAT 102 3949  High Definition H264 value pac k 
offering:  

Upgrade from single H264 to 4 
channels of H264 video  

CE-HEVC 

CE/UPS/VP/HEVC/MP4/X
4 

FAZ 101 
0196/307  

FAT 102 3948  High definition MPEG -4 value pack 
offering:  

4 channels HD MPEG -4 AVC  

16 channels of MPEG -1 Layer II audio 
encode  

CE-HEVC 

CE/UPS/ VP/HEVC/HEV
C/CONT  

FAZ 101 
0196/285  

FAT 102 3829  Contribution value pack offering:  

¶ 4:2:2 encode for one HD video  

CE-HEVC 

CE/UPS/VP/HEVC/HEV

C/CONT/x4  

FAZ 101 

0196/286   
FAT 102 3830  Contribution value pack offering:  

¶ 4:2:2 encode for UHD video  

CE-HEVC 

CE/UPS/VP/MPEGH  FAZ 101 
0196/318  

FAT 102 4010  Audio value pack for:  

¶ One MPEG-H Contribution stream 
comprising up to 10 channels of 
audio.  

CE-HEVC 

CE/UPS/VP/CONT/AUDI
O 

FAZ 101 
0196/260  

FAT 102 3790  Contribution audio value pack offering:  

¶ Additional 2 channels of  MPEG-1 
Layer  II encode  

¶ Phase Aligned Audio  

CE-a 

CE-xA 

CE-HEVC 

CE/UPS/VP/M1L2  FAZ 101 

0196/261  
FAT 102 3791  Audio value pack for :  

¶ MPEG-1 Layer  II encode of up to 2 
channels of audio (e.g. stereo).  

CE-a  

CE-xA 

CE-x 

CE-HEVC 
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Marketing Code  Price Object 

Number  

Supply 

Object 
Number  

Description  Applicable 

to Option 
Card  

CE/UPS/VP/AAC  FAZ 101 
0196/262  

FAT 102 3792  Audio value pack for :  

¶ AAC-LC or HE -AAC encode of up to 
2 channels of audio (e.g. stereo).  

Note 3 packs required for surround 

encoding.  

CE-a 

CE-xA 

CE-x 

CE-HEVC 

CE/UPS/VP/DOLBY/AC3  FAZ 101 
0196/263  

FAT 102 3793  Audio value pack for :  

¶ Dolby Digit al encode of up to 2 
channels of audio (e.g. stereo).  

Note 3 packs required for surround 
encoding.  

CE-a 

CE-xA 

CE-x 

CE-HEVC 

AVP/UPS/VP/MOD  FAZ 101 

0196/250  
FAT 102 3780  Basic modulation value pack offering:  

¶ DVB-DSNG 8PSK & 16QAM  
¶ DVB-S2 QPSK & 8PSK  
¶ Extende d symbol rate range  

SATMOD 

AVP/UPS/VP/MOD/ADV  FAZ 101 
0196/251  

FAT 102 3781  Advanced modulation value pack 
offering:  

¶ DVB-S2 QPSK, 8PSK, 16APSK & 
32APSK 

¶ DVBS-2X Extensions  

SATMOD 

AVP/UPS/VP/HEVC/HEV

C/x3  

FAZ 101 

0196/301  
FAT 102 3895  HEVC HD to UHD upgrade  value pack:  

¶ to add UHD HEVC encode to 
existing HD HEVC encode.  

CE-HEVC 

AVP/UPS/VP/HEVC/CON
T/x3  

FAZ 1010 
0196/300  

FAT 102 3894  HEVC 422 upgrade value pack:  

¶ Upgrade from single 4:2:2 encode 
to support 4:2:2 UHD encode.  

CE-HEVC 

CE/UPS/CE -HEVC/SLD/  

HDTO4K  

FAZ 101 

0196/299  
FAT 102 3993  Upgrade to Super Low Delay from HD 

to 4K UHD encode.  

Note must already have SLD license.  

CE-HEVC 

The AVP is a flexible platform consisting of a base unit or chassis in to which various option cards 
can be plugged. The base uni t provides an Ethernet control interface  for configuration, an  Ethernet 
data interfaces  for data routing between the host and the option cards , and basic transport stream 

processing functionality. Other functionalities such as video encoding, audio encodin g, or other 
input or output interfaces are provided by option cards  through various int erfaces .  

The following is a summary of the features of the base chassis:  

¶ 19  inch 1 óRUô rack mount chassis. 

¶ Front panel main display and keypad for control and status r eporting.  

¶ Power switch.  

¶ Tri -color  light bar to indicate chassis health.  

¶ Dual redundant Ethernet control ports.  

¶ Dual redundant Ethernet ports for data input and output.  

¶ Option card slots  (the number of option cards that may be fitted is different for each b ase 
unit) .  

¶ Option cards are óhot swappableô. 

¶ Confidence monitor for monitoring input vi deo stream.  
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1.2  Front Panel  

The front panel of the unit consists of a power switch, a confidence monitor, a light bar, an USB 
Connector, a rotary knob, a main display and a keypad.  

 

 

Figure 1.1 Front Panel  

1.2.1  Power Switch  

The mains switch is recessed  to prevent accidental switch -off.  

1.2.2  Confidence Monitor  

The confidence monitor allows the user to monitor the sele cted input video signal.  

 

Figure 1.2 Confidence Monitor  

The confidence monitor is a 1.8  inch  TFT LCD. The On key on the confidence monitor turns the 

monitor on or off. By pressing and holding the On  key, ope ration related data is shown. The first 
line displays the total number of hours the monitor has been operating; the second line displays 
the software version. The source of the video to be displayed, the sleep timeout time and the 
monitor brightness can be  set up through the front panel or the web user interface. For details on 
how to configure the settings for the confidence monitor see Chapte r 3, Getting Started .  

Note:  The AVP 1000 (1RU) does not have a VCM fitted so although fitted, the Confidence 
Monito r is not relevant for this model unless subsequently upgraded to AVP 2000 
functionality.  

1.2.3  Light Bar  

The light bar is green when there are no a ctive alarms or warnings and red if there is a critical 
alarm. The light bar is yellow if there is an active warnin g, minor or major alarm.  

1.2.4  USB Connector  

The USB connector provides an interface for saving or exporting configurations to, and loading or 
impo rting configuration from an USB stick. Moreover, by applying an USB -Ethernet adaptor, the 
Ethernet port of a contro l computer can be connected to the USB connector on the Front Panel of 
the unit.  

Power Switch  

Light Bar  Mini USB  Rotary Knob  Main Display  

Keypad  Confidence Monitor  
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1.2.5  Rotary Knob  

The rotary knob is used for scrolling through an d selecting the menu items.  

1.2.6  Main Display  

Control and status information is displayed on a graphic VFD display.  

1.2.7  Keyp ad  

Select and Cancel keys, as well as a numeric keypad is provided for interaction.  

1.3  Base Chassis Options  

1.3.1  AVP**** /BAS/1AC 1U Base Chassis  

This  chassis option provides  a single mains input and slots for up to six option cards.  

 

Figure 1.3 AVP**** /BAS/1AC Rear Panel with Six Option Cards Fitted  

1.3.2  AVP **** /BAS/2AC 1U Base Chassis  

This chassis option provides  a dual mains input and slots for up to four option cards.  

 

Figure 1.4 AVP**** /BAS/2AC Rear Panel with One CE-x Option Card  Fitted  

1.3.3  AVP**** /BAS/2ACFL 1U Base Chassis  

This chassis option provides dual mains input via flying leads and slots for up to six option cards.  

 

Figure 1.5 AVP**** /BAS/2ACFL  Rear Panel  with Two  Option Cards  Fitted  
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1.4  License Keys  

Licenses control the availability of some of the features accessible from the unit.  

A License Key consists of a feature, and the number of instances of this feature that are  allowed 
within the chassis or option card.  

License Keys are allocated on a ófirst configured first servedô basis. If an attempt is made to enable 
a feature, but the required license key is not available then the feature is not enabled, and a log 

message i s generated.  
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Installing the Equipment  
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2.1  Read This First!  

Please refer to the Installation, Safety and Compliance Information for MedaiKind  Compression 
Products  Reference Guide  supplied with your product for full details of installation requirements. 
This guide only contains additional product specific information where required.  

2.2  Mounting and Ventilation  

2.2.1  Fixing and Rack Mounting  

The equipment is designed for fixed use only and has been shipped with fixing brackets suitable 
for a standard 19 - inch rack. When installed in a rack, it should be secured using the fixing 
brackets. In addition, support shelves must be used to reduce the weight on the brackets. Ens ure 
it is firmly an d safely located and it has an adequate free - flow of air.  

Slide the unit onto the chassis supports and affix to the rack by means of an M6  x 18  mm panhead 
screw in each corner.  

A freestanding unit should be installed on a secure horizon tal surface where i t is unlikely to be 
knocked or its connectors and leads disturbed.  

2.2.2  Ventilatio n  

Side openings in the unit, as well as side -mounted cooling fans, are provided for ventilation. They 
ensure reliable operation of the product and protect it fr om overheating. The  openings of the fans 
must not be blocked or covered.  

 

Figure 2.1 Air -Flow through the Equipment  

2.3  Signal Connections  

2.3.1  Rear Panel Signal Connectors  

Caution!  

It is strongly recommended that the terminal marked     at the rear panel of the equipment is 
connected to a site Technical Earth before any external connections are made and the equipment 
is powered. This limits the migration of stray charges.  

Signal connections are made via the rear pa nel.  The rear panels, which are available are shown 
below. Full technical specifications for the connections are given in Annex B .  

Only the Data and Control Ethernet connectors and the PSU connectors are mounted on the 
chassis. All other connections at the  rea r panel are provided with the option modules that may be 

fitted. Examples are shown below.  
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Figure 2.2 Rear Panel With CE -x VCM, SatMod and ASI I/O Options Fitted  

2.3.2  Data Ethernet Connector  

The u nit has four Ethernet ports -  two for data input, and two for 
data output and will respond to ARPs, pings and other low - level 
Ethernet  traffic. The ports are accessible via RJ -45 connectors on the 

rear panel of the chassis. These are labeled Ge 1, Ge 2, Ge  3 and Ge 
4. Ge 1 and Ge 2 are used for data input, while Ge 3 and Ge 4 are 
data output.  

Table 2.1 Data Ethernet Connector  

Item  Specification  

Connector type  RJ-45 (100/1000 Base T)  

Connector designation  Ge 1  (data input)  

Ge 2 (data input)  

Ge 3 (data output)  

Ge 4 (data output)  

Pin outs  

(Unused pins are not 
connected)  

Pin 1 -  Tx Out (+)  

Pin 2 -  Tx Out ( - )  

Pin 3 -  Rx In (+)  

Pin 6 -  Rx In ( - )  

Status and Activity Indication  

Each Ethernet Data Port has a rear pan el mounted status LED associated with it to indicate link 
status, activity and speed as follows:  

Table 2.2 Link Speed: Left (Green) LED  

Link Speed  LED Status  

No Link  Off  ð ð ð ð ð ð ð ð ð ð ð ð ð ð ð ð ð ð  

100 Mbps  Flash Off x 2  ð  δð  δ  δ  δ  δ  δ  δð  δð  δ  δ  δ  δ  δ  δ  δ  

1000 Mbps  Flash Off x 3  ð  δð  δð  δ  δ  δ  δð  δð  δð  δ  δ  δ  δ  δ  

The left LED flash sequence period is 1 s, with a short flash duration of 100  ms.  

Table 2.3 Link Activity: Right (Yellow) LED  

Link Speed  LED Status  

No Link  Off  
ð ð ð ð ð ð ð ð ð ð ð ð ð ð ð ð ð 

ð  

Link  On  δ  δ  δ  δ  δ  δ  δ  δ  δ  δ  δ  δ  δ  δ  δ  δ  δ  δ  δ  

Data Ethernet (x4) 
Ethernet  

Control Ethernet (x2) 
Ethernet  

SatMod  

ASI I/O Module  

CE-x VCM  
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Link Speed  LED Status  

Activity  Flash  ð  δð  δð  δ  δ  δ  δ  δð  δ  δ  δð  δ  δ  δ  

2.3.3  Control Ethernet Connector  

The Ethern et control ports are used to connect the equipment to a PC for 
access with a web browser. Both connectors share the same IP address, CTL 1 
is the Primary control port, and is by default the active control port. Control 
Port CTL 2 should be consid ered as th e secondary control network as it will not 
respond to the Control Port IP Address unless control has been passed to it 
either as a result of a redundancy switch, or via a user command. The active 
control port switches when CTL 1 has no link (e.g.  carrier),  and CTL 2 has the 
link.  

Table 2.4 Control Ethernet Connector  

Item  Specification  

Connector type  RJ-45 (100/1000 Base T)  

Connector designation  CTL 1  

CTL 2  

Pin outs  

(Unused pins are not 
connected)  

Pin 1 -  Tx Out (+)  

Pin 2 -  Tx Out ( - )  

Pin 3 -  Rx In (+)  

Pin 6 -  Rx In ( - )  

Status and Activity Indication  

Each Ethernet Control Port has rear panel mounted status LEDs to indicate link status, activity and 
speed as follows:  

Table 2.5 Port Status: Left (Green) LED  

Port 

Status  

Link 

Speed  
LED Status  

Active 
Port  No Link  Off  

ð ð ð ð ð ð ð ð ð ð ð ð ð ð ð ð ð 

ð  

100 Mbps  Flash Off x 2  
ð  δð  δ  δ  δ  δ  δ  δð  δð  δ  δ  δ  δ  δ  δ

 δ  

1000 Mbps  Flash Off x 3  
ð  δð  δð  δ  δ  δ  δð  δð  δð  δ  δ  δ  δ

 δ  

Spare 
Port  No Link  Off  

ð ð ð ð ð ð ð ð ð ð ð ð ð ð ð ð ð 

ð  

100 Mbps  Flash On x 2  
 δð  δð ð ð ð ð ð  δð  δð ð ð ð ð 

ð  

1000 Mbps  Flash On x 3  
 δð  δð  δð ð ð ð  δð  δð  δð ð ð 

ð  

The left LED flash sequence period is 1 s, with a short fl ash duration of 100  ms.  
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Table 2.6 Link Activity: Right (Yellow) LED  

Link Speed  LED Status  

No Link  Off  
ð ð ð ð ð ð ð ð ð ð ð ð ð ð ð ð ð 

ð  

Link  On  δ  δ  δ  δ  δ  δ  δ  δ  δ  δ  δ  δ  δ  δ  δ  δ  δ  δ  δ  

Activity  Flash  ð  δð  δð  δ  δ  δ  δ  δð  δ  δ  δð  δ  δ  δ  

2.3.4  CE Option Modules  

The following connectors are provided on the CE Video Compression Modules.  

2.3.4.1  Digital Video Input (All CE - a and CE - x Option Modules)  

Standard and High Definition digital video can be input via the 75 Ý 
femal e BNC connector (labeled 3G/HD/SD -SDI) on the rear panel. 
The figure shows the SDI/HD -SDI type 75 Ý female BNC video input 
connector located on the rear panel of the module. The LED (labeled 
LOCK) next to the connector shows the lock status of the in put vi deo 
signal.  

Table 2.7 Digital Video Input via the SDI/HD -SDI Interface  

Item  Specification  

Connector types  75 Ý female BNC  

Connector designation  3G/HD/SD SDI IN  

Pin-outs  Centre  

Shield  

Input  

Ground/Chassis  

Table 2.8 Lock LED State Descriptions  

Item  Description  

Off  The SDI/HD -SDI Input is not active.  

Red The SDI/HD -SDI Input is active, but not locked.  

Green  The SDI/HD -SDI Input is active and is locked.  

Alterna te Red and Green  The SDI/HD -SDI Input is active, but video with the wrong line 
standard is being received.  

2.3.4.2  Digital Video Input (CE - HEVC/BNC Option Module)  

High definition digital video can be input via the four 75 ǹ female 
BNC connecto rs on the rear panel.  

For a single channel of HD, the input must be fed into connector SDI  
1. For a single channel of UHD 4K, the input is fed to all four 
connectors, and may be presented to the input as either four 
synchronized HD quadrants, or as four s ynchronized interleaved  
sub -pictures as per SMPTE -425 -5. In all cases, the LEDs (labeled 
LOCK) next to each connector will show the lock status of the input 
video signal for t hat connector.   

In encoding more than one channel of H264 or HEVC video the relevant multi -channel license (x4) 
needs to be purchased. If only one channel is licensed, the first connector (labeled SD 1) must be 

used for video input. The other connectors wi ll not be operational unless in UHD.  
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Table 2.9 Digital Video Input via the SDI Interface  

Item  Specification  

Connector types  75 Ý female BNC  

Connector designation  SDI 1 -4 

Pin-outs  Centre  

Shield  

Input  

Ground/ Chassis  

Table 2.10  Lock LED State Descriptions  

Item  Description  

Off  The SDI Input is not active.  

Red The SDI input is active, but not locked.  

Green  The SDI input is active and is locked.  

Alternate Red and  Green  The SDI input is active, but video with the wrong line standard is 
being received.  

2.3.4.3  Digital Video Input (CE - HEVC/SFP Option Module)  

The CE -HEVC/SFP option card can be fitted with one or two SFP+ 
modules. If two modules are fitted, they must be of t he same  
type -   a mixed  population is not supported.  

SFP Copper  

For the card ordered as CE/HWO/HEVC/SFP/C/A, two SFP+ modules are fitted which have two 

miniature 75 -ohm BNC connectors per module. High Definition and Ultra High Definition 4K  
digital video  can be input via the mi niature BNC connectors.  

For a single channel of HD, the input must be fed into the first connector of the first module.  

For a single channel of UHD 4K, the input is fed to all four connectors, and may be presented to 
the input as ei ther four synchronized HD quadrants, or as four synchronized interleaved  
sub -pictures as per SMPTE -425 -5.  

SFP Fiber  

For the card ordered as CE/ HWO/HEVC/SFP/F/A, two SFP+ modules are fitted which have two 
fiber optical inputs per module. High Definition an d Ultra High Definition 4K digital video can be 
input via the fiber optical inputs.  

For a single channel of HD, the input must be fed into the f irst connector of the first module.  

For a single channel of UHD 4K, the input is fed to all four connectors, and  may be presented to 

the input as either four synchronized HD quadrants, or as four synchronized interleaved  
sub -pictures as per SMPTE -425 -5.  

2.3.4.4  Analogue  Video Input via the CVBS Interface (CE - xA)  

Analogue composite video can be input via the 75 Ý female BN C 
connector (CVBS) on the rear panel.  
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Table 2.11  Analogue Video Input via the CVBS Interface  

Item  Specification  

Connector types  75 Ý female BNC  

Connector designation  CVBS 

Pin-outs  Centre  

Shield  

Input  

Ground /Chassis  

Table 2.12  CVBS LED State Descriptions  

Item  Description  

Off  The CVBS input is not active.  

Red The CVBS input is active, but not locked.  

Green  The CVBS input is active and is locked.  

Alternate Red  and Green  The CVBS input is active, but video with the wrong.  

2.3.4.5  Digital Audio Input Connector (All CE - a and CE - x Option 

Modules )  

Digital audio may be input via the 15 -way D - type connector  
labeled AUDIO/DATA. The connector supports both balanced  
and unba lanced digital audio signals, though not at the same time. 
The connector does not support simultaneous analogue and digital 
inp ut. The digital audio can either be balanced (AES3) or unbalanced 
(AES3 - id) depending on the audio breakout cable used.  

Table 2.13  Audio Breakout Cables  

Marketing Code  Part Number  Supported Audio Mode  

AVP/CAB/BAL  S14936 Audio Breakout 

Cable  

Balanced Audio: 4 XLRs in + 1 BNC for 

Audio Reference Output  

AVP/CAB/UNBAL  S14937 Audio Breako ut 
Cable  

Unbalanced Audio: 4 BNCs in + 1 BNC 
out for Audio Reference Output  

Note:  An audio breakout cable is NOT supplied as standard with the chassis and must be 
ordered separately.  

The chassis detects which cable is fitted (balanced or unbalanced) and makes the necessary 
selection.  

Table 2.14  Breakout Cable Detection Criteria  

Item  AES3  AES -3id  

Interface  Balanced  Unbalanced  

Connector  XLR-3 BNC 

Impedance  110 Ý 75 Ý 

Input Level  2-7 V peak to peak  1 V peak to peak  

Max Input  7 V peak to peak  1.2 V peak to peak  

Max Current  64 mA  1.6 mA  

Min Input  0.2 V  0.32 V  
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Item  AES3  AES -3id  

Cable  Shielded Twisted Pair  Coax  

Interface  Balanced  Unbalanced  

Balanced Audio (AVP/CAB/BAL)  

With thi s option four balanced AES3 audio channels can be connected to the Audio/Data D -Type 
connector on an option card.  

An XLR socket is provided for each of the four digital inputs, and a 75 ǹ BNC plug for an AES3 
reference signal at 3.072 Mbps. The reference s ignal contains a 1 kHz tone at -6 dBFS at a sample 
rate of 48 kHz.  

Table 2.15  Digital Audio Input (Balanced)  

Item  Specification  

Connector types  15 -way D -Type  

Connector designation  AUDIO/DATA  

Pin Outs  Digita l 1 ï 1 

Digital 1 ï 2 

Digital 1 ï 3 

Digital 2 ï 1 

Digital 2 ï 2 

Digital 2 ï 3 

Digital 3 ï 1 

Digital 3 ï 2 

Digital 3 ï 3 

Digital 4 ï 1 

Digital 4 ï 2 

Digital 4 ï 3 

Ref ï 1 

Ref ï Shell  

Shell  

1 

9 

11  

10  

3 

Shell  

4 

12  

Shell  

13  

6 

7 

15  

Screen  

Digital 1 Line  

Digital  1 Return  

Screen  

Digital 2 Line  

Digital 2 Return  

Screen  

Digital 3 Line  

Digital 3 Return  

Screen  

Digital 4 Line  

Digital 4 Return  

AES3 Reference (48 kHz)  

Screen  

Unbalanced Audio (AVP/CAB/UNBAL)  

With this option four unbalanced AES -3id audio channels can be c onnected to the Audio/Data  
D-Type connector on an option card.  

A BNC plug is provided for each of the four digital inputs, and a 75 ǹ BNC plug for an AES3 
reference signal at 3.072 Mbps. The reference signal contains a 1 kHz tone at -6 dBFS at a sample 
ra te of 48 kHz.  

Table 2.16  Digital Audio Input (Unbalanced)  

Item  Specification  

Connector types  15 -way D -Type  

Connector designations  AUDIO/DATA  

Pin Outs  Digital 1 ï 1 

Digital 1 ï Shell  

Digital 2 ï 1 

Digital 2 ï Shell  

Digital 3 ï 1 

1 

9 

10  

3 

4 

Digital 1 Line  

Screen  

Digital 2 Line  

Screen  

Digital 3 Line  
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Item  Specification  

Digital 3 ï Shell  

Digital 4 ï 1 

Digital 4 ï Shell  

Ref ï 1 

Ref ï Shell  

12  

13  

6 

7 

15  

Screen  

Digital 4 Line  

Screen  

AES3 Reference (48 kHz)  

Screen  

2.3.4.6  Analogue Audio Input  via the 15 - way D - type Connector (CE -
xA)  

Two stereo pairs of an alogue audio may be input via the 15 -way  
 D- type connector labeled AUDIO/DATA. The analogue audio can 

either be balanced or unbalanced depending on the audio breakout 
cable used.  

Table 2.17  Audio Breakout Cabl es 

Marketing Code  Part Number  Supported A udio Mode  

AVP/CAB/BAL  S14936 Audio Breakout 
Cable  

Balanced Audio: 4 XLRs in + 1 BNC for 
Audio Reference Output  

AVP/CAB/UNBAL  S14937 Audio Breakout 

Cable  

Unbalanced Audio: 4 BNCs in + 1 BNC out 

for Audio Reference  Output  

Note:  An audio breakout cable is NOT supplied as standard with the chassis and must be 
ordered separately.  

The chassis detects which cable is fitted (balanced or unbalanced) and make s the  necessary 
selection.  

Table 2.18  Breakout Cable Detection Criteria  

Item  AES3  AES -3id  

Interface  Balanced  Unbalanced  

Connector  XLR-3 BNC 

Impedance  110 Ý 75 Ý 

Input Level  2-7 V peak to peak  1 V peak to peak  

Max Input  7 V peak to peak  1.2 V peak to peak  

Max Current  64 mA  1.6 mA  

Min Input  0.2 V  0.32 V  

Cable  Shielded Twisted Pair  Coax  

Balanced Audio (AVP/CAB/BAL)  

With this option four balanced analogue  audio channels can be connected to the Audio/Data D -
Type connector on a VCM option card.  

An XLR socket is provided for each of the four analogue inputs, and a 75 ǹ BNC plug for an AES3 
reference signal. The reference signal contains a 1 kHz tone at -6 dBFS at a sample rate of 48 
kHz.  
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Table 2.19  Analogue Audio Input (Balanced)  

Item  Specification  

Connector types  15 -way D -Type  

Connector designation  AUDIO/DATA  

Pin Outs  Analogue 1 ï 1 

Analogue 1 ï 2 

Analogue 1 ï 3 

Analogue 2 ï 1 

Analogue 2 ï 2 

Analogue 2 ï 3 

Analogue 3 ï 1 

Analogue 3 ï 2 

Analogue 3 ï 3 

Analogue 4 ï 1 

Analogue 4 ï 2 

Analogue 4 ï 3 

Ref ï 1 

Ref ï Shell  

Shell  

1 

9 

11  

10  

3 

Shell  

4 

12  

Shell  

13  

6 

7 

15  

Screen  

Audio in 1 +  

Audio in 1 -  

Screen  

Audio in 2 +  

Audio in 2 -  

Screen  

Audio in 3 +  

Audio in 3 -  

Screen  

Audio in 4 +  

Audio in 4 -  

AES3 Reference (48 kHz)  

Screen  

Unbalanced Audio (AVP/CAB/UNBAL)  

With this option four unbalanced audio channels can be connected to the Audio/Data D -Type 
connector on a VCM opt ion card. A BNC plug is provided for each of the four analogue inputs, and 
a 75 ǹ BNC plug for an AES3 reference signal at 3.072 Mbps. The reference signal contains a 1 
kHz tone at -6 dBFS at a sample rate of 48 kHz.  

Table 2.20  Analo gue Audio Input (Unbalanced)  

Item  Specification  

Connector types  15 -way D -Type  

Connector designation  AUDIO/DATA  

Pin Outs  Analogue 1 ï 1 

Analogue 1 ï Shell  

Analogue 2 ï 1 

Analogue 2 ï Shell  

Analogue 3 ï 1 

Analogue 3 ï Shell  

Analogu e 4 ï 1 

Analogue 4 ï She ll 

Ref ï 1 

Ref -  Shell  

1 

9 

10  

3 

4 

12  

13  

6 

7 

15  

Audio 1 Line  

Screen  

Audio 2 Line  

Screen  

Audio 3 Line  

Screen  

Audio 4 Line  

Screen  

AES3 Reference (48 kHz)  

Screen  

2.3.4.7  Satellite Modulator Option Card Connectors  

The Satellite Modulator Option  Card takes MPEG Transpo rt Streams on its input and provides a 
modulated output either in L -band (950 ï 2150 MHz) or in IF band (80 ï 150 MHz) according to 
the DVB -S, DVB -DSNG, DVB -S2 or DVB -S2X specification.  
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The output sign al can be fed to an up -convert er for mixing the signal  to the appropriate satellite 

channel. The module is also capable of powering the downstream up -converter. The module can 
take two input Transport Streams and encode and modulate one of them at a time. If the 
Transport Stream being modulated is lost for so me reason, the module can switch automatically to 
the other Transport Stream input and continue the transmission using that. The L -band input can 
be used for inputting a modulated L -band signal to the m odule. The module then can com bine the 
input and its o wn modulated output and feed a common up -converter with the combined signal.  

 

Figure 2.3 Satellite Modulator Option Card Rear Panel  

Table 2.21  Satellite Modulat or Option Card Connectors  

Item  Specification  

Connector types  50 Ý female SMA L -Band (L -BAND IN and L -BAND OUT MAIN)  

75 Ý female SMA L -Band F - type (L -BAND OUT MON)  

75 Ý female BNC (IF OUT MAIN and IF OUT MONITOR)  

Connector designat ion  L-BAND IN  

L-BAND OUT  MAIN  

L-BAND OUT MON  

IF OUT MAIN  

IF OUT MONITOR  

Pin-outs  Centre  

Shield  

Input/Output/Monitor  

Ground/Chassis  

2.3.4.8  ASI I/O Option Card Connectors  

The ASI I/O Option Card rear panel provides two ASI inputs and two ASI outputs.  

 

Figure 2.4 ASI I/O Option Card  

Table 2.22  ASI I/O Option  Card Connectors  

Item  Specification  

Connector types  75 Ý female BNC  

Connector designation  ASI IN 1  

ASI IN 2   

ASI OUT 1  

ASI OUT 2  

Pin-outs  Centre  

Shield  

Input  

Ground/Chassis  

The input connectors are used for feeding the unit with external Transport Streams for external 

data insertion.  
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The output connectors can be configured as a mirrored output pair (with the same Transport 

Stream on both outputs) or two independent outputs (with different Transport Streams on each 
output).  

2.3.4.9  G.703 Transceive r Option Card Connectors  

The G.703 Transceiver card provides one PDH (Plesiochronous Digital Hierarchy) input and one 
output interface that can be used for interfacing Transport Streams to PDH networks. The 

interface is G.703 compliant, and can provide sup port for E carriers, namely E31 (E3) and E32 
(DS3) as specified in IT U-T Rec. G.703.  

 

Figure 2.5 G.703 Option Card Rear Panel  

Table 2.23  G.703 Transceiver Option Card Connectors  

Item  Specification  

Connector types  75 Ý female BNC  

Connector designation  IN  

OUT 

Pin-outs  Centre  

Shield  

Input  

Ground/Chassis  

2.3.4.10  External Sync Input Option Card Connector  

The External Sync Option Card rear panel connector is used for connecting a 10  MHz 1  Vpp 

reference signal or an analogue video signal .  

 

Figure 2.6 External Sync Input Option Card  

Table 2.24  External Sync Input Option Card Connector  

Item  Specification  

Connector types  75 Ý female BNC  

Connector designation  SYNC IN  

Pin-outs  Centre  

Shield  

Input  

Ground/Chassis  

2.3.4.11  GPI Option Card Connectors  

The General Purpose Interface (GPI) Option Card provides the following interfaces .  
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Table 2.25  GPI Data In Connector (Not supported in this release)  

Item  Specification  

Connector types  9-way D - type female (not 
supported in this release)  

Connector designation  DATA IN  

Table 2.26  GPI Alarm Contact Clos ure Connector  

Item  Specification  

Connector types  25 -way D - type female  

Connector designation  GPI/ALARM  

Pin-outs  1   GPI Pin 1  

  14  GPI Pin 2  

2   GPI Pin 3  

  15  GPI Pin 4  

3   GPI Pin 5  

  16  GPI Pin 6  

4   GPI Pin 7  

  17  GPI Pin 8  

5   GPI Pin 9  

  18  GPI Pin 10  

6   GPI Pin 11  

  19  GPI Pin 12  

7   GPI Pin 13  

  20  GPI Pin 14  

8   GPI Pin 15  

  21  GPI Pin 16  

9   Reset  

  22  Fail (NO)  

10    Fail (COM)  

  23  Fail (NC)  

11    Alarm (NO)  

  24  Alarm (COM)  

12    Alarm (NC)  

  25  GND 

13    Sync/10 MHz  

NO, NC and COM label normally open, normally closed and common alarm or fail relay contacts 

respectively.  

GPI Data Input Connector (Not supported in this release)  

The Data Input provides an asynchronous serial data communications inte rface conforming to the 
IEC-232 (RS -232) standard.  

The DATA IN connector is a 9 -way D - type female connector on the rear panel. T he pin connections 
are shown in Table 2.27 . 
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Table 2.27  Data Input Connector Pin -out  

Remote (DTE) Male   Option Card (DTE) Female  

Signal Name  Pin  Signal Direction  Pin  Signal Name  

 1  1 Not Connected  

Received Data  2  2 Received Data  

Transmit Data  3  3 Transmit Data  

 4  4 Not Connected  

Sign al Ground  5  5 Signal Ground  

 6  6 Not Connected  

 7  7 Not Connected  

 8  8 Not Connected  

 9  9 Not Connected  

2.3.4.12  Mini USB Connector  

The mini USB connector on the front panel of the AVP chassis provides an interface for remote 
web access and update from a  computer, and for saving or exporting configurations to, and 
loading or importing configurations from a USB stick.  

 

Figure 2.7 Mini USB Connector  

For details on using the mini USB connector, see Chapter 4, Front Panel Control .  
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3.1  Introduction  

Due to the number of different ways the Advanced Video Processor (AVP) Series can be used, it is 
impossible to give precise setting up instructions for every possible work ing scenario. This chapter, 
therefore, gives gener al guidance and principles on how to power up and set up your unit for 
operation and describes the more common operations you will want to perform.  

For details of all Front Panel menus and controls, see Chapter 4, Front Panel Control.  For details of 

all We b Graphical User Interface (GUI) menus and controls, see Chapter 5, Web GUI Control .  

For more information on possible networking scenarios, see Chapter 6, Advanced Video Processing 
and Networking . 

3.2  How to Co nnect Up the Unit  

See Chapter 2, Installing the Equipment for all connector details.  

 

Figure 3.1 AVP Connections  

To connect up the unit(s):  

1.  Connect signal input connectors Ge 1 and Ge 2 (for your input Tran sport Streams) to your 

local area network if IP inputs are to be used.  

2.  Connect signal output connectors Ge 3 and Ge 4 (for your output Transport Streams) to your 
local area network if IP outputs are to be used.  

3.  Connect computer control connectors CTL1 and CTL2 (for Web GUI Control) to your local area 
network. Both connectors share the same IP address, Ctrl1 is the Primary control port, and is 
by default the active control port. Control Port Ctrl2 should be considered as the secondary 



 

AVP 1000, 2000 & 3000  | Version Y www.m ediakind.com  
 

3-5 

control network as it w ill not respond to  the Control Port IP Address unless control has been 

passed to it either as a result of a redundancy switch, or via a user command. The active 
control port switches when Ctrl1 has no link (e.g. carrier), and Ctrl2 has the link.  

4.  Connect si ngle or dual AC or  DC power connectors, depending on the option purchased, to the 
power supply.  

5.  Connect your signal cables to/from your option cards, depending on which options are fitted to 
your unit, as required.  

3.3  How to Power Up the Unit  

To power up the unit(s):  

1.  With all signal and power cables connected as required, switch on unit using the front panel 
switch.  

2.  Wait for unit initialization  to complete.  

Caution!  

This equipment should not be operated unless the cooling fans are working and there is free -air 
flow around the unit.  

 

3.4  How to Set the Unit IP Address  

Setting the IP address of a unit is accomplished using the front panel menus. For a full description 
of these menus, see Chapter 4, Front Panel Control .  

To set the IP address of the unit(s):  

1.  Ensure th e unit is fully powered up.  

2.  On the AVP front panel, using the rotary knob, scroll down to the Unit Config > Remote 
Control Setup option ( Unit  Config > Remote Control In - band Setup  option, when In -
band Control is enabled).  

3.  Press knob to select.  

4.  Using the k eys on the keypad, set the IP address, subnet mask and gateway address.  

5.  Press the Select  button to save, or Cancel to discard, the changes.  

Note:  It may be necessary to set the IP address, gateway address and Virtual IP address to 0, 
and to set a subnet ma sk i n order to allow the IP address to be changed.  

IP Addresses on the unit must adhere to RFC3330 range of restrictions as listed in the following 
table of allocated IP addresses.  

Table 3.1 IP Address Restric tion s 

Block  Present Use  Reference  

0.0.0.0/8  This Network  [RFC1700, p4]  

10.0.0.0/8  Private -Use Networks  [RFC1918]  

14.0.0.0/8  Public -Data Networks  [RFC1700, p181]  

24.0.0.0/8  Cable Television Networks  ---  

39.0.0.0/8  Reserved but subject to allocation  [RFC1797]  
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Block  Present Use  Reference  

127.0.0.0/8  Loopback  [RFC1700, p5]  

128.0.0.0/16  Reserved but subject to allocation  ---  

169.254.0.0/16  Link Local   ---  

172.16.0.0/12  Private -Use Networks   [RFC1918]  

191.255.0.0/16  Reserved but subject to allocation  ---  

192.0.0.0/24  Reserved b ut subject to allocation  ---  

192.0.2.0/24  Test -Net  ---  

192.88.99.0/24  6to4 Relay Anycast   [RFC3068]  

192.168.0.0/16  Private -Use Networks  [RFC1918]  

198.18.0.0/15  Network Interconnect Unit Benchmark Testing  [RFC2544]  

223.255.255.0/24  Reserved but subjec t to allocation  ---  

224.0.0.0/4  Multicast  [RFC3171]  

240.0.0.0/4  Reserved for Future Use   [RFC1700, p4]  

Notes:  The control network and data networks should not conflict.  It is suggested that the 
ranges for these networks are in the Private -Use Networks as listed in the summary 

Table.  

 IP Address range 192.168.10.x (subnet 255.255.255.0) is used for internal unit 
communications, so should not be used for external communica tions.  

 IP Address 192.168.20.20 is reserved for the use of a USB to Ethernet adapt er, and 
should not be used for other purposes.  

3.5  How to Configure In - band Control  

The In -band Control feature enables you to configure the unit using the Ethernet Data Output 
ports (Ge  3 and Ge  4) for control traffic rather than the Ethernet Control ports (C TL 1 and CTL2). 
This is useful where only a single network is provided for the AVP unit.  

When In -band Control is configured, this setting will remain unchanged:  

¶ after reboot ing  

¶ after a system upgrade.  

¶ after loading a profile (unless Support > Save Configur ation > Save configuration including 
control parameters and Support > Restore Configuration including Control Parameters web 
GUI options are used).  

Limitations  

In -band Control enables you to perform most of the usual configuration, control and monitoring 
functions, but has the following limitations:  

¶ The Control port is not supported when using In -band Control mode.  

¶ The In -band Control feature is only supported f or the following network configuration:  

o Data Output ports configured as Same -Network.  

o Data Outpu t ports configured as Active/Active.  
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o The physical IP address need not be set be set on the Data Output ports. When In -band 

Control is enabled, the value configu red at Device Configuration > Advanced Setup 
> Network Configuration > Data Interface Group 3 - 4 > IP Address  shall be valid 
for HTTP, SNMP, NTP, Unit Upgrade, ssh and License Key Generator . 

¶ If a unit upgrade fails resulting in the unit going into factory m ode, all data network access 
will be lost. It will therefore be necessary to retry the upgrade u sing the unitôs Control port. 
If you have no Control port network, it will be necessary upgrade the unit locally.  

¶ No reboot warning dialog appears when the In -band Control setting is changed on the front 
panel. A warning dialog will be presented, however, if the setting is updated on the web 
GUI.  

¶ The following features are not available when using In -band Control mode:  

o LDAP 

o Remote logging  

o SCTE 104 over IP  

o ESAM 

o CSM messaging for MGP  

3.5.1  How to Configure In - band Control Using the Front Panel  

Configuring In -band C ontrol is accomplished using the front panel menus. For a full description of 
these menus, see Chapter 4, Front Panel Control .  

To configure In -band Contr ol on the unit(s):  

1.  Ensure the unit is fully powered up.  

2.  On the AVP front panel, using the rotary knob, scroll down to  Advanced > System > Network 
Configuration > Use Data Interface 3_4 for Control (true/false).  

3.  Press knob to select true  (In -band Control enabled) or false  (In -band Control disabled).  

4.  Press the Select  button to save, or Cancel  to discard, th e changes.  

Note : Changing In -band Control shall result in the unit rebooting.  

When In -band Control is enabled, both the Control port and Data Output port IP addresses are 
displayed on the front panel top leve l display, see section 4.3 Front Panel Display .  

3.6  How to Configure Ethernet Control Ports  

Overview  

The Base Chassis has two Ethernet control ports that support IEEE 802.3 100BaseTX and 
1000BaseT protocols. The control ports are accessible via RJ -45 connector s mounted on the rear 
panel of the unit.  

 

Figu re 3.2 Ethernet Control Port Numbering  
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The Ethernet control ports are used to connect the unit to a control computer for control through a 

web browser or to a co ntrol system for control through nCompass Contr ol.  

Ethernet Control Port Parameters  

A single IP port is defined for all Ethernet control traffic to and from the chassis. The physical ports 
used for Ethernet control are by default the control Ethernet ports . The control ports can raise an 
alarm during a bnormal operational conditions.  

The parameters defining the control Ethernet port are as shown in the following table.  

Table 3.2 Ethernet Control Port Parameters  

Parameter  Values  Description  Comments  

Network Mode  Same Network 

[default]  

The interface pair is on the 

same subnet.  
Read only parameter  

Different Network  The interface pair is on 
different subnet.  

IP Redundancy Mode  Active -Active  The same traffic is present 

on both interfaces all the 
time.  

Read on ly parameter.  

 

Active -Standby 
[default]  

The secondary interface is 
active only if the primary is 
down.  

Autorevert  Auto - revert to 

Primary [default]  

Defines which of the 

interface group. will be used 
when connection is lost  

 

Auto - revert to 
Secondary  

Autorevert delay   The delay in seconds before 

a redundancy switch occurs, 
after the interface link is up. 
If this is set to 0 then 
switching happens 
immediately.  

 

Active Interface  Primary, Secondary  The currently active 
interface  

Read only parameter  

    

Line Speed  Auto [default]  The connection speed   

100 Mbps  

1 Gbps  

Duplex Mode  Auto [default]  Auto negotiate the mode   

Full Duplex  Simultaneously transmit and 

receive  

Half Duplex  Transmit and receive in a 
time division manner  

Default MAC Ad dress  aa:bb:cc:dd:ee:ff  The virtual MAC address of 

the Gex interface.  
Read only parameter  

IP Address  aaa.bbb.ccc.ddd  Virtual IP address of the 
control interface group  

IP address used for control 
and configuration of the unit.  

Should not be set to 0.0.0.0  
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Parameter  Values  Description  Comments  

Subnet Mask  0.0.0.0 [default]  

aaa.bbb.ccc.ddd  

Subnet mask for the control 
interface group  

 

Default Gateway  0.0.0.0 [default]  No defined gateway   

aaa.bbb.ccc.ddd  Gateway address for 
packets outside the defined 
subnet  

 

IGMP mode selection  

 

IGMP v3  Uses version 3 of the IGMP 

protocol  
 

IGMP v2 [default]  Uses version 2 of the IGMP 
protocol  

 

Physical Control Interface <n>   

Default MAC Address  aa:bb:cc:dd:ee:ff  The MAC address of the Gex 
interface.  

Read only parameter  

Link Status  Link Up (1000)  Link is u p and the link speed 

is 1000 Mbps.  
Read only parameter  

Link Up (100)  Link is up and the link speed 
is 100 Mbps.  

Link Down  Link is down.  

Link Up Time  days : hours : mins : 
secs 

The length of time that the 
link has been up. If the link 
goes down this value is 
reset to 0.  

Read only parameter  

TX Packets   Number of IP packets 
transmitted  

Read only parameter  

RX Packets   Number of IP packets 
received  

Read only parameter  

IP Address  aaa.bbb.ccc.ddd  IP address of the physical 
control interface  

 

If set to 0. 0.0.0 control 
interfaces will only respond to 
virtual IP address  

Setting the physical IP 
address allows the interface 
to be pinged to validate the 
connection.  This is not 
intended not be used as the 
IP address for configuration 
and control.  

Must be on th e same subnet 
and gateway as the virtual 
interface.  

3.7  How to Configure Ethernet Data Ports  

Overview  

Four gigabit Ethernet ports are provided for data input and output.  
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Figure 3.3 Ethernet Data Port Numbering  

Ethernet Data Port Parameters  

The data Ethernet ports Ge 1  and Ge 2 are bonded together, as are Ge 3 and Ge 4. Each port of a 
pair transmits the same IP traffic. If the IP address, or subnet mask of a secondary port is set to 
0.0.0.0, then it will be assu med that it is operating in a mirrored redundancy configura tion with 
the primary port, and therefore has the same IP address and subnet mask.  

VLAN Tagging  

VLAN tagging is supported on the Data Output interfaces. To configure VLAN, browse to Device 
Configur ation > Advanced Setup  and select Vlan Group  in the appropr iate output under the 
Vlan Tags  folder. Alternatively, you can also use the front panel to set up VLANs. The settings can 
be found under Advanced/System/Base Unit/Vlan Tags .  

The data Ethernet ports  are configured by the parameters listed in the following t able.  

Table 3.3 Ethernet Data Port Parameters  

Parameter  Values  Description  Comments  

Network Mode  Same Network [default]  The interface pair is on the 
same subnet.  

 

Different Network  The interface pair is on different 

subnet.  

IP Redundancy 
Mode  

Active -Active  The same traffic is present on 
both interfaces all the time.  

If Network Mode is set to 
Different Network then Active -
Active is set and becomes r ead 
only.  Active -Standby  The secondary interface is 

active only if the primary is 
down.  

Active Interface  Primary, Secondary  The currently active interface  Read only parameter  

Line Speed  Auto  The connection speed   

100 Mbps  

1 Gbps  

Duplex Mode  Auto [default]  Auto negotiate the mode   

Full Duplex  Simultaneously transmit and 
receive  

Half Duplex  

 
 
 
 
 
 
 

Transmit and receive in a time 

division manner  
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Parameter  Values  Description  Comments  

Default Virtual MAC 
Address  

aa:bb:cc:dd:ee:ff  

 
 
 
 
 

The virtual MAC address of the 
Gex interface.  

Read only parameter  

IP Address  aaa.bbb.ccc.ddd  Virtaul IP address of the data 

interface group  
Must be unique  

Will be used as source address for 
multicast output.  

Subnet Mask  0.0.0.0 [default]  

aaa.bbb.ccc.ddd  

Subnet mask for the data 
interface group  

 

Default Gateway  0.0.0.0 [default]  No defined gateway   

aaa.bbb.ccc.ddd  Gateway address for packets 

outside the defined subnet  
 

IGMP mode 
selection  

 

IGMP v3  Uses version 3 of the IGMP 
protocol  

 

IGMP v2 [default]  Uses version 2 of the IGMP 

protocol  
 

Physi cal Data Interface <n>  

Default MAC 
Address  

aa:bb:cc:dd:ee:ff  The MAC address of the Gex 
interface.  

Read only parameter  

Link Status  Link Up (1000)  Link is up and the link speed is 
1000 Mbps.  

Read only parameter  

Link Up (100)  Link is up and the link spee d is 
100 Mbps.  

Link Down  Link is down.  

Link Up Time  days : hours : mins : 
secs 

The length of time that the link 
has been up. If the link goes 
down this value is reset to 0.  

Read only parameter  

TX Packets   Number of IP packets 

transmitted  
Read only parameter  

RX Packets   Number of IP packets received  Read only parameter  

IP Address  aaa.bbb.ccc.ddd  Physical IP address of the data 

interface  
Can remain set to 0.0.0.0  

Must be unique if set  

Setting the physical IP address 
allows the interface to be pinged 
to validate the connection.  

Must be on the same subnet and 
gateway as the virtual interface.  

 

Data Input (Ge1 and Ge2)  

The unit has two Ethernet ports that can be used for data input, and responds to ARPs and pings. 
Currently input data is not supported.  

Data Output (Ge3 and Ge4)  
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The unit can generate one or more output Transport Streams from the components produced by 

the option cards fitted. The IP output Transport Stream packe ts are encapsulated in IP packets 
prior to being transmitted via the Ethernet Data ports. The base unit does not provide any other 
interface through which Transport Streams can be output.  

Table 3.4 Ethernet Re dundancy Modes  

Redundancy 
Mode  

Description  Type of Network  

Active -  Active  Both interfaces (Data 3 and Data 
4) simultaneously output the 

same output TS.  

Same  Network  

¶ Both interfaces are configured to be on the same 
network.   

¶ They have identical IP configuration, which is set using 
the Interface Group IP address (Virtual IP Addr ess).  The 
Physical Interface IP address does not need to be set 
and can remain at 0.0.0.0.  

¶ The unit automatically assigns the Source Address for 
output TS to be the IP address of the Interface Group.  

Different Network   

¶ Each interface has different IP c onfiguration.  
¶ This is set using the Physical Interface IP settings for 

each Interface.  
¶ The unit automatically assigns the Source Address for 

each output TS to be the address configured for the 
Physical Interface used for that TS.  

Active -  

Standby  

Only the  primary interface (Data 

3) will transmit the output TS.  

If the primary interface goes 
Link -Down, the TS is sent from 
the secondary interface (Data 4).  

Configuration to control auto -
revert is provided).  

Same  Network  

¶ Both interfaces are configured to be o n the same 
network.   

¶ They have identical IP configuration, which is set using 
the Interface Group IP address (Virtual IP Address).   
The Physical Interface IP address does not need to be set 
and can remain at 0.0.0.0.  

¶ The unit automatically assigns the So urce Address for 
output TS to be the IP address of the Interface Group.  

Different Network   

¶ Not supported in Active ï Standby mode.  

3.8  How to Configure the AVP Using the Web GUI  

The unit is configured using the web browser Graphical User Interface (GUI). F or details of all the 
GUI screens and options, see Chapter 5, Web GUI Control .  

For details of supported Web Browsers please refer to the release notes accompanying the 
software r elease.  

3.8.1  General AVP Configuration  

The configuration consists of two phases. Fi rst, the general parameters of the base unit and the 
option cards are configured through the Device Configuration  web page. Then, the output 
streams can be configured through the  Service Configuration  web page.  

To save any changes made, click on the Apply All  button located at the right side of the user 
interface below the page tabs.  

Note:  To save time, save the changes only after each parameter has been altered. When trying 
to le ave a page without saving the changes, a dialog is displayed which allows savi ng or 

discarding the changes or abandoning the page.  

The modified folders in the Advanced Video Processor Settings  widget and the corresponding 
parameters in the Properties  widge t are highlighted in orange. Moreover, the changes are also 
listed on the Chan ges  tab of the Information  widget. To undo a change, simply click on it in the 
Information  widget. The appropriate item shows up in the Properties  widget and its original 
value c an be restored manually.  
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3.8.2  How to Enforce HTTPS  

The AVP control interface can be  used over HTTP or HTTPS protocols. The HTTPS protocol is 
always available, and uses a self -signed certificate. It is not possible to change this certificate.  

HTTP is available by default, but an administrator of the unit can turn this off.  

To turn off HT TP access:  

1.  Navigate to the Device Configuration > Advanced Setup page and select Base Unit > Remote 

Authentication and HTTP server options.  

2.  Change the control Disable HTTP Access (HTTPS is always On)  to ON  in order to disable 

HTTP access, thereby enforci ng the use o f HTTPS.  

3.8.3  How to Configure User Authentication  

The AVP can be configured to force a user to log into the web application. Two authentication 
methods are available: Basic Authentication, and LDAP Authentication.  

Basic Authentication  

Basic Authent ication allo ws an administrator to set up a user name and password via the web 
application. When applied, the browser will immediately require that the user logs into the unit for 
that session.  

Note:  Basic Authentication is not designed to be a strong auth entication m ethod. Should 
something more robust be required, consider using LDAP Authentication.  

To set up Basic Authentication:  

1.  Navigate to the Device Configuration > Advanced Setup page and select Base Unit > Remote 

Authentication and HTTP server options .  

2.  Set Authe ntication  on the Properties  widget to Basic  and enter a username and password.  

3.  Select Apply All  to enforce authentication for the current session.  

 

Figure 3.4 Configuring Basic Authentication  

LD AP Authentication  

LDAP Authentication allows an administrator to use an external LDAP server to perform the user 
authentication.  

Note:  The AVP provides a test mode to check the parameters for LDAP have been correctly 
entered. This test mode is necessary be cau se if a mistake is made on entering the data, 
and full live LDAP is applied, no user will be able to authenticate and hence access to the 
unit will be permanently locked . 

To set up LDAP authentication:  
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1.  Navigate to the Device Configuration > Advanced Set up page and select Base Unit > Remote 

Authentication and HTTP server options.  

2.  Set Authentication on the Properties widget to LDAP Test.  

3.  Enter the LDAP parameters as provided by the userôs IT department. 

 

Figure 3.5 Configuring LDAP Authentication Test  

4.  Select Apply All . The user will be asked to enter their authentication details (username and 

password). The unit will attempt to authenticate against the server, and the result will be 

displayed on the same page . The unit automatically times out after two minutes and rese ts 

the Authentication  mode to Off .  

5.  If the LDAP settings were successful, select LDAP Authentication  for the Authentication  

control and select Apply All .  

 

Figure 3.6 Configuring LDAP Authentication  

3.8.4  How to Configure Advanced Video Processor Settings  

3.8.4.1  General Advanced Video Processor Settings  

To configure the General Advanced Video Processor Settings:  
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1.  Navigate to the Device Configuration  page and click on the Advanced Setup  tab.  

Note:  The Advanced Video Processor Settings  widget displays all the unit parameters 
organized into different folders in a tree view. The folders can be expanded and collapsed 
by clicking on the plus or minus sign next to them or by selecting a node, right clicking 
on it, then choosing Expand Selected  or Collapse Selected  from the context menu.  

2.  General parameters such as Unit Name, UTC and SNTP Server are configured by navigating to 
Encoder > Base Unit  

3.  Configure the IP output param eters by navigating to Encoder > Net work Configuration > 
Data Interface Group 3 - 4 .  

Note:  There is no actual output until a Transport Stream is created and its Status of 
Service  parameter is set to Online . 

4.  Optionally, the redundancy mode for the unit can be  set up in the Encoder > MGP Support  

folder  

3.8.4.1.1  Set the Unit Time and Date  

The UTC time and date can be set manually or  the unit can obtain the current time from a 
network time server using SNTPv4 (RFC 4330) and is capable of working with Microsoft Windows 
Time, (SNTP as defined in RFC 1769).  

SNTP Time Server  

If an SNTP Time Server is selected, and communications are established with it, then the unit uses 
the time obtained to correct the systemôs real time clock, and the user cannot set the clock. 

If a time server has been configured, but it f ails to respond, then an óSNTP Server Failed  
To Respondô alarm is generated. 

Note:  SNTP always uses port 123.  

One set of parameters is applicable to Carrier ID present in the NIT and used in the Satellite 
Modulator DVB RF Carrier ID (DVB -CID).  

The properties of these fields can be entered from the Device Configuration  Advanced Setup 
menu or from the Voyager Dashboard. A tab will also be available as part of the Satellite 
Modulator output Properties  under the Service Conf iguration  tab.  

3.8.4.2  Configure Option Card Output Parameters  

Note:  An output MUST have a Transport Stream created and set to Online  
before the  output signal will be present.  

To configure the Option Card Output Parameters:  

1.  Configure the parameters for satellite t ransmission by navigating to Encoder > Slots > Slot 
n ï Satellite Modulator Option Card > Satellite Modulator Option Card . The input, 
modulation and output parameters can be set up by selecting the Input Parameters, 

Modulation Parameters and Output Paramet ers folder and entering the required information, 
as shown on the picture below. To enable the output ensure that a Transport Stream has been 
created (this can be an empty Transport Stream if just a signal test is re quired). Set the 
Transport Stream status  to Online . Set the Output State  to either On (Reduced Power) or  
On (Nominal Power) , and when required set Modulation State  to On .  
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Figure 3.7 Setting the Parameters f or Satellite Transmission  

2.  The ASI output s can be configured to be mirrored (same TS on both outputs) or independent. 
There are no other configurable parameters for the ASI outputs  

3.  The format of the G703 Output is configured by navigating to Encoder > Slots  >  
Slot n ï G>703 Transceiver Card > G. 703 Transceiver Card > G.703 I/O Port 1.  

3.8.5  How to Configure Output Transport Streams  

To configure a Transport Stream for an AVP, follow the steps below. Here, the Satellite Modulator 
output is taken as example. Transpo rt Streams also can be easily configured  on other outputs 
using the same procedure.  

Note:  The unit can be configured to simultaneously provide either the same TS over multiple 
outputs (e.g. where additional output option cards are fitted) or different TS and the 

various available outputs.  See section 3.8.12  for information on copying a TS.   

1.  Navigate to the Service Configuration web page.  

2.  Expand the  Host Outputs node in the Outputs  widget, and click on the required output .  
A blue box is drawn around  the selected item and the properties associated with it are 
displayed in the Transport Stream  accordion panel of the Properties  widget.  

3.  Create a Transport Stream by right clicking the required output and selecting Add 
Transport S tream  command from the con text menu as shown in Figure 38 . The properties of 
the newly created Transport Stream appear in the Properties  widget.  

Note:  The Satellite Modulator Output Stream 1  and Satellite Modulator Output Stream 
2  outputs behave somewhat d ifferently than the other outputs. When selected, the 
parameters from the Device Configuration > Advanced Video Processor Settings > 

Encode > Slot n ï Satellite Modulator Option Card > Satellite Modulator Option 
Card > Modulation Parameters , Output Paramet ers  and Input Parameters  are 
shown to ease access and reduce the time needed for setting up the unit. The Input 
Parameters  tab is shown to allow easy access to the RAS encryption setting. All other 
parameters on this tab should be left at their default val ues. For other outputs, an  empty 
page is shown in the Properties  widget if no Transport Stream exists under them. 
Otherwise, the Transport Stream properties are displayed.  
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Figure 3.8 Service Configuration W eb Page ï Adding a Transpo rt Stream  

4.  Adjust the Transport Stream properties as required.  

Note:  It is good practice to configure a Transport Stream by setting the Bit rate tracking 
mode  to Maximize Video . In this way, any changes in the Transport Stream bit rate 
will be reflected in the video component bit rates. Moreover, on the Satellite Modulator 
output, the Transport Stream bit rate is determined by the modulation parameters. Any 
change in the modulation parameters will also be reflected in the bit rate o f the video 
component.  

5.  To set up internally generated ATSC tables, see Chapter 5, Web GUI Control . 

6.  To create a service in the newly created Transport Stream, make sure the Transport Stream is 
selected. Right click on it and select Add Service  from the context menu, as shown in Figure 
3.9. The properties of the newly created service shall appear in the Service  accordion panel 
of the Properties  widget. Adjust the service properties as required.  

 

Figure 3.9 Service Configuration Web Page ï Adding a Service  
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Note:  Transport Streams and services can also be added through the Action  menu in the 

Outputs  widget.  

7.  Expand the nodes in the Inputs  widget and select the video stream to be included in the 
Tran sport Stream.  

8.  Hold down the left mouse button and drag it over the newly created service. Once the 
component is over the service, the color of the dragging box changes to green indicating that 
the component is now over a valid dropping  position.  

 

Figure  3.10  Service Configuration Web Page ï Adding a Component  

9.  Release the left mouse button. The component is added to the newly created service and its 
parameters are shown on separate tabs i n the Video Componen t  accordion panel of the 
Properties  widget.  

10.  Adjust the video properties as required.  

11.  Add all the required components (audio, VBI...) from the Inputs  widget to the Transport 
Stream as above. Adjust the component parameters in the respec tive accordion panel  of the 
Properties  widget.  

Note:  To identify the source of a certain component in the Outputs  widget, click on the 
component. The source of the component is highlighted in grey in the Inputs  widget. 
You may have to scroll in the Inputs widget to actually s ee the highlighted component.  

12.  Modifying the same parameter for different items of the same type (for instance, the bit rate 
of two or more audio components) can be carried out by selecting a ll the items, navigating to 
the property to be changed, and changi ng the value. If the values for the selected items are 
different, then the string [Mixed]  is shown in the respective field.  

13.  If you want to create another service or Transport Stream, repeat the steps above.  

14.  Turn the Transport Streams online by selecting th e Transport Stream and clicking on the 
Online  button in the Properties  widget.  

Note:  Turning the Transport Stream online does not turn the modulator output on.  The 
additional steps below ar e needed.  

15.  The Satellite Modulator output and modulation parameters  can be configured from the 
Service Configuration > Satellite Modulator > Properties  tabs. For the output to be 
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transmitted, in addition to the TS being set Online, the output state must be set to ON (either 

reduced or nominal power) and the modulation sta te must also be ON. These parameters are 
also available in the Device Configuration  menus.  

16.  The status of the modulator output is indicated by the icons in the banner at the top of the 
user i nterface.  

Note:   All Transport Streams can be set online in one go  by selecting all of them and clicking on 
the Online  button.  

3.8.6  How to Configure the PCR  

By default, the unit will use a PCR embedded in the video. If a separate PCR is required the 
following s teps are necessary:  

1.  Turn off embedded PCR in the Video Component O utput Properties  panel.  

 

Figure 3.11  Video Component Output  

2.  Select the Video PCR Stream  from the video input list and drag and drop it into the output 
service.  

3.  Configure the required PCR PID  on this componen t.  

4.  Select Outputs > Service ï n  and set the PCR PID  to the same value as that set for the 
component.  
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Figure 3.12  Setting PCR PID Value  

3.8.6.1  PCR Embedded in Audio  

When configuring an audio component with embedde d PCR, the PCR PID is not automatically 
updated to match the audio component PID. You must configure the PCR PID in the service 
properti es to match the audio component PID. Failure to do this may result in the output being 
non -decodable, depending upon the  receiving device.  

3.8.7  How to Set Up Pass - thru Transport Streams  

The AVP supports Transport Stream content Pass - thru. That means that a Tran sport Stream on an 
ASI input interface can be passed through to the Satellite Modulator, G.703 or IP Output interface 
in  a content preserving mode.  

3.8.7.1  Configuration  

To configure a Transport Stream Pass - thru, select the ASI Transport Stream in the Input  widge t 
on Advanced  tab of the Service Configuration  page, and simply drag -and -drop to the Satellite 
Modulator or IP Output St ream in the Output  widget. When the cursor is above the output an 
information pop -up is displayed indicating that a Pass - thru Transport Stream will be created.  

 

Figure 3.13  Configuring a Pass - thru Transport Stream  

The Properties  widget shows that a Pass - thru Transport Stream has been configured and there are 
no configurable parameters.  
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Figure 3.14  Properties Panel view of Pass - thru Transport Stream  

3.8.7.1.1  Configuring  a Pass - thru TS From the Front Panel  

To configure a Transport Stream Pass - thru on the front panel, select Add Existing Transport 

Stream  in the menu of the appropriate output, and choose the required incoming Transport 
Stream from the list.  

3.8.7.1.2  TS Pass - thru Lim itations  

I f the bit r ate of an input stream is too high for the output to handle, the output is unusable, and 
alarms for too high data rate or buffer overflow are issued.  

3.8.8  How to Configure MGP  

3.8.8.1  Overview of MGP  

The Multicast Guard Protocol (MGP) is a mechanis m used to control the emission of multicasts 
containing media streams over IP, where multiple AVP units can emit the same multicast onto the 
same network. This mechanism ensures only one AVP unit in such a group will emit. In a system 
deployment, this perm its contro lling software to not have to configure downstream switches to 
prevent duplication of the same multicast onto the same network.  

MGP is configured automatically by MediaKind  control software, but can be set up via the GUI (or 
the Front Panel). Ple ase note t hat some of the settings mentioned here are hidden if the unit is or 
has been under the control of MediaKind  control software.  

MGP can operate in one of two modes, or it may be turned off:  

¶ In Unit Level  mode, it is assumed that another unit is, o r may be c onfigured with, the same 

output transport streams. When a failure occurs, MGP will coordinate a redundancy switch of 
all the services from one unit to the other.  

¶ In Media Level  mode, transport streams may be grouped together into media bundles, w hich 
may b e individually switched between units.  

In addition, MGP operation is significantly affected by two other settings:  

¶ The Network Mode for the output Interfaces, a choice of Same Network  or Different 
Network , and  

¶ The transport stream source IP redun dancy, a c hoice of Transparent  or Non - transparent .  

With a Network Mode  set to Same - Network , interfaces 3 and 4 share the same IP address and 
are therefore on the same network. Further options define how the interfaces are used. But from 
the perspective of MGP, there  is only one logical output interface.  
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With a Network Mode  set to Different - Network , interfaces 3 and 4 must be connected to 

seemingly different networks (or sub nets) and they each get their own distinct IP address.  

When TS Source IP Redundancy  is set to Transparent , media IP packets and MGP status IP 
packets are virtually sourced from IP addresses which can remain the same when a service bundle 
is switched from one unit to another. This setting is incompatible with the Different - Network  
mode.  

MGP works by  emitting MGP Status Messages (MSMs) alongside the media packets, but on a 
separate multicast common to a bundle, if applicable, and shared with units likely to take over a 
service in case of failure or simply targeted for a near -seamless switch.  

3.8.8.2  Configuri ng MGP  

1.  Set up the output interface Network mode: Device Configuration > Advanced Setup > Device 
> Network Configuration > Data Interface Group 3 -4 > Network Mode.  

2.  Set up the Transport Stream source IP redundancy mode: Device Configuration > Advan ced 
Setup > Device > Base Unit > TS Source IP Redundancy.  

Note:  A selection of output interface Network mode of Different Network , together with a 
transport stream source IP redundancy mode of Transparent , is not a valid 
combination.  

3.  Select the mode of ope ration for  MGP: Device Configuration > Advanced Setup > Device > 

MGP Support > MGP Settings.  

4.  Set up the MSM multicast address:  

a In Unit Level mode, the MSM multicast address is configured at Device Configuration > 
Advanced Setup > Device > MGP Support > MGP  Settings.  

b In Module Level  mode, there is the potential of a media bundle per Transport Stream 
and the MSM multicast address is configured at Service Configuration > Host 
Outputs > Transport Stream (output) > MGP Settings . MGP protection  also 
needs to be s witched on  for each Transport Stream ( Configuration > Host Outputs > 
Transport Stream (output) > MGP protection ). Please note that toggling between 
MGP modes will disable MGP protection  for each Transport Stream.  

5.  Configure the MGP spares:  

a In Unit Level  mod e, configure the spares through Device Configuration > Advanced 

Setup > Device > MGP Support > MGP Spares , entering the IP address of each 
spare. Up to four spares can be configured.  

3.8.8.3  Recommendations  

With a Same - Network  configuration, it is recommended that  Transparent  source IP redundancy 
is used.  

With a Different - Network  configuration, only Non - Transparent  source IP redundancy is 
available. Care must be taken to set the source addresses for spare units, providing the addresses 
of both output interfaces, or  MGP will not work correctly.  

Note:  Source IP redundancy can only be set to Non - Transparent  when there  are no output 
Transport Streams configured.  

3.8.9  How to Set Up Remux  

Services from a Transport Stream can be remuxed from an IP, ASI or G.703 input to any ou tput 
that can produce a Transport Stream.  
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3.8.9.1  Configuring Service  Level Remux  

I n order to remux a service f rom an input to an output, first ensure there is a Transport Stream 
already configured with an existing service on the output you wish to add the remuxed  service to. 
Once the Transport Stream has been created, drag one or more required services from their input 
to the target Transport Stream.  

 

Figure 3.15  Drag and Drop Service from ASI input to Output Trans port Stream  

Note:   The Remux Configuration wizard will start when the service has been dropped onto the  
Transport Stream.  

The Remux Configuration wizard will prompt you to select which components you want to remux. 
By default, all components from all servi ces dragged across will be selected. Once you have 
confirmed the components you want to remux, click on  Finish . 

 

Figure 3.16  Remux Configuration Wizard  

The remuxed services will appear in the target Transpor t Stream, one for each service that was 
dragged across. All remuxed components will have a blue R badge  to denote a remuxed 
component displayed in the Transport Stream tree in the Outputs  widget.  

Components in the remuxed service cannot be configured, alth ough their PID can be altered. The 

resulting services can be configured as normal.  
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It is not possible f or the device to know in advance what the bitrates of any remuxed components 

are, so it is necessary to add an upper value of their combined bitrates int o the Reserved bit 
rate  field of the Transport Stream. This bit rate will be put aside for remuxed serv ices and bit rate 
tracking will take it into account when allocating bitrates of encoded components.  

3.8.9.2  Remux of Data  

A simple form of remux is also availab le without a license. This allows an input TS containing data 

without PCR timing information (for examp le, SI/PSI tables) to be remuxed into an output TS. This 
is referred to as óNon-timed data remuxô. The data will be passed through the encoder with no 
ti ming information and there will be no alignment of the data to services from the unit.  

Configuring Non - Timed Data Remux  

First click on the input that you are using, and in the Properties  window, use the Max Reserved 
Bandwidth  field to enter the data rate o f the incoming data. Next, ensure there is a Transport 
Stream already configured with an existing service on the output you wish to add the data to.  

When the Transport Stream has been created, drag the input (e.g. ASI Stream 1) to the target 
Transport Stre am. All Transport Stream packets received on that input port will now be included in 
selected Transport Stream output.  

It should be noted, when this feature is used for the insertion of SI/PSI tables, it is expected that 
the internal SI/PSI generation is t urned off (Select the output Transport Stream, and in the 

Properties  window, switch off all tables).  

3.8.10  How to Configure the Front Panel Video Confidence Monitor  

The confidence monitor on the front panel can be configured to mon itor the video input on any 
VCM fitted to the chassis, from either the GUI or the front panel.  

From the GUI go to Device Configuration > Advanced Setup > Base Unit > Front Panel Parameters 
> Video Monitor Setup > Video Monitor Video Select. The Properties panel will provide a drop 

down box listing all available sources with the relevant slot number (in many cases this will be 
only a single VCM). Select the required source.  

There is a preview time for the confidence monitor that sets the time the monitor dis play is active 
from the time th e ON  button is pressed. This is to help maximize the life of the monitor.  If a 
longer preview time is required, from the GUI go to Device Configuration > Advanced Setup > 
Base Unit > Front Panel Parameters and set the Video Monitor Preview Time  to the 
req uired value (in seconds).  

From the front panel navigate to Unit Config > Display Setup > Video Monitor Input and 
select the required source.  

3.8.11  How to Configure VLAN Tagging  

VLAN tagging can be used to segregate IP packets from data interfaces.  

VLAN Creation  

A VLAN is created by specifying the VLAN ID, IP address and the Netmask. All Transport Streams 
which are tagged to this VLAN use the VLAN IP address as its source IP address. Hence the VLAN 
and VLAN ID must be cr eated before it can be used to tag a Transpo rt Stream.  

To create VLANs, on the Advanced Setup  tab of the Device Configuration  page navigate to the 
Device > Vlan Tags  folder, select the output you want to assign the VLAN tag to, and click Add  in 

the Propert ies pane and configure the IP settings as re quired. Alternatively, on the front panel 
navigate to Advanced/System/Vlan Tags  and set up the VLANs as required.  

Alternatively VLANs can be created via the Service Configuration  page by clicking on the 
Manage  button next to the Vlan Tag  parameter.  

The av ailable options are listed in the following table.  
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Table 3.5 VLAN Creation Options  

Parameter  Values  Description  

Vlan ID (Create)  2-4094  New VLAN ID to create.  

Vlan IP  xxx.xxx.xxx.xxx  VLAN IP Address (VLAN ta gged Transport Stream will 

have this as its source IP address).  

Vlan Netmask  yyy.yyy.yyy.yyy  VLAN Netmask.  

Vlan Gateway  zzz.zzz.zzz.zzz  VLAN gateway address for the current VLAN.  

Note:  The VLAN Id and its IP address must be unique across all Ethernet in terfaces.  

VLAN Tag Sharing  

Once the VLANs are created, they can be assigned to IP Transport Streams. To do that, navigate 
to Service Configuration  page, and create a Transport Stream for the a ppropriate IP output. 
Then, click on the newly created Transport  Stream, and in the Properties  widget select the 
required VLAN tag. VLANs can also be assigned to Transport Streams in the Outputs/IP Output 
<m>/Data Interface Group <n>/Transport Stream ID: < id>/Destination 
List/Destination <k>/Vlan Tag  front panel menu. The following options can be set:  

Table 3.6 VLAN Tag Sharing Options  

Parameter  Values  Description  

Vlan Tag  None, existing VLAN tag  Disables VLAN tagging or assigns the selected VLAN 
tag to the current Transpo rt Stream.  

Vlan Priority  0-7 Priority that can be used to support QoS.  

It is also possible to group multiple Transport Streams under the same VLAN. To do this, assign 
the same VLAN tag to all of them.  

Note:  On the web user interface, VLANs can be managed  through the Service Configuration 
page by clicking on the Manage button next to the Vlan Tag parameter.  

VLAN Deletion  

A VLAN can be removed from the Transport Stream by ch anging the VLAN Tag parameter under 
the Transport Stream to None. If a VLAN tag use d by any Transport Stream is deleted from the 
VLAN Tags  folder, the VLAN Tag  parameter is set to None  in the respective Transport Streams.  

3.8.12  How to Copy and Move Transport Streams and Services  

To copy or move a previously created Transport Stream or service , or an existing component from 
one output to the other, proceed as follows:  

1.  Select the Transport Stream, service or component.  

Note:  More items can be highlig hted by holding down the Ctrl  or Shift  key while clicking.  

2.  To move the selected items, drag them  over another valid dropping location and release the 
mouse button. For Transport Streams, valid dropping positions are the outputs, for services, 
the Transport Streams and for components, the services.  

3.  To copy the item instead of moving, hold the Ctrl  key  while dragging. The item is moved or 
copied to the specified location.  

The commands in the Edit  menu of the Properties  widget can also be used for cop ying or moving 

items. To use these, proceed as follows:  

1.  Highlight the item or items you want to copy or m ove, then choose Edit > Copy  or Edit > 
Cut .  
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2.  Then, highlight the location where you want to paste the items. Select Paste  from the Edit  

menu. The items will be copied or moved to the new location.  

3.  There is also an option to create an identical mirror of an existing Transport Stream such that 
any changes made to the original Transport Stream are automatically applied to the mirrored 
Transport Stream.  To c reate a mirrored Transport Stream highlight the Transport Stream to 
be copied, chose Edit > Copy , highlig ht the output where the mirrored TS is to be applied to 
and chose Edit > Paste as Mirror  

4.  To save your changes, click the Apply All  button located at th e right side of the user interface 
below the page tabs.  

Note:  A component can be included in more than on e Transport Stream as an instance of an 
input component. Therefore, any change to it, be it automatic by the bit rate tracking 
algorithm or manually ap plied by the user, is reflected in all instances.  

3.8.13  How to Customize the Quick Set - up Menu to Quickly Acces s 

Required Features  

The quick set -up menu provides a means for the user to customize access to frequently used 
parameters:  

1.  Open the Customize Items dia log by selecting Actions > Customize Items.  

2.  In the Configuration Items widget of the Customize Items dia log, select the Quick Setup Items 
node, and select Actions > Add Folder.  

3.  Double -click on the newly created node, and rename it to a more descriptive n ame.  

4.  Expand the Encoder tree and scroll down to the item you want to add to your custom list in 
the Adva nced Video Processor Settings  widget.  

5.  By holding down the left mouse button, drag the item over the new folder in the 
Configuration Items  widget.  

6.  Add  the item to the new folder by releasing the mouse button. The item cannot be added to 
the Quick Setup It ems  node. Any valid drop position is indicated by the dragging rectangle 
changing into green.  

7.  Repeat the process for any additional items you want to add. You can create as many folders 
as you wish or you can use any previously created one. The created fo lders can be reordered 
by the drag -and -drop technique used for adding the item. The added items can also be 
relocated through drag -and -drop. To delete a folder or an item, select it then choose Action 
> Remove Item .  

8.  When ready, click Save  to save the chan ges. The new items are added to the Quick Setup  
menu.  

Notes:  The list of added items can be exported by selecting Action > Export and can be 

imported  on another unit by Action > Import  
 
Parameters associated with Transport Stream creation and configurati on cannot be added 
to the quickset -up items.  

3.9  How  to Configure Video  

Buffer Mode  

The buffer modes offered are:  

¶ CBR  ï Constant Bit Rate operation is the recommended mode of operation for all profiles and 
bit rates.  

¶ Low Delay  ï removes pre -processing function s to reduce the encode delay but at a lower 
quality. Bit Rate, GOP Structure and GOP length selections will affect the delay .  
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¶ Mega Low Delay  ï removes frame sync in pre -processing to reduce encode delay further but 

at reduced quality. Bit Rate, GOP Structu re and GOP length selections will affect the delay.  

¶ Super Low Delay  (CE - HEVC Card only) ï offers the lowest delay p ossible. Bit rate selection 
may affect the delay. In this mode, the only GOP structures possible are All P and  I Frame 
only . Not available wi th H.264.  

GOP Structure  

For best picture quality the following GOP structures are recommended:  

¶ In SD and HD 1080i H .264 and HEVC operation the GOP structure should be set to IBBBP .  

¶ In HD 720p H.264 and HEVC use IBBBBBBP . 

To achieve low encoding delay, the Low Delay Buffer  mode should be used. In this case, the 
recommended GOP structure is still IBBBP . To achieve even s maller delays, a smaller number of 
B pictures can be used. The IBP GOP structure is the best compromise between latency and 
picture quality a nd the IP GOP structure gives the lowest possible delay, but may impact on video 
quality.  

Table 3.7 GOP Length  

Video Quality  GOP Length  

1080i 29.97 Hz  32  

720p 59.94 Hz  60  

1080i 25 Hz  24  

720p 50 Hz  52  

To a chieve the lowest possible encoding delay Super Low Delay  mode should be used. In this 
mode, the GOP Structure  options will change from the typical offerings of: IBBBP etcé to: All P 
and  I Frame only.  

Profile  

High@Level 4.0 is recommended for 4:2:0 mode an d bit rates below 20 Mbps.  

High@Level 4.1 will achieve the same performance, but allows higher bit rates up to 62.5 Mbps.  

Hi422 -10bit@Level 4.1 is recommended for better quality performance and allows bit rates up to 
80 Mbps.  

Bit Rates  

The maximum bit rate  possible varies with the profile and level. Ho wever, if two or more channels 
are in use, each channel is defined by the profile, or 30 Mbps, whichever is lower.  

CE- HEVC Card Teletext / Ancillary Data Rates  

For single channel usage, the maximum data rate t hat can be supported is 500 kbps for the 
combin ed Teletext and ancillary data, across all channels. This can be subdivided in any way 
between the channels so long as the total bit rate does not exceed 500 kbps.  

HEVC HDTV 4:2:0 Recommendation  

For HD HEVC Ma in Profile Level 4.0 High Tier 4:2:0 8 bit, the  typical bit rate is around 12 Mbps.  

HD HEVC Main Profile Level 4.1 High Tier 4:2:0 8 bit is supported by professional STBs and allows 
higher bit rates to be used. Typically this profile is used for bit rates  above 25 Mbps.  

HEVC UHDTV 4:2:0 Recommendation  
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For UHD HEVC Main 10 Profile Level 5.1 High Tier 4:2:0 10 bit, the typical bit rate is   around 30 

Mbps.  

HEVC HDTV and UHDTV 4:2:2 Recommendation  

On video with strong color content on 4:2:2 HEVC HDTV, the bi t rate should be set at 9 Mbps or 
higher for HD TV and 20 Mbps for UHDTV. At a bit rate below 9 Mbps for HDTV and 20 Mbps for 
UHDTV, the video quality is likely to be better in the 4:2:0 format. Video content with less color, 
e.g. film material, the bit rat e can also be used at a lower bit rate in 4:2:2  format.  

HEVC HDTV and UHDTV 10 - bit Recommendation  

The 10 bit format can be used at the same bit rate as in 8 bit even at low bit rates. There is no 
cross -over in video quality between 8 bit and 10 bit. Even a t low bit rates, the 10 bit format can 
remove c ontour artifacts on flat areas or on fade changes.  

Horizontal Bandwidth  

Always set to 100% for Contribution and Distribution applications  

Inloop Filter  

The default (recommended) setting is Normal . Setting the Inloop Filter to Low  can be used to 
improve sha rpness (e.g., in grass in sports sequences) at the expense of increased blocking 
artifacts.  

Auto mode  is designed to be adaptive and alter the filter strength on a per -picture basis, and will 
generally lower t he filter strength on sports content to improve  the sharpness in grass, albeit at 
the expense of increased blocking artefacts on the crowd and players perhaps, but will revert back 
to normal or higher filter strength on other content.  

3.10  How to Configure and Use Video Input Detection  

Overview  

The CE VCMôs are capable of detecting if there is a valid video stream available at the SDI/HD -SDI 
input. The VCM can be set up to report whenever it detects a format change in the input video 
stream, or it can even modif y encoding parameters to suit.  

Note:  Changes to the source that result in a change of configuration will result in a loss of video 
for a short time. This outage time varies depending on the configuration change.  

Input Detection Configuration  

Once a video c omponent has been added to an output Transpor t Stream on the Service 

Configuration  page, input detection options can be set up on the Input  and Encode  tabs for the 
respective video in the Properties  widget.  

Input Options  

Table 3.8 Input Options Parameters  

Parameters  Values  Description  

Input Detection  Off, Auto Detect and Report, Auto Detect 
and Configure Video Profile Only, Auto 
Detect and Restore Saved Config  

Specifies what to do when the input video format 
has been changed.  

Detected Video 
Standard  

Not Detected, SD 567i25, SD 480i29.97, 
HD 720p50, HD 720p59.94, HD 1080i25, 
HD 1080i29.97  

The detected video standard if Input Detection  is 
set to other than Off. If the format is not detected 
or Input Detection  is set to Off, it is set to N ot 
Detected. Read only parameter.  

Select Configs to be 
loaded on input 
video detection  

No Action  

Config n  

Only availab le when Auto Detect and Restore 
Saved Config is selected.  
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Parameters  Values  Description  

SD 567i25,  

SD 480i29.97,  

HD 720p50,  

HD 720p59.94,  

HD 1080i25,  

HD 1080i29.97,  

3G 1080p50,  

3G 1080p59.94  

For each input format a drop down box will display 
all available stored configs  

Encode Options  

Table 3.9 Encode Options Parameters  

Parameters  Values  Description  

Profile for SD  Profile Off,  
Available profiles depend on card type and 
licenses  

The profile to set when a change to an SD format 
has been detected. Available only if Input 
Detection  is set to Auto Detect and Configure.  

Profile for HD  Profile O ff,  
Available profiles depend on card type and 
licenses  

The profile to set when a change to an HD format 
has been detected. Available only if Input 
Detection  is set to Auto Detect and Configure  

Profile for 3G  Profile Off  

Available profiles depend on card type  and 
licenses  

The profile to set when a change to an 3G format 
has been detected. Available only if Input 
Detection  is set to Auto Detect and Configure  

Input Detection is Set to Off  

If Input Detection  is turned off, the input video format is not monit ored by the VCM. No action is 

taken when there is a change in the format of the incoming native video through the SDI/HD -SDI 
input, other than that specified by the output on video loss parameter.  

Input De tection is Set to Auto Detect and Report  

If Input D etection is set to Auto Detect and Report, a video lock alarm is raised if the video lock is 
lost on the SDI/HD -SDI input and the output on video loss setting will apply.  

If no source is connected or the input source is not recognized then Not Detected is  reported as 
the detected video standard, otherwise the detected standard will be displayed.  

Input Detection is Set to Auto Detect and Configure Video Profile Only  

If no source is connected or the input source is not recognized then Not Detected is reporte d as 
the detected video standard, a video lock alarm is raised and the output on video loss setting will 
apply.  

If the VCM can lock to the new input, a change in the input format the detected stand ard will be 
displayed and a change in the Video Input Forma t parameter will be triggered. Then the Video 
Profile will be changed as set in the Profile for {SD, HD or 3G} field if there is a change between 
SD, HD or 3G.  

Notes:  When the format changes betwe en SD and HD the video bit rate may be changed if the 
curre nt bit rate is outside the range supported by the new profile.  

 When the format changes between SD and HD any VBI or VANC configuration will not be 
maintained.  

Input Detection is Set to Auto Detect  and Restore Saved Config  

Pre - requisites  
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The user must full y configure the unit as required for each expected source and save each as a 

separate stored configuration on the unit.  

If the user does not intend to support all of the possible source options, th en an associated 
configuration is not required.  

The sugges ted operational workflow is described by the diagram below.  

FULLY Configure unit for required 
input format operation (eg SD 25Hz) 

with Auto Detect set to OFF

Save as a Stored Configuration and 
name appropriately.

Repeat for all required input formats 

All required 
configs stored

Load stored config n onto unit.

9ƴŀōƭŜ ά!ǳǘƻ 5ŜǘŜŎǘ ŀƴŘ /ƻƴŦƛƎǳǊŜ ς 
ǳǎŜ ǎǘƻǊŜŘ ŎƻƴŦƛƎǎέ ŀƴŘ ǎŜƭŜŎǘ ǘƘŜ 

required config to be used sof each 
required source.

Save the modified configuration in 
the same stored config location. 

Repeat for each stored config

All required configs 
modified and stored?

Unit is ready to use ς any of the 
stored configurations can be loaded 
at any time and the auto detect and 
configure operation will continue to 

function.

Note that when no stored configs are 
available no options will be presented for 
ǎŜƭŜŎǘƛƻƴ ǿƘŜƴ ǘǊȅƛƴƎ ǘƻ ŎƻƴŦƛƎǳǊŜ ά!ǳǘƻ 

Detect and Configure ς ǳǎŜ ǎǘƻǊŜŘ ŎƻƴŦƛƎέ, 
so no point setting it yet!

Once all required stored configs are 
ŀǾŀƛƭŀōƭŜ ά!ǳǘƻ 5ŜǘŜŎǘ ŀƴŘ /ƻƴŦƛƎǳǊŜ ς 
ǳǎŜ ǎǘƻǊŜŘ ŎƻƴŦƛƎέ Ŏŀƴ ōŜ ŎƻƴŦƛƎǳǊŜŘ ŀǎ 

required.

It is not absolutely necessary to do this for 
every configuration, but would ensure that 
the unit would continue to operate in the 

same way if any of the stored configs were 
manually loaded onto the unit. 

Identify which input formats need 
operational  requirements

Y

N

Y

N

 

Figure 3.17  Set -up Procedure for Auto Detect and Restore Saved Config  
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Figure 3.18  Input Detection Configuration  

Operation  

If no source is connected or the input source is not recognized then Not Detected is reported as 
the detected video standard, a video  lock alarm is raised and the output on video loss setting will 
apply.  

If the VCM can lock to the new input, a change in the input format the detected standard will be 
displayed and the selected configuration file for the detected format is applied.  

Note:  ONLY the video, audio, VANC and VBI configuration parameters from the stored 
configuration for the associated options card are applied in this case.  All other cards and 
base unit parameters remain unaffected.  

If the video is embedded in a Transport Stream  for which Bit Rate Tracking Mode is set to 
Maximize Video, and the Bi t Rate Weighting for the video component is set to other than Fixed or 

Minimal, then the Video Bit Rate might also get updated. For more information, see Operation and 
Control > Bit Rate  Tracking. Some examples are also given below:  

¶ Source  changed from HD to SD , and Profile for SD  input is set to SD MPEG - 2 Main 
Profile Main Level 4:2:0 8  bit:  The new encoding profile is SD MPEG -2 Main Profile Main 
Level 4:2:0 8  bit. The bit rate is limite d to 15 Mbps (maximum allowed by profile) if it was 
higher than 15 Mbp s before the change. Otherwise the bit rate is not affected.  

¶ Source  changed from SD to HD , and Profile for HD  input is set to HD H.264 Main Profile 
Level 4.0 4:2:0 8  bit : The new encodin g profile is HD H.264 Main Profile Level 4.0 4:2:0 
8  bit . If there is a room to increase the video bit rate to a value higher than the maximum set 
for the previously used SD profile, then the bit rate is increased.  

3.11  How to Set Up 4K Video Encoding  

About UHD  Video  

The CE - HEVC encoder is capable of encoding a 3840x2160 UHD pict ure as defined in 
SMPTE 2036 - 1.  
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The 4K image is delivered into the encoder via either 4 -off 3G BNC connectors or 4 -off LC optical 

connectors depending on the input option ordered at the time of manufacture.  

There are 2 recognized formats of how to carry t he 4K picture over the 4 -off 3G connections, 
quadrant or interleaved. The CE -HEVC encoder supports both input forma ts.  

The CE -HEVC option module supports Level A direct image mapping. Mapping an uncompressed 
video image into a serial digital interface oper ating at a nominal rate of 3 Gbps.  

Quadrant  

The 4K picture is broken into for HD quadrants and carried on 4 synchro nized SDI signals as show 
below.  

 

Figure 3.19  4K Video -  HD Quadrants  

Interleaved  

The 4K pic ture is broken up into sub pictures by dividing the original picture using the two sample 

interleaved division as s hown below. See SMPTE 425 -3 and 425 -5 for more information.  
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Figure 3.20  4K Video -  Interlea ved  

Configuration  

To set up 4K video encoding for a service on the Service Configuration  page, proceed as 
follows:  

Note:  This procedure assumes that a service has already been created. If not, one must be 
created before continuing. See section 3. 26.3 .  

1.  In the Inp uts  widget, select Video 1 Main Video Stream .  

2.  Drag the selected component to a service in the Outputs  widget.  

3.  In the Outputs  widget, click on the video component.  

Note:  If you click on Audio Stream 1  in th e Inputs  widget, the corresponding audio stream 
will be highlighted in grey in the Outputs  widget.  

4.  In the Properties  widget, click on the Input  tab.  

5.  Set the Source to SDI . 

6.  Set the Video Input Format  to one of the following depending on the input format des cribed 
above and the video frame rate:  

a UHD 2160p50 Interleaved.  

b UHD 2160p59.94 Interleaved.  

c UHD 2160p50 Quad.  

d UHD 2160p59.94 Quad.  

Note:   It is possible to set Input Detection  to Auto Detect and Configure  if using the 
Interleaved format.  

7.  Click on the Encod e  tab.  

8.  Set the Profile  to UHD HEVC Main 10 Profile Level 5.1 High Tier 4:2:0 10 bit .  

Note:   For 4:2:2 video encoding a license must be purchased and the Profile  set to UHD HEVC 

Main 10 Profile Level 5.1 H igh Tier 4:2:2 10 bit .  

9.  Set the Buffer Mode  to either  CBR, Low Delay or Mega Low Delay depending on the 
picture quality and end to end delay required . See section 3.9  for more details.  

10.  Set the Video Bitrate  to the required value  depending on the bandwidth availabl e and 
picture quality required . See section 3.9  for more details and recommendations.  

3.12  How to Set up Bit Rate Tracking  

Overview  

The bit rate tracking feature ensures that the output TS rate is automatically fully  utilized. In case 
of a bandwidth change the tracked components change their  bit rate accordingly.  

The bandwidth can be influenced typically by the bit rate of the Transport Stream but other factors 
can also trigger a change.  

Weighting is used to proportio nally distribute the change in bandwidth among the components in a 
multi pro gram transport stream. A weight value between 2 and 20 can be assigned to a video 
component and so the component becomes a tracked component whose bit rate is influenced by 
the Tra nsport Stream. The bit rate of Fixed  weight components do not change and a Minimum 
setting  will result in the video component bit rate being configured at the lowest bit rate allowed 
by its video profile.  
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As individual components can be included in multipl e Transport Streams, a Master TS  has  to be 

specified which will be the controlling factor that determines the bit rate of the tracked 
components, which will be reflected in all Transport Streams that a component is included in.  

For example: An IP output tr ansport stream may have significantl y more bandwidth than the 
Satellite Modulator output and the same TS is to be transmitted over both interfaces. The Satellite 
Modulator TS is defined as the Master TS  (by default) so that it is not overrated. The common IP 
output components will have the s ame bit rate but the IP TS will not be fully utilized.  

Notes:  A Transport Stream becomes overrated when the sum of the component bit rates 
exceeds the Transport Stream bit rate. This can occur when the master Transport S tream 
increases the bit rate of a co mponent that is included in another Transport Stream and 
that other Transport Stream cannot compensate the increase by the decreasing of the 
null packets bit rate. As long as IP and ASI outputs are also configured with b it rate 

tracking set to maximize vid eo, they will automatically increase their bit rate in line with 
the Satellite Modulator  (or Master TS ) output in order to avoid being overrated.  

Enabling Bit Rate Tracking  

Select the Transport Stream for which bit rate tracking is required.  

Notes:  If the Transport Stream is not yet created, build it by following the steps in Manual 
Configuration via the Web Pages or in Manual Configuration via the Front Panel.  
 
Bit rate tracking mode  is set to Maximize video  by default, but this step is included in the 
pro cess to ensure success.  

In the web browser navigate to Service Configuration  and click the TS  in the Outputs  panel. Set 
the Bit rate tracking mode  to Maximise video . 

 

Figure 3.21  Enabling Bit Rate Tracking M ode  

Alternatively on the front panel navigate to Bit rate Tracking  and select the Transport Stream. 
Set the Enable Bit rate Tracking  to Maximize video . 

Set Weight of Component  

There is also a weighting parameter for each  video component. This provides the user with  
control over how the available bit rate should be shared between the video components in a  
multi -program Transport Stream.  

For example: A TS contains 2 video programs that could both have the same bit rate, b ut one is 
premium so needs double th e bit rate allocation of the second. In this case the weighting for the 
premium video should be set to 20 and the second video should be set to 10.  

The weighting parameter is accessible in the video component's menu. In the web browser click 
the component in the Outputs  panel and select the component tab.  
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Figure 3.22  Setting Bit Rate Weighting of Component  

On the front panel navigate to Bit rate Tracking/Components/<compon ent>.  

Table 3.10  Bit Rate Weighting Parameters  

Weighting  Comment  

Fixed  This will result in the user configured video bit rate to b e used and the video 
component bit rate will not automatically be adjusted.  

Minimum  This will result in the video component bit rate being configured at the lowest bit 

rate allowed by its video profile.  

2 -  20  A numerical entry to determine what proportion of the available TS bit rate should 
be allocated to the video component (2 being smallest, 20 being largest).  

Note:  The weight of the video in the Transport Stream is set to 20 by default.  

3.13  How to Return to Default Settings from the GUI  

All settings are retained through a power cycle. If the unit seems to be behaving strangel y or you 
just want to erase all settings then the default settings can be restored. To restore the default 
settings navigate to Support > General > Clear Device Configuration  and select the Reset 
Configuration  button. The configuration will be reset and th e device will reboot.  

3.14  How to Set Up Audio Pass - thru  

When configuring the audio module to pass audio without encoding, it is necessary to set the 
audio encode coding standard to Pass - thru  before selecting the audio input format to the pre -
compressed format to be passed.  

Note:  If an attempt is made to select a pre -compressed input format while the module is 
configured to encode audio, an error message referring to no more licensesé will be 
displayed, and the configuration cannot be applied.  

When configured fo r audio Pass - thru, the user is provided with the abi lity to select the bit rate or 

bit depth of the incoming stream. This helps ensure that there is not an excessive bit rate 
allocated to the audio component when bit rate tracking is enabled. However, ther e is no 
monitoring to ensure that the input matches the configured value and, if the configured value is 
set lower than the actual incoming bit rate, the output  Transport Stream can be over - rated 
causing problems with the output.  
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Table 3.14 Audio Pass - thr u Bit Rate Configuration  

Audio Input  Configurable Options  

LPCM Pass- thru  Bit Depth  16 bit (1960 kbps)  

20 bit (2340 kbps))  

24 bit (2728 kbps)  

Dolby -E Pass- thru  Bit Depth  16 bit (1960 kbps)  

20 bit (2340 kbps))  

24 bit (2728 kbps)  

Dolby Digital Pass - thr u Bit rate  Range 96 kbps to 640 kbps  

3.15  How to Set Up Phase Aligned Audio Encoding  

About Phase Aligned Encoding  

Note:  ñPhase Aligned Audioò is patented MediaKind  functionality.  

Phase Aligned Audio (PAA) is a proprietary feature of MediaKind  Television Contri bution Encoders 
that uses multiple MPEG -1 Layer II encoders operating at 384 kbps to carry each channel pair in 
the group of phase aligned audio channels. Phase aligned encoding is supported only if the 

appropriate number of CE/SWO/PAA li censes are present  (1 for single PAA, and 2 for dual PAA) 
combined with additional CE/SWO/M1L2 licenses.  

PAA is available on SDI inputs as long as the upstream embedder provides DIDs on the same 
video line and in a fixed sequence. It is only guaranteed to be aligned if the audio channel status 
blocks are aligned at the input of the encoder.  

Table 3.11  License Requirements for PAA Encoding  

 Number of additional licenses required  

 6 channel  8 channel  Dual 6 chan nel  Dual 8 channel  

CE/SWO/M1L2  1 2 4 6 

CE/SWO/PAA  1 1 2 2 

When configured in MPEG -1 Layer II 6 or 8 Channel Aligned Encoding, each pairing is identified by 
the use of ISO_639_language descriptors. The languages are encoded using two language codes 
per component as follow s:  

¶ First instance on Audio Module 1:  

¶ aaa, aab for first dual mono  

¶ aac, aad for second dual mono  

¶ aae, aaf for third dual mono  

¶ aag, aah for fourth dual mono  

¶ Second instance on Audio Module 2:  

¶ bba, bbb for first dual mono  

¶ bbc, bbd for second dual mono  

¶ bbe, bb f for third dual mono  

¶ bbg, bbh for fourth dual mono  
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When adding PAA to an output Transport Stream service each audio component that makes up the 

PAA must be manually added to the service before configuring the components for PAA . 

Configuration  

To set up PA A or dual PAA audio streams for a service on the Service Configuration  page, 
proceed as follows:  

Note:  This procedure assumes that a service has already been created. If not, one must be 
created before continuing. See section 3.26.3 .  

1.  In the Inputs  widget, select Audio 1 -  Audio 3  (for 6 channel aligned) or Audio 1  -  Audio 4  
(for 8 channel aligned) by first selecting Audio 1 ,  holding down the Shift  key, then clicking 
on Audio 3  (for 6 channel aligned) or Audio 4  (f or 8 channel aligned).  

2.  Drag the selected components to a service in the Outputs  widget.  

3.  If you are setting up dual PAA encoding, repeat steps 1 -2 for Audio 9  -  Audio  11  (for 6 

channel aligned) or Audio 9  -  Audio 12  (for 8 channel aligned).  

4.  In the Outputs  widget, click on the audio component corresponding to Audio 1 .  

Note:  If you click on Audio Stream 1  in the Inputs  widget, the corresponding audio stream 
will be highl ighted in grey in the Outputs  widget.  

5.  In the Properties  widget, click on the Input  tab.  

6.  Set  the Input Format  to Uncompressed LPCM .  

7.  Set the Input Source  to Embedded 1 (SDI 1) . 

8.  Click on the Encode  tab.  

9.  Set the Coding Standard  to MPEG Layer II . 

10.  Set the Coding Mode  to either 6 Channel Aligned  or 8 Channel Aligned . 

The unit will automatically set the  other input sources and the necessary languages and dual 
phase aligned audio output can now be produced.  

3.16  How to Set Up Input for 3/2L (5.1 Surround) Encoding  

Overview  

The unit can only de -embed stereo channel pairs (groups) from the SDI/HD -SDI input signa l. 
Therefore, to set up 5.1 encoding, three groups have to be de -embedded from the SDI/HD -SDI 
input signal, and routed to the audio encoder.  

The embedded groups have to be consecutive. That is, they have to carry the different channels 

as detailed in Table 3.12  (SMPTE 320M).  

Table 3.12  Embedded Stereo Channel Pairs  

Group  Description  

Embedded n  Left Front, Right Front  

Embedded n+1  Center, LFE  

Embedded n+2  Left Rear, R ight Rear  

Configuration  

Note:  This procedure assumes that a service has already been created. If not, one must be 
created before continuing.  

1.  In the Inputs widget, select Audio Stream 1.  

2.  Drag the selected component to a service in the Outputs widget.  
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3.  In th e Outputs widget, click on the audio component.  

Note:  If you click on the Audio component in the Outputs  widget, the corresponding audio 
stream will be highlighted in grey in the Inputs  widget.  

4.  In the Properties  widget, click on the Input  tab.  

5.  Set the Inpu t Format to Uncompressed (LPCM)  

6.  Set the Input Source  to Embedded n (SDI 1) , the embedded stream that contains the left 
front and right front channels.  

7.  In the Properties  widget, click on the Encode  tab.  

8.  Select the required Coding Standard .  

9.  Select 3/2L (5.1 Surround) for Coding Mode.  

Your 5.1 encoding is now se t up.  

Note:  The encoder automatically selects and routes the additional embedded streams required 

to make up the 5.1 encode. The channel pairs must be embedded as specified in Table 
3.12 .  

3.17  How to Set Up BISS Encryption for Services  

When the CE/SWO/BISS license is enabled, the encoder can use the Basic Interoperable 
Scrambling System (BISS) to scramble services in the outgoing Transport Stream. Both BISS 
Mode -1 and  BISS Mode -E are supported.  

3.17.1  BISS Security  

To provide the option of add itional security for the BISS encrypted stream, there are two security 
levels available: normal BISS encryption (the original implementation) and Advanced BISS 
encryption (new, higher s ecurity). By default, the Advanced BISS Encryption security level is 
enabled.  

If the higher security level is required this can be configured from the GUI by browsing to Device 

Configuration > Advanced Setup > Base Unit . 

 

Figure 3.23  BISS Security Level Selection  

From the front  panel these settings are available by navigating to Advanced > System > Base 
Unit . 
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3.17.2  BISS Key Entry  

For further security enhancement when BISS has been enabled at a service level it is p ossible to 
individually select which components in that service are scr ambled using the key defined at the 
service level.  

The unit supports the use of 31 keys for BISS, which are stored in a memory table on the unit, 
with the location identified as BISS Ke y 1 to BISS Key 31.  

Each required key must be entered into the table b y the user, and once entered, the key value is 
not visible and there is no means of reading the value.  

The key may be entered or edited via the browser when applying BISS to an output service from 
the Service Configuration  tab.  

 

Figure 3.24  BISS Key Entry  

Alternatively the table entries can be edited by browsing to Device Configuration > Advanced 
Setup > Base Unit > BISS keys table  and se lecting the required key location.  

 

Figure 3.25  BISS Key Session Word  



 

AVP 1000, 2000 & 3000  | Version Y www.m ediakind.com  
 

3-40  

From the front panel it is necessary to enter the key value into the table location by navigating to 

Advanced > System > Base Unit > BISS  keys table . Use the rotary knob to scroll to the 
required BISS Key (1 ï 31), select and enter the required key value.  

Note:  This does not enable BISS.  

3.17.3  Setting Up BISS from the GUI  

To set up BISS encryption for a service from the GUI:  

1.  If you want to use B ISS Mode -E, browse to the Device Configuration > Advanced Setup  tab, 
open the Encode > Base Unit  node in the Advanced Video Processor Settings  widget, and add 
the injected ID in the BISS injected ID (14 hexadecimal characters)  field .  

2.  If you have not alread y done so, create a Transport Stream and a service as described in 
Sect ion  3.8.5 . 

3.  Go to the Outputs  widget of the Service Configuration  page, and select the service for which 
you want to apply BISS encryption.  

4.  I n the properties tab select the drop down option against BISS  Key , which will show the list 
of 31 keys.  Select the required key location.  

Note:  If None  is selected, BISS will not be enabled.  

 

Figure 3.26  BI SS Enabling and Key Selection  

5.  If a key is selected that has not had its key word set, a pop -up box provides the user 
definable fields for this key. Select the required key type  (Mode - 1 or Mode - E) and enter the 
New Key value  (12 hexadecimal characters  for Mode - 1 and 16 hexadecimal 
chara cters  for Mode - E).  
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Figure 3.27  Setting BISS Key Value  

If a key has already been set, an asterisk is displayed in the drop down list next to the 
label. If this key is selected t he pop -up box will not appear.  The user can modify the key 
by selecting the Edit Key box.  

 

Figure 3.28  Editing a BISS Key  

Note:  Although the BISS technical specification (Tech 3292 rev. 2.) states that BISS Mode -E 
shall work with shorter  BISS Mode -1 keys, this is not supported in the unit. The 
Encrypted Session Word  field only accepts 16 -digit keys.  

6.  When BISS has been enabled on a service a padlock will appear in the outputs tree 
next to the service name and in Voyager units the Clear indicators on the GUI 
banner and front panel will change to Scrambled.  

7.  It is possible to select which of the components of the service shall be scrambled, when a 
BISS key has been selected. The choice of components can be done at  the service level or  
independently for each component. At the service level, in the Service Configuration > 
Outputs > Service Properties  widget, open the Service > Scrambling  accordion and 
select the components to be scrambled.  

 

Figure 3.29  Selection of Components to be Scrambled Using BISS  

8.  Selecting an individual component to be scrambled using BISS is performed on the 
Component tab of the Properties of that output component.  
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Figure 3.30  Scrambling Selection of an Individual Component  

3.17.4  Setting Up BISS from the Front Panel  

To set up BISS encryption service from the front panel:  

Note:  When a value needs to be changed using the front panel, the existing value nee ds to be 
deleted usin g the Del  key, before a new value can be entered using the keypad.  

1.  If you want to use BISS Mode - E navigate to Advanced>System>Base Unit  on the front 
panel and set the BISS injected ID  (14 hexadecimal characters ) using the keypad.  

2.  Navig ate to the required output service ( Output > Transport Stream ID > Service List > 
Service n  and scroll down to BISS Key . Enter the required key location (1 to 31).  

Note:  Selecting 0  configures the key to None  and BISS will not be enabled.  

3.  If a key is selec ted that ha s not had its key word set, a message is displayed telling the user 
that a key needs to be set. In this case navigate back to Advanced > System/Base Unit > 
BISS Keys Table  and select the required key. Select the required key type  (Mode - 1  or 

Mode - E) and enter the New Key value  (12 bits  for Mode - 1  and 16 bits  for Mode - E). Go 
back to the Service Menu and enable BISS by selecting the required key.  

4.  When BISS has been enabled on a service the Clear indicators on the GUI banner 
and front panel will chan ge to Scrambled.  

Both an xml and stored configuration will contain an entry for a BISS key, if a key had been set for 
the service on the unit that the configuration was saved from. T o comply with the specification 
that requires the value of keys that are n ot available on external interfaces and cannot be 
retrieved, this uses the name of the table location (BISS Key n).  

3.17.5  BISS and Stored Configurations  

Loading an xml or stored configurat ion  with BISS enabled will successfully configure the unit, 
resulting in a  Transport Stream output and service configured, with BISS enabled using the same 
BISS Key n setting as for the original configuration.  The contents of the BISS key table are NOT 
tr ansferred, so unless the same key has already been entered the key will ei ther be not set or a 
previously entered different key might be applied.  To ensure the correct key is set the user can 
edit the key stored in the table as described above.  

Loading an  xml that contains a BISS key entry onto a unit that has never had BISS en abled will 
not enter any keys. ******NOTSET*****  will still be displayed on the user interface and the 
output WILL NOT be encrypted. A key needs to be manually entered.  

Once a BISS k ey has been set for a service, switching BISS off does not affect the stor age of the 
key. The key is maintained and used when BISS is re -enabled. If a different key is required it 
needs to be manually updated, or a different key from the table selected.  T he entered keys are 
maintained over a power cycle.  

Note:   Deleting the uni t configuration does not delete the contents of the BISS key table.  
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3.18  How to Splice and Insert Digital Programme Insertion (DPI)  

Splicing is used to insert Digital Programme (DPI), e.g . advertisements, into an MPEG -2 Transport 
Stream. DPI is available when t he DPI license is purchased. One licence is required for each video 
component.  

3.18.1  Splice Point Operation  

The VCM is capable of storing up to 10 splice events, which can be inserted up t o 13 hours before 
the event is due, but no less than 4 seconds to the spli ce point. If splicing is disabled all stored 
pending splice events will be deleted.  

Splice point insertion can be controlled from SCTE104 messages, either in VANC or from the IP 
inpu t, or from GPI triggers (see Section 3.19  for GPI details)  

Table 3.13  Example Multiple Operation SCTE104 Message Structure  

Data  Comment  

0xFF, 0xFF  reserved  

0x00, 0x27  message size = 39 bytes  

0x00  SCTE-104 protocol version  

0xAA  AS inde x 

0xBB  message number   

0x01, 0x01  DPI PID index (slot 1, channel 1) 1  

0x00  SCTE-35 protocol version  

0x00  timestamp type = zero (no timestamp)  

0x02  number operations...(2)  

0x01, 0x01  op ID = splice request data  

0x00, 0x0E  data length = 14 bytes  

0x01  splice insert type -  splice start normal  

0x12, 0x34, 0x56, 0x78  splice event ID  

0x66, 0x99  unique program ID  

0x0F, 0xA0  pre -roll time = 4000ms  

0x00, 0x64  break duration = 10s  

0x01  avail num  

0x01  avails expected  

0x01  auto return flag  

0x01, 0x0A  op ID = insert avail descriptor request data  

0x00, 0x05  data length = 5 bytes  

0x01  number of avails = 1  

0xA1, 0xB2, 0xC3, 0xD4  avail ID = 0xA1B2C3D4  

1The DPI_PID_index value contained within the SCTE -104 message is not a PID.  It provides a way 
of address ing a particular VCM within a multi -module unit to ensure that the SCTE104 message s 

are received by the specific encoder.  It is a 2 byte value.  
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Table 3.14  DPI PID Index Value  

Bit  Description  

15..8  The option  card slot number (1 to 6)  

7..0  The encoder channel on the option card  

(Note: All option cards referenced in this manual support only 1 channel 
of video.  If the channel is set to 0 or 1 the encoder will have splice points 
inserted.  

If the option  card s lot number or the encoder channel does not exist the Video Processor wil l 
return a splice failure message.  

It is not possible to insert splice points into the video which are closer than 1 second apart. Any 
messages received with a splice time within 1 sec ond of another splice point and with the same 
splice_event_id will be tr eated as a duplicate of the initial splice request and deleted.  

Any messages received with a splice time within 1 second of another splice point and with a 

different splice_event_id wi ll be aligned to the initial splice request. This will result in 2 SCTE3 5 
messages being generated containing the same PTS value but different splice_event_ids and 1 
splice point inserted into the video, unless the auto return is set to 1 and the duration is 
populated, in which case the video PID will be conditioned for two sp lice points.  

3.18.2  SCTE104 Over IP  

SCTE 104 messages can also be sent to the unit over the control port. The DPI TCP Port on the 

unit is 5167 by default. This parameter can be accessed on t he GUI through Device 
Configuration > Advanced Setup > Base Unit . 

3.18.3  How to  Configure Splicing  

1.  I f you have not already done so, create a Transport Stream and a service as described in 
Chapter 5, Web GUI Control .  

2.  Go to the Inputs  widget of the Service Configur ation  page and select the Video SCTE 35 
Stream  from the VCM inputs tree and drag it into the required output service.  

3.  Select the required source from the Splicing Control  drop down box in the Properties  
widget (see Section 3.19  for additional requirements for GPI triggered splicing).  

Table 3.15  Splicing Control Options  

Option  Description  

Off  No splice operation  

On VANC message only  SCTE104 messages in VANC will be passed through as SCTE35 
messages that can then be added as a component in the output 
transport stream.  

No splice points will be inserted in the video bitstream.  

On VANC  SCTE104 messages in VANC will trigger the insertion of splice 

points  

On IP  SCTE104 m essages in IP will trigger the insertion of splice points  

On GPI  Splice point insertion will be triggered by GPI card inputs ( see 

section 3.19 )  

3.19  How to Configure GPI Triggered Splicing  

The GPI option card can b e configured for triggered splicing by sending SCTE -104 messages to the 
enco ders of the VCM cards fitted in the unit.  

Note:  To enable splicing, splice point insertion license (CE/SWO/DPI) is required.  
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The triggers are realized by closing and opening the ge neral purpose input pins (GPI pins 1 -16) 

with a common GND; for the pin connections see Chapter 2, Installing the Equipment ). The 
configuration process has two parts:  

¶ Setting up the GPI Card  

¶ Setting up  the VCMs  

The connections between the configured pins o f the GPI card and the destination encoders are 
represented by virtual SCTE -104 channels. Each GPI card has 16 channels, labeled from ChannelA 
to ChannelP.  

3.19.1  How to Set Up a GPI Card  

To configure Genera l Purpose Interface (GPI) input pins for splicing, proc eed as follows.  

1.  Select the Advanced Setup  tab on the Device Configuration  page on the GUI.  

2.  Expand Encoder > Slots > Slot n Data & GPI Card > GPI Input Pin n Setup  folders in the 
Advanced Video Process or Settings  widget.  

3.  Set up the GPI input pins. For a de tailed parameter list, see GPI Triggered Splicing  in Chapter 
5, Web GUI Control . 

4.  Configure splicing options by expanding the appropriate GPI Input Pin n Setup  folder and 
selecting Splicing Setup . For a detailed parameter list, see GPI Triggered Splicing  in  Chapter 
5, Web GUI Control . 

Note:  A Splicing Setup  folder is shown only if the GPI input pin mode has already been set up 

in the respective GPI Input Pin n Setup  folder.  

3.19.2  How to Set Up a VCM to  Use GPI Inputs  

To set up a Video Compression Module (VCM) for  using GPI inputs, proceed as follows:  

1.  From the web browser navigate to Device Configuration  page and select the Advanced Setup  
tab.  

2.  Expand the Encoder > Slots  folders and the folder for the slo t containing the appropriate 

encoder card.  

3.  Select Video > Vide o 1 > Video > Main Video > Video Encoder > Splicing .  

4.  Set Splicing Control  to On GPI . An SCTE-104 Input  folder appears in the settings tree and 
provides a list displaying all usable SCTE -104 chan nels. A channel is usable if there is at least 
one GPI pin con figured on the source end of the channel (as described above).  

5.  Choose an input channel for the VCM encoder core. The configuration of the VCM is now 
complete and the encoder waits for SCTE -104 m essages on the selected channel.  

Combinations and Limitations  

With the SCTE -104 channels a many - to -many relationship can be set up between the GPI pins and 
the encoder cores of VCMs, as follows.  

¶ More pins of the same GPI card can be configured to send mes sages to the same set of 
encoder cores. This is achieved with selecting the same channel for them on the GPI Input 

Pin Setup panel.  

¶ More encoder cores (of the same VCM or different VCMs) can be configured to get messages 
from the same set of pins of a GPI card. This is achieved by selecting the same channel for 
them on the SCTE-104 Input > Encoder  folder.  

¶ Different GPI cards fitted in the same unit can not send messages to the same encoder core, 
because one encoder core can only use one  channel for  
SCTE-104 input.  
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3.20  How to Use the Simplified View (Option)  

3.20.1  Using the Sim plified View  

An optional óSimplified Viewô is available for AVP 2000 a nd AVP  3000 units, aimed at providing a 
single page, quick and easy - to -use, user interface for the day - to -day operation of units. This 
extends the original simple Voyager Dashboard to in clude support for ASI and IP outputs, and is 
not dependent on a Satell ite Modulator card being fitted.  

It provides access to the primary settings that an operator may need access to in order to make 
minor adjustments to frequently used parameters, and to e asily perform a line -up procedure 
ready for a broadcast. It is NOT a r eplacement for the existing advanced user interface and does 
NOT support full configuration of the unit.  

By default following an upgrade or clearing of device configuration, the Advanced  View is 
displayed. The user can easily switch between views, and has the facility to select which view 

should be displayed by default when a browser session is opened. This selection is maintained 
through a unit reboot.  

3.20.1.1  Assumed Workflow  

The workflow is pr imarily based on the use of existing configurations which are already loaded 
onto the unit. These configurations are created and stored on the unit using the advanced view. If 
the configurations have been created using an earlier version of software they m ust be upgraded 

using the XML upgrade utility to ensure compatibility with the software version in use.  

3.20.1.2  What to Expect  

The Simplified View requires at least one output (Satellite Modulator, IP or ASI) to be configured 
with a Transport Stream containing one  service, with at least a video component, before 
parameters will be d isplayed.  

Only outputs that are configured will be displayed on the Simplified View, and only the first TS and 
first service with the components that have already been included will be a vailable. There is no 
way of adding new TS, services or components to the outputs using the Simplified View.  

Following a software upgrade no output is configured. In this case when opening a browser 
session to the unit and selecting the link to Simplified View, a box is displayed informing you that 
there is no output service  configured.  

This box provides a link to access and load a stored configuration (which, if created and stored in 
an earlier version of software, must be converted to match the release v ersion before being used) 
or a link to go to the Advanced Configuratio n  pages to manually configure the output as 
required.  

 

Figure 3.31  Simplified View -  Pop-Up Display When There Is No Output Configured  

When at least one output is configured, the Simplified View is displayed.  
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Figure 3.32  Simplified View Web Page ï Satellite Modulator, IP and ASI Outputs Configured (IP 
and ASI Mirrored)  

3.20.1.3  Multiple Outputs  

Multi ple outputs are supported in the Simplified view, but with so me limitations. When multiple 
outputs are configured (either mirrored or independent), the Transport/Service and Properties 
panels are only those included in the main output, which is defined in the following priority order:  

1.  SatMod (if available and config ured),  

2.  IP (if no SatMod output and IP is configured)  

3.  ASI (if configured and no other output is configured).  

It is not possible to select which output these panels relate to. When components ar e common 
across the outputs changes will affect the common outputs, but this will not necessarily be 
indicated on the Simplified View.  

Note:  The immediate action header banner at the top of the page shows the configured 
outputs in this order, so as a gener al rule of thumb is that the Transport/Service and P roperties 
panels relate to the first output in the header banner.  
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Figure 3.33  Simplified View -  Properties Relate to Main Output  

If mirrored outputs are r equired, they should be mirrored from the main outpu t. This gives 
combinations supported in the Simplified View as follows:  

Table 3.16  Simplified View Outputs  

SatMod Output  IP Output  ASI Output  

MAIN    

MAIN  Mirror of SatMod   

MAIN   Mirror of SatMod  

MAIN  Mirror of SatMod  Mirror of SatMod  

MAIN    

MAIN  Independent   

MAIN   Independent  

MAIN  Independent  Independent  

 MAIN   

 MAIN  Mirror of IP  
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SatMod Output  IP Output  ASI Output  

 MAIN  Independent  

  MAIN  

When the Simplified View is to be used, out puts should either be all mirrored from the main 
output, or should all be independent (but there are limitations associated with this configuration). 
If other combinations are required then the advanced view should be used.  

When multiple outputs are config ured as mirrored outputs, common TS paramete rs that are 

defined by the main output are greyed out and read only for the mirrored outputs.  

3.20.1.4  Simplified View Summary  

3.20.1.4.1  Immediate Action Banner -  Output Configuration  

The parameters, shown in the header banner, are  immediately actioned on the unit, when 
adju sted, without the need for an additional Apply . The parameters in this banner are protected 
by the padlock to help prevent accidental changes to the output configuration. This banner will 
show which outputs have been configured.  

 

Figure 3.34  Simplified View -  Immediate Action Banner, All Outputs Configured: SatMod (Main), 
IP and ASI Mirrored  

Note:  When the outputs are mirrored, the encryption buttons for the mirrore d outputs will be 

greyed o ut and read only. Toggling the main output encryption on/off will also apply encryption to 
the mirrored outputs and the button state updates to reflect this.  

3.20.1.4.2  Configurable Parameters Requiring Apply Button  

The remaining configurabl e parameters available on the Simplified View operate in the same way 
as for the Advanced View, in that multiple changes can be made which are not loaded onto the 
unit until the Apply  button is pressed.  

As with the Advanced View, changes that have not been  applied are highlighted, and the Apply  
and Discard  buttons become active.  
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Changes in colour to highlight that changes have been made but not applied

 

Figure 3.35  Simplified View -  Configuration Changes Requiring Apply Button  

3.20.1.4.3  Output Properties Configurat ion  

Each type of output has a different set of parameters that can be configured. When the output is 
configured a new accordion panel is displayed containing these parameters. Parameters that have 
dependencies are described below.  

IP Output Parameters  

¶ Sour ce Address  -  By default this does not need to be configured. The unit will automatically 
determine the appropriate source address for the transport stream. It is possible to force the 
source address to a user defined value only when the unit is configured in óTransparentô mode 
ï in this case ensure that the multicast address has been configured first.  

¶ Row and Column  -  These parameters are related to FEC on the IP output, which needs to be 
licensed in order to be configured. The encapsulation mode of the IP output nee ds to be set to 
enable FEC for these fields to become active.  The encapsulation mode must be set using the 
Advanced View.  

¶ IP TS Rate -  This is the transport stream bitrate of the IP output. It does not include 
overheads needed for IP encapsulati on. If thi s field cannot be edited the output is a mirror 

and the bit rate is determined by the main output.  

ASI Output Parameters  

Note:   As the only configurable parameter for an ASI output is the bit rate, this shares the IP 
properties panel if both are configured . 

¶ ASI TS Rate  -  This is the transport stream bit rate for the ASI output. If this field cannot be 
edited the ASI output is a mirror and the bit rate is determined by the main output.  

3.20.1.4.4  Service Configuration  

The Simplified View provides the ability to modify the configuration of the Main output Transport 
Stream. Service Information, PID values, Carrier ID information (for Satellite Modulator Output), 
encryption mode and key (RAS or BISS if licensed for a Satellite Modulator output or BISS if 
licensed  for ASI o r IP outputs) are configurable, as well as the ability to simply add or remove 
available audio and ANC components that have been included in the service when initially 
configured.  
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Note:   Only a single BISS key is supported from the Simplified Vie w, so the same key will be 

applied when BISS is enabled on multiple outputs.  If different keys are required then the 
Advanced View must be used.  

Remove Component

Add Component

Display more Video and Audio configurable properties

Edit PID
 

Figure 3.36  Simplified View -  Mod ifying Com ponent Configuration  

Note:  The number of audio components available is determined by the number of audio 
components included in the service (up to a maximum of 8). If more are required, the 
user should go to the advanced view and add the required  audio com ponents.  

 

Figure 3.37  Simplified View -  Configuring Carrier ID and Encryption Key  

3.20.1.4.5  Alarm Status Information  

The color of the alarm button indicates the highest level alarm . Selecting the button  displays a 
pop -up listing the current active alarms.  
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Figure 3.38  Simplified View -  Alarm List  

3.20.1.4.6  Additional Support Tools  

The drop -down list accessed from the tools icon provides the use r with access to some additional 
useful information or tools. The licenses available on the unit can be viewed, the stored 
configurations list (to either load or save a configuration) can be accessed, the option to select the 
default view when a browser se ssion is opened and the ability to reset the unit are provided.  
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Figure 3.39  Simplified View -  Tools  

3.20.1.4.7  Switching Between the Simplified View and the Advanced 

View  

Links are provided on both the Simplified View  and the Advanced View to allow the user to switch 
between the pages to access parameters that are not supported by the Simplified View.  

 

Figure 3.40  Switching between Simplified View and Adva nced Configurat ion GUI  

3.20.1.5  Simplified View Limitations  

The following is a list of limitations which should be observed when using the Simplified View.  

1.  The Advanced View and Simplified View should not be open at the same time. This can result 
in discrepancies i n reported valu es. The link should be used to switch between views when 
necessary.  

2.  At least one output MUST be configured with a Transport Stream containing a service with 
video and audio components. This means that:  

¶ The Transport Stream must be set online .  

¶ Only a single  service with one video and up to eight audio components and an ANC 
component is supported on the Simplified View. Additional services in the TS will not be 
presented on the Simplified View.  

¶ The first service must be configured to use the fi rst VCM fitted in a multiple VCM 
chassis.  

¶ All required components must be initially added to the service using the Advanced 
pages.  

¶ Additional services and components need to be controlled using the Advanced View.  

¶ Any VBI requirements must be configured using the Advanc ed View.  

3.  Only one Transport Stream (the first Transport Stream of the main output) is supported in the 
Simplified View. Additional Transport Streams may be configured, but need to be accessed 
using the Advanced View.  

4.  Only the fir st service in a Transport S tream is available in the Simplified View. Additional 

services may be configured, but need to be accessed using the Advanced View.  
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5.  The input monitor shows the status of the components in the first service of the main output.  

6.  When  multiple outputs are avail able and configured, the output for which the Simplified View 
supports configuration of TS parameters is determined in the following order:  

¶ Satmod  ï if fitted and configured.  

¶ IP  ï if fitted and configured.  

¶ ASI  ï if configured.  

This cannot be modified. 

7.  When  outputs are mirrored the common configurable parameters of the mirrored output will 
be read only (so bit rate and encryption can only be set for the main output). There is the 
ability to set each output ON or OFF.  

8.  When the outputs are independent and have  been configured with different BISS keys the 
Advanced View must be used to enable/disable encryption, otherwise the key will be replaced 
with BISS key 1.  

9.  A Remux service must NOT be the first service in the output TS as:  

¶ The Simplified View will reject a Remux service as a non -supported configuration. 
Ensure that the first service contains components encoded in the box.  

¶ A Remux service can be the second service, but there is no visibility or access to this 
service from the S implified View.  

10.  A Pass- thru tran sport stream is not recognised as a supported output configuration for the 
Simplified View. The advanced view needs to be used for this configuration.  

11.  Current alarm status is reported on the Simplified View but alarm masking  needs to be 
performed using the  Advanced View.  

12.  A browser refresh may be needed to update the display to show some changes made using 
other interfaces (e.g. via front panel). This applies to both Simplified View and the Advanced 
View.  

13.  Some unlicensed feat ures are displayed but an attemp t to configure the feature will result in 
an error message pop -up stating not enough licenses  and the configuration will be rejected.  

14.  Limited Video Profiles. The Simplified View only supports configuring MPEG -2 Main profile 
(main level for SD or high level  for HD) and H.264 High (level 3.1 for SD or level 4.1 for HD) 
profiles. This means:  

o It is not possible to configure SD H264 Main Level 3.0, SD H264 High Level 
3.0 or HD H264 Main level 4.0, which are available on the Advanced View. 

3.21  How to Control Temperat ure/Fan Speed  

Temperatures are reported to the user in degrees Celsius (° C) and degrees Fahrenheit (° F).  

Host Card Monitoring  

The die temperature of the main components on the Host card are monitored, and reported to an 
accuracy of ±2 °C.  

A host card tem perature alarm threshold can be set that, if exceeded, causes a System Over 
Temperature  Alarm to be generated.  

Note:  It is recommended that the default threshold settings are not adjusted.  

Option Card Monitoring  
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Option cards  monitor the die temperature of their main components, and report these 

temperatures to an accuracy of ±2 °C. If an option card reports die temperatures, it allows an 
alarm threshold to be defined for each temperature, which if exceeded causes an alarm to be 
generated.  

Note:  It is recomm ended that the default threshold settings are not adjusted.  

VCMs  

The controlling processor monitors the core temperatures of the main components and passes this 
information back to the host card via the back plane for monito ring.  

Temperature thresholds can  be set to cause a warning or an alarm. The warning level is 
configurable by the user, whereas the alarm level is hard coded.  

Note:  It is recommended that the default threshold settings are not adjusted.  

Fans  

The fans fitted to the chassis are speed contro llable, providing a limited range of operating 
conditions.  

To control temperature/fan speed:  

1.  Go to the Device Control > Advanced Setup > Base Unit page.  

2.  Using the slide bar control, set to Lowest Noise , Quiet , Cool  or Best Cooling , as required.  

 

Figure 3.41  Fan Control  

The internal temperature of the unit will vary according to the fan speed, but the unit will attempt 
to maintain the unit within safe operating limits. If it cannot do this and the temperature  increases 
above the set alarm thresholds, over temperature warnings or alarms will be raised and 
appropriate action is needed.  
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3.22  How to Get and Apply Additional Licenses  

The unit comes with the optio n cards and licenses, which were ordered, already installe d.  

For AVP 2000 and AVP 3000 units, general licenses are stored on the host, while video and audio 
related licenses are stored on the VCM option cards and modulator related licenses are stored on 
th e Satellite Modulator Card. For AVP1000 only general licen ses are stored on the host.  

3.22.1  Verifying Which Licenses Are Present in the Unit  

Access to the web pages is necessary to verify the licenses that are enabled on the unit.  

Navigate to Support > Licenses .  This page displays a tab for each card that contains lice nses. 
Each tab contains the marketing code, number of each license and a description of the feature 
enabled by the license.  

Note:  Short term licenses are not supported.  

The number of licenses can be  extended and new licenses ordered after the unit has been  shipped.  

3.22.2  Ordering Additional Licenses  

When ordering additional licenses for existing units the following information is needed when 
contacting Customer Services:  

¶ A Purchase Order to cover the new l icenses.  

¶ Details of the license types, the number of each license required and which slot the card to 
be licensed is fitted in if applicable.  

¶ Download the manifest file from the Support > Licenses  page of the GUI and provide the 
downloaded file with the or der.  

Note:  Earlier versions of software may not support th is function. In this case go on to the next 
step.  

 

Figure 3.42  Downloading the License Manifest file for License Generation  

¶ If the version of software running on the unit does not support this feature, then the minimum 
information required is the Serial Number and ChipID of the unit. To retrieve this information, 



 

AVP 1000, 2000 & 3000  | Version Y www.m ediakind.com  
 

3-57  

go to Support > Versions , and in the Modules  widget of the Genera l  tab click on the Host  

tab.  

 

Figure 3.43  Finding the Host Card Chip ID and Serial Number for License Generation  

¶ If the required license is for an option card the unique Chip ID of the  option card is requir ed. 
To retrieve the Chip ID, go to Support > Versions , and in the Modules  widget of  the 
General  tab click on the tab for the slot the option card is fitted in.  

¶ The corresponding slot number MUST also be provided.  

 

Figure 3.44  Finding the Option Card Chip ID for License Generation  

Based on the above information, a license key file will be generated and provided to the customer.  

3.22.3  Entering License Keys  

The keys are saved in a License Key file ready to be entered onto the unit via the web page.  

1.  Open Support > Licenses . Click the Browse  button to  locate the license key file.  

2.  Click on the Upload  button.  

3.  If licenses are required for both the base chassis and VCM option card then multiple files will 
be provided  (one for the base chassis and one for each slot containing a card being licensed). 
All fil es need to be loaded onto the specific unit.  

4.  Reboot the unit once all files have been loaded for the changes to take effect.  

Note:  The Front Panel CANNOT be used to upload license keys.  
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3.23  Alarm Monitoring  

Alarms are reported on the GUI and Front Panel LED in dication.  Alarm trap handling is also 
supported through SNMP.  

The severity of an alarm can be changed or the alarm can be masked if required.  This can be 
performed  on active alarms on the GUI dashboard or on any alarms by browsing to the Support 
> Device  Management page .  

 

 

Figure 3.45  Alarm Monitoring  

3.24  Simple Network Management Protocol  

Simple Network Management Protocol (SNMP) is an application layer protocol that facilitates the 
exchange of management info rmation between network devices. It is part of the Transmission 
Control Protocol/Internet Protocol (TCP/IP) protocol suite and is defined in a set o f standards (RFC 
1065 -  RFC 1067, RFC 1155 -  RFC 1157, RFC 1213, RFC 1441 -  RFC 1452, RFC 1901 -  RFC 1910, 
RFC 2576, RFC 3411 -  RFC 3418) published by the Internet Engineering Task Force (IETF).  

3.24.1  Supported Protocols  

SNMP versions 1 and 2c are supported, pri marily for alarm trap handling. The General MediaKind  
Television MIB is also supported.  

Note:  The unit does not support control via SNMP, all remote control is via HTTP.  

3.24.2  Operation  

SNMP traps are a way of reporting status information to a control system. Th e unitôs SNMP 
functionality can be enabled or disabled, with up to five IP addresses assigned for any SNMP T rap 
message to be sent. The default is 000.000.000.000, which causes the SNMP traps to be sent to 
the last SNMP master. The SNMP community name can also be set.  

The user can control which SNMP traps are generated. The options are:  

¶ All traps  ï traps sent fo r all failure alarms, warnings and start messages.  

¶ Start Msgs, warning ï critical  ï traps sent for start messages or alarms raised of severity 
warni ng to critical.  

¶ Start Msgs, minor ï critical  ï traps sent for start messages or alarms raised of severity 
mi nor to critical.  

¶ Start Msgs, major ï critical  ï traps sent for start messages or alarms raised of severity 

major to critical.  

¶ Start Msgs, critical  ï traps sent for start messages or critical alarms.  

¶ Start Msgs only  ï traps sent for start messages only.  
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Table 3.17  SNMP Interface Parameters  

Parameter  Description  

SNMP Read Community  The SNMP community name for read access. default = public  

SNMP Location  Textual description of the location of the unit  

SNMP Con tact  Name of the person responsible for this unit  

SNMP Trap Community  The SNMP community name for read access. default = private  

SNMP Trap Destination  The destination IP address for SNMP trap messages. Up to five 
destinations can be defined, but by defau lt none are assigned  

SNMP Trap Alarm Level  Defines what events trigger the generation of an SNMP trap 
message. The option s are: Start Messages Only, i.e. only system 
start up events. Fail and Start Messages only i.e. start -up events 
and critical alarms. A ll traps i.e. start -up events and all alarms and 
warnings.  

3.25  MPEG - H Audio Encoding  

Uncompressed audio data arriving over an HD -SDI or 3G -SDI link may be compressed using the 
MPEG-H 3D Audio encoding standard. MPEG -H Audio Encode is supported if the appropri ate 
CE/SWO/MPEGH license is present. MPEG -H is currently only supported with 29.97 / 59.94 video 
frame rates.  

The A VP allows you to encode up to 5 audio channel groups with a combined total of up to 10 
audio channels per MPEG -H Audio Encode instance.  

3.25.1  How to Set Up an MPEG - H Audio Encode  

To set up an MPEG -H Audio Encode:  

1.  Set up the encode service as per section 3.8.5 .  Ensure a Video Component  is included in 
the service.  

Note:  MPEG-H only supports 29.97 / 59.94 video frame rates.  

2.  Add an Audio Component  in the same manner as a video stream as described in section 
3.8.5 .   

3.  Within the Encode  tab for the Audio Component , set the Coding Standard  to MPE G- H . 
The display will u pdate and show an MPEG - H Group Set  with five MPEG -H Groups.  
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Figure 3.46  MPEG-H Groups  

 

4.  For each MPEG -H Group, configure the Source , Channel  Layout , Loudness , Language  and 

Type , as required.  

Groups must be e nabled starting with Group 1. Similarly, when turning groups Off , the last group 
must be disabled first.  

The Source  parameter determines which embedded source is used for the first input when using 
multi -channel configurations. Fo r example, if Embedded 4  is selected as the Source  and 5.1 
Surround is selected for the Channel Layout , six input channels will be required. Each 
embedded input source carries 2 audio channels, so Embedded 4 , Embedded 5  and Embedded 
6  will be used for this  MPEG-H Group.  

The Channel  Layout , Loudness , Language  and Type  parameters are all used for metadata 
carried within the compressed MPEG -H audio stream.  

A total of up to ten audio channels can be encoded per MPEG -H Audio Encode instance spread 
across up to f ive MPEG -H Groups.  

3.26  How to Configure the AVP Using the Front Panel  

The unit is fully configurable via the front panel. The most important parameters are available 
under the dedicated menu items, while the full functionality of an option card can be found un der 
the Advanced  menu. For  the details of the interaction with the front panel and the menu system, 
see Front Panel Control.  

The configuration consists setting the general parameters of the base unit and the option cards. 
Then, the output streams can be co nfigured through the Outpu t  menu.  



 

AVP 1000, 2000 & 3000  | Version Y www.m ediakind.com  
 

3-61  

3.26.1  How to Configure Video Parameters  

To configure the video parameters, select the AVP Encoder n menu and set the parameters as 
listed in Figure 3.8. 

Table 3.18  Video Parameter Settings  

Parameter  Setting  Comment  

Video Input Locked  True, False.  Read only parameter.  

Video Bit rate  0.5 ï 80 Mbps.  Range and limits depends on video profile.  

Video Profile  Off  

SD MPEG2 Main Profile Main Level 4:2:0 8 bit,  

SD MPEG2 4: 2:2 Profile Main Level 4:2:2 8 bit,  

SD H.264 Main Profile Level 3.0 4:2:0 8 bit,  

SD H.264 High Profile Level 3.0 4:2:0 8 bit,  

SD H.264 High Profile Level 3.1 4:2:0 8 bit,  

SD H.264 Hi422 Profile Level 3.1 4:2:2 8 bit,  

SD H.264 Hi422 Profile Level 3.1 4:2:2 10 bit,  

HD MPEG2 Main Profile High Level 4:2:0 8 bit,  

HD MPEG2 4:2:2 Profile High Level 4:2:2 8 bit,  

HD H.264 Main Profile Level 4.0 4:2:0 8 bit,  

HD H.264 High Profile Level 4.0 4:2:0 8 bit,  

HD H.264 High Profile Level 4.1 4:2:0 8 bit,  

HD H.264 Hi422 Profi le Level 4.1 4:2:2 8 bit,  

HD H.264 Hi422 Profile Level 4.1 4:2:2 10 bit.  

SD J2K Profile Level 1 4:2:2 10 bit  

HD J2 K Profile Level 2 4:2:2 10 bit  

HDp50/59.94 H.264 High Profile Level 4.2 4:2:0 8 
bit  

HDp50/59.94 H.264 Hi422 Profile Level 4.2 4:2:2 

8 bit  

HDp50/59.94 H.264 Hi422 Profile Level 4.2 4:2:2 
10 bit  

The availability of a profile depends on the 

option card and th e presence of a certain 
license.  

Buffer Mode  CBR, Low Delay, Mega Low Delay, Compatibility, 

Ultra Low Delay, Stripe Refresh, Stripe Refresh (+ 
Audio Encode)  

Available options depend upon the option 

card and licenses.  

Source  Analogue, SDI, Color Bars, Black, Moving Object, 
Slate.  

Configures the input source, which can be 
an external video signal through the SDI 
connector or the analogue CVBS connector 
on the back of the VCM, or an internally 
generated test pattern.  

3.26.2  How to Co nfigure Audio Parameters  

Audio Input Parameters  

To configure the audio input parameters, select the AVP Encoder /Audio Module/Audio n /Input  
menu and set the parameters as  listed in  
Table 3.19 . 

Table 3.19  Audio Input Settings  

Parameter  Settings  

Input Format  Uncompressed (LPCM),  Dolby Digital, Dolby E,  

Input Source  Off, Mute, Test T one, Embedded 1 -8, Input 1 -4. Analogue 1 -2.  

Output on Audio Loss  Silence, No PID  
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Audio Encode Parameters  

To configure the audio encode parameters, select the AVP Encoder /Audio Module/Audio n 
/Encode  menu and set the parameters as liste d in  
Table 3.20 . 

Table 3.20  Audio Encode Settings  

Parameter  Settings  

Coding Standard  MPEG Layer II, Dolby Digital,  AAC, Pass - thru (Options depend on licenses)  

Bitrate  Range depends  upon selected coding standard  

Coding Mode  Available options depend on selected coding standard.  

The parameters of the encoding can be configured in a sub menu whose name depends on the 

Coding Standard chosen. Set up the encoding as needed.  

Note:  The num ber of audios available for configuration will depend upon the number of 
licenses.  

MPEG - H Audio Encode Parameters  

MPEG-H can be fully configured via the Front Pan el, but some additional steps are required.  

1.  Select MPEG - H  as the Coding Standard , as described  above.  

2.  A new option will appear called MPEG - H Group Set Index . This must be set to a value 
that is not currently in use on this card. If this is the first MPEG -H Audio Encode being 
configured, then set this to 1.  

3.  Navigate up two levels to Audio Module  the n select MPEG - H Audio . 

4.  Select the MPEG - H Group Set  corresponding to the value of MPEG - H Group Set Index  
set previously. In this example, select MPEG - H Group Set 1 .  

5.  This menu level shows the five MPEG -H Groups. These should be configured starting with 
MPEG - H Group 1 . Each MPEG -H Group contains the parameters as listed in Table 3.21 .  

Table 3.21  MPEG-H Group Parameters  

Parameter  Description  

Source  Off, Embedded 1 -8.  

Channel Layout  1/0 (L ï input), 1/0 (R ï input), 2/0, 3/2L (5.1 Surround), 5/2L (7.1 Surround), 10 

Channel Mono  

Loudness  -40 to 0 LKFS (LU)  

Language   

Type  Dialogue, Non -Dialogue, ADS (Receiver mix), ADS (Broadcast mix)  

 

3.26.3  How to Set Up a Transport Stream  

A Transport Stream is made up from one or more servic es. A service is made up from one or more 
components. To build a Transport Stream to be sent to the output, proceed as follows:  

1.  Select the Output  menu.  

2.  Select the output to which the Transport Stream is to  be sent.  
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3.  Select Transport Stream ID: 1  if available, otherwise Select Add Transport Stream.  

4.  Check that the parameter settings are correct.  

Table 3.22  Transport Stream Parameters  

Parameter  Description  

Service  List  Select to manage services in the Transport Stream. (Next step.)  

Current State  Read Only ï displays current output state (online, offline)  

Change State  Online, Offline. Controls the actual presence of the Transport Stream in the output.  

Transport S tream Bit rate  0.04 ï 200 Mbps.  

Reserved Bit rate  The amount of bit rate in the Transport Stream that cannot be allocated to any of the 
transmitted components.  

Bit rate Tracking Mode  Off, Maximize Video.  

Auto Enable  false, true. Specifies whether or not  to automatically re -enable the Transport Stream 
(set its Setmode state to Online) when the condition set in the Auto Disable field is not 
met.  

Auto Disable  Never, Audio Lost, Video Lost, Audio or Video lost, Any UPSTREAM critical alarm, Any 
critical alar m. Specifies the c ondition on which the Transport Stream has to be disabled. 
Audio lost and video lost means that the audio or video lock of any of the components 
in the Transport Stream is lost, UPSTREAM critical alarm is an alarm that is triggered by 
any  of the components  that contribute to producing the elementary streams carried by 

the Transport Stream.  

Syntax  DVB, ATSC  

Program Specific 
Information  

Transport Stream ID  A new ID can be assigned to the Transport Stream.  

PAT-PMT On, Off  

PAT-PMT Parame ters  PMT Repetition Period  100 ms, 400 ms, 500 ms. Specifies 
how often (in ms) the PMT shall be 
transmitted.  

Dolby Digital 

Descriptor  
DVB, ATSC, DVB & ATSC  

CAT On, Off  

TSDT On, Off  

 TDT On, Off  

EIT On, Off  

Service Information   

Original Network ID   

NIT  On, Off  

NIT Parameters  Network Name  Set Network Name  

Network ID  Set network ID.  

Generate LCN  Off, IEC 62216, NorDig v1, DTG Default  

Send extended NIT 

(SIRG)  

On, Off. If PSI/SI Level is set to On (PAT/PMT/SDT/CAT/NIT) 

make sure the Send exte nded NIT (SIRG) is On so that the 
Carrier ID is sent.  

Insert NIT into PAT  True, False  
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Parameter  Description  

SDT On, Off  

5.  For an IP Transport Stream set up the IP related parameters as shown in  
Table 3.23 .  

Table 3.23  IP Related Parameters  

Parameter  Description  

TS Packets per IP Packet  Specifies how many Transport Stream packets to encapsulate in one IP packet.  

IP Encapsulation  Specifies what higher layer to encapsulate in IP packets. UD P and RTP is self 
explanatory and means that the Transport Stream is first encapsulated in UDP or RTP 
packets, then an IP header is added. If RTP FE C column or RTP FEC Columns and Row is 
selected one (Column) or two (Column and Row) RTP streams are output in addition to 
the RTP streams that carry the Transport Stream.  

IP Configuration/Destination 1  

Destination IP Address  The destination IP address to use in the IP packet header of the IP packets that carry 
the Transport Stream.  

Destination UDP Port  The d estination UDP port to use in the IP packet header of the IP packets that carry the 

Transport Stream.  

Source IP Address  The source IP address to use in the IP packet header of the IP packets that carry the 
Transport Stream.  

Source MAC Address  Read only p arameter, not yet supported.  

Source UDP Port  The source UDP port to use in the IP packet header of the IP packets that carry the 
Trans port Stream  

6.  Select the Service List  menu in order to add one or more services to the Transport Stream.  

7.  Select Add Servic e. A new service by the name Service Name  appears in the list.  

8.  Select Service Name . 

9.  Check that the parameter settings are correct .  

Table 3.24  Component and Service Parameters  

Parameter  Description  

Component L ist  Select to manage components in the service. (Next step.)  

Service ID  Set Service ID  

PMT PID  A new PMT PID can be assigned to the service.  

PCR PID The PID to be used for the PCR.  

NOTE: If PCR on separate PID is enabled, this value must match the PID g iven to the 
PCR component in the output service.  

SDT Parameters  Service Provider  Set service provider name.  

 Service Name  Set service name. After setting the service name the service 

will be listed accordingly.  

 Service ID  A new ID can be assigned to th e service.  

 Service Type  Digital TV, Digital Radio, Teletext, Mosaic, Data Broadcast, Off, 

BISS Mode -1, BISS M ode -E. 

NIT Service Parameters  LCN 0 -  1023  



 

AVP 1000, 2000 & 3000  | Version Y www.m ediakind.com  
 

3-65  

Parameter  Description  

BISS KEY  0 ï 31 Selects the location in the BISS key table to use for BISS scrambling  

 

10.  Select the Component List  menu in order to add one or more components to the service.  

11.  Select Add Component . A new component identified by its PID appears in the list.  

12.  Select the component just added (it will display none on PIDnn  until a valid component is 
selected.  

13.  Select the req uired Elementary Stream  from the appropriate VCM and assign an input to be 
handled as the component.  

14.  Adjust PID or Bit rate weighting if necessary.  

15.  Move up to the Component List  menu and repeat steps 9 -12 to add more components to the 
service.  

16.  Move up to t he Service List  menu and repeat steps 5 -13 to add more services to the Transport 
Stream.  

17.  After the Transport Stream has been created, move up to the Transport Stream ID: 1  menu. 

Select the Change State  option and set it to Online . 

Note:  As the  output has n ot been enabled in the Line -up menu, at this point the unit will not 
produce an output through the RF connectors.  

3.26.4  How to Add More Transport Streams  

To add more Transport Streams to other outputs, follow the procedure detailed in Section 3.26.3 . 
by first selecting the Outputs  menu, then repeating the Transport Stream creation process. 

Alternatively, an existing Transport Stream can be copied to anothe r (or in case of IP output to the 
same) output by p roceeding as follows:  

1.  Select Outputs . 

2.  Navigate to the output to which a Transport Stream is to be added.  

3.  Select Add Existing Transport Stream . 

4.  Select the Transport Stream you want to copy.  

5.  The selected Transport Stream will be copied to the output.  

6.  Select the newly copied Transport Stream.  

7.  Select Change State  and set it to Online . 

3.26.5  How to Remove a Component from a Service  

To remove Components from a Service, proceed as follows:  

1.  Select the Output  menu.  

2.  Select the Output  containing the Transport Stream.  

3.  Select  the Transport Stream.  

4.  Select Service List.  

a Select the required Service (not Add Service).  

5.  Select Component List.  

b Scroll to the Component to be removed.  
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c Press the DEL  button on the keypad and c onfirm by pressing select (as instructed on the 

display).  

Note:  Adding or removing services or components from a TS will result in a short interruption 
to the output while the SI tables are updated to reflect the change.  
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4.1  Introduction  

This chapter describes the features and options provided by the Front Panel menus for controlling 
the Advance Video Processor Series.  

Note:  After powering up (see Chapter 3 , Getting Started ), wait for initialization to complete 
(approximately 1.5 to 3 minutes, depending on the number of options fitted in the 
chassis) before attempting to use the front panel menus and controls.  

4.2  Using the Front Panel Controls  

The user interfac e for the Front Panel consists of an ON/OFF power switch, light bar, mini USB, 
rotary knob alphanumeric keypad, pushbuttons, main display and confidence monitor that are 
used to set -up, control and monitor the unit.  

The unit can be controlled through the front panel by the rotary knob and the keypad. In a given 
state only the illuminated keys are functional.  

 

Figure 4.1 Advanced Video Processor Front Panel  

4.2.1  Light Bar  

The light bar indicates the alarm state of  the unit.  

4.2.2  Power Switch  

The power switch is used for turning the unit On or Off. The switch is recessed to prevent the unit 
from being accidentally switched off.  

4.2.3  Mini USB  

The mini USB connector provides an interface for remote web access and update  from a computer, 
and for saving or exporting configurations to, and loading or importing configurations from a USB 
stick.  

 

Figure 4.2 Front Panel Mini USB  
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4.2.3.1  Web Access and Update from Computer through the Mi ni 

USB  

The Mini USB port on the front panel of the unit can be used as a virtual IP connector through an 
USB- to -Ethernet adaptor. A computer connected through an USB - to -Ethernet adaptor to the front 
panel USB connector can provide the same functions as a c omputer connected to the control 
Ethernet interface of the unit. In this way the USB port can be used for unit upgrade and control. 
To access the unit from a computer through the USB connector, proceed as follows:  

4.  Connect an USB - to -Ethernet adaptor to the front pa nel USB connector with a USB cable.  

5.  Connect one of the Ethernet ports of the control computer to the Ethernet port on the USB - to -
Ethernet adaptor through an UTP cable.  

6.  Set up the Ethernet interface of the control computer connected to the USB - to -Ethernet  
adaptor as detailed in Table 4.1 .  

Table 4.1 Ethernet Interface Settings  

Parameter  Setting  

IP Address  192.168.20.[2 -255]  

Gateway Address  192.168.20.1  

Subnet Mask  255.255.255.0  

Note:  The USB interface uses  the IP address 192.168.20.20, so this address cannot be 
assigned to the control computer.  

4.2.3.2  Configuration Handling through USB  

Configurations can be loaded or imported from, and saved or exported to a USB stick connected to 
the front panel USB  connector.  

No tes:  Only configurations saved from, or converted to, the same software version as that 
running on the unit should be loaded or imported onto the unit.  

 If a configuration file is loaded onto a unit that has a different hardware configuration  to 
that of th e original unit, not all parameters will be configured and operation of the unit 
cannot be guaranteed.  

 The USB stick must be pre - formatted to FAT32 file system prior to use. The Unit 
Config/USB Control/Format USB Stick  command on the front panel does not  format the 
attached USB stick; it only clears its content and recreates the directory structure 
required  by the unit, 64 empty ñslotsò ready to take configurations. This means that any 
data already on the USB stick will be lost.  

4.2.3.3  Loading a Configuration fr om USB  

To load a configuration from the connected USB stick, select Manage Configuration/Load 
Configurati on from USB . 

Note:  The selected configuration is applied but not stored on the unit.  

4.2.3.4  Saving a Configuration to USB  

To save the current configuration of  the unit to the connected USB stick, select Manage 
Configuration/Save Configuration to USB . 

Note:  Entrie s already containing a stored configuration cannot be overwritten. Choose an entry 
with <empty slot>  label to save the configuration.  



 

AVP 1000, 2000 & 3000  | Version Y www.m ediakind.com  
 

4-4 

4.2.3.5  Importing Configu rations from USB  

To import all the configurations stored on the USB stick, select Manage Configuration/Im port 
Configuration/Import All Configurations .  

To choose some configurations on the USB stick to import, select Manage Configuration/Import 
Configuratio n/Select Configuration to Import .  The selected items are marked with '>', and can be 
imported by selectin g the Import Selected Configurations  command.  

Configurations can also be imported one by one by selecting Manage Configuration/Import 
Configuration/USB  Config <n> . 

4.2.3.6  Exporting Configurations to USB  

To export all of the configurations stored on the unit, select Manage Configuration/Export 
Configuration/Export All Configurations .  

To choose some configurations on the unit to export, select Manage Configuratio n/Export 

Configuration/Select Configuration t o Export .   

The selected items are marked with '>', and can be imported by selecting Export Selected 
Configurations .   

Configurations can also be imported one by one by selecting Manage Configuration/Export 
Config uration/Device Config <n> . 

4.2.4  Rotary Knob  

The ro tary knob is used for scrolling in the menu system, moving the cursor or stepping attribute 
values. The knob also serves as a push button and performs the same function as the Select  key.  

The current position on  the menu is indicated by a diamond next to t he text. The diamond is solid 
if the parameter is configurable or outline if the text is for information (read only).  

The menu option is selected by either pressing the rotary knob or pressing the select key.  

Selecting an item will either take you to the n ext level in the menu tree or will provide you with 
the configurable options. These are either a pre -defined list that can be scrolled through and 
selected, or user entry from the alphanumeric keypad. When chang es are made, pressing the 
knob or the Select  key  will activate and save the change. If you do not want to apply or save the 
change then press the Cancel key  

4.2.5  Keypad  

The main keys provided on the keypad are detailed in Table 4.2  

Table 4.2 Keypad Description  

Key  Description  

Select  Used for selecting a menu item or accepting attribute value input.  

Cancel  Used for exiting a menu or cancelling attribute value input.  

Ins  Used for creating a link in a menu or inserting a character during text 

input.  

Del  Used for deleting an item in a list or deleting a character during 
parameter input.  

Alphanumeric Keys  Used for entering numerical or textual va lues. Different characters are  

invoked by multiple presses within a short interval.  
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4.2.6  Confidence Monitor On Key  

The On key on the confidence monitor turns the monitor on or off. By pressing and holding the On 
key operation related data is shown. The first line displays the total number of hours the monitor 
has operated, the second line displays the software version.  

For details on how to configure the settings for the confidence monitor, see Chapter 3 Getting 
Started.  

4.2.7  Keyboard Lock  

The controls are lo cked after a time of inactivity. In o rder to set the key lock time, navigate to Unit 
Config/Display Setup/Menu Display And Keypad . The keys can be unlocked by pressing the Ins , 
then the  Select  keys in this sequence as instructed on the front panel.  

It is p ossible to configure the time before the keyboard becomes locked. This is available in the 
Unit Config / Display Setup / Menu Display and Keypad  menu of the front panel or, from the GUI, 

go to Device Configuration > Advanced Setup > Base Unit > Front Panel  Parameters and set the 
Key Lock Time  in the Properties panel.  

4.3  Front Panel Display  

The parameters of the main display can be configured through the Unit   Config/Display Setup 
menu of the front panel.  

4.3.1  Appearance and General Features  

The parameters of the ma in displays for all models of the AVP  are similar in content and can be 
configured through the Unit Config/Display Setup  menu of the front panel.  

When the power -up sequence is complete, if In -band Control is disabled, a main screen is 
displayed showing the  following features, see Figure 4.3 .  

 

Figure 4.3 Typical Screen Displayed on Power -Up (In -band Control Disabled)  

When the power -up sequence is complete, if In -band Control is enabled, a main screen is 
displayed showing the following features, see Figure 4.4.  
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Figure 4.4 Typical Screen Displayed on Power -Up (In -band Control Enabled)  

4.3.1.1.1  Title Bar  

Alternately displays th e current location within the menu tree and the recently loaded 
configuration. If the  loaded configuration was changed in any way, the '(changed)' string is 
appended to the name.  

4.3.1.1.2  Icons  

The icons allow the user to determine the current state of the AVP 3000  at a glance. The icons 
available on the main screen are shown in Table 4.3 .  

Table 4.3 Main Screen Icons  

Icon  Description  

Output Power  Modulation State  Output State  

 Irrelevant  Irrelevant  Off  

 
Moderate  Off  On 

 

High  Off  On 

 

Moderate  On On 

 

High  On On 

Off Air
 

Either of Output State or Modulation State is Off or the Current State 
of the satellite modulator Transport Stream is not Online.  

On Air
 

Both Output State and Modulation State are On and the Current State 
of the satellite modulator Transport Stream is Online.  

CLEAR
  

No service in an enabled Modulator Transport Stream output is BISS 
or RAS  encrypted  

SCRAMBLED
 

At least one service in an enabled Modulator Transport Stream output 
is BISS or RAS encrypted  

 

4.3.1.1.3  Active Area  

The active area is used for:  

¶ Displaying the IP address and status information about the active streams  

¶ Disp laying the Satellite Modulator parameters (AVP 3000 only)  

¶ Displaying the menu system  

¶ Displaying parameter setting  

4.3.1.1.4  Audio Monitor  

A selected audio input can be monitored. To select an audio input for constant monitoring, 
navigate to Unit C onfig/Display Setup /Audio Monitor Input  and set the slot and channel 
parameters.  
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4.3.1.1.5  Audio Input Monitor  

On the Audio Input Monitor Screen, see Figure 4.4 , all the encoded channels from an option card 
can be displayed.  

 

Figure 4.5 Audio Input Monitor Screen  

The entire audio input range for an encoder card can be monitored by selecting the AV 

Encoder/Audio Monitor menu . The rotary knob can be used to switch between Channels 1 -8 

and Channels 9-16 on each card.  

4.4  Front Panel Menus  

4.4.1  Main Menu  

Shortly after power -up the title bar of this screen displays the current location within the menu 
tree and the recently loaded configuration. The main area of the screen may also display either 
the current IP Address or Service Name, if one has been set.  

 

Figure 4.6 Main Menu Navigational Overview  

The front panel provides a menu structure which is extended by the installed option cards. Menu 
navigation is achieve d by the front panel controls. The menu is organized in such a way tha t 
frequently used items are easily accessible, while all the functionality is still made available 
through the front panel. The menu items are described in Table 4.4 . 

Table 4.4 Main Menu Options  
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Menu Item  Description  AVP 2000  AVP 3000  

Manage Configuration  Saving, loading, exporting, importing configuratio ns V V 

Line Up  Carrier signal power and frequency settings  U V 

Modulation Parameters  Carrier signal modulation settings  U V 

Bit Rate Tra cking  Transport Stream Bit Rate settings  V V 

A/V Encoder  Audio/Video encoding settings, VCM specific  V V 

Output  Building a Transport Stream on a specific output  V V 

Alarms  Viewing alarms and setting alarm masks  V V 

Shortcuts  User -defined links to menu items  V V 

Unit Config  Device settings  V V 

Adv anced (AVP2000/3000)  Access to full functionality of the AVP and the installed 
option cards  

V V 

Sub Menus are listed in the following tables.  

4.4.1.1  Manage Configuration Menu  

The Manage Configuration Menu is used for saving, loading, exporting and importing 
configurations.  

4.4.1.2  Line Up Menu  

The Line Up Menu displays the Satellite modulator line up settings.  

4.4.1.3  Modulation Parameters Menu  

The Modulation Parameters Menu displays the Satellite Modulation settings.  

4.4.1.4  Bit Rate Tracking Menu  

The Bit Rate Tracking Menu display s the Transport Stream Bit Rate settings.  

4.4.1.5  A/V Encoder Menu  

The A/V Encoder Menu displays the VCM specific audio/video encoder settings.  

4.4.1.6  Output Menu  

The Output Menu is used for building a Transport Stream on a specific out put.  

4.4.1.7  Alarms Menu  

The Alarms Menu d isplays the alarm settings available on the unit.  

4.4.1.8  Shortcuts Menu  

The Shortcuts menu displays the shortcuts available on the unit.  

4.4.1.9  Unit Config Menu  

The Unit Config Menu displays the device settings.  
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4.4.2  Advanced Menu  

The Advan ced menu allows access to all of t he Advanced menus for the installed option cards. 
Selecting the option card whose parameters you wish to edit  from the Slot <n> option will give 
access to the required menu.  

Note:  The availability of some options depends u pon the hardware fitted or license s available.  
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5.1  Using the Web Graphical User Interface  

The Advanced Video Processor (AVP) is designed to be configured and controlled by its own web 
graphical user interface (GUI).  

The Graphical User Interface uses a widget -based architecture. This section describes the 
functions and elements of the GUI, referenced as the Advanced View.  

 Appearance and General Features  

The appearance and the mai n components of the Advanced View are shown in Figure 5.1.  

 

Figure 5.1 Main Components of the GUI (Advanced View)  

5.1.1.1  Header  

The header contains the Company Logo , the Model Name  and the Unit Name , the Alarm 
Status Bar , the Output Status Indicators , and the name of the recently loaded configuration, if 
any.  

 

Figure 5.2 Header  

The Unit Name can easily identify the unit when browsing remotely. The name can be changed by 
double clicking on it.  

The color of the Ala rm Status Bar  indicates the highest actual alarm severity. The bar is red in 
case of an alarm with critical severity, orange if an alarm or warning with any severity o ther than 
critical and no alarm with critical severity is issued, and green otherwise.  

Pages Tabs  Alarm Status Bar  Widgets  
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5.1.1.2  Na vigation Area  

The unit is controlled through five different web pages , each of them responsible for a well -defined 
control task. The pages can be accessed through the top menu in the Navigation area. Where 
appropriate, control tasks are further broken down into smaller subtasks. Each subtask has its 
own tab.  

 

Figure 5.3 Navigation Area  

The area below the tabs serves as a taskbar with two buttons on it. The Apply All  button allows 
the user to commit the changes made to any of the parameters on the displayed page or tab. With 
the Discard All  button the changes can be revoked and the state prior to the modifications can be 
recalled. Modified parameters are highlighted in orange. If the user first modifies some parameters 
and then tries to navigate away from the page or tab, a warning dialog is displayed. The buttons 
do not appear on every pa ge.  

The information next to the butt ons displays the number of running tasks and the processing 
status of them.  

5.1.1.3  Widgets  

Widgets are containers that allow the user to perform specific actions or display relevant 
information. Widget can be resized by draggin g the splitters between them. By dou ble clicking on 
the splitters the widgets can be collapsed to provide more room for neighboring widgets. Double 
clicking on a splitter again redisplays the previously hidden element.  

 

Figure 5.4 Example of a  Widget  

Where relevant, objects can be manipulated by drag and drop within or between the widgets.  

Note:  Avoid sudden moves with the mouse while dragging and dropping.  

5.1.1.3.1  Accordion Panels  

Accordion panels are separate areas  within widgets which can be collaps ed and expanded by 
clicking on the small arrow on the top left hand of the panel.  
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Figure 5.5 Example of an Accordion Panel  

5.1.1.4  Footer  

The footer on the page displays copyrigh t information and contains a link th rough which MediaKind  
can be contacted. Moreover, the color of the footer indicates the status of the link to the unit being 
controlled through the web user interface. Orange color indicates that the link to the unit is down; 
navy blue indicates that the l ink is up.  

 

Figure 5.6 Footer  

 Supported Actions and Features  

¶ Drag and Drop  ï The web GUI supports drag and drop , for example in the Configuration  
> Services  page, to enab les you to quickly copy services and  profiles. Additionally, when 
selecting services and profiles, the web GUI supports Shift - Click operation to enables you to 
select multiple adjacent items, and Ctrl - Click  operation when selecting multiple non -adjacent 
it ems.  

¶ Drop - Down Menus  ï Some web GUI pages provide drop -down menus to enables you to 
select from the available options.  

¶ Right - Click/Context Menus  ï Some web GUI pages provide right -click menus for speedier 

configuration.  

¶ Parameter Highlighting  ï When you mo dify service and profile properties,  any changes you 
make will be highlighted as orange text . These changes will not be carried out until they are 
confirmed, by clicking the Apply All  green button.  

¶ Web Page Resizing and Collapsing  ï To enable you to view j ust the information that you 
need, t he panes displayed on some web pages may be resized by dragging the pane boundary 
or collapsed by clicking on the t symbol in the pane boundary. If your monitor screen width is 
less than 1300 pixels, panes may be collaps ed automatically.  

 Pages  

The control options of the unit are grouped into five categories. Each of the categories is 
represented by a page. They are as follows:  

¶ Dashboard  

¶ Stored Configurations  

¶ Device Configuration  
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¶ Service Configuration  

¶ Support  

Each page is described in the following sections and the descriptions are followed by tasks that can 
be performed on these pages.  

5.2  Dashboard Page  

The Dashboard  page provides detailed information about the device and the Transport Streams.  

 

Figure 5.7 Dashbo ard Page  

 Dashboard Page Widgets  

5.2.1.1  Outputs Widget  

The Outputs  widget lists the items within the Transport Streams set up for the different outputs. 
If you want to quickly edit the properties of an item (other than the output itself), select it by 
clicking on its name with the left mouse button, then either select th e Edit Properties  option 
from the Actions menu, or right click on the item and select the same option from the context 
menu. You will be directed to the Service Configuration  page with the respectiv e item selected 
in the Outputs  widget there.  

 

Figure 5.8 Outputs Widget  
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5.2.1.2  Bit Rate Utilization widget  

The  Bit Rate Utilization  widget provides status information about the different Transport 
Streams by color  coding them according to the legend shown at the bottom o f the Transport 
Stream Rates  accordion panel. (For the meaning of the respective states and colors refer to Bit 
Rate Tracking.) Moreover, the useful and total bit rates of each Transport Stream are also shown. 
Click on a Transport Stream here and a pie cha rt will be displayed in the Component Bit Rates 

per Transport Stream  accordion panel with the bit rates of the individual services and 
components.  

 

Figure 5.9 Bit Rate Utilization Widget  

5.2.1.3  Device Information W idget  

The Device Information  widget provides information on the unit, the option cards and the 
network configuration. If there is a configuration mismatch in one of the slots, an alarm is raised 
and  displayed in the Alarm Monitor  widget. In this case, the Accept Hardware Configuration  
button is shown below the slot information. By clicking on the button, the current configuration 
can be accepted. After accepting the hardware configuration, the alarm is ceased.  
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Figure 5.10  Device Information Widget  

5.2.1.4  Alarm Monitor Widget  

The Alarm Monitor  widget displays the current alarms and an alarm history sorted by severity. 
The alarms can be expanded or collapsed by  clicking on the arrow next to their nam e.  

 

Figure 5.11  Alarm Monitor Widget  

 Using the Dashboard Page  

This section describes the tasks that can be completed on the Dashboard  page.  

5.2.2.1  Accessing the Properties of  Transport Streams, Services or 

Componen ts Associated with an Output  

To directly access the properties of a Transport Stream, service , or component from the 
Dashboard , do the following:  

7.  In the Outputs  widget, select the Transport Stream, service, or compon ent whose 
parameters you want to access.  

8.  Right click on the selected item and choose Edit Properties  from the context menu.  

9.  The view will change to the Service Configuration  page with the item selected in the 

Outputs  widget.  
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The Setmode  state is reflected how the Transport Streams are color code d in the Transport 

Stream Rates  accordion panel of the Bit Rate Utilization  widget. The color codes are shown in  
Table 5.1. 

Table 5.1 Setmode State Color Codes  

State  Color  

Online green 

Offline grey 

Preview light green 

Retire orange 

5.2.2.2  Checking the Bit Rates of the Different Components in a 

Transport Stream  

To check the bit rates of services and components in a Transport Stream, do the following:  

1.  In the Transport Stream Rates  accordion panel of the Bit Rate Utilization  widget, click on 
the Transport Stream whose components you want to check.  

2.  The bit rates are shown in a table in the Component Bit Rates per Transport Stream  
accordi on panel. The bit rates of the components are also shown if the mouse is hovered over 
a component in the pie chart.  

 

Figure 5.12  Component Bit Rates per Transport Stream  Accordion Panel  

5.2.2.3  Setting Alarm Severit y  

To set the severity of any of the current alarms or any alarms raised since power up, do the 
following:  

1.  On the Current  or History  tab in the Alarm Monitor  widget, click on the arrow next to the 

alarm whose seve rity you want to modify.  

2.  In the Severity  dro p down list, set the required severity level.  

5.2.2.4  Accepting Hardware Configuration Changes  

When the persistent store is cleared, the hardware configuration settings are also deleted. After 
the unit is rebooted an ala rm will be raised to signify that the hardwa re configuration has been 
changed. This is normal and does not indicate any malfunction. To clear the alarm, do the 

following:  

1.  In the Option Slot Summary  accordion of the Device Configuration  widget, click on the  
Accept Hardware Configuration .  
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2.  The respecti ve alarms are cleared.  

5.3  Stored Configurations Page  

The Stored Configuration  page allows saving the current configuration to or restoring a stored 
configuration from the unit. To load or save a configuration throug h the front panel, select 
Manage Configurati on . 

 

Figure 5.13  Stored Configurations Page  

 Stored Configuration Page Widgets  

This section describes the tasks that can be completed on the Stored Configurations  page.  

5.3.1.1  Stored Configurations Widget  

The Stored  Configurations  widget lists 64 slots to which configurations can be saved or from 
which configurations can be restored. If you click on an entry, the corresponding information is 
shown in the Configuration Workb ench  widget.  

 

Figure 5.14  Stored Configuration Widget  
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5.3.1.2  Configuration Workbench Widget  

The Configuration Workbench  widget displays the information about the slot selected in the 
Stored Configurations  widget. M oreover, it lets the user overwrite, restore , delete or export the 
configuration in the selected slot.  

 

Figure 5.15  Configuration Workbench Widget  

Note:  The format of the files exported through the Stored Configurations  page is not 
compatible with the  format of the configurations saved on the Support  page.  

 Using the Stored Configuration Page  

This section describes the tasks that can be completed on the Sto red Configuration Page.  

5.3.2.1  Storing the Current Configuration  

The unit provides 64 configuration slots  for storing different configurations. On delivery, all store 
locations are empty. When the user has configured the unit with a complete set of parameters the  
configuration can be saved to a store location. Configurations can be saved at any time. To save 
the current configuration, do the following:  

1.  In the Stored Configurations  widget, select the slot you want to use for storing the 
configuration. If the slot is not empty, it will be overwritten.  

2.  In the Name  field in the Configuration Workbench  widget, ente r a name for the 
configuration.  

3.  You can also add a description in the Des cription  field if you wish. The description can help 
identifying the configuration in the future.  

4.  Click on the Save Config  button within the Configuration Workbench  widget.  

5.  A confirma tion dialog will appear. Choose Yes  to save the configuration in the sele cted slot.  

Once stored the configuration is available to be recalled and used at any time. The table below 
describes each main action associated with the stored configurations.  

Table 5.2 Stored Configuration P arameters  

Parameter Description 

Restore Restores the configuration from the selected stored onto the unit. Select required stored number and press 
Restore 

Save Config Saves the current unit configuration into the selected store location. Select required store number, enter Name 
and Description and press Save Config 

Edit Allows Store Name and Description to be changed. Select required store, modify the Name and/or Description as 
required and press Edit to save the modified text only. The stored configuration data will not be affected 

Delete Delete contents, name and description of selected store. Select required store number and press Delete 

Import Imports a configuration from file to selected store location. Browse to required file and select Import. This does 
not affect unit configuration. 

The file being imported must be in the same format (ie exported from the stored configurations function rather 
than the save-load XML 
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Export To export the selected configuration to a file, move the mouse pointer over the link, right click and select Save 
target as... or Save link as..., dependent on the browser you are using. You will then be prompted for a filename 
and a place to store the file. Give the file a .xml extension. 

Update Properties Refreshes the contents of the list and the workbench from the unit. 

5.3.2.2  Restoring a Configuration  

The unit provides 64 configuration slots for storing different configurations. Configurations can be 
restored  at any time. To restore a previously stored configuration, do the following:  

1.  In the Stored Configurations  widget, select the configuration you want to restore.  

2.  The Configuration Workbench  widget will display the properties of the selected stored 
configura tion.  

3.  To restore the configuration, click the  Restore  button in the Configuration Workbench  
widget.  

5.3.2.3  Exporting a Configuration  

The unit provides 64 configuration slots for storing different configurations. The content of any of 
the slots can be exported. Ex ported configurations from a previous version  of the unit can be fed 
to the Configuration Converter Tool  and converted to the current version. To export a 
previously stored configuration, do the following:  

1.  In the Stored Configurations  widget, select the co nfiguration you want to restore.  

2.  The Configur ation Workbench  widget will display the properties of the selected stored 
configuration.  

3.  To export the configuration, click the Export  button in the Configuration Workbench  
widget.  

4.  In the popup window, select th e Save file  option.  

5.  By default, the file will  be saved in the Downloads  folder on your computer.  

Note:  The format of files exported from a Stored Configurations  page is not compatible with 

the files saved on the General  tab of the Support  page. Similarly f iles saved on the 
Support  page cannot be impo rted into stored configurations.  

5.3.2.4  Importing a Configuration  

The unit provides 64 configuration slots for storing different configurations. The content of any of 
the slots can be exported. Exported configurations from a previous version of the unit can be fe d 
to the Configuration Converter Tool  and converted to the current version. To import a 

converted configuration, do the following:  

1.  In the Stored Configurations  widget, select the slot you want to use to store th e imported 
configuration.  

2.  Click on the Browse  button within the Configuration Workbench  widget.  

3.  In the popup window, browse to the file you want to import, and click Open . 

4.  The file name will be populated into the text box next to the Browse  button.  

5.  Click o n the Import  button.  

6.  Answe r Yes  to the confirmation message.  

Note:  The format of files exported from the Stored Configurations  page is not compatible 
with the files saved on the General  tab of the Support  page. Similarly files saved on the 
Support  page ca nnot be imported into stor ed configurations.  
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5.4  Device Configuration Page  

The Device Configuration  page provides setup options for the device and provides access to the 
following tabs:  

¶ Quick Setup Tab  

¶ Advanced Setup Tab  

 Quick Setup Tab  

The Quick Setup  tab pro vides access to the most commonly used parameters. The list of 
parameters displayed here can be customized and even exported. The tab contains the 
Configuration Items , the Properties , the Help , and the Information  widgets.  

 

Figure 5.16  Quick Setup Tab  

5.4.1.1  Configurations Items Widget  

The Configuration Items  widget displays the Quick Setup  menu as a tree. The tree contains 

the most commonly used parameters. These include default parameters as well as the p arameter s 
added by the user.  

 

Figure 5.17  Configuration Items Widget  

For information on how to add your own parameters to the tree, go to 5.4.3.1 :  
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5.4.1.2  Properties Widget  

The Properties  widget displays the properties of the items selected in the Configuration Items  
widget. When a value of a property is changed its label is highlighted in orange and remains 
highlighted until the change is committed or abandoned by clicking on the  Apply All  or Discard 
All  buttons on the taskbar, respectively.  

 

Figure 5.18  Properties Widget  

5.4.1.3  Information Widget  

The Information  widget contains the Changes , Warnings  and Errors  tab pages for displaying 
cha nges, warnings, and errors. By clicking on a Change the corresponding item is displayed in the 
Properties  widget and the change can be revoked by manually resetting th e parameter to its 

original value.  

 

Figure 5.19  Information Widget  

Note:  The original value is shown in a tooltip by hovering the mouse pointer over the item in 
the Changes  tab.  

 Advanced Setup Tab  

The Advanc ed Setup  tab provides access to all configuration options of the unit.  
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Figure 5.20  Advanced Setup Tab  

5.4.2.1  Advanced Video Processor Settings  Widget  

The Advanced Video Processor Settings  widget displays a tree view of all configuration items 
available on the unit organized into different folders for easier navigation. The properties of the 
selected node (if any) are displayed in the Properties  widget.  

 

Figure 5.21  Advanced Video Processor Settings Widget  

5.4.2.2  Properties  Widget  

The Properties  widget displays the properties of the items selected in the Advanced Video 
Processor Settings  widget. When a value of a property is changed, its label is hig hlighted in 
orange and remains highlighted until the change is committed or abandoned by clicking on the 
Apply All  or Discard All  buttons on the taskbar, respectively. Fan speed may be controlled by 
adjusting the slider to the appropriate setting.  

 

Figure  5.22  Properties Widget  
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 Using the Device Configuration Page  

This se ction describes the tasks that can be completed on the Device Configuration  page.  

5.4.3.1  Customizing the Quick Setup Menu  

The Configuration Items  widget displays the Quick Setup  menu as a tree. The tree contains 
the most commonly used parameters. These include de fault parameters as well as the parameters 
added by the user. To add your own parameters to the tree, do the following:  

1.  Open the Customize  Items  dialog by selecting Actions > Customize Items .  

2.  In the Configuration Items  widget of the Customize Items  dialog,  select the Quick Setup 
Items  node, and select Actions > Add Folder . 

3.  Double click on the newly created node, and rename it to a more descr iptive name.  

4.  Scroll down to the item you want to add to your custom list in the Advanced Video 
Processor Settings  widg et.  

5.  By holding down the left mouse button, drag the item over the new folder in the 
Configuration Items  widget.  

6.  Add the item to the new fo lder by releasing the mouse button. The item cannot be added to 
the Quick Setup Items  node. Any valid drop position is  indicated by the dragging rectangle 
changing into green.  

7.  Repeat the process for any additional items you want to add. You can create as m any folders 
as you wish or you can use any previously created one. The created folders can be reordered 
by the drag an d drop technique used for adding the item. The added items can also be 
relocated through drag and drop. To delete a folder or an item, sel ect it then choose Action > 
Remove Item . 

8.  When ready, click Save  to save the changes. The new items are added to the Qu ick Setup  
menu.  

Note:  The list of added items can be exported by selecting Action > Export  and can be 
imported on another unit by Action >  Import . 
 
The Settings  widget of the Customize Items  dialog displays all the options available to 
be set regardless of  the visibility of the individual items. (Normally, some items might be 
hidden depending on the settings selected for other parameters.) W hen such an item is 
added to the Configuration Items  list and the list is saved, the item will only show up 
on the Qui ck Setup  list if the other parameters controlling its visibility are changed to 
the correct value.  

 Configuring Option Cards Using the Devi ce Configuration 

Page  

This section gives the tables of parameters available for configuring the option cards using the  
Device Configuration  web page.  

5.4.4.1  CE VCM Option Cards  

I t is recommended that the configuration of the CE VCM option cards is done through the Service 
Configuration  web page.  

5.4.4.2  ASI Option Card  

The ASI Option module provides ASI outputs for the transmission of M PEG-2 Transport Streams. 
When an ASI option module i s fitted in a base chassis the host detects its presence and adds the 
option to configure a Transport Stream to be output over ASI.  
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5.4.4.2.1  ASI Output Configuration  

The following parameters are available through the Advanced Setup  tab of the Device 
Configuration  page under Slots > Slot <n> -  ASI IO Option Card > ASI IO Option Card > 
ASI Output Streams . The same parameters can be accessed through the Advanced/ASI/ASI 
Output Streams  menu on the front panel.  

Table 5.3 ASI  Output Configuration Parameters  

Parameter Values Description 

Output Mode Mirrored, Independent Specifies whether the two outputs output the same 
Transport Stream or they operate independently. If set to 
Mirrored, only one output will be accessible. 

5.4.4.3  G.703 Transceiver Card  

The section describes the options available to set up the G.703 input and output through the web 
user interface or the front panel. When a G.703 Transceiver Card is fitted in a base ch assis, the 

host detects its presence and adds the option to configure a Transport Stream to be output over it.  

5.4.4.3.1  Transceiver Configuration  

The following parameters are available through the Advanced Setup  tab of the Device 
Configuration  page under Slots > Sl ot <n> -  G.703 Transceiver C ard > G.703 Transceiver 
Card > G.703 I/O Ports > G.703 I/O Port 1 . The same parameters can be accessed through 
the Advanced/ G.703 Transceiver Card/G.703 I/O Ports/G.703 I/O Port 1  menu on the front panel.  

Table 5.4 Transmitter Configuration Parameters  

Parameter Values Description 

PDH Carrier E3, DS3 Specifies which E carrier to use. E3 is equivalent to E31 (which supports an output bit 
rate of 34368 kbps), DS3 is equivalent to E32 (which supports an output bit rate of 44736 
kbps) as defined by ITU-T Rec. G.703. 

Framing None, M13, C-bit Specifies the framing used in DS3 operation. 

Receiver/ATM Configuration  

ATM Mode  Off, On  ATM encapsulated transmission as per ETSI ETS 300 813. Available only if Framing is 
set to C-bit.  

Alpha  2 ï 255  Number of consecutive incorrect HEC to lose ATM synchronization (ITU-T I.432.1). 

Delta 2 ï 255 Number of consecutive correct HEC to achieve ATM synchronization (ITU-T I.432.1). 

VPI 1 ï 255 ATM Virtual Path Identifier. This value should not normally be changed. 

Cell Header 
Correction 

Off, On Do not correct any ATM cell header error, but report error even for single bit error. 

Cell Header Error 
Ignore 

Off, On Never report ATM cell header error; treat headers even with multibit errors as good. 

Receiver/DVB Configuration  

Destuffing Off, On  Proprietary stuff packet removal. Should not normally be turned off. 

Derandomization Auto, Off  Inversion of spectral shaping data randomization as per ETSI/EN 300 429. "Auto" 
enables decision based on bit stream analysis. 

RS Decoding Auto, Off  Reed-Solomon bit error correction processing as per ETSI/EN 300 429. "Auto" enables 
decision based on bit stream analysis. 

Deinterleaving Auto, Off  Block error correction interleaving removal as per ETSI/EN 300 429. "Auto" enables 
decision based on bit stream analysis. 



 

AVP 1000, 2000 & 3000  | Version Y www.m ediakind.com  
 

5-21  

Parameter Values Description 

Receiver/Advanced  

Packet Size Auto, 188 bytes, 
204 bytes 

Number of bytes in a TS packet. The 204-byte format is used with Forward Error 
Correction (FEC) scheme laid down in ETSI/EN 300 429.  

"Auto" enables packet size detection. 

#Sync Bytes To Lock 2 ï 255 Number of consecutive TS sync characters to achieve TS synchronization. Possible 
values are between 2 and 255 (default is 5). 

Sync Miss Sample 
Size 

2 ï 255 Number of consecutive TS packets to look for missing sync characters in synchronized 
state. Possible valuesare between 2 and 255 (default is 30). 

Sync Miss Limit 2 ï 255 Number of missing sync characters to lose TS synchronization. Possible values are 
between 2 and 255 (default is 2). 

Transmitter/ATM Configuration  

ATM Mode Off, On Enables or disables ATM encapsulated transmission as per ETSI ETS 300 813. 
Available only if Framing is set to C-bit. 

VPI 1 ï 255 Virtual Path Identifier. Should not normally be changed. 

Transmitter/DVB Configuration  

G.703 Stuffing Off, On Controls whether only G.703 packets are inserted into the output transport stream. 

On [default] = G.703 packets only included in the output transport stream.  The output 
bitrate can be manually configured as required. 

Off = nulls will be inserted as well as G.703 packets and the output bitrate is determined 
by the G.703 configuration. 

Randomization Off, On Enables spectral shaping by data randomization as per ETSI EN 300 429. 

RS Encoding Off, On Enables or disables Reed-Solomon forward error correction as per ETSI EN 300 429. 

Interleaving Auto, Off Enables interleaving as per ETSI EN 300 429. If set to Auto, interleaving will be enabled 
if RS Encoding is applied. 

5.4.4.4  GPI Option Car d  

This section describes the options available to set up the GPI option card through the web user 
interface or the front panel.  

5.4.4.4.1  GPI Input Configuration  

To configure GPI input pins for splicing, select the Advanced Setup  tab on the Device 
Configuration  page  on the GUI. Expand Encoder > Slots > Slot n Data & GPI Card > GPI 
Input Pin n Setup  folders in the Advanced Video Processor Settings  widget.  



 

AVP 1000, 2000 & 3000  | Version Y www.m ediakind.com  
 

5-22  

 

Figure 5.23  GPI Pin Setting via GUI  

The parameters for each inp ut pin are listed below.  

Table 5.5 GPI Input Pin Configuration  

Parameter Values Description 

GPI Input Pin Mode Off (Default)  

Load Stored Configuration Only available for pins 1 to 10. 

Splice Out of Network When selected and the GPI pin changes state, an Out of 
network  splice point is signaled to be inserted into the 
Transport Stream. Further setting determines how and when 
the splice point is inserted. 

Splice Return to Network When selected and the GPI pin changes state, a Return to 
network  splice point is signaled to be inserted into the 
Transport Stream. Further setting determines how and when 
the splice point is inserted. 

Splice Latched When selected and the GPI pin changes state, an Out of 
network  splice point is signaled to be inserted into the 
Transport Stream. A return to network splice point is signalled 
when either the GPI pin polarity changes state again or when 
the splice duration is reached. Further setting determines how 
and when the splice point is inserted. 

5.4.4.4.2  Load Stored Configurations  (Not Supported in this Release)  

I t is possible to use the GPI input pins to trigger the loading of any of the 64 stored configurations 
on the unit. The selection of the stored configuration is made by configu ring 6 of the GPI input 
pins as a binary repres entation of the store number while a 7 th  pin provides the toggle to action 
the loading of the configuration.  

When a GPI Input Pin Mode  is set to Load Stored Config  the next 6 pins are automatically 
configured to the same setting. The lowest pin number (ori ginally selected) is the LSB of the store 
number. The highest pin number is the GPI trigger to load the selected configuration.  
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Figure 5.24  Load Stored Configu rations  

For example: If 'GPI Input Pin 3' is se t to óLoad Stored Configô and the following pins are set as 

follows  

¶ GPI Input Pin 3  0 LSB 

¶ GPI Input Pin 4  0  

¶ GPI Input Pin 6  1  

¶ GPI Input Pin 7  0  

¶ GPI Input Pin 8  1 MSB 

When GPI Input Pin 9 is toggled the conf iguration in store 40 is loaded.  

When a GPI inp ut pin mode is selected, the splicing setup options become available by expanding 
the appropriate GPI Input Pin n Setup folder. The parameters are listed below.  

5.4.4.4.3  Splicing Configuration  

The card can be configure d to send SCTE 104 messages to encoders of VCMs  fitted in the unit.  

The closure (or opening) of the general purpose input pins (GPI Pin 1 ï 16) with the common GND 
can trigger these SCTE 104 messages. The configuration can be divided into two parts:  

¶ Settin g up the GPI card (pins and messages)  

¶ Setting u p the VCMs  

5.4.4.4.4  GPI Card Splicing Configuration  

When any of the Splice  options are selected a further set of configurable options are displayed if 
the GPI Input Pin n Setup is expanded to show Splicing Setup  
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Figu re 5.25  GPI Input Pin Splicing Setup  

Table 5.6 Splicing Set Up Options  

Parameter Values Description 

SCTE 104 Channel None, ChannelA to ChannelP Virtual SCTE 104 channel used to route messages to 
encoders. Different pins can share same channel. Different 
encoders can share same channel. 

GPI Pin Triggered 
Polarity 

Open, Closed (Default) When the parameter is set to Open  a message is sent when 

the pin goes from Clo sed  state to open state. When the 
parameter is set to closed a message is sent when the pin 

goes from open state to closed state. Splice latched  mode 

defines the trigger for the Out of network  message. 

Out Pre-roll 0, 4 to 100(s) 0 (default value) indicates immediate and a value less than 4 
will be treated as immediate. A splice point is inserted at the 
earliest possible opportunity. If a value is set for the pre-roll, a 
splice point shall be inserted that many seconds after the GPI 
pin contact change has been signalled. 

Return Pre-roll 0, 4 to 100(s) 0 (default value) indicates immediate and a value less than 4 
will be treated as immediate. 

Return to Network Automatic 

External Control 

If set to Automatic  a Return to network  splice shall 

automatically be inserted after the time set for the Splice 
Duration  has elapsed from when the Out of Network  
splice was signalled. 

Splice Duration 1 to 10000 (s)  

Fixed Delay 0 to +1000 (ms) Added to both Out and Return pre-roll. 

Splice ID Increment 
Mode 

For each Avail, For each Msg  

Avail_Descriptor Off (Default), Present If set to Present , the value in the Provider Avail Id  is 
inserted into the output SCTE 35 message 

Provider Avail Id 0 to 424967295 Used as a reference to identify a specific Transport Stream 
that the splice point is to be associated with. 

GPI Input Pin State  Read only. 
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5.4.4.4.5  Setting Up the VCM to Use GPI Input s 

Note:  It is not possible to define the EventID , so all SCTE -35 messages will contain the same 
EventID.  

The example given here shows setting up a CE-x in slot 3.  

To set Up the VCM to use GPI inputs, select the Advanced Setup  tab on the Device 
Configuration  page on the GUI. Expand Encoder > Slots > Slot 3 > CE - x > Video > Video 1 

>  Video > Main Video > Video Encoder > Splicing folders in the Advanc ed Video Processor  
Settings  widget.  

 

Figure 5.26  VCM Splicing Control  

When Splicing Control is set to On GPI  the SCTE 104 Input  node appears in the settings tree. 
This provides a list dis play ing all usable S CTE 104 channels. A channel is usable if there is at least 
one  GPI pin configured on the source end of the channel. After choosing an input channel for the 
VCM encoder core, th e configuration of the VCM is complete, it now waits for messages on 
selected ch annel for SCTE 104 messages.  
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Figure 5.27  VCM SCTE 104 Input Selection  

Combinations and Limitations  

With the SCTE 104 Channels a many - to -many relation can be set up between the GPI pins and the 
encoder cores  of VCMs. This means:  

¶ More pins of the same GPI card can be configured to send messages to the same set of 
encoder cores. This is achieved with selecting the same channel for t hem on the GPI Input Pin 
Setup panel.  

¶ More encoder cores (of the same VCM or dif ferent VCMs) can be configured to get messages 
from the same set of pins of a GPI card. This is achieved with selecting the same channel for 
them on the SCTE 104 Input / Encode r panel.  

Different GPI cards fitted in the same unit can not send messages to th e same encoder core. This 
is because channels belong to GPI cards and one encoder core can use only one channel for SCTE 
104 input.  

5.4.4.4.6  Alarm Relay  

The alarm relay function is init iated by an alarm relay and a fail relay. The alarm relay is energized 
when ther e is no active alarm condition and de -energized when an alarm with the severity Major is 

raised or cleared by the unit. The fail relay is energized when there is no active fail  condition and 
de-energized when an alarm with the severity Critical is raised b y the unit. A loss of power is 
signaled as both an alarm and a fail condition.  

The alarm relay function is not configurable. At the same time, it is possible to configure the 
severities of the unit alarms. To do so, browse to the Dashboard  page and select  the All  tab in 
the Alarm Monitor  widget. An expandable box is displayed for the host, and one for each card 
inserted in the chassis. By expanding a box, the individual alarms can be selected and the 
appropriate severity level can be set.  
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Figure 5.28  Alarm Severity Configuration  

5.4.4.4.7  Data Input Configuration (Not Supported in this Release)  

To configure the Data Input Pins using the GU I, select the Advanced Setup  tab on the Device 
Configuration  page on the GUI. Ex pand Encoder > Slots > Slot n Data & GPI Card > RS232 
Input  options in the Advanced Video Processor Settings  widget.  

 

Figure 5.29  Data Input Configuration  

Table 5.7 Data Input Configuration Options  

Parameter Options Description 

Enabled True 

False 

Data Channel enable/disable 

Encoding Wenger Identified in the PMT as a component of type 0xC1 with no descriptors. 

Wegener ASYNC data are transmitted as private stream 2 type data. This stream conforms 
to ISO13818. The adaptation field is used to add stuffing bytes if needed to complete a TS 
packet. Stuffing bytes are set to a value of 0xFF. Payload data bytes follow the packet 
length field and do not include a CRC field. 

 Motorola Identified in the PMT as a component of type 0xC0 with no descriptors. 

The IEC-232 data are encapsulated directly into the full 184 payload bytes of the transport 
packets (i.e. no PES layer). 
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Parameter Options Description 

The IEC-232 data-stream is expected to contain complete DCIIText packets. These packets 
must be preceded by the sequence (0x7F, 0xFE, 0x7F, 0xFE) followed by 2 bytes which 
contain the length of the DCIIText packet. If this sequence is not detected, the card shall 
raise an alarm to indicate that it is not locked to the data stream. 

 DVB Format as specified by DVB 

 MediaKind MediaKind proprietary format  

Baud Rate 1200 

2400 

4800 

9600 (Default) 

19200 

38400 

Sets the baud rate of the IEC-232 

asynchronous data channel (Baud/s) 

Buffer Mode Send Immediately Only available in MediaKind encoding mode. If selected, whenever data is available at the 
Data Input port it is sent in the output Transport Stream. This can result in wasted 
bandwidth due to low packet occupancy. It also results in a higher packet rate, which may 
cause some receivers to overflow 

 Wait 1s Data is buffered until enough have arrived to fill a transport packet or 1 second elapses, 
whichever occurs first 

Component Tag 0 to 16383 Defines the optional component tag to be assigned to the data stream 

5.4.4.5  External Sync Input O ption Card  

The External Sync Input Option Card has no configurable parameters. To configure the external 
sync input to be used as the clock source, from the web interface, browse to Device 
Configuration > Advanced Setup  and under Base Unit set the MUX SCR  Source to External. 
Alternatively, on the front panel use the External option under Advanced/System/Base 
Unit/MUX SCR Source . 

5.4.4.6  Satellite Modulator Option Card (AVP 3000 Voyager Only)  

The section describes the operation and control of the Satellite Modulato r.  

5.4.4.7  DVB RF Carrier ID  

To comply with ETSI 103129, the Carrier ID information entered by the operator can now be 
included in the Satellite Modulator Output. The Carrier ID configuration field provides a single 

point of entry for the required parameters that are used in both the NIT and the RF output.  

By default, the RF Carrier ID State control is set to On  for the Satellite Modulator Output, thus 
including Carrier ID in the RF output.  

 

Figure 5.30  DVB RF Carrier ID  
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5.4.4.7.1  Configuring Carrier ID Parameters  

The user -defined fields for Carrier ID information can be accessed through a number of routes, all 
of which will configure the same parameters.  

¶ Front Panel .  

¶ Simplified View  -  The Carrier ID b utton in the left panel provides a pop -up box for data 
entry.  

¶ Advanced View  -  There is a Carrier ID tab on the Satellite Modulator properties panel when 
using the Service configuration tab.  

 

Figure 5.31  DVB RF Carrier ID Tab  

The data can also be entered by browsing to Device Configuration > Advanced Setup > Base Unit 

> Carrier ID Setup.  

5.4.4.7.2  Satellite Modulator Input Configuration  

The following parameters are available through the Advanced Setup  tab of the Device 
Configuration  page under Slots > Slot <n> -  Satellite Modulator Option Card > Satellite 
Modulator > Input Parameters . The same parameters can be accessed through the 
Advanced/Satellite Modulator/Input Parameters menu on the front panel.  

Table 5.8 Satellite Modulator Input Configuration Parameters  

Parameter Values Description 

Primary Input Source Stream 1, Stream 2, Null Packets, PRBS The source of the primary input of the Satellite Modulator card. 

Secondary Input 
Source 

Stream 1, Stream 2, Null Packets, PRBS The source of the secondary input of the Satellite Modulator 
card. 

Input Select Primary, Secondary  Specifies the Transport Stream on which input to feed to the 
satellite modulator. 

Input Mode Manual, Semi-automatic, Fully Automatic Specifies how to switch over to the other input in case the 
current input fails. In Manual mode no automatic switch over is 
done. In Semi-automatic mode the switch-over to the other 
input is automatic, if the a Transport Stream on current input is 
not detected, but there is no automatic switch back to the 
original input if the Transport Stream is restored. In fully 
automatic mode the even switch back to the original input is 
automatic once the Transport Stream on that input is restored. 

Input Format MPEG TS, BB Frames The format of the input data stream. BB Frames are currently 
not supported. 

Rate Adaptation Off, On Allows the modulator to be used at a fixed symbol rate, 
asynchronously with its transport stream input data rate. 

The recommended setting is for Rate Adaptation to be ON, 
allowing the modulator to either insert or drop null packets in 
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Parameter Values Description 

the input stream to match that expected by the modulator 
according to the selected modulation, FEC rate and other 
relevant parameters.  In this mode the modulator cardôs 
symbol rate is held constant at a value nominally equal to the 
user-defined symbol rate setting.  

When rate adaptation is disabled, the modulator card tries to 
lock its symbol rate to the input data rate, but it can only do so 
if the configured input data rate is within the tracking range of 
the input rate control PLL (approximately ±122 ppm).  If this 
does not match, errors will be seen at the output. 

Input Buffer Size 512 bytes to 4096 bytes The size of the input buffer. 

Clock Reference 
Mode 

Internal, External The source of the 10 MHz reference clock used by the satellite 
modulator. External mode is not supported by the current 
hardware configuration. 

RAS Scrambling Off, On Specifies whether to use RAS scrambling. 

RAS Key  The 7-byte key used for RAS scrambling. 

RAS version  The version of the RAS implemented on the satellite 
modulator. 

5.4.4.7.3  Satellite Modulator Modulation Configuration  

The following parameters are available through the Advanced Setup  tab of the Device 
Configuration  page under Slots > Slot <n> -  Satellite Modulator Option Card > Satellite 
Modulator > Modulation Parameters  or on the Modulation Parameters  tab in the 

Propert ies  widget of the Service Configuration  page if one of the Satellite Modulator Output  
Stream  is selected in the Outputs  widget. The same parameters can be accessed through the 
Advanced/Satellite Modulator/Modulation Parameters  menu on the front panel.  

Table 5.9 Satellite Modulator Modulation C onfiguration Parameters  

Parameter Values Description 

Modulation Standard DVB-S, DVB-DSNG, DVB-S2, DVB-S2X Specifies the modulation standard to use for satellite 
transmission. 

Modulation State Off, On Turns on or off the modulation of the carrier. If the output is 
enabled and modulation is turned off, an unmodulated 
carrier is output. 

Stream 
Synchronization 
Mode1 

Disabled, Short, Normal Specifies whether to transmit ISSY and if so, whether to use 
a two or three-byte ISSY field in the BB header. 

Stream 
Synchronization 
Mode1 for TS2 

Disabled, Short, Normal Same as above for the 2nd Transport Stream in VCM mode. 

Null Packet Deletion1  Off, On If set to On, null packets will be deleted from the incoming 
Transport Stream. 

FEC Rate 1/41,4, 1/31,4, 2/51,4, 1/2, 3/51,4, 2/3, 3/4, 4/51,4, 
5/6, 7/82,3, 8/91,4,  9/101,4, 13/45,4 , 9/20,4, 
8/15,4, 11/20,4, 5/9,4, 26/45,4, 28/45,4, 23/36,4, 
25/36,4, 32/45,4, 13/18,4, 11/15,4, 7/9,4, 77/90,4  

The code rate of the Reed-Solomon encoder (DVB-S and 
DVB-DSNG mode) or the BCH ï LDPC encoder (DVB-S2 
and DVB-S2X mode) 

FEC Rate for TS2 1/41, 1/31, 2/51, 1/2, 3/51, 2/3, 3/4, 4/51, 5/6, 
7/82,3, 8/91,2, 9/101 

Same as above for the 2nd Transport Stream in VCM mode. 

Frame Size1,4  Normal, Short The size of the BB frames in DVB-S2 mode. 

Frame Size1 for TS2 Normal, Short Same as above for the 2nd Transport Stream in VCM mode. 
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Parameter Values Description 

Modulation QPSK1,2,3,4 , 8PSK 1,2,4 , 8PSK -L4 ,16QAM 2, 

16APSK 1,4 , 16APSK -L4, 
32APSK 1,4, ,32APSK -L4, 64APSK 4 and 
64APSK -L4 

The modulation mode and order used for the transmission. 

Modulation for TS2 QPSK, 8PSK1,2, 16QAM2, 16APSK1, 32APSK1 Same as above for the 2nd Transport Stream in VCM mode. 

Pilots1,4  Off, On Toggles the insertion of pilot symbols into the transmitted 
signal on and off. 

Pilots1 for TS2 Off, On Same as above for the 2nd Transport Stream in VCM mode. 

NCR Stamping PID 0 - 8191 The PID used for packets transmitting Network Clock 
Reference. 

Symbol Mapping 
Mode 

Peak Power, Mean Power Specifies what to use for power normalization. 

PL Scrambling 
Sequence Number1,4 

0 to 26141 The sequence number used for physical layer scrambling. 

Symbol Rate 1.000000 Msymbol/s to 45.000000 Msymbol/s 
(standard) 

0.132000 Msymbol/s to 66.000000 Msymbol/s 
(with VOY/SWO/HSYM license - extended 
range) 

The symbol rate used for modulation. 

Roll-off Factor 5, 10, 15, 20, 25, 35 % The roll-off factor of the filter used for pulse shaping 

1 Applies to  DVB-S2 

2 Applies to DVB -DSNG 

3 Applies to DVB -S 

4 Applies to DVB -S2X 

5.4.4.7.4  Satellite Modulator Output Configuration  

The following pa rameters are available through the Advanced Setup tab of the Device 
Configuration page under Slots > Slot <n> -  Satellite Modulator Option Card > Satellite Modulator 
> Output Parameters or on the Output Parameters tab in the Properties widg et of the Servic e 
Configuration page if one of the Satellite Modulator Output Stream is selected in the Outputs 
widget. The same parameters can be accessed through the Advanced/Satellite Modulator/Output 
Parameters  menu on the front panel.  

Table 5.10  Satellite Modulator Output Configuration Parameters  

Parameter Values Description 

RF Carrier ID State On, Off Enables DVB-CID on the modulator output. 

Output Select L-band, IF Specifies which output to use. 

Output State On (Reduced Power), On (Nominal Power), 
Off 

Turns the output of the Satellite Modulator on at the specified 
power level or off. Note that to enable the output, the Transport 
Stream through the satellite modulator output has to be set to 
Online Setmode state. 

L-Band Output  

Frequency Input Mode  L-Band Frequency, Uplink Frequency The mode how the frequency is treated. For L-Band 
Frequency the RF center frequency of the respective output is 
directly entered. For Uplink Frequency, the RF center 
frequency is calculated from the Uplink Frequency and the Up-
converter Frequency. 
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Parameter Values Description 

L-Band Frequency  950.000 MHz to 2150.000 MHz The center frequency of the signal output through the L-Band 
output. 

Uplink Frequency  The frequency the signal is converted to by the up-converter 
fed from the AVP 3000 Voyager through the L-Band output. 

Uplink Frequency = Up-converter Frequency ± IF 
Frequency. 

± depends on the Spectrum Sense. 

Nominal L-Band 
Power  

-40.0 dBm to 5.0 dBm The Nominal signal power output through the L-Band output 
applied when the output is set to On (Nominal Power) 

Reduced L-Band 
Power 

-40.0 dBm to 5.0 dBm The Reduced signal output power applied when the output is set 
to On (Reduced Power) when the output frequency is changed 
or after a reboot if the Output State is allowed to stay on. 

L-Band Spectrum 
Sense  

Normal, Inverted  Specifies whether the spectrum is inverted or not inverted. It 
has an effect on the Up-converter Frequency calculation. 

L-Band Tilt -0.040 dB/MHz to 0.040 dB/MHz  The tilt applied in the L-band. 

L-Band Up-converter 
Frequency 

2500.000 MHz - 100000.000 MHz The oscillator frequency of the up-converter fed by the AVP 
3000 Voyager through the L-Band output. 

Up-converter Power  Off, 15V, 24V The voltage level to feed a downstream up-converter device. 

Up-converter 
Reference  

Off, On  Specifies whether to produce a 10-MHz reference for the 
downstream up-converter device. 

IF Output  

Frequency Input Mode  IF Frequency, Uplink Frequency The mode how the frequency is treated. For IF Frequency the 
RF center frequency of the respective output is directly 
entered. For Uplink Frequency, the RF center frequency is 
calculated from the Uplink Frequency and the Up-converter 
Frequency. 

IF Frequency  50.000 MHz to 180.000 MHz The center frequency of the signal output through the IF 
output. 

Uplink Frequency  The frequency the signal is converted to by the up-converter 
fed from the AVP 3000 Voyager through the IF output. 

Uplink Frequency = Up-converter Frequency ± IF 
Frequency. 

± depends on the Spectrum Sense. 

Nominal IF Power  -30.0 dBm to 5.0 dBm The Nominal signal power output through the IF output applied 
when the output is set to On (Nominal Power). 

Reduced IF Line-up 
Power 

-30.0 dBm to 5.0 dBm The Reduced  IF output power level applied when the output is 
set to On (Reduced Power), when the output frequency is 
changed or after a reboot if the Output State is allowed to stay 
on. 

IF Spectrum Sense  Normal, Inverted Specifies whether the spectrum is inverted or not inverted. It 
has an effect on the Up-converter Frequency calculation. 

IF Tilt  -0.040 dB/MHz to 0.040 dB/MHz  The tilt applied to the IF output signal. 

IF Up-converter 
Frequency  

500.000 MHz to 100000.000 MHz The oscillator frequency of the up-converter fed by the AVP 
3000 Voyager through the IF output. 

 Configuring Base Unit LDAP User Authentication  

This section describes the options for Lightweight Directory Access Protocol (LDAP) that can be 
used to authenticate  a user before full access is granted to the AVP via the Web GUI through the 
parameters avai lable via the page Device Configuration  > Advanced Setup  > Base Unit  > 
Remote Authentication and HTTP server options .  
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Figure 5.32  Remote Authentication and HTTP Server Option Properties  

When authenticated, the user retains access to the AVP for that browser session. If the session is 
closed, the user must re -authenticate. The AVP does not offer different levels of acc ess: once a 
user is authenticated, all functionality is available to that user.  

Table 5.11  LDAP Authentication Configuration Parameters  

Parameter Values Description 

Authentication Off, Basic, LDAP Test, LDAP Authentication Off: No user authentication is performed 

Basic: the username and password presented on this page are 
used to access the AVP web UI 

LDAP Test: a short-term configuration of LDAP used to check 
the settings. The settings will be applied for 2 minutes. The 
user will be asked for username and password and the AVP 
will attempt to authenticate these details against the LDAP 
server. The results are printed on this page. After the test, this 
setting will be turned to Off. 

LDAP Authentication: user access to the web UI is controlled 
through user authentication against the configured LDAP 
server. 

Disable HTTP Access 
(HTTPS is always On) 

Off, On Off: Both HTTP and HTTPS access to the web UI is available 
on the control interface. 

On: Only HTTPS access is available on the control interface. 

HTTPS uses a self-signed certificate and this cannot be 
changed. 

LDAP Host IP Address  The LDAP serverôs IP address. The AVP does not support 
DNS. 

LDAP Bind Dn  The BIND distinguished name. This information must be 
obtained from the administrator of the LDAP server. 

LDAP Bind Password  The password for binding to the LDAP server. This information 
must be obtained from the administrator of the LDAP server. 

LDAP Base Dn  The root distinguished name used to query the LDAP server. 
This information must be obtained from the administrator of the 
LDAP server. 

LDAP Entry Filter  Filter detail for the LDAP sever. This information must be 
obtained from the administrator of the LDAP server. 
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Parameter Values Description 

Start TLS Off, On Enables TLS (transport layer security).  

Off: Communication between the AVP and the LDAP server 
will be in clear text.  

On: Communication between the AVP and the LDAP server 
will be encrypted. This may result in a slower response from 
the AVP. 

Default LDAP 
Authentication 
Behaviour 

Positive Authentication, Negative 
Authentication 

If the LDAP server is out of contact for any reason, the 
behavior of user authentication can be selected to either reject 
the user (Negative Authentication), or accept the user and 
permit the user to operate the web UI (Positive Authentication). 

All activity is logged. 

Note:  When LDAP Auth entication is active, there is no special administrator access. If Negative 
Authentication  is selected, and the LDAP server is unavailable, or mist akes have been 

made on entering the parameters for the LDAP server, the AVP WILL BE LOCKED FOR 
ALL USERS. MediaKind  Customer Services must be contacted to assist on regaining 
access. It is strongly recommended to use the LDAP Test Authentication  setting to  
check parameter entry and LDAP server access, before committing to the LDAP 
Authentication  setting. See Chap ter 3, Getting Started: How to Configure User 
Authentication.  

5.5  Service Configuration Page  

The Service Configuration  page provides setup options for the outputs of the device.  

 

Figure 5.33  Service Configuration Video Page  

 Widgets  

5.5.1.1  Inputs Widget  

The Inputs  widget shows the available components sorted by input. Any component on this list can 

be added to the outputs prov ided that there is a valid license to do so or the number of times a 
component can be reused has not been exceeded.  
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Figure 5.34  Inputs Widget  

5.5.1.2  Outputs Widget  

The  Outputs  widget lists the inputs and outputs o f the device, respectively. The Edit  menu of the 
Outputs  widget provides Copy , Cut  and Paste  commands to copy or move Transport Streams, 
serv ices, and components. Components can be dragged and dropped from the Inputs  widget to 

the services listed in the Outputs  widget, and can also be dragged and dropped within the 
Outputs  widget. Drag and drop moves the item, Ctrl  + drag and drop copies the item. Items 
cannot be dropped arbitrarily: components can only be dropped on services, services on Transport 
Streams,  and Transport Streams on outputs. A valid drop location is indicated by a green 
rectangle.  

 

Figure 5.35  Outputs Widget  



 

AVP 1000, 2000 & 3000  | Version Y www.m ediakind.com  
 

5-36  

5.5.1.3  Properties Widget  

The Properties  widget displays the properties of the items selected e ither in the Inputs  or in the 
Outputs  widget. When a value of a property is changed, its label is highlighted i n orange and 
remains highlighted until the change is committed or abandoned by clicking on the Apply All  or 
Discard All  buttons on the taskbar, r espectively. Depending on which item is selected in the Inputs  
and Outputs  widget, the properties are displayed  in different accordion panels in the Properties  

widget.  

 

Figure 5.36  Properties Widget  

Note:  If  a component is selected in the Outputs  widget, its source is also highlighted in the 

Inputs  widget and the oth er way around. This makes it easy to identify corresponding 
components.  

 Using the Service Configuration Page  

This section describes the tasks tha t can be completed on the Service Configuration  page.  

5.5.2.1  Adding a Transport Stream to an Output  

To add a Transport  Stream to an output, do the following:  

1.  In the  Outputs  widget, select the output you want to add a Transport Stream to.  

2.  Right click on the select ed output.  

3.  Select Add Transport Stream  from the context menu.  

OR 

1.  In the Outputs  widget, select the output you w ant to add a Transport Stream to.  

2.  Click Action > Add Transport Stream . 

OR 

1.  In the Outputs  widget, select the output you want to add a Transport St ream to.  
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2.  Right click on the selected output and choose Add Transport Stream  from the context menu.  

Note:  Outputs other than the IP outputs cannot have more Transport Streams associated to 
them.  

5.5.2.2  Adding a Service to a Transport Stream  

To add a service to a T ransport Stream, do the following:  

1.  In the Outputs  widget, select the Transp ort Stream you want to add a service to.  

2.  Right click on the selected Transport Stream.  

3.  Select Add Service  from the context menu.  

OR 

1.  In the Outputs  widget, select the Transport Strea m you want to add a service to.  

2.  Click Action > Add Service .  

OR 

1.  In the Outpu ts  widget, select the Transport Stream you want to add a service to.  

2.  Right click on the selected Transport Stream, and choose Add Service  from the context menu.  

 

Figure 5.37  Add Service Menu  

5.5.2.3  Adding a Compone nt to a Transport Stream  

To add a component to a service, do the following:  

1.  In the Inputs  widget select the component you want to add to a service in the Outputs  widget.  

2.  Drag the co mponent over the desired service in the Outputs  widget.  

Note:  To select more components to add, press and hold the< Ctrl  key then click on the 
appropriate components in the Inputs  widget. To select consecutive items, select the first 
item, press  and hold t he  Shift  key, then select the last item.  

5.5.2.4  Deleting Transport Streams, Services or Components  

To delete a Transport Stream, service or component, do the following:  

1.  In the Outputs  widget, select the Transport Stream, service or component you want to delete.  

2.  Press the Del  key.  
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3.  Answer Yes to the confirmation message.  

OR 

1.  In the Outputs  widget, select the Transport Stream, service or component you want to delete.  

2.  Click Action > Delete Selected .  

OR 

1.  In the Outputs  widget, select the Transport Stream, service or comp onent you want to delete.  

2.  Right click on the selected item and choose Delete Selected  from the context menu.  

 

Figure 5.38  Delet ing a Service  

Note:  Ctrl  key then click on the appropriate items. To select cons ecutive items, select the first 

item, press and hold the  Shift  key, then select the last item.  

5.5.2.5  Manually Changing the Setmode State of a Transport 

Stream  

To change the Setmode  state of a Transport Stream, do the following:  

1.  In the Outputs  widget, select the Transport Stream for which you want to change the 
Setmode  state.  

2.  In the Properties  widget, click on the Online  or Offline  button.  

5.5.2.6  Copying Transport Streams, Services or Components  

To copy a Transport Stream, do the following:  

1.  In the Outputs  widget, select the Transport Stream, service or component you want copy.  

2.  Drag the selected Transport Stream, service or component over another output (when copying 
a Transport Stream),  another Transport Stream (when copying a service) or another service 
(when copying a c omponent).  

OR 

1.  In the Outputs  widget, select the Transport Stream, service or component you want copy.  

2.  Select Edit > Copy  from the widget menu bar.  

3.  Select the output (whe n copying a Transport Stream), the Transport Stream (when 

copying a service) or the ser vice (when copying a component) you want to copy the 
selected item to.  
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4.  Select Edit > Paste  from the widget menu bar.  

Note:  To select more Transport Streams, services or components, press and hold the Ctrl key 
then click on the appropriate items. To select consecutive items, select the first item, 
press and hold the Shift key, then select the last item.  

5.5.2.7  Moving Transport Streams, Services or Components  

To move a Transport S tream, do the following:  

1.  In the Outputs  widget, select the Transport Stream, service or  component you want move.  

2.  While holding down the Ctrl  key, drag the selected Transport Stream, service or component 
over another output (when moving a Transport Stream),  another Transport Stream (when 
moving a service) or another service (when moving a com ponent).  

 

Figure 5.39  Dragging a Transport Stream or Service  

OR 

1.  In the Outputs  widget, select the Transport Stream, serv ice or component you want to move.  

2.  Select Edit > Cut  from the widget menu bar.  

3.  Select t he output (when moving a Transport Stream), the Transport Stream (when moving a 
service) or the service (when moving a component) you want to move the selected item to.  

4.  Select Edit > Paste  from the widget menu bar.  

Note:  To select more Transport Streams, s ervices or components, press and hold the Ctrl  key 
then click on the appropriate items. To select consecutive items, select the first item, 
press and hold the Shift key, then select the last item.  

5.5.2.8  Cloning Transport Streams  

Transport Stream cloning allows t he user to create a mirror of an existing Transport Stream. 
Mirrored Transport Streams are only references to the original one. Thus, any change in the 
original Tran sport Stream will be automatically applied in the mirrored Transport Stream.  

Note:  No exter nal Transport Streams, services, or components will show up under a mirrored 
Transport Stream in the Outputs  widget of the Service Configuration  page. 
Furthermore, w hen a mirrored Transport Stream is selected, the Properties  widget will 
display a link to t he original one, and will not display any parameters.  
 
Although the content of the mirrored and the original Transport Stream is the same, the 

physical output stream s will not be identical bit -by -bit. This is due to the mechanism the 
Transport Streams are played out through the different outputs.  

To create a clone of an existing Transport Stream, do the following:  

1.  In the Outputs  widget, select the Transport Stream you want to clone.  
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2.  Select Copy  from the Edit  menu on the menu bar of the Outputs  widget.  

3.  Selec t the output you want to insert the clone to.  

4.  Choose Edit > Paste as Mirror . The Transport Stream will be pasted as a mirror at the 
selected Transport Stream.  

5.5.2.9  Disabling a Transport Stream if Audio or Video Lock is Lost  

To disable the output when the input lock is lost for a component in a Transport Stream, do the 

following:  

1.  In the Outputs  widget, select the Transport Stream you want to disable when the lock of any 
of its components is lost.  

2.  In the Properties  widget, set the Auto Disable  to Audio Lost , Video  Lost , or Audio or 
Video Lost  depending on what shall trigger turning the output off.  

3.  In the Outputs  widget, select the video  component whose lock state shall influence the 
Transport Stream output.  

4.  In the Properties  widget, click on the Input  tab, and set the Output On Video Loss  to No 
PID . 

5.  In the Outputs  widget, select the audio component whose lock state shall influence the 
Transport Stream output.  

6.  In the Properties  widget, click on the Input  tab, and set the Output On Audio Loss  to No 

PID . 

5.5.2.10  Disabling a Tr ansport Stream if a Critical Alarm or an 

Upstream Critical Alarm is Raised  

An upstream CRITICAL alarm is an alarm raised by a  module that has direct influence on the 
Transport Stream.  

To disable the output when a critical alarm or an upstream CRITICAL alar m is raised, do the 
following:  

1.  In the Outputs  widget, select the Transport Stream you want to disable when a CRITICAL 
alarm o r an upstream CRITICAL alarm is raised.  

2.  In the Properties  widget, set the Auto Disable  to Any Critical Alarm  or Any Upstream 
CRITIC AL Alarm .  

When a transport stream has been auto -disabled due to an ongoing alarm condition, any attempt 
to manually put the transport stream online will be rejected and an error message will be 
displayed.  

5.5.2.11  Restoring a Transport Stream if the Auto Disable Co ndition 

is not Met  

To restore the output when the Auto Disable  condition is cleared, do the following:  

1.  In the Outputs  widget, select the Transport Stream whose Online  state you want to restore.  

2.  In the Properties  widget, set the Auto Enable  to true.  

5.5.2.12  Reserv ing Bandwidth for Transport Streams  

Bandwidth reservation allows the user to reserve a configurable amount of bandwidth in the 
output Transport Streams. The reserved amount will always be preserved even if bit rate tracking 
is enabled. To specify the amoun t of bandwidth to reserve, do the following:  

1.  Select a Transport Stream in the Outputs  widget.  
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2.  In the Properties  widget, set the Reserved Bit Rate  to the required value.  

5.5.2.13  Providing More Space for Configuration Items in the 

Properties Widget  

When a service ha s many components of different types, the Properties  widget might get 
crowded with accordion panels that belong to the d ifferent components. To preserve space, some 
of the components (based on their types) can be hidden. To show or hide a component type, d o 
the following:  

1.  Select a Transport Stream in the Outputs  widget.  

2.  In the Properties  widget, choose View > Visibility Con trol > Show x  or View > Visibility 
Control > Hide y , where x and y is the type you want to show or hide.  

 Configuring Option Cards Using the Service Configuration 

Page  

This section gives the tables of parameters available for configuring the option cards us ing the 
Service Configuration  Web Page.  

5.5.3.1  CE- a VCM (Video Compression Module)  

5.5.3.1.1  Video and VBI Stream Configuration  

Video Input and Pre - Proce ssing  

The parameters listed below are available on the Input  tab of the Properties  widget on the 
Service Configuration  page when a video component is selected in the Outputs  widget. The 
same parameters can be accessed through the Advanced/CE - a/Video/Video1 /Input  menu on 
the front panel.  

Table 5.12  Video Input and  Pre-Processing Parameters  

Parameter Values Description 

Video Input Lock Yes, No Shows whether there is a video lock to the format specified 
through the parameters below. Read only parameter. 

Source SDI The video will be sourced from the SDI/HD-SDI input on 
the rear panel. 

 
Bars An internally generated color bars test pattern will be used 

as the video source. 

 
Black An internally generated black test pattern will be used as 

the video source. 

 
Moving Object An internally generated moving object test pattern will be 

used as the video source. 

 
Slate A slate file uploaded by the user will be used as the video 

source. 

Input Detection Off, Auto Detect and Report, Auto Detect and 
Configure Video Profile Only, Auto Detect and 
Restore Saved Config 

Controls whether the format of the SDI input shall be 
automatically detected or what actions to take if a change 
is detected in the Input Video Format. 

Detected Video 
Standard 

Not Detected, SD 567i25, SD 480i29.97, HD 
720p50, HD 720p59.94, HD 1080i25, HD 
1080i29.97 

The detected video standard if Input Detection is set to 
other than Off. If the format is not detected or Input 
Detection is set to Off, it is set to Not Detected. Read only 
parameter. 

Video Input Format SD 567i25, SD 480i29.97, HD 720p50, HD 
720p59.94, HD 1080i25, HD 1080i29.97 

Defines the expected video format on the SDI input or the 
video format used for encoding the test patterns. A change 
in the Video Input Format might result in a change in the 
Video Profile used for encoding. As from the current 
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Parameter Values Description 

release down-conversion is supported, SD profiles can be 
selected for HD input formats. 

Output On Video Loss Freeze Frame, Freeze with text overlay Repeats the last good video frame on loss of video input. 

 Black, Black with text overlay Switches to a black test pattern on loss of video input. 

 Color Bars, Bars with text overlay Switches to a color bars test pattern on loss of video input. 

 
No PID The video PID shall no longer be transmitted. The SI is not 

updated. 

 
Slate, Slate with text overlay A slate file uploaded by the user will be used as the video 

source. 

Ident Text  Overlay text to display on top of images when with text 
option is selected in Output on Video Loss. 

MCTF Off, Default, Strong, Stronger The amount of Motion Compensated Temporal Filtering 
done to improve image quality. 

Adaptive 
Preprocessing 

Off, On Increases the video quality by performing preprocessing 
operations. Available only if Video Input Format is set to 
SD 480i29.97 or SD 576i25. 

Bandwidth 30 to 100 % Sets the video horizontal bandwidth filter. 

Half Line Removal Off, On Enables or disables the removal of black half lines at the 
top of the picture by substituting video data from adjacent 
lines. The option is available when Video Input Format is 
set to SD 576i25. 

Logo 

Logo insertion Off, On Controls if logos are displayed or not. The file to use can 
be selected under Logo file. 

Logo file  The file to use as a logo. The selected file can be 
uploaded by selecting the Upload option. Not supported in 
this release. 

A fixed logo position? On, Off Controls whether to use the default position for overlaying 
the logo on the video. If On, the position of the logo is fixed 
according to the position held within the logo file. If O ff, 
the position of the logo is determined by the coordinates 
entered in the X and Y position boxes. 

The X position of the 
logo 

 The position relative to left of the screen 0 (number of 
pixels per video line - logo width - 1). If an invalid 
position is specified, a logo display alarm will be 
generated. Displayed only if A fixed logo position? is set to 
Off. Not supported in this release. 

The Y position of the 
logo 

 The position relative to top of screen 0 (number of video 
lines - logo height - 1). If an invalid position is specified, a 
logo display alarm will be generated. Displayed only if A 
fixed logo position? is set to Off. Not supported in this 
release. 

HD to SD Video Down-conversion 

Default Aspect Ratio 
Conversion 

Anamorphic, Center Cut, Letterbox The down-conversion to apply when AFD is lost or AFD 
code 000 is received. 

Use Input AFD true, false Specifies whether to attempt to use AFD code at input for 
format conversion (when true) or always apply the default 
(when false).  

Action on AFD lost Convert as anamorphic and put AFD code 1000 
out, Convert as specified in Default and put AFD 
code out 

Specifies what to do if AFD is lost. 
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Parameter Values Description 

Action on AFD code 
0000 

Convert as anamorphic and put AFD code 1000 
out, Convert as specified in Default and put AFD 
code out 

Specifies what to do if AFD code 0000 is received. 

Video Encoding  

The parameters listed bel ow are available on the Encode tab of the Properties widget on the 
Service Configuration page when a video c omponent is selected in the Outputs widget. The same 
parameters can be accessed through the Advanced/CE -a/Video/Video 1/Video/Main Video/Video 
Encod er menu on the front panel.  

Table 5.13  Video Encoding Paramet ers  

Parameter Values Description 

Video Profile Profile Off, 
SD MPEG2 Main Profile Main Level 4:2:0 8 bit, 
SD H.264 Main Profile Level 3.0 4:2:0 8 bit, 
SD H.264 High Profile Level 3.0 4:2:0 8 bit, 
SD H.264 High Profile Level 3.1 4:2:0 8 bit, 
HD MPEG2 Main Profile High Level 4:2:0 8 bit, 
HD MPEG2 4:2:2 Profile High Level 4:2:2 8 bit, 
HD H.264 Main Profile Level 4.0 4:2:0 8 bit, 
HD H.264 High Profile Level 4.0 4:2:0 8 bit, 
HD H.264 High Profile Level 4.1 4:2:0 8 bit 

Sets the encoder profile. The profile will also affect the 
allowed bit rate range. 

Profile for SD input Profile Off, 
SD MPEG2 Main Profile Main Level 4:2:0 8 bit, 
SD H.264 Main Profile Level 3.0 4:2:0 8 bit, 
SD H.264 High Profile Level 3.0 4:2:0 8 bit, 
SD H.264 High Profile Level 3.1 4:2:0 8 bit 

The profile to set when an SD input is detected on the SDI 
input. Visible only if Input Detection is set to Auto Detect 
and Configure. If this option is visible, the Video Profile 
cannot be set manually. 

Profile for HD input Profile Off, 
SD MPEG2 Main Profile Main Level 4:2:0 8 bit, 
SD H.264 Main Profile Level 3.0 4:2:0 8 bit, 
SD H.264 High Profile Level 3.0 4:2:0 8 bit, 
SD H.264 High Profile Level 3.1 4:2:0 8 bit, 
HD MPEG2 Main Profile High Level 4:2:0 8 bit, 
HD MPEG2 4:2:2 Profile High Level 4:2:2 8 bit, 
HD H.264 Main Profile Level 4.0 4:2:0 8 bit, 
HD H.264 High Profile Level 4.0 4:2:0 8 bit, 
HD H.264 High Profile Level 4.1 4:2:0 8 bit 

The profile to set when an HD input is detected on the HD-
SDI input. Visible only if Input Detection is set to Auto 
Detect and Configure. If this option is visible, the Video 
Profile cannot be set manually. 

Resolution 352 x 576, 480 x 576, 528 x 576, 544 x 576, 640 
x 576, 704 x 576, 720 x 576, 352 x 480, 480 x 
480, 528 x 480, 544 x 480, 640 x 480, 704 x 
480, 720 x 480, 1280 x 720, 1440 x 1080, 1920 
x 1080 

Defines the horizontal and vertical resolution of the 
encoded video. The available options depend on the 
values set for Video Input Format and Video Profile. 

Video Bit Rate The valid bit rate range depends on the selected 
video profile. 

Defines the Transport Stream bit rate to be used by the 
compressed video component. If Bit Rate Tracking Mode 
is set to Maximize Video for the Transport Stream that 
contains the video component and the Bit Rate Weighting 
of the component is set to other than Fixed or Minimal, this 
field is read only. 

Buffer Mode 

CBR Constant Bit Rate operation. 

Low Delay Reduced encode delay (typically 350ms) achieved by 
removing pre-processing functions. Bit Rate, GOP 
structure and GOP length impact the delay. The IP GOP 
structure will give lowest delay, but with reduced quality. 

Aspect Ratio 16:9, 4:3 Does not affect the video encoding but rather indicates 
what the desired aspect ratio for the decoded picture (not 
the pixel). If no other mechanism such as WSS in the VBI 
is used, the video output image will use this aspect ratio. 
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GOP Length 4 to 250 Defines the nominal distance in steps of video frames 
between two consecutive I frames in the encoded bit-
stream. 

GOP Structure IP, IBP, IBBP, IBBBP, IBBBBBBBP Sets the number of B frames between reference frames. 
IBBBBBBBP can only be used for 720p video format 
encoded with a H.264 video profile. 

Closed GOPs Off, On Enables or disables the usage of Group of Pictures in 
which the predicted frames can have their reference from 
outside the group. 

Scene Cut Detection On, Off When enabled, minimizes the negative effect the scene 
changes have on the bit rate by inserting an I-Frame when 
a change is detected. It also affects the GOP length. 

Delay  Displays the actual video encoding delay. Read only 
parameter. 

Stills Detection Off, Intelligent, Clamp Detects if the video is a still picture, and adjusts the 
encoded video bit rate accordingly when operating in VBR 
mode. 

Film Mode Off, On Sets encoding parameters that give better image quality 
for film like sources. 

Inloop Filter High, Normal, Low, Very Low, Auto Sets the characteristics of the filter placed in the feedback 
loop of the encoder. Applying the filter to the picture can 
increase picture sharpness. 

Max CABAC Bit Rate Depends on the Video Profile set. Controls the bit rate at which the encoder switches from 
CABAC to CAVLC entropy coding. 

SEI Encapsulation 
Mode 

Combined, Mediaroom Defines how the SEi messages are formatted in the picture 
header for H264. For combined, all the different types of 
messages (for example AFD) are bundles into one NAL 
packet. For Mediaroom each type of message is put into 
its own NAL packet. This was done for STB compatibility 
issues 

Video Output  

The following parameters are avai lable on the Output  tab of the Properties  widget on the 
Service Configuration  page when a video component is selected in the Outputs  widget. The 

same parameters can be accessed through the Advanced/CE - a/Video/Video 1/Video/Main 
Video/Stream Output  menu on the front panel.  

Table 5.14  Video Output Pa rameters  

Parameter Values Description 

Embedded PCR Off, On, On (Picture Header) Sets if the PCR is embedded within the video or is on a 
separate PID. When set to Off, there must be a separate 
PCR component in the service which can have a user 
defined PID. When set to On, the PCR PID will be the 
same as the associated component. A PCR will be 
included for every I picture. The On (Picture Header) 
option is provided in MPEG-2 encoding only as an option 
to support some legacy equipment that required a PCR on 
every picture. This should only be used when absolutely 
necessary. 

Copyright Off, On Sets the copyright flag in the elementary stream header. 

Original Off, On Sets the original flag in the elementary stream header. 

PES Packet Per GOP, Picture Determines how PES packets shall be generated. The 
Picture option is only available if MPEG 2 encoding is 
used. 
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AU Information Ctrl RAI, RAI and AU Info, RAI, AU Info and TC Controls insertion of Private Data in the TS Adaptation 
Field for video Access Units (AU) with the following values: 
Random Access Indicator (RAI), ETSI 101 154 (AU info), 
and Time Code (TC). 

AR Signalling Output 
Control 

Off, AFD Only, AFD and Bar Data Controls which source is used for embedding aspect ratio 
signaling into user data. If set to Off, no aspect ratio data 
will be resent in the output. AFD sources are: SMPTE 
2016, Video Index, WSS-AFD/WSS, user set Aspect 
Ratio. Bar Data is only SMPTE 2016. 

TC Output Location Off, SEI Message Defines how timecode is put into the output video stream. 

Video Component  

The parameters listed in are available on the Component tab of the Properties widget on the 
Service Configuration page when a video component is sel ected in the Outputs widget. The same 
parameters can be acces sed through the Output/<output name>/Transport Stream ID: 

<n>/Service List/<service name>/Component List/Slot <x> Video Stream on PID <y> menu on 
the front panel.  

Table 5.15  Video Component Parameters  

Parameter Values Description 

PID 32 to 8190 Sets the packet identifier associated with the component. 

Bit Rate Weighting Fixed, Minimum, 2 to 20 Specifies the weight associated to the component in the 
Bit Rate Tracking algorithm. 

Master TS Off, On Sets the master Transport Stream for the component. 

Source PID Monitoring
  

Off, On Priority 1 ETR290 monitoring on this PID from an IP input 
can be enabled, and can be set to caused a redundancy 
switch to a spare device if in a system controlled by 
MediaKind control software.  Not supported in this release. 

Vertical Blanking Interval / Ancillary Data  

The parameters listed in the table below are available on the VBI tab of the Properties widget on 
the Servic e Configuration page when a video stream is selec ted in the Outputs widget. The same 
parameters can be accessed through the Advanced/CE -a/Video/Video 1/Input/VBI Extraction 
menu on the front panel.  

Table 5.16  Vertical Blanking Interval / Ancillary Data Parameters  

Parameter Values Description 

Enable VBI Pass-thru 
Mode 

Off, On Enable Pass-thru of VBI, ANC and Teletext data from 
specified PIDs, instead of extracting them from SDI. Read 
only parameter. Not supported in this release. 

Description Control 

VBI Descriptor Mode Standard, Legacy, Philips, User The source for Closed Captions data encoded as part of 
the Video Stream (only applicable when Video Frame Rate 
is 29.97 Hz) 

VBI Data Descriptor 
Insertion 

Off, On Controls if the VBI Data Descriptor is inserted into the 
PMT. Available only if VBI Descriptor Mode is set to 
User. 

VBI Teletext 
Descriptor Insertion 

Off, On Controls if the VBI Teletext Descriptor is inserted into the 
PMT. Available only if VBI Descriptor Mode is set to 
User. 

Teletext Descriptor 
Insertion 

Off, On Controls if the Teletext Descriptor is inserted into the PMT. 
Available only if VBI Descriptor Mode is set to User. 
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Proprietary Descriptor 
Insertion 

Off, On Controls if the Legacy Proprietary Descriptor is inserted 
into the PMT. Available only if VBI Descriptor Mode is set 
to User. 

Aspect Ratio (AR) Signaling 

Video Index Off, On (Default), On (User) Controls the extraction of Video Index (and thus whether 
Video Index can be used as source of AR info).  

Default: The default lines will be set to decode Video Index 
(11/324 in 25Hz, 14/277 in 29.97 Hz) 

User: The User defines the lines used to decode Video 
Index. 

Video Index Field 1 10 to 22 Specifies which line contains the video index in field 1. 

Video Index Field 2 10 to 22 Specifies which line contains the video index in field 2. 

SMPTE 2016 Off, On Controls whether SMPTE 2016 data can be used as a 
source for AR info. 

AFD Sustain Indefinitely, Default after Timeout, Off after 
Timeout 

Control what AFD code goes out when AFD is lost at input. 

Indefinitely: Maintains previously received AFD code 
indefinitely. 

Default after Timeout: Maintains previously received AFD 
code for period specified in Sustain Timeout, then drop to 
default, i.e. code 1000. 

Off after Timeout: Maintains previously received AFD code 
for period specified in Sustain Timeout, then switch AFD 
off. 

AFD Sustain Timeout 0 to 5,10, 20, 50, 100, 120 Control how long previous AFD code is maintained. Zero 
means drop to default immediately on loss. 

AFD Action on 
Reserved Codes 

Pass Through, Code as 0000 Specify what code is passed to the output when reserved 
AFD codes are received at the input. 

Pass Through: Passes code through unchanged. 

Code as 0000: Changes code to 0000. 

Closed Captions 

Closed Captions 
Source 

Off, VBI lines, SMPTE334 The source for Closed Captions data encoded as part of 
the Video Stream. Only applicable when frame rate is 
29.97 Hz. 

Timecode 

TC Mode Off, External, Zero on Loss, External, Freewheel 
on Loss, Internal 

Controls what mode the Time code (TC) is working in, 
either Off, external source or internally generated. Also 
sets what happens on loss of external source (zero or 
freewheel). 

TC External Source Auto, ANC VITC1, ANC VITC2, ANC LTC, VBI 
VITC 

Controls the external source of Time Code. Auto will select 
the first source present in order of the drop down list. 

TC Dropframes Off, On, Auto Only in 525 line operation controls if Time Code takes 
account of drop frames or not. Auto configures to external 
source, or to ON for internal source. 

Broadcaster ID 

Reception Timeout  Timeout in seconds for reception of Source ID from input 
(RP207). 

Insertion Timeout  Timeout in seconds for insertion of default source ID. 

Broadcaster ID Mode Off, Auto, Default Only, Source Only Gives what to insert as a broadcaster ID. 

Default Servicename  The default service name to be used. 
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Broadcaster ID Source No, Input, Default Indicates if the Broadcaster ID is derived from the input, 
the default or is invalid. 

Broadcaster ID  The Broadcaster ID that is currently being inserted into the 
output stream. 

Generic ANC 

Generic ANC 
Extraction 

Off, On Controls whether Generic ANC is extracted from the SDI 
stream or not as per SMPTE 2038-2008. 

Max ANC Bit Rate 100 to 2000 kbps The maximum data rate of the Generic ANC data output. 

Field 1 

VBI Line 9 - VBI Line 
22 

Off, Closed Caption Specifies the content in the respective VBI lines. Set to Off 
if the line in the incoming video does not carry any 
information, Closed Caption for closed caption information. 
Visible for 480i (525-line) input streams. 

VBI Line 6 - VBI Line 
23 

Off, VITC, WSS, WSS-AFD, Teletext System B Specifies the content in the respective VBI lines. Set to Off 
if the line in the incoming video does not carry any 
information, VITC for Time Code, WSS for Wide Screen 
Signaling, WSS-AFD for Active Format Detection and 
Teletext System B for Teletext. Visible for 576i (625-line) 
input streams. 

Field 2 

VBI Line 272 - VBI 
Line 285 

Off, Closed Caption Specifies the content in the respective VBI lines. Set to Off 
if the line in the incoming video does not carry any 
information, Closed Caption for closed caption information. 
Visible for 480i (525-line) input streams. 

VBI Line 319 - VBI 
Line 336 

Off, VITC, WSS, WSS-AFD, Teletext System B Specifies the content in the respective VBI lines. Set to Off 
if the line in the incoming video does not carry any 
information, VITC for Time Code, WSS for Wide Screen 
Signalling, WSS-AFD for Active Format Detection and 
Teletext System B for Teletext. 

Input Detection  

The CE -a VCM supports video input detection as described in Chapter 3, Getting Started: How to 
Configure and Use Input Detection.  

5.5.3.1.2  Audio Stream Configuration  

Audio Input  

The parameters listed in the table below are available on the Input  tab of the Properties widget on 
the Service Configuration page whe n an audio component is selected in the Outputs widget. The 
same parameters can be accessed through the Advanced/CE -a/Audio Module/Audio <n>/Input 
menu on the front panel.  

Table 5.17  Audio Input Parameters  

Parameter Values Description 

Input Format Uncompressed (LPCM), Dolby Digital, Dolby E Sets the input format used by the audio encoder. 

Input Source Off, Mute, Test Tone, Embedded 1 to 8, Input 1 -
4 

Sets the source used by the audio encoder. No input is fed 
to the encoder if Off is selected. Mute mutes the incoming 
audio and encodes silence. Test Tone encodes an 1 kHz 
test tone, Embedded 1 to 8 sets the source to an SDI 
embedded audio stream. Input 1-4 are for the digital 
inputs. 
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Output On Audio Loss No PID, Silence Specifies the action to take when input is Lost. No PID is 
for dropping the audio PID from the stream, Silence is for 
encode silence. 

When No PID is selected, the reference to the PID is not 
removed from the Program Map Table, so a Transport 
Stream analyzer will indicate a ghost PID in the output 
Transport Stream. 

Source Switchout Off, Mute, Test Tone, Embedded 1 to 8, Input 1 -
4 

Specifies which input to output to the reference output on 
the 15-way D-type audio connector. 

Downmix Parameters  

Downmix Type  Lo/Ro downmix, Lt/Rt downmix  Specifies the downmix type.  

Downmix metadata 

override  
Off, on.  Specifies the downmix override.  

Downmix metadata 
reversion mode  

If available, maintain last received 
metatdata values, otherwise use fixed 
settings ;  Use fixed settings.  

Specifies the downmix metadata reversion mode.  

Center mix level  0.707 ( -3.0 dB), 0.595 ( -4.5 dB), 0.500 ( -

6.0 dB).  
Specifies the center mix level.  

Surround mi x level  0.707 ( -3.0 dB), 0.500 ( -6.0 dB), 0 ( - inf 
dB).  

Specifies the surround mix level.  

Use preferred 

stereo downmix if 
available.  

Off, on  Enables the preferred stereo downmix, if available.  

Audio Status  

Audio Locked  No, Yes  Specifies audio si gnal is locked.  

Downmix active  No, Yes  Specifies the downmix is active.  

Downmix active  Lo/Ro downmix, Lt/Rt downmix  Specifies the downmix type.  

Level (L)  0  Specifies the left channel level.  

Level (R)  0  Specifies the right channel level.  

PCM Bypass Active  No, Yes  Specifies if PCM Bypass is active.  Only valid for 

Dolby E.  

Switchout Active  No, Yes  Specifies if switchout is active. Only valid for Dolby 
E. 

Input Buffer Level  0  Specifies input buffe r level.  

Input Bit Rate  0  Specifie s input bit rate (in kbps).  

Dolby Digital 
Sample Rate  

0  Specifies Dolby Digital sample rate in (Hz). Only 
valid for Dolby Digital or Dolby Digital Plus 
decoding.  

Input Coding Mode   Read-only. Specifies the input coding mode as 
determined by a Dolby D igital or Dolby Digital plus 
decode.  

Resync Count  0  Specifies the resync count.  

Bad RC Packets  0  Specifies the number of bad timing packets 

received by the audio processor.  

Delay  1000  Specifies the delay (in ms).  
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Audio Encoding  

The following pa rameters are available on the Encode  tab of the Properties  widget on the 
Service Configuration  page when an audio component is selected in the Outputs  widget. The 
same parameters can be accessed through the Advanced/CE - a/Audio Module/Audio 
<n>/Encode  menu on the front panel.  

Table 5.18  Audio Encoding Standards  

Parameter Options Description 

Coding Standard MPEG Layer 2 MPEG Layer 2 Encode(More than two channel pairs 
require the /SWO/M1L2 license) 

Dolby Digital Dolby Digital encode, requires CE/SWO/DOLBYAC3 
license.. 

AAC-LC AAC-LC encoding, requires CE/SWO/AAC license. 

HE-AAC HE-AAC or HE-AAC v2 encoding, requires CE/SWO/AAC 
license. 

Pass-thru Pass-thru of the input 

Audio Description Service MPEG-1 Layer II Encode of a mono audio track that 
describes action in the video plus a control track. 

Table 5.19  MPEG Layer 2 Parameters  

Parameter Values Description 

Bit Rate 32, 48, 56, 64, 80, 96, 112, 128, 160, 192, 224, 
256, 320, 384 

Bit rate of the audio stream 

Coding Mode 1/0 (Left - input), 1/0 (Right - input), 1/0 (L+R)/2, 
1+1 (L/Ch1, R/Ch2), 2/0, 2/0 (Joint), Phase 
Aligned Audio (6 Cannels), Phase Aligned Audio 
(8 Cannels) 

Specifies what channel configuration to use for encoding.. 

Embedded PCR On, Off Controls whether PCR is to be embedded in the audio 
PES. 

Au Information Cont Off, AU Info Controls the insertion of private data in the adaptation unit 
of the audio access units (AU). AU Info is defined in ETSI 
TR 101 154. Only AU_PTS is present for audio 

Advanced 

Lip Sync Offset -500 to 500 ms Configures a delay to the audio to improve A/V 
synchronization. 

Gain -6 to 6 dB Sets the gain in dB for the audio stream. 

Language  The language of the stream when not in dual mono (1+1) 
mode. 

Language (Left)  The language of the left channel when in dual mono (1+1) 
mode. 

Language (Right)  The language of the right channel when in dual mono 
(1+1) mode. 

Audio Stream Type  Main Audio  

Clean Effects  

Hearing Impaired  

Visu al Impaired  

 

The audio stream type descriptor for the stream 
when not in dual mono (1+1) mode.  

Main Audio (00)  

Clean Effects (01)  

Hearing Impaired (02)  

Visual Impaired (03)  
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Audio Stream Type 

(Left)  
Main Audio  

Clean Effects  

Hearing Impaired  

Visual Impa ired  

 

The audio stream type descriptor for the left 

channel when in dual mono (1+1) mode.  

Main Audio (00)  

Clean Effects (01)  

Hearing Impaired (02)  

Visual Impaired (03)  

Audio Stream Type 

(Right)  
Main Audio  

Clean Effects  

Hearing Impaired  

Visual Impaired   

 

The audio stream type descriptor for the right 

channel when in dual mono (1+1) mode.  

Main Audio (00)  

Clean Effects (01)  

Hearing Impaired (02)  

Visual Impaired (03)  

User Language 1  A custom three-character language code when User 
Defined 1 is set in any of the language fields. 

User Language 2  A custom three-character language code when User 
Defined 2 is set in any of the language fields. 

MPEG Version MPEG1, MPEG2 Configures if MPEG-1 or MPEG-2 to be signaled. 

Copyright Off, On Indicates if the material is copyright protected. 

Original Off, On Indicates if source is the original or a copy 

De-emphasis Off, 50/15us, CCITT J.17 To meet the MPEG-1 Layer 2 encoding algorithm 
specification the audio must not have pre-emphasis 
applied. If the input signal does have pre-emphasis 
applied, a de-emphasis filter must be applied prior to 
encoding. 

Table 5.20  Dolby Digital Parameters  

Parameter Values Description 

Bit Rate 56, 64, 80, 96, 112, 128, 160, 192, 224, 256, 
320, 384, 448, 512, 576, 640 

Bit Rate of the audio stream. The available options depend 
on the selected coding mode. 

Coding Mode 1/0 (Left ï input), 1/0 (Right ï input), 1/0 (L+R)/2, 
2/0, 3/2L (5.1 Surround) 

Specifies what channel configuration to use for encoding. 

Metadata Controls 
Coding Mode 

Off, On Override default coding mode with coding mode indicated 
in decoder program configuration or live metadata (if 
present). 

Metadata source type Embedded/Decoded Auto Selects where live metadata comes from. 

Metadata override 
type 

None, All, Compression Profile, Dialogue 
Normalization, Comp Profile and Dial Norm 

Defines which metadata parameters to override. 

Metadata Reversion 
Mode 

Last Used, Preset Determines which metadata is used upon loss of live 
metadata. 

Metadata preset type 1 to 8 Defines which metadata preset to use if Preset is selected 
for Metadata Reversion Mode. 

Embedded PCR On, Off Controls whether PCR is to be embedded in the audio 
PES. 

Au Information Cont Off, AU Info Controls the insertion of private data in the adaptation unit 
of the audio access units (AU). AU Info is defined in ETSI 
TR 101 154. Only AU_PTS is present for audio 
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Advanced 

Lip Sync Offset -500 to 500 ms Configures a delay to the audio to improve A/V 
synchronization. 

Gain -6 to 6dB Sets the gain in dB for the audio stream. 

Language  The language of the stream. 

User Language 1  A custom three-character language code when User 
Language 1 is set in the Language field. 

User Language 2  A custom three-character language code when User 
Language 2 is set in the Language field. 

Table 5.21  AAC-LC Parameters  

Parameter Values Description 

Bit Rate 32, 48, 56, 64, 80, 96, 112, 128, 160, 192, 224, 
256, 320, 384, 448, 512 

Bit Rate of the audio stream. The available options depend 
on the selected coding mode. 

Coding Mode 2/0, 3/2L (5.1 Surround) Specifies what channel configuration to use for encoding. 

Embedded PCR On, Off Controls whether PCR is to be embedded in the audio 
PES. 

Au Information Cont Off, AU Info Controls the insertion of private data in the adaptation unit 
of the audio access units (AU). AU Info is defined in ETSI 
TR 101 154. Only AU_PTS is present for audio 

Encapsulation MPEG2 ADTS, MPEG4 LATM/LOAS Specifies the encapsulation used for transmitting AAC 
content. It can be either MPEG-2 Audio Data Transport 
Stream or MPEG-4 Low Overhead Audio Stream based on 
MPEG4 Low Overhead Audio Transport Multiplex. 

TNS (Temporal Noise 
Shaping) 

Off, On Turns noise shaping on or off. 

Advanced 

Lip Sync Offset -500 to 500 ms Configures a delay to the audio to improve A/V 
synchronization. 

Gain -6 to 6dB Sets the gain in dB for the audio stream. 

Language  The language of the stream. 

Audio Stream Type  Main Audio  

Clean Effects  

Hearing Impa ired  

Visual Impaired  

 

The audio stream type descriptor for the stream.  

Main Audio (00)  

Clean Effects (01)  

Hearing Impaired (02)  

Visual Impaired (03)  

User Language 1  A custom three-character language code when User 
Defined 1 is set in the Language field. 

User Language 2  A custom three-character language code when User 
Defined 2 is set in the Language field. 

Table 5.22  HE-AAC Parameters  

Parameter Values Description 

Bit Rate 16, 24, 32, 48, 56, 64, 80, 96, 112, 128, 160, 
192, 224, 256 

Bit Rate of the audio stream. The available options depend 
on the selected coding mode. 
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Coding Mode 2/0, 3/2L (5.1 Surround) Specifies what channel configuration to use for encoding. 

Embedded PCR On, Off Controls whether PCR is to be embedded in the audio 
PES. 

Au Information Cont Off, AU Info Controls the insertion of private data in the adaptation unit 
of the audio access units (AU). AU Info is defined in ETSI 
TR 101 154. Only AU_PTS is present for audio 

Encapsulation MPEG2 ADTS, MPEG4 LATM/LOAS Specifies the encapsulation used for transmitting AAC 
content. It can be either MPEG-2 Audio Data Transport 
Stream or MPEG-4 Low Overhead Audio Stream based on 
MPEG-4 Low Overhead Audio Transport Multiplex. 

TNS (Temporal Noise 
Shaping) 

Off, On Turns noise shaping on or off. 

SBR Signaling Explicit, Implicit Specifies how Spectral Band Replication is signaled. 

Advanced 

Lip Sync Offset -500 to 500 ms Configures a delay to the audio to improve A/V 
synchronization. 

Gain -6 to 6dB Sets the gain in dB for the audio stream. 

Language  The language of the stream. 

Audio Stream Type  Main Audio  

Clean Effects  

Hearing Impaired  

Visual Impaired  

 

The audio stream type descriptor for the stream.  

Main Audio (00)  

Clean Effects (01)  

Hearing Impai red (02)  

Visual Impaired (03)  

User Language 1  A custom three-character language code when User 
Defined 1 is set in the Language field. 

User Language 2  A custom three-character language code when User 
Defined 2 is set in the Language field. 

Table 5.23  LPCM Pass- thru Parameters  

Parameter  Values  Description  

Embedded PCR  On, Off  Controls whether PCR is to be embedded in the 
audio PES.  

Au Information Ctrl  Off, AU Info  Controls the insertion of private data in the 

adaptation unit of the audio access units (AU). AU 
Info is defined in ETSI TR 101 154. Only AU_PTS is 
present for audio.  

Channel Mode  2 channel (stereo / dual mono)  LPCM pass - thru will always pass thru both channels 
present in the incoming AE S3 stream.  

Bit Depth  16 -bit, 20 -bit, 24 -bit  Select the expected bit depth of the audio words. 

This will affect the outgoing elementary stream bit 
rate.  

Channel 
Identification  

0 -  255  User defined channel identifica tion number of the 
first audio channel i n the outgoing SMPTE 302M 
streamôsAES3 data header. 

Advanced  

Lip Sync Offset  -500 to 500 ms  Configures a delay to the audio to improve A/V 
synchronization.  



 

AVP 1000, 2000 & 3000  | Version Y www.m ediakind.com  
 

5-53  

Parameter  Values  Description  

Gain  -6 to 6dB  Sets the gain in dB for the audio stream.  

Language  A selection of language s from across the 
world.  

The language of the stream to be signaled in 
descriptors.  

Audio Stream Type  Main Audio; Clean Effects; Hearing 
Impaired; Visual Impaired  

Intended use of the audio.  

Table 5.24  Dolby -E Pass- thru Parameters  

Parameter  Values  Description  

Embedded PCR  On, Off  Controls whether PCR is to be embedded in the 

audio PES.  

Au Information Ctrl  Off, AU Info  Controls the insertion of private data in the 
adaptation unit of the audio access uni ts (AU). AU 
Info is defined in ETSI TR 101 154. Only AU_PTS is 
present for audio.  

Bit Depth  16 -bit, 20 -bit, 24 -bit  Select the expected bit depth of the audio words. 

This will affect the outgoing elementary stream bit 
rate.  

Advanced   

Lip Sync Offset  -500 to 500 ms  Configures a delay to the audio to improve A/V 

synchronization.  

Language  A selection of languages from across the 
world.  

The language of the stream to be signaled in 
descriptors.  

Audio Stream Type  Main Audio; Clean Effects; Hearing 
Impaire d; Visual Impaired  

Intended use of the audio.  

Table 5.25  Dolby Digital and Dolby Digital Plus Pass - thru Param eters  

Parameter  Values  Description  

Input Bit rate  16 to 640 kbps in discrete steps as 
defined b y Dolby  

Bit rate of the incoming audio. The outgoing audio 
shall retain the same bit rate.  

Embedded PCR  On, Off  Controls whether PCR is to be embedded in the 

audio PES.  

Au Information Ctrl  Off, AU Info  Controls the insertion of private data in the 
adaptation unit of the audio access units (AU). AU 
Info is defined in ETSI TR 101 154. Only AU_PTS is 
present for aud io.  

Advanced  

Lip Sync Offset  -500 to 500 ms  Configures a delay to the audio to improve A/V 
synchronization.  

Language  A selection of l anguages from across the 

world.  

The language of the stream to be signaled in 

descriptors.  

Audio Stream Type  Main Audio; Clean Effects; Hearing 
Impaired; Visual Impaired  

Intended use of the audio.  

Table 5.26  Audio Description Service Parameters  

Parameter  Values  Description  

Bit Rate  64  Bit Rate of the audio stream.  
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Parameter  Values  Description  

Coding Mode  1/0 (Left ï input)  Specifies what channel configuration to use for 
encoding.  

Embedded PCR  On, Off  Controls whether PCR is to be embedded in the 
audio PES.  

Au Information 
Cont  

Off, AU Info  Controls the insertion of private data in the 
adaptation unit of the audio access units (AU). AU 
Info is defined in ETSI TR 101 154. Only AU_PTS is 
present for audio  

Advanced  

Lip Sync  Offset  -500 to 500 ms  Configures a delay to the audio to improve A/V 
synchronization.  

Gain  -6 to 6dB  Sets the gain in dB for the audio stream.  

Language  A selection of languages from across the 

world.  

The language of the stream to be signaled in 

descriptors.  

Audio Stream Type  Main Audio; Clean Effects; Hearing 
Impaired; Visual Impaired  

Intended use of the audio.  

MPEG Version  MPEG-1; MPEG -2 Standard to be used for the output compressed 

audio.  

Copyright  Off; On  Set the copyright bits in the MPEG he aders.  

Original  Off; On  Set the original bits in the MPEG headers.  

De-emphasis  Off; 50/15us; CCITT J.17  Set de -emphasis as applied to the audio, in the 
MPEG headers. Does not apply the appropriate pre -
emphasis.  

Action on control 

track loss  
No action; Bi t rate s aving  If Bit rate Saving is selected, there shall be no 

emitted elementary stream for Audio Description if 
the control track is not received.  

Action when silence 
is detected  

No action; Bit rate saving  If Bit rate Saving is selected, there shall be  no 
emitted elementary stream for Audio Description if 
silence is detected on the incoming audio track.  

Silence Threshold  Decibels, -90 to -1, dBFS  Threshold of incoming audio track, which, if below 

the threshold will be determined to be silence.  

Silence  Period  Time, seconds, 0 -300  Duration of silence as determined by the threshold, 
needed before Action when Silence is Detected will 
take place.  

Table 5.27  Automatic Loudness Control Parameters  

Parameter  Valu es  Description  

Operating Mode  Off  ALC is not in use.  

Measure  Long and short measurements are taken and 
displayed in the status but no audio adjustments 
are made.  

Measure + ALC  Measurements are taken and corrections are made 

for short term peak  in audio that are measured 1 
LU above the Target level.  
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Parameter  Valu es  Description  

Measure + ALC + LTLC  Measurements are taken and corrections are made 
for short term peak in audio that are measured 1 
LU above the Target level. Corrections are also 
made over the longer term to adjust the channel 
loudness level to that of the Target Level.  

In this mode manua l gain adjustment from the 
codec page is disabled.  

Target Level  -40 to 0 (LKFS (LU)  The desired Loudness level for the channel  

Time Period  5 to 120 minutes  This contr ols the responsiveness of the long term 
audio loudness level correction.  

A smaller number will result in the audio being 
adjusted more dynamically. A larger value will give 
a slower less noticeable adjustment.  

Peak Limit  -20 to 0 dBFS  This controls a hard clipping limiter for the audio 
level. This adjustment is based on the absolute 
peak level measured in dBFS.  

The peak limiter only operates in óMeasure + ALCô 
and óMeasure + ALC + LTLCô modes.  

If this value is set to 0 no limiting is performed  

Maxi mum Boost  0 to 10 dB  This control determines the maximum amount of 
gain that the LTLC algorithm can apply. This is to 
prevent over adjustment which can lead to 
unwanted audio artifacts. This only applies when 

the operating mode is ñMeasure + ALC + LTLCò  

Maximum 
Attenuation  

0 to 10 dB  This control determines the maximum amount of 
attenuation that the ALC and the LTLC algorithm 
can apply. This is to prevent over adjustment 
which can lead to unwanted audio artifacts  

Preset  Subtle, Standard, Strong  The available options are Subtle, Standard and 
Strong. This setting controls the aggressiveness of 

the corrections performed by the Short Term ALC 
algorithm. It controls how quickly the correction 
takes place and the strength of t he correction  

Reset Statis tics  True, false  This can be used to reset the statistics that have 
been collected in the Audio Algorithm. Due to the 
slower update nature of the web interface the 
apparent change would be to the measurement of 
the Integrated Loudness only  

The referenc e 

target level  

Line out mode; RF mode; Portable mode -

14dB; Portable mode -1dB; Portable mode 
-8dB  

Sets the reference target level for downstream 

decoders.  

Override dialnorm 
metadata  

Off, on  For Dolby encoding, the dialnorm parameter can be 
overridden with the Target Level. This is 
recommended practice.  

Audio Component  

The parameters listed in the table below are available on the Component  tab of the Properties  
widget on the Service Configuration  page when an audio component is selected in the Outputs  
widget. The same parameters can be accessed through the Output/<output name>/Transport 
Stream ID: <n>/Service List/<service name>/Component List/<component name>  

menu on the front panel.  
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Table 5.28  Audio Comp onent Parameters  

Parameter Values Description 

PID 32 to 8190 Sets the packet identifier associated with the component. 

Bit Rate Weighting Fixed Specifies the weight associated to the component in the 
Bit Rate Tracking algorithm. For audio stream, this is Fixed 
and read only. 

Exclude from PMT  False If set to True, this component will not be 
referenced in the PMT, and its bit rate is excluded 
from bit rate calculations.  

Source PID 

Moni toring  
None; Monitor; Monitor & Redundancy  Priority 1 ETR290 monitoring  on this PID from an 

IP input can be enabled, and can be set to cause a 
redundancy switch to a spare device if in a system 
controlled by MediaKind  control software.  Not 
supported in this release.  

Dolby Metadata Presets  

Four custom Dolby Metadata Presets can be configured in the Advanced Setup tab of the Device 
Configuration page. To set the preset options, in the Advanced Video Processor Settings drill down 
to Encoder > Slots > Slot <n> -  CE-a >CE -a > Audio Module > Dolby Metadata Presets, and 
select the preset you want to modify. Alternatively, the settings can be reached through the front 
panel under Advanced/CE -a/Audio Module/Dolby Meta data Presets. Any of these presets can then 
be applied to any audio channel encoding audio in the Dolby Digital format.  The table below lists 
the parameters for each preset.  

Table 5.29  Dolby Metadata Preset Pa rameters  

Parameter Values Description 

Preset name  Name of the preset (for user information) 

Dialogue 
normalization level 

-31 to -1 dB Used by a decoder to determine the level of adjustment 
required to achieve this set level. 

Bitstream mode Main audio service: complete main, music and 
effects, Associated service: visually impaired, 
Associated service: hearing impaired, 
Associated service: dialogue, Associated 
service: commentary, Associated service: 
emergency, Associated service: visually 
impaired, Associated service: karaoke/voiceover 

Flags the type of service in the bitstream. 

Line mode 
compression profile 

None, Film Standard, Film Light, Music 
Standard, Music Light, Speech 

Alters the dynamic range for line output. 

RF mode compression 
profile 

None, Film Standard, Film Light, Music 
Standard, Music Light, Speech 

This alters the dynamic range for RF output. The overall 
level is raised by 11 dB. 

Center mix level 0.707 (-3.0 dB), 0.595 (-4.5 dB), 0.500 (-6.0 dB) Indicates the downmix level when there is no centre 
speaker. This is applied to left and right channels only. 

Surround mix level 0.707 (-3.0 dB), 0.500 (-6.0 dB), 0 (-inf dB) Surround downmix level for the front left and right 
channels when consumer has no surround speakers. 

Dolby Surround mode Not Indicated, Not Encoded, Encoded Flags if a two channel encoded stream contains 
information for a Dolby Pro-logic decode (Lt/Rt) 

Audio production 
information exists 

Off, On This indicates whether the Mixing Level and Room Type 
parameters exist within the bit-stream. 

Mixing level 80 to 111 dB Indicates the acoustic sound pressure level of the dialogue 
level during the final audio mixing session. 

Room type Not indicated, Large room X curve monitor, 
Small room flat monitor 

Type and calibration of the mixing room used for the final 
audio mixing session. 

Copyright flag Off, On Indicates if the material is copyright protected 
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Parameter Values Description 

Original bitstream flag Off, On Indicates if source is the original or a copy 

Enable extended 
bitstream information 

Off, On Flags if additional information is available for downmixing. 

Preferred downmix 
mode 

Not indicated, Lt/Rt downmix preferred, Lo/Ro 
downmmix preferred 

Indicates if the producer would prefer a Lt/Rt or a Lo/Ro 
downmix. Can be over-ridden by the decoder. 

Lt/Rt center mix level 1.414 (+3.0 dB), 1.189 (+1.5 dB), 1.000 (0 dB), 
0.841 (-1.5 dB), 0.707 (-3.0 dB), 0.595 (-4.5 dB), 
0.500 (-6.0 dB), 0 (-inf dB) 

Indicates the required level reduction of the center channel 
when mixed with the L& R channels for a Lt/Rt downmix. 
Similar to 'Center mix level'. 

Lt/Rt surround mix 
level 

0.841 (-1.5 dB), 0.707 (-3.0 dB), 0.595 (-4.5 dB), 
0.500 (-6.0 dB), 0 (-inf dB) 

Indicates the required level reduction of the surround 
channels when mixed for a Lt/Rt downmix. Similar to 
Surround mix level'. 

Lo/Ro center mix level 0.841 (-1.5 dB), 0.707 (-3.0 dB), 0.595 (-4.5 dB), 
0.500 (-6.0 dB), 0 (-inf dB) 

Indicates the required level reduction of the center channel 
when mixed with the L& R channels for a Lo/Ro downmix. 
When present this replaces the value set for the 'Center 
mix level' 

Lo/Ro surround mix 
level 

0.841 (-1.5 dB), 0.707 (-3.0 dB), 0.595 (-4.5 dB), 
0.500 (-6.0 dB), 0 (-inf dB) 

Indicates the required level reduction of the center channel 
when mixed for Lo/Ro downmix. When present this 
replaces the value set for the 'Surround mix level'. 

Dolby Surround EX 
mode 

0.841 (-1.5 dB), 0.707 (-3.0 dB), 0.595 (-4.5 dB), 
0.500 (-6.0 dB), 0 (-inf dB) 

Flags if the stream has been encoded in 'Surround Ex'. 
Only used if surround channels are present. 

A/D converter type Standard, HDCD Indicates type of A/D conversion used. 

Digital de-emphasis Off, Auto, On To meet the Dolby Digital encoding algorithm specification 
the audio must not have pre-emphasis applied. If the input 
signal does have pre-emphasis applied, a de-emphasis 
filter must be applied prior to encoding. 

DC high pass filter 
enable 

Off, On Removing the DC component can lead to more efficient 
encoding, but there is a risk that signals that do not reach 
100% PCM may exceed this after filtering and therefore 
must be clipped. 

Bandwidth low-pass 
filter enable 

Off, On Remove high frequency signals before encoding. The filter 
removes frequencies that would not normally be encoded. 

Low-frequency effects 
low pass filter enable 

Off, On Apply a 120 Hz low pass filter prior to an encode. Should 
only be switched off if it is known that there are no 
frequencies above 120 Hz. 

Surround attenuation 
enable 

Off, On Attenuate surround channels by 3 dB before encoding. 
Theatrical and consumer mixing rooms use different levels 
for the surround channels, and this can be used to 
compensate. 

Surround phase shift 
enable 

Off, On Apply a phase shift of 90 degrees to the surround 
channels. This simplifies the decode process for producing 
a 'Lt/Rt' downmix. 

5.5.3.1.3  Splicing Stream Configuration  

Splicing  

The parameters listed in the table below are available on the Splicing  tab of the Properties  
widget on the Service Configuration  page when an S CTE 35 stream is selected in the Outputs  
widget. The same parameters can be accessed through the Advanced/CE - a/Video/Video 

1/Video/Main Video/Splicing  menu on the front panel.  
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Table 5.30  Splicing Parameters  

Parameter Values Description 

Splicing Control Off, On VANC Message Only, On VANC, On IP On VANC or On IP Enables splice points to be set in the 
video stream upon reception of a SCTE104 message and 
determines the insertion point. 

On VANC Message Only does not insert splice point, but 
converts the SCTE 104 message to SCTE 35 message in 
the output. 

To enable splicing, a splice point insertion license 
(CE/SWO/DPI) is needed. 

Splice Null Insertion Off, On Used to determine the insertion of NULL SCTE 35 
messages into the output stream if no messages have 
been sent for 500ms. 

Audio Splicing Off, On Used to determine if audio is manipulated at the point that 
the video splice occurs. 

AS Index Control Don't Care, Use 1, Use 1 + 2 Only available when Splicing Control is set to On VANC 
Message Only. 

If set to Donôt Care the AVP will create SCTE 35 output 
regardless of the source Automation System. 

If set to Use 1 the AVP will create SCTE 35 output only for 
incoming SCTE 104 whose AS Index matches the setting 
in AS Index 1. 

If set to Use 1 + 2 the AVP will create SCTE 35 output only 
for incoming SCTE 104 messages whose AS Index 
matches either the setting in AS Index 1 or the setting in 
AS Index 2. 

DPI PID Index Control Don't Care, Use 1, Use 1 + 2 Determines how many values of DPI PID Index are 
compared against the incoming SCTE 104message. 
Available only when Splicing Control is set to On VANC 
Message Only. 

AS Index 1 0 to 255 The AS index used if AS Index Control is set to Use 1 or 
Use 1 + 2. 

AS Index 2 0 to 255 The AS index used if AS Index Control is set to Use 1 + 2. 

DPI PID Index 1 0 to 255 The DPI PID index used if DPI PID Index Control is set to 
Use 1 or Use 1 + 2. 

DPI PID Index 2 0 to 255 The DPI PID index used if DPI PID Index Control is set to 
Use 1 + 2. 

SCTE 104 Encode  

Input Stream 

Channel  
None  Only available if triggering splicing based on 

contact closure through a GPI card.  

Splicing Component  

The following parameters are available on the Component  tab of the Properties  widget on the 
Service Configuration  page when an SCTE 35 stream is selected in the Outputs  widget. The 
same parameters can be accessed through the Output/<output name>/Transport Stream 
ID: <n>/Service List/<service name>/Component List/<c omponent name>  menu on the 
front panel.  

Table 5.31  Slicing Co mponent Parameters  

Parameter Values Description 

PID 32 to 8190 Sets the packet identifier associated with the component. 

Bit Rate Weighting Fixed Specifies the weight associated to the component in the 
Bit Rate Tracking algorithm. For audio stream, this is Fixed 
and read only. 
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5.5.3.1.4  Teletext Stream Configuration  

This section describes the parameters for setting up Teletext.  

Teletext  

This section gives th e parameters that have an effect on how Teletext is transmitted.  

The parameters listed are available on the Teletext  tab of the Properties  widget on the Service 
Configuration  page when a Teletext stream is selected in the Outputs  widget. The same 

parameter s can be accessed through the Advanced/CE - a/Video/Video 1/Input/V BI 
Extraction/Teletext  menu on the front panel.  

Table 5.32  Teletext Parameters  

Parameter Values Description 

Teletext Source Off, OP-47 (Max 300kb/s), VANC Teletext Controls the source from where Teletext is extracted, 
including encapsulation method where appropriate. 

Teletext Packetisation Normal (ETS 300-472) - Data on Teletext 
Component, Legacy (ETS 301-775) - Data on 
VBI Component 

Controls how the Teletext data is packetized in to a 
component data stream. 

SMPTE2031 Max. No. 
Teletext  

3, 7, 11, 15, 36 Defines the maximum number of Teletext lines inserted. 
Available only if VANC Teletext is selected for Teletext 
Source. 

SMPTE2031 Teletext 
Present 

Yes, No Displays whether Teletext is found in the SDI stream. 
Available only if VANC Teletext is selected for Teletext 
Source. Read only parameter. 

Min # Teletext Packets 0 to 3 Defines the minimum number of Teletext packets 
generated per field, even if there is no Teletext data. 

PTS On Teletext Off, On Controls whether a PTS value is included in the output 
Teletext packets. 

Teletext Descriptor Page List / Teletext Descriptor Page 

Teletext Page Type Off, Initial Page, Subtitle Page, Additional 
Information Page, Programme Schedule Page, 
Heading Impaired Subtitle Page 

The page type of the Teletext descriptor. 

Teletext Page Number  The page number for the page to be set. 

Teletext Page 
Language 

List of languages The language set for the Teletext descriptor. 

Teletext Component  

This section describes the parameters associated with the component carrying Teletext data.  

The following parameters are available on the Component  tab of the Properties  widget on the 

Service Configuration  page when a Teletext str eam is selected in the Outputs  widget. The 
same parameters can be accessed through the Output/<output name>/Transport Stream 
ID: <n>/Service List/<service name>/Component List/<component name>  menu on the 
front panel.  

Table 5.33 Teletext Component Parameters  

Parameter Values Description 

PID 32 to 8190 Sets the packet identifier associated with the component. 

Bit Rate Weighting Fixed Specifies the weight associated to the component in the 
Bit Rate Tracking algorithm. For audio stream, this is Fixed 
and read only. 
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5.5.3.1.5  VBI and ANC Stream Configuration  

This section describes the parameters available for setting up VBI and ANC streams.  

VBI and Ancillary Data  

This section gives the parameters that have an effect on wha t  ancillary data is extracted and how 
the data is transmitted.  

The following parameters are available on the VBI  tab of the Properties  widget on the Service 

Configuration  page when an ANC stream is selected in the Outputs  widget. The same 
parameters can  be accessed through the Advanced/CE - a/Video/Video 1/Input/VBI 
Extraction  menu on the front panel.  

Table 5.34  VBI and Ancillary Data Parameters  

Parameter Values Description 

Description Control 

VBI Descriptor Mode Standard, Legacy, Philips, User The source for Closed Captions data encoded as part of 
the Video Stream (only applicable when Video Frame Rate 
is 29.97 Hz) 

VBI Data Descriptor 
Insertion 

Off, On Controls if the VBI Data Descriptor is inserted into the 
PMT. Available only if VBI Descriptor Mode is set to 
User. 

VBI Teletext Descriptor 
Insertion 

Off, On Controls if the VBI Teletext Descriptor is inserted into the 
PMT. Available only if VBI Descriptor Mode is set to 
User. 

Teletext Descriptor 
Insertion 

Off, On Controls if the Teletext Descriptor is inserted into the PMT. 
Available only if VBI Descriptor Mode is set to User. 

Proprietary Descriptor 
Insertion 

Off, On Controls if the Legacy Proprietary Descriptor is inserted 
into the PMT. Available only if VBI Descriptor Mode is set 
to User. 

Aspect Ratio (AR) Signalling 

Video Index Off, On (Default), On (User) Controls the extraction of Video Index (and thus whether 
Video Index can be used as source of AR info).  

Default: The default lines will be set to decode Video Index 
(11/324 in 25Hz, 14/277 in 29.97 Hz) 

User: The User defines the lines used to decode Video 
Index. 

Video Index Field 1 10 to 22 Specifies which line contains the video index in field 1. 

Video Index Field 2 10 to 22 Specifies which line contains the video index in field 2. 

SMPTE 2016 Off, On Controls whether SMPTE 2016 data can be used as a 
source for AR info. 

AFD Sustain Indefinitely, Default after Timeout, Off after 
Timeout 

Control what AFD code goes out when AFD is lost at input. 

Indefinitely: Maintains previously received AFD code 
indefinitely. 

Default after Timeout: Maintains previously received AFD 
code for period specified in Sustain Timeout, then drop to 
default, i.e. code 1000. 

Off after Timeout: Maintains previously received AFD code 
for period specified in Sustain Timeout, then switch AFD 
off. 

AFD Sustain Timeout 0 to 5,10, 20, 50, 100, 120 Control how long previous AFD code is maintained. Zero 
means drop to default immediately on loss. 
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Parameter Values Description 

AFD Action on Reserved 
Codes 

Pass Through, Code as 0000 Specify what code is passed to the output when reserved 
AFD codes are received at the input. 

Pass Through: Passes code through unchanged. 

1 Code as 0000: Changes code to 0000. 

Closed Captions 

Closed Captions Source Off, VBI lines, SMPTE 334 The source for Closed Captions data encoded as part of 
the Video Stream. Only applicable when frame rate is 
29.97 Hz. 

Timecode 

TC Mode Off, External, Zero on Loss, External, 
Freewheel on Loss, Internal 

Controls what mode the Time code (TC) is working in, 
either Off, external source or internally generated. Also 
sets what happens on loss of external source (zero or 
freewheel). 

TC External Source 2 Auto, ANC VITC1, ANC VITC2, ANC LTC, VBI VITC Controls the external source of Time Code. Auto will select 
the first source present in order of the drop down list. 

TC Dropframes Off, On, Auto Only in 525 line operation controls if Time Code takes 
account of drop frames or not. Auto configures to external 
source, or to ON for internal source. 

Broadcaster ID 

Reception Timeout  Timeout in seconds for reception of Source ID from input 
(RP207). 

Insertion Timeout  Timeout in seconds for insertion of default source ID. 

Broadcaster ID Mode Off, Auto, Default Only, Source Only Gives what to insert as a broadcaster ID. 

Default Servicename  The default service name to be used. 

Broadcaster ID Source No, Input, Default Indicates if the Broadcaster ID is derived from the input, 
the default or is invalid. 

Broadcaster ID  The Broadcaster ID that is currently being inserted into the 
output stream. 

Generic ANC 

Generic ANC Extraction Off, On Controls whether Generic ANC is extracted from the SDI 
stream or not as per SMPTE 2038-2008. 

Max ANC Bit Rate 100 to 2000 kbps The maximum data rate of the Generic ANC data output. 

Field 1 

VBI Line 9 - VBI Line 22 Off, Closed Caption Specifies the content in the respective VBI lines. Set to Off 
if the line in the incoming video does not carry any 
information, Closed Caption for closed caption information. 
Visible for 480i (525-line) input streams. 

VBI Line 6 - VBI Line 23 Off, VITC, WSS, WSS-AFD, Teletext System 
B, Monochrome samples 

Specifies the content in the respective VBI lines. Set to Off 
if the line in the incoming video does not carry any 
information, VITC for Time Code, WSS for Wide Screen 
Signaling, WSS-AFD for Active Format Detection and 
Teletext System B for Teletext. Visible for 576i (625-line) 
input streams. 

Field 2 

VBI Line 272 - VBI Line 
285 

Off, Closed Caption Specifies the content in the respective VBI lines. Set to Off 
if the line in the incoming video does not carry any 
information, Closed Caption for closed caption information. 
Visible for 480i (525-line) input streams. 
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Parameter Values Description 

VBI Line 319 - VBI Line 
336 

Off, VITC, WSS, WSS-AFD, Teletext  
System B, Monochrome samples 

Specifies the content in the respective VBI lines. Set to Off 
if the line in the incoming video does not carry any 
information, VITC for Time Code, WSS for Wide Screen 
Signalling, WSS-AFD for Active Format Detection and 
Teletext System B for Teletext. 

ANC Componen t  

This section de scribes the parameters associated with the component carrying ancillary data.  

The following parameters are available on the Component  tab of the Properties  widget on the 
Service Configuration  page when an ANC stream is selected in the Outp u ts  widget. The s ame 
parameters can be accessed through the Output/<output name>/Transport Stream ID: 
<n>/Service List/<service name>/Component List/<component name>  menu on the 

front panel.  

Table 5.35  ANC Com ponent Parameters  

Parameter Values Description 

PID 32 to 8190 Sets the packet identifier associated with the component. 

Bit Rate Weighting Fixed Specifies the weight associated to the component in the 
Bit Rate Tracking algorithm. For audio stream, this is Fixed 
and read only. 

5.5.3.1.6  PCR Stream Configuration  

The video encoding module can generate a separate PCR stream. The PCR stream contains timing 
reference that can be used for decoding the elementary streams included in the same service as 
the PCR stream itse lf. To use the PCR stream as a timing reference for decoding, set the PCR PID 
parameter associated with the service to the PID assigned to the PCR stream.  

The following parameters are available in Properties  widget on the Service Configuration  page 
when a PCR Str eam is selected in the Outputs  widget. The same parameters can be accessed 
through the Output/<output name>/Transport Stream ID: <n>/Service List/<service 
name>/Component List/Slot <m> Video 1 PCR stream on PID <n>  menu on the front 
panel.  

Table 5.36  PCR Stream Configuration Parameters  

Parameters Values Description 

PID 16 - 8190 The packet identifier assigned to packets carrying the 
program clock reference values. 

Bit Rate Weighting Fixed Not relevant for the PCR component. Read only 
parameter. 

5.5.3.2  CE- a J2K VCM  

5.5.3.2.1  Video and VBI Stream Configuration  

Video Input and Pre - Processing  

The following parameters are available on the Input tab of the Properties  widget on the Service 
Configuration  page when a v ideo comp onent is selected in the Outputs  widget. The same 
parameters can be accessed through the Advanced/CE - a J2K/Video/Video1/Input  menu on 
the front panel.  
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Table 5.37  Video Input and Pre -Processing Parame ters  

Parameter Values Description 

Video Input Lock Yes, No Shows whether there is a video lock to the format specified 
through the parameters below. Read only parameter. 

Source SDI The video will be sourced from the SDI/HD-SDI input on 
the rear panel. 

 
Bars An internally generated color bars test pattern will be used 

as the video source. 

 
Black An internally generated black test pattern will be used as 

the video source. 

 
Moving Object An internally generated moving object test pattern will be 

used as the video source. 

 
Slate A slate file uploaded by the user will be used as the video 

source. 

Input Detection Off, Auto Detect and Report, Auto Detect and 
Configure Video Profile Only, Auto Detect and 
Restore Saved Config 

Controls whether the format of the SDI input shall be 
automatically detected or what actions to take if a change 
is detected in the Input Video Format. 

Detected Video 
Standard 

Not Detected, SD 567i25, SD 480i29.97, HD 
720p50, HD 720p59.94, HD 1080i25, HD 
1080i29.97 

The detected video standard if Input Detection is set to 
other than Off. If the format is not detected or Input 
Detection is set to Off, it is set to Not Detected. Read only 
parameter. 

Video Input Format SD 567i25, SD 480i29.97, HD 720p50, HD 
720p59.94, HD 1080i25, HD 1080i29.97 

Defines the expected video format on the SDI input or the 
video format used for encoding the test patterns. A change 
in the Video Input Format might result in a change in the 
Video Profile used for encoding. As from the current 
release down-conversion is supported, SD profiles can be 
selected for HD input formats. 

Output On Video Loss Freeze Frame, Freeze with text overlay Repeats the last good video frame on loss of video input. 

 Black, Black with text overlay Switches to a black test pattern on loss of video input. 

 Color Bars, Bars with text overlay Switches to a color bars test pattern on loss of video input. 

 
No PID The video PID shall no longer be transmitted. The SI is not 

updated. 

Video Encoding  

The following parameters are available on the Encode  tab of the Properties  widget on the 
Service Configuration  page when a video component is selected in the Outputs  widget. The 
same parameters can be accessed through the Advanced/CE - a J2K/Video/V ideo 
1/Video/Main Video/Video Encoder  menu on the front panel.  

Table 5.38  Video Encoding Parameters  

Parameter Values Description 

Video Profile Profile Off, 
SD J2K Profile Level 1 4:2:2 10 bit, 
HD J2K Profile Level 2 4:2:2 10 bit 

Sets the encoder profile. The profile will also affect the 
allowed Bit Rate range. 

Profile for SD input Profile Off, 
SD J2K Profile Level 1 4:2:2 10 bit, 
HD J2K Profile Level 2 4:2:2 10 bit 

The profile to set when an SD input is detected on the SDI 
input. Visible only if Input Detection is set to Auto Detect 
and Configure. If this option is visible, the Video Profile 
cannot be set manually. 

Profile for HD input Profile Off, 
SD J2K Profile Level 1 4:2:2 10 bit, 
HD J2K Profile Level 2 4:2:2 10 bit 

The profile to set when an HD input is detected on the HD-
SDI input. Visible only if Input Detection is set to Auto 
Detect and Configure. If this option is visible, the Video 
Profile cannot be set manually. 
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Parameter Values Description 

Resolution 720 x 576, 720 x 480, 1280 x 720, 1920 x 1080 Defines the horizontal and vertical resolution of the 
encoded video. The available options depend on the 
values set for Video Input Format and Video Profile. 

Video Bit Rate The valid bit rate range depends on the selected 
video profile. 

Defines the Transport Stream bit rate to be used by the 
compressed video component. If Bit Rate Tracking Mode 
is set to Maximize Video for the Transport Stream that 
contains the video component and the Bit Rate Weighting 
of the component is set to other than Fixed or Minimal, this 
field is read only. 

Buffer Mode 

 

Compatibility Compatibility with the JPEG 2000 standard, usually means 
a delay no more than 160 ms. 

Ultra low delay Very low delay brought by the JPEG 2000 encoding. 

Delay  Displays the actual video encoding delay. Read only 
parameter. 

Video Output  

The fo llowing parameters are available on the Output  tab of the Properties  widget on the 
Service Configuration  page when a video component is selected in the Outputs  widget. The 
same parameters can be accessed through the Advanced/CE - a/Video/Video 1/Video/Main 
Video/Stream Output  menu on the front panel.  

Table 5.39  Video Output Parameters  

Parameter Values Description 

Embedded PCR Off, On, On (Picture Header) Sets if the PCR is embedded within the video. If it is set to 
other than Off, the PCR PID field of a service will become 
read only and will contain the PID of the current component. 

Copyright Off, On Sets the copyright flag in the elementary stream header. 

Original Off, On Sets the original flag in the elementary stream header. 

PES Packet Per GOP, Picture Determines how PES packets shall be generated. The 
Picture option is only available if MPEG 2 encoding is used. 

AU Information Ctrl 3 RAI, RAI and AU Info, RAI, AU Info and TC Controls insertion of Private Data in the TS Adaptation 
Field for video Access Units (AU) with the following values: 
Random Access Indicator (RAI), ETSI 101 154 (AU info), 
and Time Code (TC). 

AR Signaling Output 
Control 

Off, AFD Only, AFD and Bar Data Controls what Aspect Ratio signaling will get embedded in 
the video as user data. AFD sources are: SMPTE 2016, 
Video Index, WSS-AFD/WSS, user set Aspect Ratio. Bar 
Data is only SMPTE 2016. 

TC Output Location Off, SEIMsg Defines how timecode is put into the output video stream. 

Video Compone n t  

The following parameters are av ailable on the Component  tab of the Properties  widget on the 
Service Configuration  page when a video component is selected in the Outputs  widget. The 
same parameters can be accessed through the Output/<output name>/Transpo r t Stream 
ID: <n>/Service List/<service name>/Component List/Slot  <x> Video Stream on PID 
<y>  menu on the front panel.  

Table 5.40  Video Component Parameters  

Parameter Values Description 

PID 32 to 8190 Sets the packet identifier associated with the component. 
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Bit Rate Weighting Fixed, Minimum, 2 to 20 Specifies the weight associated to the component in the 
Bit Rate Tracking algorithm.  

Master TS Off, On Sets the master Transport Stream for the component.  

Vertical Blanking Interval / Ancillary Data Configuration  

VBI Stream and ANC/DVB Subtitle Stream  

The following parameters are available on the VBI tab of the Properties  widget on the Service 
Configuration  page when a video stream is selected in the Outputs  widget. The same 
parameters can be accessed through the Advanced/CE - x/Video/Video 1/Input /VBI 
Extraction  menu on the front panel.  

Table 5.41  VBI Stream and ANC/DVB Subtitle Stream Parameters  

Parameter Values Description 

Generic ANC 

Generic ANC 
Extraction 

Off, On Controls whether Generic ANC is extracted from the SDI 
stream or not as per SMPTE 2038-2008. 

Max ANC Bit Rate 100 to 2000 kbps The maximum data rate of the Generic ANC data output. 

VBI in Picture 

Enable VBI in picture Off, Closed Caption  

Input Detection  

The CE -a J2K VCM supports video input detection as described in Chapter 3, Getting Started: How 
to Configure and Use Input Detection.  

5.5.3.2.2  Audio Stream Configuration  

Audio Input  

The following parameter s are available on the Input tab of the Properties widget on the Service 

Conf iguration page when an audio component is selected in the Outputs widget. The same 
parameters can be accessed through the Advanced/CE -a J2K/Audio Module/Audio <n>/Input 
menu on th e front panel.  

Table 5.42  Audi o Input Parameters  

Parameter Values Description 

Input Format Uncompressed (LPCM), Dolby E Sets the input format used by the audio encoder. 

Input Source Off, Mute, Test Tone, Embedded 1 to 8, Input 1 -
4 

Sets the source used by the audio encoder. No input is fed 
to the encoder if Off is selected. Mute mutes the incoming 
audio and encodes silence. Test Tone encodes a 1 kHz 
test tone, Embedded 1 to 8 sets the source to an SDI 
embedded audio stream. Input 1-4 are for the digital 
inputs. 

Output On Audio Loss No PID, Silence Specifies the action to take when input is Lost. No PID is 
for dropping the audio PID from the stream, Silence is for 
encode silence. 

When No PID is selected, the reference to the PID is not 
removed from the Program Map Table, so a Transport 
Stream analyzer will indicate a ghost PID in the output 
Transport Stream. 

Audio Encoding  
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The following parameters are available on the Encode  tab of the Properties  widget on th e 

Service Configuration  page when an audio component is selected in the  Outputs  widget. The 
same parameters can be accessed through the Advanced/CE - a J2K/Audio Module/Audio 
<n>/Encode  menu on the front panel.  

Table 5.43  Audio Encoding Standards  

Parameter Options Description 

Coding Standard Pass-thru Pass-thru of the input 

Table 5.44  Pass- thru Parameters  

Parameter Values Description 

Embedded PCR On, Off Controls whether PCR is to be embedded in the audio 
PES. 

Au Information Cont Off, AU Info Controls the insertion of private data in the adaptation unit 
of the audio access units (AU). AU Info is defined in ETSI 
TR 101 154. Only AU_PTS is present for audio. 

Advanced 

Lip Sync Offset -500 to 500 ms Configures a delay to the audio to improve A/V 
synchronization. 

Gain -6 to 6dB Sets the gain in dB for the audio stream. 

Language  The language of the stream. 

User Language 1  A custom three-character language code when User 
Language 1 is set the Language field. 

User Language 2  A custom three-character language code when User 
Language 2 is set in the Language field. 

Audio Component  

The following parameters are available on the Component  tab of the Properties  widget o n the 
Service Configuration  page when an audio component is selected in the Outputs  widget. The 

same parameters can be accessed through the Output/<output name>/Transport Stream 
ID: <n>/Service List/<service name>/Component List/<component name>  menu on th e 
front panel.  

Table 5.45  Audio Component Parameters  

Parameter Values Description 

PID 32 to 8190 Sets the packet identifier associated with the component. 

Bit Rate Weighting Fixed Specifies the weight associated to the component in the 
Bit Rate Tracking algorithm. For audio stream, this is Fixed 
and read only. 

5.5.3.2.3  VBI and ANC Stream Configuration  

VBI and Ancillary Data  

The following parameters are available on the VBI tab of the Properties  widget on the Service 
Configuratio n  page when an ANC  stream  is selected in the Outputs  widget. The same 
parameters can be accessed through the Advanced/CE - a J2K/Video/Video 1/Input/VBI 
Extraction  menu on the front panel.  
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Table 5.46  VBI and Anc illary Data Parameters  

Parameter Values Description 

Generic ANC 

Generic ANC Extraction Off, On Controls whether Generic ANC is extracted from the SDI 
stream or not as per SMPTE 2038-2008. 

Generic ANC Extraction Off, On Controls whether Generic ANC is extracted from the SDI 
stream or not as per SMPTE 2038-2008. 

VBI in Picture 

Enable VBI in picture Off, Closed Caption  

ANC Component  

The following parameters are available on the Component  tab of the Properties  widget on the 
Service Configurat io n  page when an ANC  stream is selected in the Outputs  widget. The same 
parameters can be accessed through the Output/<output name>/Transport Stream ID: 
<n>/Service List/<service name>/Component List/<component name>  menu on the 

front panel.  

Tabl e 5.47  ANC Component Parameters  

Parameter Values Description 

PID 32 to 8190 Sets the packet identifier associated with the component. 

Bit Rate Weighting Fixed Specifies the weight associated to the component in the 
Bit Rate Tracking algorithm. For audio stream, this is Fixed 
and read only. 

5.5.3.2.4  PCR Stream Configuration  

The video encoding module can generate a separate PCR stream. The PCR stream contains timing 
reference that can be used for decoding the elementary streams included in the same service as 
the PCR stream itself. To use the PCR stream as a timing reference for decoding, set the PCR PID 
parameter associated with the service to the PID assigned to the PCR stream.  

The following para meters are available in Properti es  widget on the Service Configuration  page 
when a PCR Stream is selected in the Outputs  widget. The same parameters can be accessed 
through the Output/<output name>/Transport Stream ID: <n>/Service List/<service 
name>/Compo nent List/Slot <m> Video 1 PCR s tr eam on PID <n>  menu on the front 
panel.  

Table 5.48  PCR Stream Configuration Parameters  

Parameter Values Description 

PID 16 - 8190 The packet identifier assigned to packets carrying the 
program clock reference values. 

Bit Rate Weighting Fixed Not relevant for the PCR component. Read only 
parameter. 

5.5.3.3  CE- x VCM  

5.5.3.3.1  Video and VBI Stream Configuration  

Video Input and Pre - Processing  
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The following parameters are available on the Input  tab of the Properties  widget on th e Service 

Configuration  page when a video component is selected in the Outputs  widget. The same 
parameters can be accessed through the Advanced/CE - x/Video/Video1/Input  me nu on the 
front panel.  

Table 5.49  Video  I nput and Pre -Processing Parameters  

Parameter Values Description 

Video Input Lock Yes, No Shows whether there is a video lock to the format specified 
through the parameters below. Read only parameter. 

Source SDI The video will be sourced from the SDI/HD-SDI input on 
the rear panel. 

Bars An internally generated color bars test pattern will be used 
as the video source. 

Black An internally generated black test pattern will be used as 
the video source. 

Moving Object An internally generated moving object test pattern will be 
used as the video source. 

Slate A slate file uploaded by the user will be used as the video 
source. 

Input Detection Off, Auto Detect and Report, Auto Detect and 
Configure Video Profile Only, Auto Detect and 
Restore Saved Config 

Controls whether the format of the SDI input shall be 
automatically detected or what actions to take if a change 
is detected in the Input Video Format.  

Detected Video 
Standard 

Not Detected, SD 567i25, SD 480i29.97, HD 
720p50, HD 720p59.94, HD 1080i25, HD 
1080i29.97 

The detected video standard if Input Detection is set to 
other than Off. If the format is not detected or Input 
Detection is set to Off, it is set to Not Detected. Read only 
parameter. 

Video Input Format SD 567i25, SD 480i29.97, HD 720p50, HD 
720p59.94, HD 1080i25, HD 1080i29.97 

Defines the expected video format on the SDI input or the 
video format used for encoding the test patterns. A change 
in the Video Input Format might result in a change in the 
Video Profile used for encoding. As from the current 
release down-conversion is supported, SD profiles can be 
selected for HD input formats. 

Output On Video Loss Freeze Frame, Freeze with text overlay Repeats the last good video frame on loss of video input. 
Text overlay is not supported in this release. 

Black, Black with text overlay Switches to a black test pattern on loss of video input. Text 
overlay is not supported in this release. 

Color Bars, Bars with text overlay Switches to a color bars test pattern on loss of video input. 
Text overlay is not supported in this release. 

No PID The video PID shall no longer be transmitted. The SI is not 
updated. 

Slate, Slate with text overlay A slate file uploaded by the user will be used as the video 
source. 

Ident Text  Overlay text to display on top of images. 

MCTF Off, Default, Strong, Stronger The amount of Motion Compensated Temporal Filtering 
done to improve image quality. 

Adaptive 
Preprocessing 

Off, On Adaptive PreProcessing analyses the incoming video to 
tries and identify areas of noise contained within the 
picture. A filter is then applied to those areas of the picture 
to remove the noise. Applying the filter may remove detail 
from the picture and may make edges of objects appear 
soft or slightly blurred.For normal operation with high 
quality input video feeds it is recommended that this option 
is set to OFF. 

Bandwidth 30 to 100 % Sets the video horizontal bandwidth filter. 
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Parameter Values Description 

Half Line Removal Off, On Enables or disables the removal of black half lines at the 
top of the picture by substituting video data from adjacent 
lines. The option is available when Video Input Format is 
set to SD 576i25. 

Logo 

Logo insertion Off, On Controls if logos are displayed or not. The file to use can 
be selected under Logo file. 

Logo file  The file to use as a logo. The selected file can be 
uploaded by selecting the Upload option. Not supported in 
this release. 

A fixed logo position? On, Off Controls whether to use the default position for overlaying 
the logo on the video. Not supported in this release. 

The X position of the 
logo 

 The position relative to left of the screen 0 (number of 
pixels per video line - logo width - 1). If an invalid 
position is specified, a logo display alarm will be 
generated. Displayed only if A fixed logo position? is set to 
Off. Not supported in this release. 

The Y position of the 
logo 

 The position relative to top of screen 0 (number of video 
lines - logo height - 1). If an invalid position is specified, a 
logo display alarm will be generated. Displayed only if A 
fixed logo position? is set to Off. Not supported in this 
release. 

HD to SD Video Down-conversion 

Default Aspect Ratio 
Conversion 

Anamorphic, Center Cut, Letterbox The down-conversion to apply when AFD is lost or AFD 
code 000 is received. 

Use Input AFD true, false Specifies whether to attempt to use AFD code at input for 
format conversion or always apply the default. 

Action on AFD lost Convert as anamorphic and put AFD code 1000 
out, Convert as specified in Default and put AFD 
code out 

Specifies what to do if AFD is lost. 

Action on AFD code 
0000 

Convert as anamorphic and put AFD code 1000 
out, Convert as specified in Default and put AFD 
code out 

Specifies what to do if AFD code 0000 is received. 

Video Encoding  

The following parameters are available on the Encode tab of the  Properties widget on the Service 
Configuration page when a video component is selected in the Outputs widget. The same 
parameters can be accessed through the Advanced/CE -x/Video/Video 1/Video/ Main Video/Video 
Encoder  menu on the front panel.  
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Table 5.50  Video Encoding Parameters  

Parameter Values Description 

Video Profile Profile Off, 
SD MPEG2 Main Profile Main Level 4:2:0 8 bit, 
SD MPEG2 422 Profile Main Level 4:2:2 8 bit, 
SD H.264 Main Profile Level 3.0 4:2:0 8 bit, 
SD H.264 High Profile Level 3.0 4:2:0 8 bit, 
SD H.264 High Profile Level 3.1 4:2:0 8 bit, 
SD H.264 Hi422 Profile Level 3.1 4:2:2 8 bit, 
SD H.264 High Profile Level 3.1 4:2:2 10 bit, 
HD MPEG2 Main Profile High Level 4:2:0 8 bit, 
HD MPEG2 4:2:2 Profile High Level 4:2:2 8 bit, 
HD H.264 Main Profile Level 4.0 4:2:0 8 bit, 
HD H.264 High Profile Level 4.0 4:2:0 8 bit, 
HD H.264 High Profile Level 4.1 4:2:0 8 bit, 
HD H.264 Hi422 Profile Level 4.1 4:2:2 8 bit, 
HD H.264 Hi422 Profile Level 4.1 4:2:2 10 bit 

HD p50/60 H.264 High Profile Level 4.2 4:2:0 
8 bit 

HD p50/60 H.264 High422 Profile Level 4.2 4:2:2 
8 bit 

HD p50/60 H.264 High422 Profile Level 4.2 4:2:2 
10 bit  

Sets the encoder profile. The profile will also affect the 
allowed bit rate range. 

Profile for SD input Profile Off, 
SD MPEG2 Main Profile Main Level 4:2:0 8 bit, 
SD MPEG2 422 Profile Main Level 4:2:2 8 bit, 
SD H.264 Main Profile Level 3.0 4:2:0 8 bit, 
SD H.264 High Profile Level 3.0 4:2:0 8 bit, 
SD H.264 High Profile Level 3.1 4:2:0 8 bit, 
SD H.264 Hi422 Profile Level 3.1 4:2:2 8 bit, 
SD H.264 High Profile Level 3.1 4:2:2 10 bit, 

The profile to set when an SD input is detected on the SDI 
input. Visible only if Input Detection is set to Auto Detect 
and Configure. If this option is visible, the Video Profile 
cannot be set manually. 

Profile for HD input Profile Off, 
SD MPEG2 Main Profile Main Level 4:2:0 8 bit, 
SD MPEG2 422 Profile Main Level 4:2:2 8 bit, 
SD H.264 Main Profile Level 3.0 4:2:0 8 bit, 
SD H.264 High Profile Level 3.0 4:2:0 8 bit, 
SD H.264 High Profile Level 3.1 4:2:0 8 bit, 
SD H.264 Hi422 Profile Level 3.1 4:2:2 8 bit, 
SD H.264 High Profile Level 3.1 4:2:2 10 bit, 
HD MPEG2 Main Profile High Level 4:2:0 8 bit, 
HD MPEG2 4:2:2 Profile High Level 4:2:2 8 bit, 
HD H.264 Main Profile Level 4.0 4:2:0 8 bit, 
HD H.264 High Profile Level 4.0 4:2:0 8 bit, 
HD H.264 High Profile Level 4.1 4:2:0 8 bit, 
HD H.264 Hi422 Profile Level 4.1 4:2:2 8 bit, 
HD H.264 Hi422 Profile Level 4.1 4:2:2 10 bit 

The profile to set when an HD input is detected on the HD-
SDI input. Visible only if Input Detection is set to Auto 
Detect and Configure. If this option is visible, the Video 
Profile cannot be set manually. 

Resolution 352 x 576, 480 x 576, 528 x 576, 544 x 576, 640 
x 576, 704 x 576, 720 x 576, 352 x 480, 480 x 
480, 528 x 480, 544 x 480, 640 x 480, 704 x 
480, 720 x 480, 1280 x 720, 1440 x 1080, 1920 
x 1080 

Defines the horizontal and vertical resolution of the 
encoded video. The available options depend on the 
values set for Video Input Format and Video Profile. 

Video Bit Rate The valid bit rate range depends on the selected 
video profile. 

Defines the bit rate to be used by the compressed video 
component. If Bit Rate Tracking Mode is set to Maximize 
Video for the Transport Stream that contains the video 
component, and the Bit Rate Weighting of the component 
is set to other than Fixed or Minimal, this field is read 
only. 

Buffer Mode CBR Constant Bit Rate operation. 

Low Delay Reduced encode delay achieved by removing pre-
processing functions. Bit Rate, GOP structure and GOP 
length impact the delay. The IP GOP structure will give 
lowest delay, but with reduced quality. 
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Parameter Values Description 

Mega Low Delay Encode delay reduced further by removing frame-sync in 
pre-processing. Bit Rate, GOP structure and GOP length 
impact the delay. The IP GOP structure will give lowest 
delay, but with reduced quality.  

Stripe Refresh Available if the AVP/SWO/CE-x/Stripe license is enabled.  
Provides sub 100ms end to end latency for H.264 
operation when combined with the appropriate MediaKind 
RX8200. 

Stripe Refresh (+ Audio Encode) Available if the AVP/SWO/CE-x/Stripe license is enabled.  
Allows MPEG-1 LayerII audio encode in Stripe Refresh 
This increases the latency by 1 frame compared to Stripe 
Refresh. 

Fixed Latency Provides a fixed latency (~650ms) across the full bit rate 
range of the selected H.264 video profile. 

Aspect Ratio 16:9, 4:3 Does not affect the video encoding but rather indicates 
what the desired aspect ratio for the decoded picture (not 
the pixel). If no other mechanism such as WSS in the VBI 
is used, the video output image will use this aspect ratio. 

GOP Length 4 to 250 Defines the nominal distance in steps of video frames 
between two consecutive I frames in the encoded bit-
stream. 

GOP Structure IP, IBP, IBBP, IBBBP, IBBBBBBBP Sets the number of B frames between reference frames. 
IBBBBBBBP can only be used for 720p video format 
encoded with a H.264 video profile. 

Closed GOPs Off, On Enables or disables the usage of Group of Pictures in 
which the predicted frames can have their reference from 
outside the group. 

Scene Cut Detection On, Off When enabled, minimizes the negative effect the scene 
changes have on the bit rate by inserting an I-Frame when 
a change is detected. It also affects the GOP length. 

Delay  Displays the actual video encoding delay. Read only 
parameter. 

Stills Detection Off, Intelligent, Clamp Detects if the video is a still picture, and adjusts the 
encoded video bit rate accordingly when operating in VBR 
mode. 

Film Mode Off, On Sets encoding parameters that give better image quality 
for film like sources. Available only for frame rates of 29.97 
or 59.94 Hz when the resolution is set to other than SIF. 

Inloop Filter High, Normal, Low, Very Low, Auto Sets the characteristics of the filter placed in the feedback 
loop of the encoder. Applying the filter to the picture can 
increase picture sharpness. 

Max CABAC Bit Rate Depends on the Video Profile set. Controls the bit rate at which the encoder switches from 
CABAC to CAVLC entropy coding. 

SEI Encapsulation 
Mode 

Combined, Mediaroom Defines how the SEi messages are formatted in the picture 
header for H264. For combined, all the different types of 
messages (for example AFD) are bundles into one NAL 
packet. For Mediaroom each type of message is put into 
its own NAL packet. This was done for STB compatibility 
issues 

3D Mode Off, Side by Side Frame Packing, Top and 
Bottom Frame Packing;  Frame Sync Delay in 
SEI 

Configures output to include 3D related information in the 
SEI messages. The frame sync delay in SEI message is 
only available for CE-x with CE/SWO/CE-x/H264, 
CE/SWO/CE-x/HD and CE/SWO/CE-x/3D licenses. 

Video Output  
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The following parameters are available on the Output  tab of the Properties  widget on the 

Service Configuration  page when a video component is selected in the Out puts  widget. The 
same parameters can be accessed through the Advanced/Video/Video 1/Vide o/Main 
Video/Stream Output  menu on the front panel.  

Table 5.51  Video Output Parameters  

Parameter Values Description 

Embedded PCR Off, On, On (Picture Header) Sets if the PCR is embedded within the video or is on a 
separate PID. 

When set to Off, there must be a separate PCR 
component in the service which can have a user defined 
PID. 

When set to On, the PCR PID will be the same as the 
associated component. A PCR will be included for every I 
picture. 

The On (Picture Header) option is provided in MPEG-2 
encoding only as an option to support some legacy 
equipment that required a PCR on every picture. This 
should only be used when absolutely necessary. 

Copyright Off, On Sets the copyright flag in the elementary stream header. 

Original Off, On Sets the original flag in the elementary stream header. 

PES Packet Per GOP, Picture Determines how PES packets shall be generated. The 
Picture option is only available if MPEG 2 encoding is 
used. 

AU Information Ctrl Off, RAI, RAI and AU Info Controls insertion of Private Data in the TS Adaptation 
Field for video Access Units (AU). This can be: Random 
Access Indicator (RAI), ETSI 101 154 (AU info), Time 
Code (TC) and Additional Info (Encoding info and 
BroadcasterID). 

Elementary Stream 
Stuffing 

Off, On Control for the Elementary stream level to maintain the 
configured bit rate. 

AR Signaling Output 
Control 

Off, AFD Only, AFD and Bar Data Controls what Aspect Ratio signaling will be put into video 
user_data. AFD sources are: SMPTE 2016, Video Index, 
WSS-AFD/WSS, user set Aspect Ratio. Bar Data is only 
SMPTE 2016. 

AR Signalling Location Sequence Hdr, Picture Hdr, Seq And Pic Hdrs Specifies which header shall contain the aspect ratio 
signaling information. 

TC Output Location SeqHdr, SeqAndPicHdr, Off, SEIMsg Determines the locations used to transmit Time code 
information in the stream. Time code can be carried by the 
sequence header, the sequence and picture headers for 
MPEG-2 or a SEI message for H.264. 

Video Component  

The following parameters are available on the Component  tab of the Properties  widget on the 
Service Configuration  page when a video component is selected in the Outputs  widget.  The 
same parameters can be accessed through the Output/<output name>/Transport Stream 
ID: <n>/Service List/<service name>/Component List/Slot  <x> Video Stream on PID 
<y>  menu on the front panel.  

Table 5.52  Video Component Parameters  

Parameter Values Description 

PID 32 to 8190 Sets the packet identifier associated with the component. 

Bit Rate Weighting Fixed, Minimum, 2 to 20 Specifies the weight associated to the component in the 
Bit Rate Tracking algorithm. 

Master TS Off, On Sets the master Transport Stream for the component.. 
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Vertical Blanking Interval / Ancillary Data  

The following parameters are available on the VBI  tab of the Properties  widget on the Service  
Configuration  page when a video stream is s elected in the Outputs  widget. The same 
parameters can be accessed through the Advanced/CE - x/Video/Video 1/Input/VBI 
Extraction  menu on the front panel.  

Table 5.53 Vertical Blanking Interval / Ancillary Data Parameters 

Parameter Values Description 

Enable VBI Pass-thru 
Mode 

Off, On Enable Pass-thru of VBI, ANC and Teletext data from 
specified PIDs, instead of extracting them from SDI. Read 
only parameter. Not supported in this release. 

Description Control 

VBI Descriptor Mode Standard, Legacy, Philips, User The source for Closed Captions data encoded as part of 
the Video Stream (only applicable when Video Frame Rate 
is 29.97 Hz) 

VBI Data Descriptor 
Insertion 

Off, On Controls if the VBI Data Descriptor is inserted into the 
PMT. Available only if VBI Descriptor Mode is set to 
User. 

VBI Teletext 
Descriptor Insertion 

Off, On Controls if the VBI Teletext Descriptor is inserted into the 
PMT. Available only if VBI Descriptor Mode is set to 
User. 

Teletext Descriptor 
Insertion 

Off, On Controls if the Teletext Descriptor is inserted into the PMT. 
Available only if VBI Descriptor Mode is set to User. 

Proprietary Descriptor 
Insertion 

Off, On Controls if the Legacy Proprietary Descriptor is inserted 
into the PMT. Available only if VBI Descriptor Mode is set 
to User. 

Aspect Ratio (AR) Signaling 

Video Index Off, On (Default), On (User) Controls the extraction of Video Index (and thus whether 
Video Index can be used as source of AR info).  

Default: The default lines will be set to decode Video Index 
(11/324 in 25Hz, 14/277 in 29.97 Hz) 

User: The User defines the lines used to decode Video 
Index. 

Video Index Field 1 10 to 22 Specifies which line contains the video index in field 1. 

Video Index Field 2 10 to 22 Specifies which line contains the video index in field 2. 

SMPTE 2016 Off, On Controls whether SMPTE 2016 data can be used as a 
source for AR info. 

AFD Sustain Indefinitely, Default after Timeout, Off after 
Timeout 

Control what AFD code goes out when AFD is lost at input. 

Indefinitely: Maintains previously received AFD code 
indefinitely. 

Default after Timeout: Maintains previously received AFD 
code for period specified in Sustain Timeout, then drop to 
default, i.e. code 1000. 

Off after Timeout: Maintains previously received AFD code 
for period specified in Sustain Timeout, then switch AFD 
off. 

AFD Sustain Timeout 0 to 5,10, 20, 50, 100, 120 Control how long previous AFD code is maintained. Zero 
means drop to default immediately on loss. 

AFD Action on 
Reserved Codes 

Pass Through, Code as 0000 Specify what code is passed to the output when reserved 
AFD codes are received at the input. 

Pass Through: Passes code through unchanged. 

Code as 0000: Changes code to 0000. 
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Parameter Values Description 

Closed Captions 

Closed Captions 
Source 

Off, VBI lines, SMPTE334 The source for Closed Captions data encoded as part of 
the Video Stream. Only applicable when frame rate is 
29.97 Hz. 

Timecode 

TC Mode Off, External, Zero on Loss, External, Freewheel 
on Loss, Internal 

Controls what mode the Time code (TC) is working in, 
either Off, external source or internally generated. Also 
sets what happens on loss of external source (zero or 
freewheel). 

TC External Source Auto, ANC VITC1, ANC VITC2, ANC LTC, VBI 
VITC 

Controls the external source of Time Code. Auto will select 
the first source present in order of the drop down list. 

TC Dropframes Off, On, Auto Only in 525 line operation controls if Time Code takes 
account of drop frames or not. Auto configures to external 
source, or to ON for internal source. 

Broadcaster ID 

Reception Timeout  Timeout in seconds for reception of Source ID from input 
(RP207). 

Insertion Timeout  Timeout in seconds for insertion of default source ID. 

Broadcaster ID Mode Off, Auto, Default Only, Source Only Gives what to insert as a broadcaster ID. 

Default Servicename  The default service name to be used. 

Broadcaster ID Source No, Input, Default Indicates if the Broadcaster ID is derived from the input, 
the default or is invalid. 

Broadcaster ID  The Broadcaster ID that is currently being inserted into the 
output stream. 

Generic ANC 

Generic ANC 
Extraction 

Off, On Controls whether Generic ANC is extracted from the SDI 
stream or not as per SMPTE 2038-2008. 

Max ANC Bit Rate 100 to 2000 kbps The maximum data rate of the Generic ANC data output. 

Field 1 

VBI Line 9 - VBI Line 
22 

Off, Closed Caption Specifies the content in the respective VBI lines. Set to Off 
if the line in the incoming video does not carry any 
information, Closed Caption for closed caption information. 
Visible for 480i (525-line) input streams. 

VBI Line 6 - VBI Line 
23 

Off, VITC, WSS, WSS-AFD, Teletext System B Specifies the content in the respective VBI lines. Set to Off 
if the line in the incoming video does not carry any 
information, VITC for Time Code, WSS for Wide Screen 
Signaling, WSS-AFD for Active Format Detection and 
Teletext System B for Teletext. Visible for 576i (625-line) 
input streams. 

Field 2 

VBI Line 272 - VBI 
Line 285 

Off, Closed Caption Specifies the content in the respective VBI lines. Set to Off 
if the line in the incoming video does not carry any 
information, Closed Caption for closed caption information. 
Visible for 480i (525-line) input streams. 

VBI Line 319 - VBI 
Line 336 

Off, VITC, WSS, WSS-AFD, Teletext System B Specifies the content in the respective VBI lines. Set to Off 
if the line in the incoming video does not carry any 
information, VITC for Time Code, WSS for Wide Screen 
Signaling, WSS-AFD for Active Format Detection and 
Teletext System B for Teletext. 
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Input Detection  

The CE -x VCM supports vide o input detection as described in Chapter 3 , Getting started: How to 
Configure and Use Input Detection.  

5.5.3.3.2  Audio Stream Configuration  

Audio Input  

The following parameters are available on the Input  tab of the Properties  widget on the Service 

Configuration  pag e when an audio component is selected in the Outputs  widget. The same 
parameters can be accessed through the Advanced/CE - x/Audio Module/Audio <n>/Input  
menu on the front panel.  

Table 5.54  Audio Input Parameter s 

Parameter Values Description 

Input Format Uncompressed (LPCM), MPEG Layer II, Dolby 
Digital, Dolby E, AAC 

Sets the input format used by the audio encoder. 

Input Source Off, Mute, Test Tone, Embedded 1 to 8, Input 1 -
4 

Sets the source used by the audio encoder. No input is fed 
to the encoder if Off is selected. Mute mutes the incoming 
audio and encodes silence. Test Tone encodes an 1 kHz 
test tone, Embedded 1 to 8 sets the source to an SDI 
embedded audio stream. Input 1-4 are for the digital 
inputs. 

Output On Audio Loss No PID, Silence Specifies the action to take when input is Lost. No PID is 
for dropping the audio PID from the stream, Silence is for 
encode silence. 

NOTE: When No PID is selected, the reference to the PID 
is not removed from the Program Map Table, so a 
Transport Stream analyzer will indicate a ghost PID in the 
output Transport Stream. 

Source Switchout Off, Mute, Test Tone, Embedded 1 to 8, Input 1 -
4 

Specifies which input to output to the reference output on 
the 15-way D-type audio connector. 

Audio Encoding  

The following parameters are available on the Encode  tab of the Properties  widget on the 
Service Configuration  page when an audio component is selected in the Outputs  widget. The 
same parameters can be accessed through the Advanced/CE -x /Audio Module/Audio 
<n>/Encode  menu on the front panel.  

Table 5.55  Audio Encoding Standards  

Parameter Options Description 

Coding Standard MPEG Layer 2 MPEG Layer 2 Encode(More than two channel pairs 
require the /SWO/M1L2 license) 

Dolby Digital Dolby Digital encode, requires CE/SWO/DOLBYAC3 
license.  

AAC-LC AAC-LC encoding, requires CE/SWO/AAC license. 

HE-AAC HE-AAC or HE-AAC v2encoding, requires CE/SWO/AAC 
license. 

Pass-thru Pass-thru of the input 

Audio Description Service MPEG-1 Layer II encode of a mono audio track that 
describes action in the video plus a control track. 
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Table 5.56  MPEG Layer 2 Parameters  

Parameter Values Description 

Bit Rate 32, 48, 56, 64, 80, 96, 112, 128, 160, 192, 224, 
256, 320, 384 

Bit Rate of the audio stream 

Coding Mode 1/0 (Left - input), 1/0 (Right - input), 1/0 (L+R)/2, 
1+1 (L/Ch1, R/Ch2), 2/0, 2/0 (Joint), Phase 
Aligned Audio (6 Cannels), Phase Aligned Audio 
(8 Cannels) 

Specifies what channel configuration to use for encoding.. 

Embedded PCR On, Off Controls whether PCR is to be embedded in the audio 
PES. 

Au Information Cont Off, AU Info Controls the insertion of private data in the adaptation unit 
of the audio access units (AU). AU Info is defined in ETSI 
TR 101 154. Only AU_PTS is present for audio 

Advanced 

Lip Sync Offset -500 to 500 ms Configures a delay to the audio to improve A/V 
synchronization. 

Gain -6 to 6dB Sets the gain in dB for the audio stream. 

Language  The language of the stream when not in dual mono (1+1) 
mode. 

Language (Left)  The language of the left channel when in dual mono (1+1) 
mode. 

Language (Right)  The language of the right channel when in dual mono 
(1+1) mode. 

User Language 1  A custom three-character language code when User 
Language 1 is set in any of the language fields. 

User Language 2  A custom three-character language code when User 
Language 2 is set in any of the language fields. 

MPEG Version MPEG1, MPEG2 Configures if MPEG-1 or MPEG-2 to be ignaled. 

Copyright Off, On Indicates if the material is copyright protected. 

Original Off, On Indicates if source is the original or a copy 

De-emphasis Off, 50/15us, CCITT J.17 To meet the MPEG-1 Layer 2 encoding algorithm 
specification the audio must not have pre-emphasis 
applied. If the input signal does have pre-emphasis 
applied, a de-emphasis filter must be applied prior to 
encoding. 

Table 5.57  Dolby Digital Parameters  

Parameter Values Description 

Bit Rate 56, 64, 80, 96, 112, 128, 160, 192, 224, 256, 
320, 384, 448, 512, 576, 640 

Bit Rate of the audio stream. The available options depend 
on the selected coding mode. 

Coding Mode 1/0 (Left ï input), 1/0 (Right ï input), 1/0 (L+R)/2, 
2/0, 3/2L (5.1 Surround) 

Specifies what channel configuration to use for encoding. 

Metadata Controls 
Coding Mode 

Off, On Override default coding mode with coding mode indicated 
in decoder program configuration or live metadata (if 
present). 

Metadata source type Embedded/Decoded Auto, Serial Port (Program 
1 to 8) 

Selects where live metadata comes from. 

Metadata override 
type 

None, All, Compression Profile, Dialogue 
Normalization, Comp Profile and Dial Norm 

Defines which metadata parameters to override. 
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Parameter Values Description 

Metadata Reversion 
Mode 

Last Used, Preset Determines which metadata is used upon loss of live 
metadata. 

Metadata preset type 1 to 8 Defines which metadata preset to use if Preset is selected 
for Metadata Reversion Mode. 

Embedded PCR On, Off Controls whether PCR is to be embedded in the audio 
PES. 

Au Information Cont Off, AU Info Controls the insertion of private data in the adaptation unit 
of the audio access units (AU). AU Info is defined in ETSI 
TR 101 154. Only AU_PTS is present for audio 

Advanced 

Lip Sync Offset -500 to 500 ms Configures a delay to the audio to improve A/V 
synchronization. 

Gain -6 to 6dB Sets the gain in dB for the audio stream. 

Language  The language of the stream. 

User Language 1  A custom three-character language code when User 
Language 1 is set in the Language field. 

User Language 2  A custom three-character language code when User 
Language 2 is set in the Language field. 

Table 5.58  AAC-LC Parameters  

Parameter Values Description 

Bit Rate 32, 48, 56, 64, 80, 96, 112, 128, 160, 192, 224, 
256, 320, 384, 448, 512 

Bit Rate of the audio stream. The available options depend 
on the selected coding mode. 

Coding Mode 2/0, 3/2L (5.1 Surround) Specifies what channel configuration to use for encoding. 

Embedded PCR On, Off Controls whether PCR is to be embedded in the audio 
PES. 

Au Information Cont Off, AU Info Controls the insertion of private data in the adaptation unit 
of the audio access units (AU). AU Info is defined in ETSI 
TR 101 154. Only AU_PTS is present for audio 

Encapsulation MPEG2 ADTS, MPEG4 LATM/LOAS Specifies the encapsulation used for transmitting AAC 
content. It can be either MPEG-2 Audio Data Transport 
Stream or MPEG-4 Low Overhead Audio Stream based on 
MPEG-4 Low Overhead Audio Transport Multiplex. 

TNS (Temporal Noise 
Shaping) 

Off, On Turns noise shaping on or off. 

Advanced 

Lip Sync Offset -500 to 500 ms Configures a delay to the audio to improve A/V 
synchronization. 

Gain -6 to 6dB Sets the gain in dB for the audio stream. 

Language  The language of the stream. 

User Language 1  A custom three-character language code when  User 
Language 1 is set in the Language field. 

User Language 2  A custom three-character language code when User 
Language 2 is set in the Language field. 
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Table  5.59  HE-AAC Parameters  

Parameter Values Description 

Bit Rate 16, 24, 32, 48, 56, 64, 80, 96, 112, 128, 160, 
192, 224, 256 

Bit Rate of the audio stream. The available options depend 
on the selected coding mode. 

Coding Mode 2/0, 3/2L (5.1 Surround) Specifies what channel configuration to use for encoding. 

Embedded PCR On, Off Controls whether PCR is to be embedded in the audio 
PES. 

Au Information Cont Off, AU Info Controls the insertion of private data in the adaptation unit 
of the audio access units (AU). AU Info is defined in ETSI 
TR 101 154. Only AU_PTS is present for audio 

Encapsulation MPEG2 ADTS, MPEG4 LATM/LOAS Specifies the encapsulation used for transmitting AAC 
content. It can be either MPEG-2 Audio Data Transport 
Stream or MPEG-4 Low Overhead Audio Stream based on 
MPEG-4 Low Overhead Audio Transport Multiplex. 

TNS (Temporal Noise 
Shaping) 

Off, On Turns noise shaping on or off. 

SBR Signalling Explicit, Implicit Specifies how Spectral Band Replication is signaled. 

Advanced 

Lip Sync Offset -500 to 500 ms Configures a delay to the audio to improve A/V 
synchronization. 

Gain -6 to 6dB Sets the gain in dB for the audio stream. 

Language  The language of the stream. 

User Language 1  A custom three-character language code when User 
Language 1 is set in the Language field. 

User Language 2  A custom three-character language code when User 
Language 2 is set in the Language field. 

Table 5.60  Pass- thru Paramet ers 

Parameter Values Description 

Embedded PCR On, Off Controls whether PCR is to be embedded in the audio 
PES. 

Au Information Cont Off, AU Info Controls the insertion of private data in the adaptation unit 
of the audio access units (AU). AU Info is defined in ETSI 
TR 101 154. Only AU_PTS is present for audio. 

Advanced 

Lip Sync Offset -500 to 500 ms Configures a delay to the audio to improve A/V 
synchronization. 

Gain -6 to 6dB Sets the gain in dB for the audio stream. 

Language  The language of the stream. 

User Language 1  A custom three-character language code when User 
Language 1 is set the Language field. 

User Language 2  A custom three-character language code when User 
Language 2 is set in the Language field. 

Table 5.61  Audio Description Service Parameters  

Parameter Values Description 

Bit Rate 64 Bit Rate of the audio stream. 
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Parameter Values Description 

Coding Mode 1/0 (Left ï input) Specifies what channel configuration to use for encoding. 

Embedded PCR On, Off Controls whether PCR is to be embedded in the audio 
PES. 

Au Information Cont Off, AU Info Controls the insertion of private data in the adaptation unit 
of the audio access units (AU). AU Info is defined in ETSI 
TR 101 154. Only AU_PTS is present for audio 

Advanced 

Lip Sync Offset -500 to 500 ms Configures a delay to the audio to improve A/V 
synchronization. 

Gain -6 to 6dB Sets the gain in dB for the audio stream. 

Language  The language of the stream. 

User Language 1  A custom three-character language code when User 
Language 1 is set in the Language field. 

User Language 2  A custom three-character language code when User 
Language 2 is set in the Language field. 

Audio Component  

The parameters listed in the table below are available on the Component  tab of the Proper tie s  
widget on the Service Configuration  page when an audio component is selected in the Outputs  
widget. The same parameters can be accessed through the Output/<output  name>/Transport 
Stream ID: <n>/Service List/<service name>/Component List/<component nam e>  
menu on the front panel.  

Table 5.62  Audio Component Parameters  

Parameter Values Description 

PID 32 to 8190 Sets the packet identifier associated with the component. 

Bit Rate Weighting Fixed Specifies the weight associated to the component in the 
Bit Rate Tracking algorithm. For audio stream, this is Fixed 
and read only. 

Dolby Metadata Presets  

Four custom Dolby Metadata Presets can be configured in the Advanced Setup tab of the Device 
Configuration page. T o s et the preset options, in the Advanced Video Processor Settings drill down 
to Encoder > Slots > Slot <n> -  CE-x >CE -x > Audio Module > Dolb y Metadata Presets, and 
select the preset you want to modify. Alternatively, the settings can be reached through t he front 
panel under Advanced/CE -x/Audio Module/Dolby Metadata Presets . Any of these presets can then 
be applied to any audio channel encoding  audio in the Dolby Digital format. The table lists the 
parameters for each preset.  

Table 5.63  Dolby Metadata Preset Parameters  

Parameter Values Description 

Preset name  Name of the preset (for user information) 

Dialogue 
normalization level 

-31 to -1 dB Used by a decoder to determine the level of adjustment 
required to achieve the set level. 
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Parameter Values Description 

Bitstream mode Main audio service: complete main, music and 
effects, Associated service: visually impaired, 
Associated service: hearing impaired, 
Associated service: dialogue, Associated 
service: commentary, Associated service: 
emergency, Associated service: visually 
impaired, Associated service: karaoke/voiceover 

Flags the type of service in the bitstream. 

Line mode 
compression profile 

None, Film Standard, Film Light, Music 
Standard, Music Light, Speech 

Alters the dynamic range for line output. 

RF mode compression 
profile 

None, Film Standard, Film Light, Music 
Standard, Music Light, Speech 

This alters the dynamic range for RF output. The overall 
level is raised by 11dB. 

Center mix level 0.707 (-3.0 dB), 0.595 (-4.5 dB), 0.500 (-6.0 dB) Indicates the downmix level when there is no centre 
speaker. This is applied to left and right channels only. 

Surround mix level 0.707 (-3.0 dB), 0.500 (-6.0 dB), 0 (-inf dB) Surround downmix level for the front left and right 
channels when consumer has no surround speakers. 

Dolby Surround mode Not Indicated, Not Encoded, Encoded Flags if a two channel encoded stream contains 
information for a Dolby Pro-logic decode (Lt/Rt) 

Audio production 
information exists 

Off, On This indicates whether the Mixing Level and Room Type 
parameters exist within the bit-stream. 

Mixing level 80 to 111 dB Indicates the acoustic sound pressure level of the dialogue 
level during the final audio mixing session. 

Room type Not indicated, Large room X curve monitor, 
Small room flat monitor 

Type and calibration of the mixing room used for the final 
audio mixing session. 

Copyright flag Off, On Indicates if the material is copyright protected 

Original bitstream flag Off, On Indicates if source is the original or a copy 

Enable extended 
bitstream information 

Off, On Flags if additional information is available for downmixing. 

Preferred downmix 
mode 

Not indicated, Lt/Rt downmix preferred, Lo/Ro 
downmmix preferred 

Indicates if the producer would prefer a Lt/Rt or a Lo/Ro 
downmix. Can be over-ridden by the decoder. 

Lt/Rt center mix level 1.414 (+3.0 dB), 1.189 (+1.5 dB), 1.000 (0 dB), 
0.841 (-1.5 dB), 0.707 (-3.0 dB), 0.595 (-4.5 dB), 
0.500 (-6.0 dB), 0 (-inf dB) 

Indicates the required level reduction of the center channel 
when mixed with the L& R channels for a Lt/Rt downmix. 
Similar to 'Center mix level'. 

Lt/Rt surround mix 
level 

0.841 (-1.5 dB), 0.707 (-3.0 dB), 0.595 (-4.5 dB), 
0.500 (-6.0 dB), 0 (-inf dB) 

Indicates the required level reduction of the surround 
channels when mixed for a Lt/Rt downmix. Similar to 
Surround mix level'. 

Lo/Ro center mix level 0.841 (-1.5 dB), 0.707 (-3.0 dB), 0.595 (-4.5 dB), 
0.500 (-6.0 dB), 0 (-inf dB) 

Indicates the required level reduction of the center channel 
when mixed with the L& R channels for a Lo/Ro downmix. 
When present this replaces the value set for the 'Center 
mix level' 

Lo/Ro surround mix 
level 

0.841 (-1.5 dB), 0.707 (-3.0 dB), 0.595 (-4.5 dB), 
0.500 (-6.0 dB), 0 (-inf dB) 

Indicates the required level reduction of the center channel 
when mixed for Lo/Ro downmix. When present this 
replaces the value set for the 'Surround mix level'. 

Dolby Surround EX 
mode 

0.841 (-1.5 dB), 0.707 (-3.0 dB), 0.595 (-4.5 dB), 
0.500 (-6.0 dB), 0 (-inf dB) 

Flags if the stream has been encoded in Surround Ex. 
Only used if surround channels are present. 

A/D converter type Standard, HDCD Indicates type of A/D conversion used. 

Digital de-emphasis Off, Auto, On To meet the Dolby Digital encoding algorithm specification 
the audio must not have pre-emphasis applied. If the input 
signal does have pre-emphasis applied, a de-emphasis 
filter must be applied prior to encoding. 
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Parameter Values Description 

DC high pass filter 
enable 

Off, On Removing the DC component can lead to more efficient 
encoding, but there is a risk that signals that do not reach 
100% PCM may exceed this after filtering and therefore 
must be clipped. 

Bandwidth low-pass 
filter enable 

Off, On Remove high frequency signals before encoding. The filter 
removes frequencies that would not normally be encoded. 

Low-frequency effects 
low pass filter enable 

Off, On Apply a 120 Hz low pass filter prior to an encode. Should 
only be switched off if it is known that there are no 
frequencies above 120 Hz. 

Surround attenuation 
enable 

Off, On Attenuate surround channels by 3 dB before encoding. 
Theatrical and consumer mixing rooms use different levels 
for the surround channels, and this can be used to 
compensate. 

Surround phase shift 
enable 

Off, On Apply a phase shift of 90 degrees to the surround 
channels. This simplifies the decode process for producing 
a 'Lt/Rt' downmix. 

5.5.3.3.3  Splicing Stream Configuration  

Splicing  

The following parameters are available on the Splicing  tab of the Properties  widget on the 
Service Configuration  page when an SCTE 35 stream is selected in the Outputs  widget. The 
same  parameters can be accessed through the Advanced/CE -x/Video/Vide o 1/Video/Main 
Video/Splicing  menu on the front panel.  

Table 5.64  Splicing Parameters  

Parameter Values Description 

Splicing Control Off, On VANC Message Only, On VANC, On IP Enables splice points to be set in the video stream upon 
reception of a SCTE 104 message and determines the 
insertion point. 
To enable splicing, a splice point insertion license 
(CE/SWO/DPI) is needed. 

Splice Null Insertion Off, On Used to determine the insertion of NULL SCTE 35 
messages into the output stream if no messages have 
been sent for 500ms. 

Audio Splicing Off, On Used to determine if audio is manipulated at the point that 
the video splice occurs. 

AS Index Control Don't Care, Use 1, Use 1 + 2 Only available when Splicing Control is set to On VANC 
Message Only. 

If set to Donôt Care the AVP will create SCTE 35 output 
regardless of the source Automation System. 

If set to Use 1 the AVP will create SCTE 35 output only for 
incoming SCTE 104 whose AS Index matches the setting 
in AS Index 1. 

If set to Use 1 + 2 the AVP will create SCTE 35 output only 
for incoming SCTE 104 messages whose AS Index 
matches either the setting in AS Index 1 or the setting in 
AS Index 2. 

DPI PID Index Control Don't Care, Use 1, Use 1 + 2 Determines how many values of DPI PID Index are 
compared against the incoming SCTE 104 message. 
Available only when Splicing Control is set to On VANC 
Message Only. 

AS Index 1 0 to 255 The AS index used if AS Index Control is set to Use 1 or 
Use 1 + 2. 

AS Index 2 0 to 255 The AS index used if AS Index Control is set to Use 1 + 2. 
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Parameter Values Description 

DPI PID Index 1 0 to 255 The DPI PID index used if DPI PID Index Control is set to 
Use 1 or Use 1 + 2. 

DPI PID Index 2 0 to 255 The DPI PID index used if DPI PID Index Control is set to 
Use 1 + 2. 

Splicing Component  

The following parameters are available on the Component  tab of the Properties  widget on the 
Service Configuration  page when an SCTE 35 stream is selected in the Outputs  widg et. The 
same parameters can be ac cessed through the Output/<output name>/Transport Stream 
ID: <n>/Service List/<service name>/Component List/<component name>  menu on the 
front panel.  

Table 5.65  Slicing Com pone nt Parameters  

Parameter Values Description 

PID 32 to 8190 Sets the packet identifier associated with the component. 

Bit Rate Weighting Fixed Specifies the weight associated to the component in the 
Bit Rate Tracking algorithm. For audio stream, this is Fixed 
and read only. 

5.5.3.3.4  Teletext Stream Configuration  

This section describes the parameters for setting up Teletext.  

Teletext  

This section gives the parameters that have an effect on how Teletext is transmitted.  

The following parameters are available on th e Te letext  tab of the Pr operties  widget on the 
Service Configuration  page when a Teletext stream is selected in the Outputs  widget. The 
same parameters can be accessed through the Advanced/CE -x/Video/Video 1/Input/VBI 
Extraction/Teletext  menu on the front pane l.  

Table 5.66  Teletext Parameters  

Parameter Values Description 

Teletext Source Off, OP-47 (Max 300 kb/s), VANC Teletext Controls whether Teletext is extracted from VANC or not 
and if it extracted, which encapsulation method (OP-47 or 
SMPTE 2031) to use. 

Teletext Packetisation Normal (ETS 300-472) - Data on Teletext 
Component, Legacy (ETS 301-775) - Data on 
VBI Component 

Controls how the Teletext data is packetized in to a 
component data stream. 

SMPTE2031 Max. No. 
Teletext  

3, 7, 11, 15, 36 Defines the maximum number of Teletext lines inserted. 
Available only if VANC Teletext is selected for Teletext 
Source. 

SMPTE2031 Teletext 
Present 

Yes, No Displays whether Teletext is found in the SDI stream. 
Available only if VANC Teletext is selected for Teletext 
Source. Read only parameter. 

Min # Teletext Packets 0 to 3 Defines the minimum number of Teletext packets 
generated per field, even if there is no Teletext data. 

PTS On Teletext Off, On Controls whether a PTS value is included in the output 
Teletext packets. 
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Parameter Values Description 

Teletext Descriptor Page List / Teletext Descriptor Page 

Teletext Page Type Off, Initial Page, Subtitle Page, Additional 
Information Page, Programme Schedule Page, 
Heading Impaired Subtitle Page 

The page type of the Teletext descriptor. 

Teletext Page Number  The page number for the page to be set. 

Teletext Page 
Language 

List of languages The language set for the Teletext descriptor. 

Teletext Component  

This section describes the parameters associated with  the component carrying Teletext data.  

The following parameters are available on the Component  tab of the Properties  widget on the 
Service Configuration  page when a Teletext stream is selected in the Outputs  widget. The 
same parameters can be accessed thro ugh the Output/<output name>/Transport Stream 
ID: <n>/Service List/<service name>/Component List/<component name>  menu on the 
front panel.  

Table 5.67  Teletext Component Parameters  

Parameter Values Description 

PID 32 to 8190 Sets the packet identifier associated with the component. 

Bit Rate Weighting Fixed Specifies the weight associated to the component in the 
Bit Rate Tracking algorithm. For audio stream, this is Fixed 
and read only. 

5.5.3.3.5  VBI and ANC Stream Conf iguration  

This section describes the parameters available for setting up VBI and ANC streams.  

VBI and Ancillary Data  

This section gives the parameters that have an effect on what ancillary data is extracted and how 
the data is transmitted.  

The followin g pa rameters are available on the VBI  tab of the Properties  widget on the Service 
Configuration  page when an ANC stream is selected in the Outputs  widget. The same 
parameters can be accessed through the Advanced/CE - x/Video/Video 1/Input/VBI 
Extraction  menu  on the front panel.  

Table 5.68  VBI and Ancillary Data Parameters  

Parameter Values Description 

Enable VBI Pass-thru 
Mode 

Off, On Enable Pass-thru of VBI, ANC and Teletext data from 
specified PIDs, instead of extracting them from SDI. 
Read only parameter. Not supported in this release. 

Description Control 

VBI Descriptor Mode Standard, Legacy, Philips, User The source for Closed Captions data encoded as part of 
the Video Stream (only applicable when Video Frame 
Rate is 29.97 Hz) 

VBI Data Descriptor 
Insertion 

Off, On Controls if the VBI Data Descriptor is inserted into the 
PMT. Available only if VBI Descriptor Mode is set to 
User. 

VBI Teletext 
Descriptor Insertion 

Off, On Controls if the VBI Teletext Descriptor is inserted into 
the PMT. Available only if VBI Descriptor Mode is set 
to User. 
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Parameter Values Description 

Teletext Descriptor 
Insertion 

Off, On Controls if the Teletext Descriptor is inserted into the 
PMT. Available only if VBI Descriptor Mode is set to 
User. 

Proprietary Descriptor 
Insertion 

Off, On Controls if the Legacy Proprietary Descriptor is inserted 
into the PMT. Available only if VBI Descriptor Mode is 
set to User. 

Aspect Ratio (AR) Signalling 

Video Index Off, On (Default), On (User) Controls the extraction of Video Index (and thus whether 
Video Index can be used as source of AR info).  

Default: The default lines will be set to decode Video 
Index (11/324 in 25Hz, 14/277 in 29.97 Hz) 

User: The User defines the lines used to decode Video 
Index. 

Video Index Field 1 10 to 22 Specifies which line contains the video index in field 1. 

Video Index Field 2 10 to 22 Specifies which line contains the video index in field 2. 

SMPTE 2016 Off, On Controls whether SMPTE 2016 data can be used as a 
source for AR info. 

AFD Sustain Indefinitely, Default after Timeout, Off after Timeout Control what AFD code goes out when AFD is lost at 
input. 

Indefinitely: Maintains previously received AFD code 
indefinitely. 

Default after Timeout: Maintains previously received 
AFD code for period specified in Sustain Timeout, then 
drop to default, i.e. code 1000. 

Off after Timeout: Maintains previously received AFD 
code for period specified in Sustain Timeout, then 
switch AFD off. 

AFD Sustain Timeout 0 to 5,10, 20, 50, 100, 120 Control how long previous AFD code is maintained. 
Zero means drop to default immediately on loss. 

AFD Action on 
Reserved Codes 

Pass Through, Code as 0000 Specify what code is passed to the output when 
reserved AFD codes are received at the input. 

Pass Through: Passes code through unchanged. 

4 Code as 0000: Changes code to 0000. 

Closed Captions 

Closed Captions 
Source 

Off, VBI lines, SMPTE334 The source for Closed Captions data encoded as part of 
the Video Stream. Only applicable when frame rate is 
29.97 Hz. 

Timecode 

TC Mode Off, External, Zero on Loss, External, Freewheel on 
Loss, Internal 

Controls what mode the Time code (TC) is working in, 
either Off, external source or internally generated. Also 
sets what happens on loss of external source (zero or 
freewheel). 

TC External Source 5 Auto, ANC VITC1, ANC VITC2, ANC LTC, VBI VITC Controls the external source of Time Code. Auto will 
select the first source present in order of the drop down 
list. 

TC Dropframes Off, On, Auto Only in 525 line operation controls if Time Code takes 
account of drop frames or not. Auto configures to 
external source, or to ON for internal source. 

Broadcaster ID 

Reception Timeout  Timeout in seconds for reception of Source ID from 
input (RP207). 
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Parameter Values Description 

Insertion Timeout  Timeout in seconds for insertion of default source ID. 

Broadcaster ID Mode Off, Auto, Default Only, Source Only Gives what to insert as a broadcaster ID. 

Default Servicename  The default service name to be used. 

Broadcaster ID Source No, Input, Default Indicates if the Broadcaster ID is derived from the input, 
the default or is invalid. 

Broadcaster ID  The Broadcaster ID that is currently being inserted into 
the output stream. 

Generic ANC 

Generic ANC 
Extraction 

Off, On Controls whether Generic ANC is extracted from the 
SDI stream or not as per SMPTE 2038-2008. 

Max ANC Bit Rate 100 to 2000 kbps The maximum data rate of the Generic ANC data 
output. 

Field 1 

VBI Line 9 - VBI Line 
22 

Off, Closed Caption Specifies the content in the respective VBI lines. Set to 
Off if the line in the incoming video does not carry any 
information, Closed Caption for closed caption 
information. Visible for 480i (525-line) input streams. 

VBI Line 6 - VBI Line 
23 

Off, VITC, WSS, WSS-AFD, Teletext System B Specifies the content in the respective VBI lines. Set to 
Off if the line in the incoming video does not carry any 
information, VITC for Time Code, WSS for Wide Screen 
Signalling, WSS-AFD for Active Format Detection and 
Teletext System B for Teletext. Visible for 576i (625-
line) input streams. 

Field 2 

VBI Line 272 - VBI 
Line 285 

Off, Closed Caption Specifies the content in the respective VBI lines. Set to 
Off if the line in the incoming video does not carry any 
information, Closed Caption for closed caption 
information. Visible for 480i (525-line) input streams. 

VBI Line 319 - VBI 
Line 336 

Off, VITC, WSS, WSS-AFD, Teletext System B Specifies the content in the respective VBI lines. Set to 
Off if the line in the incoming video does not carry any 
information, VITC for Time Code, WSS for Wide Screen 
Signaling, WSS-AFD for Active Format Detection and 
Teletext System B for Teletext. 

ANC Component  

This section describes the parameters associated wit h the component carrying ancillary data.  

The following parameters are available on the Component  tab of the Properties  widget o n th e 
Service Configuration  page when an ANC stream is selected in the Outputs  widget. The same 
parameters can be accessed throug h the Output/<output name>/Transport Stream ID: 
<n>/Service List/<service name>/Component List/<component name>  menu on the 
fro nt p anel.  

Table 5.69  ANC component Parameters  

Parameter Values Description 

PID 32 to 8190 Sets the packet identifier associated with the component. 

Bit Rate Weighting Fixed Specifies the weight associated to the component in the 
Bit Rate Tracking algorithm. For audio stream, this is Fixed 
and read only. 
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5.5.3.3.6  PCR Stream Configuration  

The video encoding module can generate a separate PCR stream. The PCR stream contains timing 
reference that can be used for decoding  the  elementary streams included in the same service as 
the PCR stream itself. To use the PCR stream as  a timing reference for decoding, set the PCR PID 
parameter associated with the service to the PID assigned to the PCR stream.  

The following parameters a re a vailable in Properties  widget on the Service Configuration  page 

when a PCR Stream is selected in th e Outputs  widget. The same parameters can be accessed 
through the Output/<output name>/Transport Stream ID: <n>/Service List/<service 
name>/Component Lis t/Sl ot <m> Video 1 PCR stream on PID <n>  menu on the front 
panel.  

Table 5.70  PCR Stream Configuration Parameters  

Parameters Values Description 

PID 16 - 8190 The packet identifier assigned to packets carrying the 
program clock reference values. 

Bit Rate Weighting Fixed Not relevant for the PCR component. Read only 
parameter. 

5.5.3.4  CE- x Analogue VCM  

5.5.3.4.1  Video and VBI Stream Configuration  

Video Input and Pre - Processing  

The following parameters are available on the Input  tab of the Properties  widget on the Service 
Configuration  page when a video component is selected in the Outputs  widget. The same 
parameters can be accessed through the Advanced/CE - x Analogue/Video/Video1/Input  
menu on the front panel.  

Table 5.71  Video Input and Pre -Processing Parameters  

Parameter Values Description 

Video Input Lock Yes, No Shows whether there is a video lock to the format specified 
through the parameters below. Read only parameter. 

Source SDI The video will be sourced from the SDI/HD-SDI input on 
the rear panel. 

Analogue The video will be sources from the CVBS input on the rear 
panel. 

Bars An internally generated color bars test pattern will be used 
as the video source. 

Black An internally generated black test pattern will be used as 
the video source. 

Moving Object An internally generated moving object test pattern will be 
used as the video source. 

Slate A slate file uploaded by the user will be used as the video 
source. 

Input Detection Off, Auto Detect and Report, Auto Detect and 
Configure Video Profile Only, Auto Detect and 
Restore Saved Config 

Controls whether the format of the SDI input shall be 
automatically detected or what actions to take if a change 
is detected in the Input Video Format. 

Detected Video 
Standard 

Not Detected, SD 567i25, SD 480i29.97, HD 
720p50, HD 720p59.94, HD 1080i25, HD 
1080i29.97 

The detected video standard if Input Detection is set to 
other than Off. If the format is not detected or Input 
Detection is set to Off, it is set to Not Detected. Read only 
parameter. 
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Parameter Values Description 

Video Input Format SD 567i25, SD 480i29.97, HD 720p50, HD 
720p59.94, HD 1080i25, HD 1080i29.97 

Defines the expected video format on the SDI input or the 
video format used for encoding the test patterns. A change 
in the Video Input Format might result in a change in the 
Video Profile used for encoding. As from the current 
release down-conversion is supported, SD profiles can be 
selected for HD input formats. 

Output On Video Loss Freeze Frame, Freeze with text overlay Repeats the last good video frame on loss of video input. 
Text overlay is not supported in this release. 

Black, Black with text overlay Switches to a black test pattern on loss of video input. Text 
overlay is not supported in this release. 

Color Bars, Bars with text overlay Switches to a color bars test pattern on loss of video input. 
Text overlay is not supported in this release. 

No PID The video PID shall no longer be transmitted. The SI is not 
updated. 

Slate, Slate with text overlay A slate file uploaded by the user will be used as the video 
source. 

Ident Text  Overlay text to display on top of images. 

MCTF Off, Default, Strong, Stronger The amount of Motion Compensated Temporal Filtering 
done to improve image quality. 

Adaptive 
Preprocessing 

Off, On Adaptive Preprocessing analyses the incoming video to 
tries and identify areas of noise contained within the 
picture. A filter is then applied to those areas of the picture 
to remove the noise. Note applying the filter may remove 
detail from the picture and may make edges of objects 
appear soft or slightly blurred. 

For normal operation with high quality input video feeds it 
is recommended that this option is set to OFF. 

Bandwidth 30 to 100 % Sets the video horizontal bandwidth filter. 

Half Line Removal Off, On Enables or disables the removal of black half lines at the 
top of the picture by substituting video data from adjacent 
lines. The option is available when Video Input Format is 
set to SD 576i25. 

Logo 

Logo insertion Off, On Controls if logos are displayed or not. The file to use can 
be selected under Logo file. 

Logo file  The file to use as a logo. The selected file can be 
uploaded by selecting the Upload option. Not supported in 
this release. 

A fixed logo position? On, Off Controls whether to use the default position for overlaying 
the logo on the video. Not supported in this release. 

The X position of the 
logo 

 The position relative to left of the screen 0 .. (number of 
pixels per video line - logo width - 1). If an invalid 
position is specified, a logo display alarm will be 
generated. Displayed only if A fixed logo position? is set to 
Off. Not supported in this release. 

The Y position of the 
logo 

 The position relative to top of screen 0 .. (number of 
video lines - logo height - 1). If an invalid position is 
specified, a logo display alarm will be generated. 
Displayed only if A fixed logo position? is set to Off. Not 
supported in this release. 

HD to SD Video Down-conversion 

Default Aspect Ratio 
Conversion 

Anamorphic, Center Cut, Letterbox The down-conversion to apply when AFD is lost or AFD 
code 000 is received. 
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Parameter Values Description 

Use Input AFD true, false Specifies whether to attempt to use AFD code at input for 
format conversion or always apply the default. 

Action on AFD lost Convert as anamorphic and put AFD code 1000 
out, Convert as specified in Default and put AFD 
code out 

Specifies what to do if AFD is lost. 

Action on AFD code 
0000 

Convert as anamorphic and put AFD code 1000 
out, Convert as specified in Default and put AFD 
code out 

Specifies what to do if AFD code 0000 is received. 

Video Encoding  

The following parameters are available on the Encode  tab of the Properties  widget on the 
Service Configuration  page when a video component is selected in the Outputs  widget. The 
same parame ters  can be accessed through the Advanced/CE -x Analogue/Video/Video 
1/Video/Main Video/Video Encoder  menu on the front panel.  

Table 5.72  Video Encoding Parameters  

Parameter Values Description 

Video Profile Profile Off, 
SD MPEG2 Main Profile Main Level 4:2:0 8 bit, 
SD MPEG2 422 Profile Main Level 4:2:2 8 bit, 
SD H.264 Main Profile Level 3.0 4:2:0 8 bit, 
SD H.264 High Profile Level 3.0 4:2:0 8 bit, 
SD H.264 High Profile Level 3.1 4:2:0 8 bit, 
SD H.264 Hi422 Profile Level 3.1 4:2:2 8 bit, 
SD H.264 High Profile Level 3.1 4:2:2 10 bit, 
HD MPEG2 Main Profile High Level 4:2:0 8 bit, 
HD MPEG2 4:2:2 Profile High Level 4:2:2 8 bit, 
HD H.264 Main Profile Level 4.0 4:2:0 8 bit, 
HD H.264 High Profile Level 4.0 4:2:0 8 bit, 
HD H.264 High Profile Level 4.1 4:2:0 8 bit, 
HD H.264 Hi422 Profile Level 4.1 4:2:2 8 bit, 
HD H.264 Hi422 Profile Level 4.1 4:2:2 10 bit 

HD p50/60 H.264 High Profile Level 4.2 4:2:0 
8 bit 

HD p50/60 H.264 High422 Profile Level 4.2 4:2:2 
8 bit 

HD p50/60 H.264 High422 Profile Level 4.2 4:2:2 
10 bit 

Sets the encoder profile. The profile will also affect the 
allowed bit rate range. 

Profile for SD input Profile Off, 
SD MPEG2 Main Profile Main Level 4:2:0 8 bit, 
SD MPEG2 422 Profile Main Level 4:2:2 8 bit, 
SD H.264 Main Profile Level 3.0 4:2:0 8 bit, 
SD H.264 High Profile Level 3.0 4:2:0 8 bit, 
SD H.264 High Profile Level 3.1 4:2:0 8 bit, 
SD H.264 Hi422 Profile Level 3.1 4:2:2 8 bit, 
SD H.264 High Profile Level 3.1 4:2:2 10 bit, 

The profile to set when an SD input is detected on the SDI 
input. Visible only if Input Detection is set to Auto Detect 
and Configure. If this option is visible, the Video Profile 
cannot be set manually. 

Profile for HD input Profile Off, 
SD MPEG2 Main Profile Main Level 4:2:0 8 bit, 
SD MPEG2 422 Profile Main Level 4:2:2 8 bit, 
SD H.264 Main Profile Level 3.0 4:2:0 8 bit, 
SD H.264 High Profile Level 3.0 4:2:0 8 bit, 
SD H.264 High Profile Level 3.1 4:2:0 8 bit, 
SD H.264 Hi422 Profile Level 3.1 4:2:2 8 bit, 
SD H.264 High Profile Level 3.1 4:2:2 10 bit, 
HD MPEG2 Main Profile High Level 4:2:0 8 bit, 
HD MPEG2 4:2:2 Profile High Level 4:2:2 8 bit, 
HD H.264 Main Profile Level 4.0 4:2:0 8 bit, 
HD H.264 High Profile Level 4.0 4:2:0 8 bit, 
HD H.264 High Profile Level 4.1 4:2:0 8 bit, 
HD H.264 Hi422 Profile Level 4.1 4:2:2 8 bit, 
HD H.264 Hi422 Profile Level 4.1 4:2:2 10 bit 

The profile to set when an HD input is detected on the HD-
SDI input. Visible only if Input Detection is set to Auto 
Detect and Configure. If this option is visible, the Video 
Profile cannot be set manually. 
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Parameter Values Description 

Resolution 352 x 576, 480 x 576, 528 x 576, 544 x 576, 640 
x 576, 704 x 576, 720 x 576, 352 x 480, 480 x 
480, 528 x 480, 544 x 480, 640 x 480, 704 x 
480, 720 x 480, 1280 x 720, 1440 x 1080, 1920 
x 1080 

Defines the horizontal and vertical resolution of the 
encoded video. The available options depend on the 
values set for Video Input Format and Video Profile. 

Video Bit Rate The valid bit rate range depends on the selected 
video profile. 

Defines the bit rate to be used by the compressed video 
component. If Bit Rate Tracking Mode is set to Maximize 
Video for the Transport Stream that contains the video 
component, and the Bit Rate Weighting of the component 
is set to other than Fixed or Minimal, this field is read 
only. 

Buffer Mode CBR Constant Bit Rate operation. 

Low Delay Reduced encode delay achieved by removing pre-
processing functions. Bit Rate, GOP structure and GOP 
length impact the delay. The IP GOP structure will give 
lowest delay, but with reduced quality. 

Mega Low Delay Encode delay reduced further by removing frame-sync in 
pre-processing. Bit Rate, GOP structure and GOP length 
impact the delay. The IP GOP structure will give lowest 
delay, but with reduced quality.  

Aspect Ratio 16:9, 4:3 Does not affect the video encoding but rather indicates 
what the desired aspect ratio for the decoded picture (not 
the pixel). If no other mechanism such as WSS in the VBI 
is used, the video output image will use this aspect ratio. 

GOP Length 4 to 250 Defines the nominal distance in steps of video frames 
between two consecutive I frames in the encoded bit-
stream. 

GOP Structure IP, IBP, IBBP, IBBBP, IBBBBBBBP Sets the number of B frames between reference frames. 
IBBBBBBBP can only be used for 720p video format 
encoded with a H.264 video profile. 

Closed GOPs Off, On Enables or disables the usage of Group of Pictures in 
which the predicted frames can have their reference from 
outside the group. 

Scene Cut Detection On, Off When enabled, minimizes the negative effect the scene 
changes have on the bit rate by inserting an I-Frame when 
a change is detected. It also affects the GOP length. 

Delay  Displays the actual video encoding delay. Read only 
parameter. 

Stills Detection Off, Intelligent, Clamp Detects if the video is a still picture, and adjusts the 
encoded video bit rate accordingly when operating in VBR 
mode. 

Film Mode Off, On Sets encoding parameters that give better image quality 
for film like sources. Available only for frame rates of 29.97 
or 59.94 Hz when the resolution is set to other than SIF. 

Inloop Filter High, Normal, Low, Very Low, Auto Sets the characteristics of the filter placed in the feedback 
loop of the encoder. Applying the filter to the picture can 
increase picture sharpness. 

Max CABAC Bit Rate Depends on the Video Profile set. Controls the bit rate at which the encoder switches from 
CABAC to CAVLC entropy coding. 

SEI Encapsulation 
Mode 

Combined, Mediaroom Defines how the SEi messages are formatted in the picture 
header for H264. For combined, all the different types of 
messages (for example AFD) are bundles into one NAL 
packet. For Mediaroom each type of message is put into 
its own NAL packet. This was done for STB compatibility 
issues 
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Parameter Values Description 

3D Mode Off, Side by Side Frame Packing, Top and 
Bottom Frame Packing 

Configures output to include information in the SEI 
message depending on the 3D mode. Frame Sync Delay 
in SEI is only available for CE-x with CE/SWO/CE-x/H264, 
CE/SWO/CE-x/HD and CE/SWO/CE-x/3D licenses. 

Video Output  

The following paramete rs are available on the Out put  tab of the Properties  widget on the 

Service Configuration  page when a video component is selected in the Outputs  widget. The 
same parameters can be accessed through the Advanced/CE -x Analogue/Video/Video 
1/Video/Main Video/St ream Output  menu on the fro nt p anel.  

Table 5.73  Video Output Parameters  

Parameter Values Description 

Embedded PCR Off, On, On (Picture Header) Sets if the PCR is embedded within the video or is on a 
separate PID. 

When set to Off, there must be a separate PCR 
component in the service which can have a user defined 
PID. 

When set to On, the PCR PID will be the same as the 
associated component. A PCR will be included for every I 
picture. 

The On (Picture Header) option is provided in MPEG-2 
encoding only as an option to support some legacy 
equipment that required a PCR on every picture. This 
should only be used when absolutely necessary. 

Copyright Off, On Sets the copyright flag in the elementary stream header. 

Original Off, On Sets the original flag in the elementary stream header. 

PES Packet Per GOP, Picture Determines how PES packets shall be generated. The 
Picture option is only available if MPEG 2 encoding is 
used. 

AU Information Ctrl 6 RAI, RAI and AU Info, RAI, AU Info and TC Controls insertion of Private Data in the TS Adaptation 
Field for video Access Units (AU) with the following values: 
Random Access Indicator (RAI), ETSI 101 154 (AU info), 
and Time Code (TC). 

AR Signalling Output 
Control 

Off, AFD Only, AFD and Bar Data Controls what Aspect Ratio signalling will get embedded in 
the video as user data. AFD sources are: SMPTE 2016, 
Video Index, WSS-AFD/WSS, user set Aspect Ratio. Bar 
Data is only SMPTE 2016. 

TC Output Location Off, SEIMsg Defines how timecode is put into the output video stream. 

Video Component  

The following parameters are available on the Component  tab of the Properties  widget on the 
Service Configuration  page when a video component is selected in the Outputs  widget. The 
same parameters can be accessed through the Outpu t/<output name>/Transport Stream 
ID: <n>/Service List/<service name>/Component List/Slot  <x> Video Stream on PID 
<y>  menu on the front pane l.  

Table 5.74  Video Component Parameters  

Parameter Values Description 

PID 32 to 8190 Sets the packet identifier associated with the component. 

Bit Rate Weighting Fixed, Minimum, 2 to 20 Specifies the weight associated to the component in the 
Bit Rate Tracking algorithm. 

Master TS Off, On Sets the master Transport Stream for the component.. 
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Vertical Blanking Interval / Ancillary Data  

The following parameters are available on the VBI  tab of the Propert ies  widget on the Service 
Configuration  page when a video stream is selected in the Outputs  widget. The same 
parameters  can  be accessed through the Advanced/CE - x Analogue/Video/Video 
1/Input/VBI Extraction  menu on the front panel.  

Table 5.75  Vertical Blanking Interval / Ancillary Data Parameters  

Parameter Values Description 

Enable VBI Pass-thru 
Mode 

Off, On Enable Pass-thru of VBI, ANC and Teletext data from 
specified PIDs, instead of extracting them from SDI. Read 
only parameter. Not supported in this release. 

Description Control 

VBI Descriptor Mode Standard, Legacy, Philips, User The source for Closed Captions data encoded as part of 
the Video Stream (only applicable when Video Frame Rate 
is 29.97 Hz) 

VBI Data Descriptor 
Insertion 

Off, On Controls if the VBI Data Descriptor is inserted into the 
PMT. Available only if VBI Descriptor Mode is set to 
User. 

VBI Teletext 
Descriptor Insertion 

Off, On Controls if the VBI Teletext Descriptor is inserted into the 
PMT. Available only if VBI Descriptor Mode is set to 
User. 

Teletext Descriptor 
Insertion 

Off, On Controls if the Teletext Descriptor is inserted into the PMT. 
Available only if VBI Descriptor Mode is set to User. 

Proprietary Descriptor 
Insertion 

Off, On Controls if the Legacy Proprietary Descriptor is inserted 
into the PMT. Available only if VBI Descriptor Mode is set 
to User. 

Aspect Ratio (AR) Signaling 

Video Index Off, On (Default), On (User) Controls the extraction of Video Index (and thus whether 
Video Index can be used as source of AR info).  

Default: The default lines will be set to decode Video Index 
(11/324 in 25Hz, 14/277 in 29.97 Hz) 

User: The User defines the lines used to decode Video 
Index. 

Video Index Field 1 10 to 22 Specifies which line contains the video index in field 1. 

Video Index Field 2 10 to 22 Specifies which line contains the video index in field 2. 

SMPTE 2016 Off, On Controls whether SMPTE 2016 data can be used as a 
source for AR info. 

AFD Sustain Indefinitely, Default after Timeout, Off after 
Timeout 

Control what AFD code goes out when AFD is lost at input. 

Indefinitely: Maintains previously received AFD code 
indefinitely. 

Default after Timeout: Maintains previously received AFD 
code for period specified in Sustain Timeout, then drop to 
default, i.e. code 1000. 

Off after Timeout: Maintains previously received AFD code 
for period specified in Sustain Timeout, then switch AFD 
off. 

AFD Sustain Timeout 0 to 5,10, 20, 50, 100, 120 Control how long previous AFD code is maintained. Zero 
means drop to default immediately on loss. 

AFD Action on 
Reserved Codes 

Pass Through, Code as 0000 Specify what code is passed to the output when reserved 
AFD codes are received at the input. 

Pass Through: Passes code through unchanged. 

7 Code as 0000: Changes code to 0000. 
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Parameter Values Description 

Closed Captions 

Closed Captions 
Source 

Off, VBI lines, SMPTE334 The source for Closed Captions data encoded as part of 
the Video Stream. Only applicable when frame rate is 
29.97 Hz. 

Timecode 

TC Mode Off, External, Zero on Loss, External, Freewheel 
on Loss, Internal 

Controls what mode the Time code (TC) is working in, 
either Off, external source or internally generated. Also 
sets what happens on loss of external source (zero or 
freewheel). 

TC External Source 8 Auto, ANC VITC1, ANC VITC2, ANC LTC, VBI VITC Controls the external source of Time Code. Auto will select 
the first source present in order of the drop down list. 

TC Dropframes Off, On, Auto Only in 525 line operation controls if Time Code takes 
account of drop frames or not. Auto configures to external 
source, or to ON for internal source. 

Broadcaster ID 

Reception Timeout  Timeout in seconds for reception of Source ID from input 
(RP207). 

Insertion Timeout  Timeout in seconds for insertion of default source ID. 

Broadcaster ID Mode Off, Auto, Default Only, Source Only Gives what to insert as a broadcaster ID. 

Default Servicename  The default service name to be used. 

Broadcaster ID Source No, Input, Default Indicates if the Broadcaster ID is derived from the input, 
the default or is invalid. 

Broadcaster ID  The Broadcaster ID that is currently being inserted into the 
output stream. 

Generic ANC 

Generic ANC 
Extraction 

Off, On Controls whether Generic ANC is extracted from the SDI 
stream or not as per SMPTE 2038-2008. 

Max ANC Bit Rate 100 to 2000 kbps The maximum data rate of the Generic ANC data output. 

Field 1 

VBI Line 9 - VBI Line 
22 

Off, Closed Caption Specifies the content in the respective VBI lines. Set to Off 
if the line in the incoming video does not carry any 
information, Closed Caption for closed caption information. 
Visible for 480i (525-line) input streams. 

VBI Line 6 - VBI Line 
23 

Off, VITC, WSS, WSS-AFD, Teletext System B Specifies the content in the respective VBI lines. Set to Off 
if the line in the incoming video does not carry any 
information, VITC for Time Code, WSS for Wide Screen 
Signaling, WSS-AFD for Active Format Detection and 
Teletext System B for Teletext. Visible for 576i (625-line) 
input streams. 

Field 2 

VBI Line 272 - VBI 
Line 285 

Off, Closed Caption Specifies the content in the respective VBI lines. Set to Off 
if the line in the incoming video does not carry any 
information, Closed Caption for closed caption information. 
Visible for 480i (525-line) input streams. 

VBI Line 319 - VBI 
Line 336 

Off, VITC, WSS, WSS-AFD, Teletext System B Specifies the content in the respective VBI lines. Set to Off 
if the line in the incoming video does not carry any 
information, VITC for Time Code, WSS for Wide Screen 
Signaling, WSS-AFD for Active Format Detection and 
Teletext System B for Teletext. 
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Input Detection  

The CE -x Analogue VCM supports video input detection as des cribed i n Chapter 3, Getting Started: 
How to Configure and Use Input Detection .  

Note:  Input detection does not work for the analogue input.  

5.5.3.4.2  Audio Stream Configuration  

Audio Input  

The following parameters are available on the Input  tab of the Properties  widget on the Service 
Configuration  page when an audio component is selected in the Outputs  widget. The same 
parameters can be accessed through the Advanced/CE - x Analogue/Audio Modul e/Audio 
<n>/Input  menu on the front panel.  

Table 5.76  Audio Input Parameters  

Parameter Values Description 

Input Format Uncompressed (LPCM), MPEG Layer II, Dolby 
Digital, Dolby E, AAC 

Sets the input format used by the audio encoder. 

Input Source Off, Mute, Test Tone, Input 1-4, Analogue 1-2, 
Embedded 1 to 8 

Sets the source used by the audio encoder. No input is fed 
to the encoder if Off is selected. Mute mutes the incoming 
audio and encodes silence. Test Tone encodes an 1 kHz 
test tone. Embedded 1 to 8 are for digital input embedded 
in the SDI/HD-SDI stream. Input 1-4 are for the digital 
input and Analogue 1-2 are for analogue input. Analogue 
and digital inputs cannot be used at the same time. 

Output On Audio Loss No PID, Silence Specifies the action to take when input is Lost. No PID is 
for dropping the audio PID from the stream, Silence is for 
encode silence. 

NOTE: When No PID is selected, the reference to the PID 
is not removed from the Program Map Table, so a 
Transport Stream analyzer will indicate a ghost PID in the 
output Transport Stream. 

Source Switchout Off, Mute, Test Tone, Embedded 1 to 8, Input 1 -
4 

Specifies which input to output to the reference output on 
the 15-way D-type audio connector. 

Audio Encoding  

The following parameters are available on the Encode  tab of the Properties  widg et on the 
Service Configuration  page when an audio component is selected in the Outputs  widget. The 
same parameters can be accessed through the Advanced/CE -x Analogue/Audio 
Module/Audio <n>/Encode  menu on the front panel.  

Table 5.77  Audio Encoding Standards  

Parameter Options Description 

Coding Standard MPEG Layer 2 MPEG Layer 2 Encode(More than two channel pairs 
require the /SWO/M1L2 license) 

Dolby Digital Dolby Digital encode, requires CE/SWO/DOLBYAC3 
license. 

AAC-LC AAC-LC encoding, requires CE/SWO/AAC license. 

HE-AAC HE-AAC or HE-AAC v2encoding requires CE/SWO/AAC 
license. 

Pass-thru Pass-thru of the input 

Audio Description Service MPEG-1 Layer II encode of a mono audio track that 
describes action in the video plus a control track. 
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Table 5.78  MPEG Layer 2 Parameters  

Parameter Values Description 

Bit rate 32, 48, 56, 64, 80, 96, 112, 128, 160, 192, 224, 
256, 320, 384 

Bit Rate of the audio stream 

Coding Mode 1/0 (Left - input), 1/0 (Right - input), 1/0 (L+R)/2, 
1+1 (L/Ch1, R/Ch2), 2/0, 2/0 (Joint), Phase 
Aligned Audio (6 Cannels), Phase Aligned Audio 
(8 Cannels) 

Specifies what channel configuration to use for encoding.. 

Embedded PCR On, Off Controls whether PCR is to be embedded in the audio 
PES. 

Au Information Cont Off, AU Info Controls the insertion of private data in the adaptation unit 
of the audio access units (AU). AU Info is defined in ETSI 
TR 101 154. Only AU_PTS is present for audio 

Advanced 

Lip Sync Offset -500 to 500 ms Configures a delay to the audio to improve A/V 
synchronization. 

Gain -6 to 6dB Sets the gain in dB for the audio stream. 

Language  The language of the stream when not in dual mono (1+1) 
mode. 

Language (Left)  The language of the left channel when in dual mono (1+1) 
mode. 

Language (Right)  The language of the right channel when in dual mono 
(1+1) mode. 

User Language 1  A custom three-character language code when User 
Language 1 is set in any of the language fields. 

User Language 2  A custom three-character language code when User 
Language 2 is set in any of the language fields. 

MPEG Version MPEG1, MPEG2 Configures if MPEG-1 or MPEG-2 to be signaled. 

Copyright Off, On Indicates if the material is copyright protected. 

Original Off, On Indicates if source is the original or a copy 

De-emphasis Off, 50/15us, CCITT J.17 To meet the MPEG-1 Layer 2 encoding algorithm 
specification the audio must not have pre-emphasis 
applied. If the input signal does have pre-emphasis 
applied, a de-emphasis filter must be applied prior to 
encoding. 

Table 5.79  Dolby Digital Parameters  

Parameter Values Description 

Bit Rate 56, 64, 80, 96, 112, 128, 160, 192, 224, 256, 
320, 384, 448, 512, 576, 640 

Bit Rate of the audio stream. The available options depend 
on the selected coding mode. 

Coding Mode 1/0 (Left ï input), 1/0 (Right ï input), 1/0 (L+R)/2, 
2/0, 3/2L (5.1 Surround) 

Specifies what channel configuration to use for encoding. 

Metadata Controls 
Coding Mode 

Off, On Override default coding mode with coding mode indicated 
in decoder program configuration or live metadata (if 
present). 

Metadata source type Embedded/Decoded Auto, Serial Port (Program 
1 to 8) 

Selects where live metadata comes from. 

Metadata override 
type 

None, All, Compression Profile, Dialogue 
Normalization, Comp Profile and Dial Norm 

Defines which metadata parameters to override. 
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Parameter Values Description 

Metadata Reversion 
Mode 

Last Used, Preset Determines which metadata is used upon loss of live 
metadata. 

Metadata preset type 1 to 8 Defines which metadata preset to use if Preset is selected 
for Metadata Reversion Mode. 

Embedded PCR On, Off Controls whether PCR is to be embedded in the audio 
PES. 

Au Information Cont Off, AU Info Controls the insertion of private data in the adaptation unit 
of the audio access units (AU). AU Info is defined in ETSI 
TR 101 154. Only AU_PTS is present for audio 

Advanced 

Lip Sync Offset -500 to 500 ms Configures a delay to the audio to improve A/V 
synchronization. 

Gain -6 to 6dB Sets the gain in dB for the audio stream. 

Language  The language of the stream. 

User Language 1  A custom three-character language code when User 
Language 1 is set in the Language field. 

User Language 2  A custom three-character language code when User 
Language 2 is set in the Language field. 

Table 5.80  AAC-LC Parameters  

Parameter Values Description 

Bit Rate 32, 48, 56, 64, 80, 96, 112, 128, 160, 192, 224, 
256, 320, 384, 448, 512 

Bit Rate of the audio stream. The available options depend 
on the selected coding mode. 

Coding Mode 2/0, 3/2L (5.1 Surround) Specifies what channel configuration to use for encoding. 

Embedded PCR On, Off Controls whether PCR is to be embedded in the audio 
PES. 

Au Information Cont Off, AU Info Controls the insertion of private data in the adaptation unit 
of the audio access units (AU). AU Info is defined in ETSI 
TR 101 154. Only AU_PTS is present for audio 

Encapsulation MPEG2 ADTS, MPEG4 LATM/LOAS Specifies the encapsulation used for transmitting AAC 
content. It can be either MPEG-2 Audio Data Transport 
Stream or MPEG-4 Low Overhead Audio Stream based on 
MPEG-4 Low Overhead Audio Transport Multiplex. 

TNS (Temporal Noise 
Shaping) 

Off, On Turns noise shaping on or off. 

Advanced 

Lip Sync Offset -500 to 500 ms Configures a delay to the audio to improve A/V 
synchronization. 

Gain -6 to 6dB Sets the gain in dB for the audio stream. 

Language  The language of the stream. 

User Language 1  A custom three-character language code when  User 
Language 1 is set in the Language field. 

User Language 2  A custom three-character language code when User 
Language 2 is set in the Language field. 
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Table 5.81  HE-AAC Parameters  

Parameter Values Description 

Bit Rate 16, 24, 32, 48, 56, 64, 80, 96, 112, 128, 160, 
192, 224, 256 

Bit Rate of the audio stream. The available options depend 
on the selected coding mode. 

Coding Mode 2/0, 3/2L (5.1 Surround) Specifies what channel configuration to use for encoding. 

Embedded PCR On, Off Controls whether PCR is to be embedded in the audio 
PES. 

Au Information Cont Off, AU Info Controls the insertion of private data in the adaptation unit 
of the audio access units (AU). AU Info is defined in ETSI 
TR 101 154. Only AU_PTS is present for audio 

Encapsulation MPEG2 ADTS, MPEG4 LATM/LOAS Specifies the encapsulation used for transmitting AAC 
content. It can be either MPEG-2 Audio Data Transport 
Stream or MPEG-4 Low Overhead Audio Stream based on 
MPEG-4 Low Overhead Audio Transport Multiplex. 

TNS (Temporal Noise 
Shaping) 

Off, On Turns noise shaping on or off. 

SBR Signalling Explicit, Implicit Specifies how Spectral Band Replication is signaled. 

Advanced 

Lip Sync Offset -500 to 500 ms Configures a delay to the audio to improve A/V 
synchronization. 

Gain -6 to 6dB Sets the gain in dB for the audio stream. 

Language  The language of the stream. 

User Language 1  A custom three-character language code when User 
Language 1 is set in the Language field. 

User Language 2  A custom three-character language code when User 
Language 2 is set in the Language field. 

Table 5.82  Pass- thru Parameters  

Parameter Values Description 

Embedded PCR On, Off Controls whether PCR is to be embedded in the audio 
PES. 

Au Information Cont Off, AU Info Controls the insertion of private data in the adaptation unit 
of the audio access units (AU). AU Info is defined in ETSI 
TR 101 154. Only AU_PTS is present for audio. 

Advanced 

Lip Sync Offset -500 to 500 ms Configures a delay to the audio to improve A/V 
synchronization. 

Gain -6 to 6dB Sets the gain in dB for the audio stream. 

Language  The language of the stream. 

User Language 1  A custom three-character language code when User 
Language 1 is set the Language field. 

User Language 2  A custom three-character language code when User 
Language 2 is set in the Language field. 

Table 5.83  Audio Description Service Parameters  

Parameter Values Description 

Bit Rate 64 Bit Rate of the audio stream. 
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Parameter Values Description 

Coding Mode 1/0 (Left ï input) Specifies what channel configuration to use for encoding. 

Embedded PCR On, Off Controls whether PCR is to be embedded in the audio 
PES. 

Au Information Cont Off, AU Info Controls the insertion of private data in the adaptation unit 
of the audio access units (AU). AU Info is defined in ETSI 
TR 101 154. Only AU_PTS is present for audio 

Advanced 

Lip Sync Offset -500 to 500 ms Configures a delay to the audio to improve A/V 
synchronization. 

Gain -6 to 6dB Sets the gain in dB for the audio stream. 

Language  The language of the stream. 

User Language 1  A custom three-character language code when User 
Language 1 is set in the Language field. 

User Language 2  A custom three-character language code when User 
Language 2 is set in the Language field. 

Audio Component  

The parameters listed in Table 5.84  are available on the Component  tab of the Properties  
widget on the Service Configuration  page when an  aud io component is selected in the Outputs  
widget. The same parameters can be accessed through the Output/<output name>/Transport 
Stream ID: <n>/Service List/<service name>/Component List/<component name>  
menu on the front panel.  

Table 5.84  Audio Component Parameters  

Parameter Values Description 

PID 32 to 8190 Sets the packet identifier associated with the component. 

Bit Rate Weighting Fixed Specifies the weight associated to the component in the 
Bit Rate Tracking algorithm. For audio stream, this is Fixed 
and read only. 

 

Dolby Metadata Presets  

Four custom Dolby Metadata Presets can be configured in the Advanced Setup tab of the Device 
Configuration page. To set the preset options, in the Advanced Video Pr ocesso r Settings drill down 
to Encoder > Slots > Slot <n> -  CE-x Analogue >CE -x Analogue > Audio Module > Dolby 
Metadata Presets, and select the preset you want to modify. Alternatively, the settings can be 
reached through the front panel under Advanced/CE -x Ana logue/Audio Module/Dolby Metadata 
Presets . Any of these presets can then be applied to any audio channel encoding audio in the 

Dolby Digital format. The table lists the parameters for each preset.  

Table 5.85  Dolby Metadata Preset Parameters  

Parameter Values Description 

Preset name  Name of the preset (for user information) 

Dialogue 
normalization level 

-31 to -1 dB Used by a decoder to determine the level of adjustment 
required to achieve the set level. 
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Parameter Values Description 

Bitstream mode Main audio service: complete main, music and 
effects, Associated service: visually impaired, 
Associated service: hearing impaired, 
Associated service: dialogue, Associated 
service: commentary, Associated service: 
emergency, Associated service: visually 
impaired, Associated service: karaoke/voiceover 

Flags the type of service in the bitstream. 

Line mode 
compression profile 

None, Film Standard, Film Light, Music 
Standard, Music Light, Speech 

Alters the dynamic range for line output. 

RF mode compression 
profile 

None, Film Standard, Film Light, Music 
Standard, Music Light, Speech 

This alters the dynamic range for RF output. The overall 
level is raised by 11dB. 

Center mix level 0.707 (-3.0 dB), 0.595 (-4.5 dB), 0.500 (-6.0 dB) Indicates the downmix level when there is no centre 
speaker. This is applied to left and right channels only. 

Surround mix level 0.707 (-3.0 dB), 0.500 (-6.0 dB), 0 (-inf dB) Surround downmix level for the front left and right 
channels when consumer has no surround speakers. 

Dolby Surround mode Not Indicated, Not Encoded, Encoded Flags if a two channel encoded stream contains 
information for a Dolby Pro-logic decode (Lt/Rt) 

Audio production 
information exists 

Off, On This indicates whether the Mixing Level and Room Type 
parameters exist within the bit-stream. 

Mixing level 80 to 111 dB Indicates the acoustic sound pressure level of the dialogue 
level during the final audio mixing session. 

Room type Not indicated, Large room X curve monitor, 
Small room flat monitor 

Type and calibration of the mixing room used for the final 
audio mixing session. 

Copyright flag Off, On Indicates if the material is copyright protected 

Original bitstream flag Off, On Indicates if source is the original or a copy 

Enable extended 
bitstream information 

Off, On Flags if additional information is available for downmixing. 

Preferred downmix 
mode 

Not indicated, Lt/Rt downmix preferred, Lo/Ro 
downmmix preferred 

Indicates if the producer would prefer a Lt/Rt or a Lo/Ro 
downmix. Can be over-ridden by the decoder. 

Lt/Rt center mix level 1.414 (+3.0 dB), 1.189 (+1.5 dB), 1.000 (0 dB), 
0.841 (-1.5 dB), 0.707 (-3.0 dB), 0.595 (-4.5 dB), 
0.500 (-6.0 dB), 0 (-inf dB) 

Indicates the required level reduction of the center channel 
when mixed with the L& R channels for a Lt/Rt downmix. 
Similar to 'Center mix level'. 

Lt/Rt surround mix 
level 

0.841 (-1.5 dB), 0.707 (-3.0 dB), 0.595 (-4.5 dB), 
0.500 (-6.0 dB), 0 (-inf dB) 

Indicates the required level reduction of the surround 
channels when mixed for a Lt/Rt downmix. Similar to 
Surround mix level'. 

Lo/Ro center mix level 0.841 (-1.5 dB), 0.707 (-3.0 dB), 0.595 (-4.5 dB), 
0.500 (-6.0 dB), 0 (-inf dB) 

Indicates the required level reduction of the center channel 
when mixed with the L& R channels for a Lo/Ro downmix. 
When present this replaces the value set for the 'Center 
mix level' 

Lo/Ro surround mix 
level 

0.841 (-1.5 dB), 0.707 (-3.0 dB), 0.595 (-4.5 dB), 
0.500 (-6.0 dB), 0 (-inf dB) 

Indicates the required level reduction of the center channel 
when mixed for Lo/Ro downmix. When present this 
replaces the value set for the 'Surround mix level'. 

Dolby Surround EX 
mode 

0.841 (-1.5 dB), 0.707 (-3.0 dB), 0.595 (-4.5 dB), 
0.500 (-6.0 dB), 0 (-inf dB) 

Flags if the stream has been encoded in 'Surround Ex'. 
Only used if surround channels are present. 

A/D converter type Standard, HDCD Indicates type of A/D conversion used. 

Digital de-emphasis Off, Auto, On To meet the Dolby Digital encoding algorithm specification 
the audio must not have pre-emphasis applied. If the input 
signal does have pre-emphasis applied, a de-emphasis 
filter must be applied prior to encoding. 
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Parameter Values Description 

DC high pass filter 
enable 

Off, On Removing the DC component can lead to more efficient 
encoding, but there is a risk that signals that do not reach 
100% PCM may exceed this after filtering and therefore 
must be clipped. 

Bandwidth low-pass 
filter enable 

Off, On Remove high frequency signals before encoding. The filter 
removes frequencies that would not normally be encoded. 

Low-frequency effects 
low pass filter enable 

Off, On Apply a 120 Hz low pass filter prior to an encode. Should 
only be switched off if it is known that there are no 
frequencies above 120 Hz. 

Surround attenuation 
enable 

Off, On Attenuate surround channels by 3 dB before encoding. 
Theatrical and consumer mixing rooms use different levels 
for the surround channels, and this can be used to 
compensate. 

Surround phase shift 
enable 

Off, On Apply a phase shift of 90 degrees to the surround 
channels. This simplifies the decode process for producing 
a 'Lt/Rt' downmix. 

5.5.3.4.3  Splicing Stream Configuration  

Splicing  

The following parameters are available on the Splicing  tab of the Properties  widget on the 
Service Configuration  page when an SCTE 35 stream is selected  in the Outputs  widget. The 
same parameters can be a ccessed through the Advanced/CE -x Analogue/Video/Video 
1/Video/Main Video/Splicing  menu on the front panel.  

Table 5.86  Splicing Parameters  

Parameter Values Description 

Splicing Control Off, On VANC Message Only, On VANC, On IP Enables splice points to be set in the video stream upon 
reception of a SCTE 104 message and determines the 
insertion point. 
To enable splicing, a splice point insertion license 
(CE/SWO/DPI) is needed. 

Splice Null Insertion Off, On Used to determine the insertion of NULL SCTE 35 
messages into the output stream if no messages have 
been sent for 500ms. 

Audio Splicing Off, On Used to determine if audio is manipulated at the point that 
the video splice occurs. 

AS Index Control Don't Care, Use 1, Use 1 + 2 Determines how many values of AS Index are compared 
against the incoming SCTE 104message. Available only 
when Splicing Control is set to On VANC Message Only. 

DPI PID Index Control Don't Care, Use 1, Use 1 + 2 Determines how many values of DPI PID Index are 
compared against the incoming SCTE 104message. 
Available only when Splicing Control is set to On VANC 
Message Only. 

AS Index 1 0 to 255 The AS index used if AS Index Control is set to Use 1 or 
Use 1 + 2. 

AS Index 2 0 to 255 The AS index used if AS Index Control is set to Use 1 + 2. 

DPI PID Index 1 0 to 255 The DPI PID index used if DPI PID Index Control is set to 
Use 1 or Use 1 + 2. 

DPI PID Index 2 0 to 255 The DPI PID index used if DPI PID Index Control is set to 
Use 1 + 2. 

Splicin g Co mponent  
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The following parameters are available on the Component  tab of the Properties  widget on the 

Service Configuration  page when an SCTE 35 stream is selected in the Outputs  widget. The 
same parameters can be accessed through the Output/<output name >/Tr ansport Stream 
ID: <n>/Service List/<service name>/Component List/<component name>  menu on the 
front panel.  

Table 5.87  Slicing Component Parameters  

Parameter Values Description 

PID 32 to 8190 Sets the packet identifier associated with the component. 

Bit Rate Weighting Fixed Specifies the weight associated to the component in the 
Bit Rate Tracking algorithm. For audio stream, this is Fixed 
and read only. 

5.5.3.4.4  Teletext Stream Configuration  

This section describe s th e parameters for setting up Teletext.  

Teletext  

This section gives the parameters that have an effect on how  Teletext is transmitted.  

The following parameters are available on the Splicing  tab of the Properties  widget on the 
Service Configuration  page w hen an SCTE 35 stream is selected in the Outputs  widget. The 
same parameters can be accessed through the Advanced/CE -x Analogue/Video/Video 
1/Video/Main Video/Splicing  menu on the front panel.  

Table 5.88  Telet ext Parameters  

Parameter Values Description 

Teletext Source Off, OP-47 (Max 300kb/s), VANC Teletext Controls whether Teletext is extracted from VANC or not 
and if it extracted, which encapsulation method (OP-47 or 
SMPTE 2031) to use. 

Teletext Packetisation Normal (ETS 300-472) - Data on Teletext 
Component, Legacy (ETS 301-775) - Data on 
VBI Component 

Controls how the Teletext data is packetized in to a 
component data stream. 

SMPTE2031 Max. No. 
Teletext  

3, 7, 11, 15, 36 Defines the maximum number of Teletext lines inserted. 
Available only if VANC Teletext is selected for Teletext 
Source. 

SMPTE2031 Teletext 
Present 

Yes, No Displays whether Teletext is found in the SDI stream. 
Available only if VANC Teletext is selected for Teletext 
Source. Read only parameter. 

Min # Teletext Packets 0 to 3 Defines the minimum number of Teletext packets 
generated per field, even if there is no Teletext data. 

PTS On Teletext Off, On Controls whether a PTS value is included in the output 
Teletext packets. 

Teletext Descriptor Page List / Teletext Descriptor Page 

Teletext Page Type Off, Initial Page, Subtitle Page, Additional 
Information Page, Programme Schedule Page, 
Heading Impaired Subtitle Page 

The page type of the Teletext descriptor. 

Teletext Page Number  The page number for the page to be set. 

Teletext Page 
Language 

List of languages The language set for the Teletext descriptor. 
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Teletext Component  

This section describes the parameters associated with the component carrying Teletext data.  

The following parameters a re a vailable on the Component  tab of the Properties  widget on the 
Service Configuration  page when a Teletext stream is selected in the Outputs  widget. The 
same parameters can be accessed through the Output/<output name>/Transport Stream 
ID: <n>/Service Lis t/<s ervice name>/Component List/<component name>  menu on the 
front panel.  

Table 5.89  Teletext Component Parameters  

Parameter Values Description 

PID 32 to 8190 Sets the packet identifier associated with the component. 

Bit Rate Weighting Fixed Specifies the weight associated to the component in the 
Bit Rate Tracking algorithm. For audio stream, this is Fixed 
and read only. 

5.5.3.4.5  VBI and ANC Stream Configuration  

This section describes the parameters available for set ting  up VBI and ANC streams.  

VBI an d Ancillary Data  

This section gives the parameters that have an effect on what ancillary data is extracted and how 
the data is transmitted.  

The following parameters are available on the VBI  tab of the Properties  widget on  the  Service 

Configuration  page whe n an ANC stream is selected in the Outputs  widget. The same 
parameters can be accessed through the Advanced/CE - x Analogue/Video/Video 
1/Input/VBI Extraction  menu on the front panel.  

Table 5.90  VBI and Ancillar y Data Parameters  

Parameter Values Description 

Enable VBI Pass-thru 
Mode 

Off, On Enable Pass-thru of VBI, ANC and Teletext data from 
specified PIDs, instead of extracting them from SDI. Read 
only parameter. Not supported in this release. 

Description Control 

VBI Descriptor Mode Standard, Legacy, Philips, User The source for Closed Captions data encoded as part of 
the Video Stream (only applicable when Video Frame Rate 
is 29.97 Hz) 

VBI Data Descriptor 
Insertion 

Off, On Controls if the VBI Data Descriptor is inserted into the 
PMT. Available only if VBI Descriptor Mode is set to 
User. 

VBI Teletext Descriptor 
Insertion 

Off, On Controls if the VBI Teletext Descriptor is inserted into the 
PMT. Available only if VBI Descriptor Mode is set to 
User. 

Teletext Descriptor 
Insertion 

Off, On Controls if the Teletext Descriptor is inserted into the PMT. 
Available only if VBI Descriptor Mode is set to User. 

Proprietary Descriptor 
Insertion 

Off, On Controls if the Legacy Proprietary Descriptor is inserted 
into the PMT. Available only if VBI Descriptor Mode is set 
to User. 
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Parameter Values Description 

Aspect Ratio (AR) Signaling 

Video Index Off, On (Default), On (User) Controls the extraction of Video Index (and thus whether 
Video Index can be used as source of AR info).  

Default: The default lines will be set to decode Video Index 
(11/324 in 25Hz, 14/277 in 29.97 Hz) 

User: The User defines the lines used to decode Video 
Index. 

Video Index Field 1 10 to 22 Specifies which line contains the video index in field 1. 

Video Index Field 2 10 to 22 Specifies which line contains the video index in field 2. 

SMPTE 2016 Off, On Controls whether SMPTE 2016 data can be used as a 
source for AR info. 

AFD Sustain Indefinitely, Default after Timeout, Off after 
Timeout 

Control what AFD code goes out when AFD is lost at input. 

Indefinitely: Maintains previously received AFD code 
indefinitely. 

Default after Timeout: Maintains previously received AFD 
code for period specified in Sustain Timeout, then drop to 
default, i.e. code 1000. 

Off after Timeout: Maintains previously received AFD code 
for period specified in Sustain Timeout, then switch AFD 
off. 

AFD Sustain Timeout 0 to 5,10, 20, 50, 100, 120 Control how long previous AFD code is maintained. Zero 
means drop to default immediately on loss. 

AFD Action on Reserved 
Codes 

Pass Through, Code as 0000 Specify what code is passed to the output when reserved 
AFD codes are received at the input. 

Pass Through: Passes code through unchanged. 

9 Code as 0000: Changes code to 0000. 

Closed Captions 

Closed Captions Source Off, VBI lines, SMPTE334 The source for Closed Captions data encoded as part of 
the Video Stream. Only applicable when frame rate is 
29.97 Hz. 

Timecode 

TC Mode Off, External, Zero on Loss, External, 
Freewheel on Loss, Internal 

Controls what mode the Time code (TC) is working in, 
either Off, external source or internally generated. Also 
sets what happens on loss of external source (zero or 
freewheel). 

TC External Source 10 Auto, ANC VITC1, ANC VITC2, ANC LTC, VBI VITC Controls the external source of Time Code. Auto will select 
the first source present in order of the drop down list. 

TC Dropframes Off, On, Auto Only in 525 line operation controls if Time Code takes 
account of drop frames or not. Auto configures to external 
source, or to ON for internal source. 

Broadcaster ID 

Reception Timeout  Timeout in seconds for reception of Source ID from input 
(RP207). 

Insertion Timeout  Timeout in seconds for insertion of default source ID. 

Broadcaster ID Mode Off, Auto, Default Only, Source Only Gives what to insert as a broadcaster ID. 

Default Servicename  The default service name to be used. 

Broadcaster ID Source No, Input, Default Indicates if the Broadcaster ID is derived from the input, 
the default or is invalid. 
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Parameter Values Description 

Broadcaster ID  The Broadcaster ID that is currently being inserted into the 
output stream. 

Generic ANC 

Generic ANC Extraction Off, On Controls whether Generic ANC is extracted from the SDI 
stream or not as per SMPTE 2038-2008. 

Max ANC Bit Rate 100 to 2000 kbps The maximum data rate of the Generic ANC data output. 

Field 1 

VBI Line 9 - VBI Line 22 Off, Closed Caption Specifies the content in the respective VBI lines. Set to Off 
if the line in the incoming video does not carry any 
information, Closed Caption for closed caption information. 
Visible for 480i (525-line) input streams. 

VBI Line 6 - VBI Line 23 Off, VITC, WSS, WSS-AFD, Teletext System 
B 

Specifies the content in the respective VBI lines. Set to Off 
if the line in the incoming video does not carry any 
information, VITC for Time Code, WSS for Wide Screen 
Signaling, WSS-AFD for Active Format Detection and 
Teletext System B for Teletext. Visible for 576i (625-line) 
input streams. 

Field 2 

VBI Line 272 - VBI Line 
285 

Off, Closed Caption Specifies the content in the respective VBI lines. Set to Off 
if the line in the incoming video does not carry any 
information, Closed Caption for closed caption information. 
Visible for 480i (525-line) input streams. 

VBI Line 319 - VBI Line 
336 

Off, VITC, WSS, WSS-AFD, Teletext System 
B 

Specifies the content in the respective VBI lines. Set to Off 
if the line in the incoming video does not carry any 
information, VITC for Time Code, WSS for Wide Screen 
Signalling, WSS-AFD for Active Format Detection and 
Teletext System B for Teletext. 

AN C Component  

This section describes the parameters associated with the co mponent carrying ancillary data.  

The following parameters are available on the Component  tab of the Properties  widget on the 

Service Configuration  page when an ANC stream is select ed i n the Outputs  widget. The same 
parameters can be accessed through the Ou tput/<output name>/Transport Stream ID: 
<n>/Service List/<service name>/Component List/<component name>  menu on the 
front panel.  

Table 5.91  ANC Component Parameters  

Parameter Values Description 

PID 32 to 8190 Sets the packet identifier associated with the component. 

Bit Rate Weighting Fixed Specifies the weight associated to the component in the 
Bit Rate Tracking algorithm. For audio stream, this is Fixed 
and read only. 

5.5.3.4.6  PCR Stream Configuration  

The video encoding module can generate a separate PCR stream. The PCR stream contains timing 
reference that can be used for decoding the elementary streams included in the same service as 
the P CR stream itself. To use the PCR stream as a timi ng reference for decoding, set the PCR PID 
parameter associated with the service to the PID assigned to the PCR stream.  
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The following parameters are available in Properties  widget on the Service Configuratio n  page 

when a PCR Stream is selected in the Outputs  widget. The same parameters can be accessed 
through the Output/<output name>/Transport Stream ID: <n>/Service List/<service 
name>/Component List/Slot <m> Video 1 PCR stream on PID <n>  menu on the front 
panel.  

Table 5.92  PCR Stream Configuration Parameters  

Parameters Values Description 

PID 16 - 8190 The packet identifier assigned to packets carrying the 
program clock reference values. 

Bit Rate Weighting Fixed Not relevant for the PCR component. Read only 
parameter. 

5.5.3.5  CE- HEVC VCM  

5.5.3.5.1  Video and VBI Stream Configuration  

Video Input and Pre - Processing  

The following parameters are available on the Input  tab of the Properties  widget on the Service 
Configur ation  page when  a v ideo component is selected in the Outputs  widget. The same 
parameters can be accessed through the Advanced/CE - HEVC/Video/Video1/Input  menu on 
the front panel.  

Table 5.93  Video Input and Pre-Processing Para mete rs  

Parameter Values Description 

Video Input Lock Yes, No Shows whether there is a video lock to the format specified 
through the parameters below. Read only parameter. 

Source SDI The video will be sourced from the HD-SDI input on the 
rear panel. 

Color Bars An internally generated color bars test pattern will be used 
as the video source. 

Black An internally generated black test pattern will be used as 
the video source. 

Moving Object An internally generated moving object test pattern will be 
used as the video source. 

Slate A slate file uploaded by the user will be used as the video 
source. 

Color Bars with text overlay The Color Bars source overlaid with the Ident Text. 

Input Detection Off, Auto Detect and Report, Auto Detect and 
Configure 

Controls whether the format of the SDI input shall be 
automatically detected or what actions to take if a change 
is detected in the Input Video Format.  

Detected Video 
Standard 

Not Detected, HD 720p50, HD 720p59.94, HD 
1080i25, HD 1080i29.97, HD 1080p50, HD 
1080p59.94, HD 2160p50, HD 2160p59.94, 

The detected video standard if Input Detection is set to 
other than Off. If the format is not detected or Input 
Detection is set to Off, it is set to Not Detected. Read only 
parameter. 

Video Input Format HD 720p50, HD 720p59.94, HD 1080i25, HD 
1080i29.97, HD 1080p50, HD 1080p59.94, HD 
2160p50 Interleaved, HD 2160p59.94 
Interleaved, HD 2160p50 Quad, HD 2160p59.94 
Quad 

Defines the expected video format on the SDI input or the 
video format used for encoding. A change in the Video 
Input Format might result in a change in the Video Profile 
used for encoding. 

Output On Video Loss Freeze Frame, Freeze with text overlay Repeats the last good video frame on loss of video input. 
Text overlay is not supported in this release. 
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Parameter Values Description 

Black, Black with text overlay Switches to a black test pattern on loss of video input. Text 
overlay is not supported in this release. 

Slate with text overlay Switches to pre-configured text overlay on loss of video. 

Color Bars, Bars with text overlay Switches to a color bars test pattern on loss of video input. 
Text overlay is not supported in this release. 

No PID The video PID shall no longer be transmitted. The SI is not 
updated. 

Ident Text  Overlay text to display on top of images. 

Upload New Logo File Browse, Upload Browse to and upload the file to be used for the logo. 

Logo insertion Off, On Controls if logos are displayed or not. The file to use can 
be selected under Logo file. 

Logo file  The file to use as a logo. The selected file can be 
uploaded by selecting the Upload option. 

A fixed logo position? On, Off Controls whether to use the default position for overlaying 
the logo on the video. Not supported in this release. 

The X position of the 
logo 

 The position relative to left of the screen 0 .. (number of 
pixels per video line - logo width - 1). If an invalid 
position is specified, a logo display alarm will be 
generated. Displayed only if A fixed logo position? is set to 
Off. Not supported in this release. 

The Y position of the 
logo 

 The position relative to top of screen 0 .. (number of 
video lines - logo height - 1). If an invalid position is 
specified, a logo display alarm will be generated. 
Displayed only if A fixed logo position? is set to Off. Not 
supported in this release. 

Upload New Slate File Browse, Upload Browse to and upload the file to be used for the slate 

Video Encoding  

The following parameters are available on the Encode tab of the Properties widget on the Service 
Configuration page when a video component is selected in th e Ou tputs widget. The same 
parameters can be accessed through the Advanced/CE -HEVC/Video/Video 1/Vid eo/Main 
Video/Video Encoder  menu on the front panel.  
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Table 5.94  Video Encoding Parameters  

Parameter Values Description 

Video Profile Profile Off,  

HD HEVC Main Profile Level 4.0 High Tier 4:2:0 8 bit,  

HD H.264 Main Profile Level 4.0 4:2:0 8 bit,  

HD H.264 Main Profile Level 4.1 4:2:0 8 bit,  

HD H.264 High Profile Level 4.0 4:2:0 8 bit,  

HD H.264 High Profile Level  4.1  4:2:0 8 bit,  

HD H.264 Hi422 Profile Level 4.0 4:2:2 8 bit,  

HD H.264 Hi422 Profile Level 4.0 4:2:2 10 bit,  

HD H.264 Hi422 Profile Level 4.0 4:2:2 8 bit,  

HD H.264 Hi422 Profile Level 4.0 4:2:2 10 bit,  

HDp50/59.94 H.264 High Profile Level 4.1 High Tier 4 :2:0  
8 bit,  

HDp50/59.94 H.264 High Profile Level 4.2 High Tier 4:2:2 
8 bit,  

HDp50/59.94 H.264 Hi 422 Profile Level 4.2 High Tier 
4:2:2 10 bit,  

HD HEVC Main Profile Level 4.0 High Tier 4:2:0 8 bit,  

HD HEVC Main Profile Level 4.0 High Tier 4:2:0 10 bit,  

HD HEVC Main Profile Level 4.1 High Tier 4:2:0 8 bit,  

HD HEVC Main Profile Level 4.1 High Tier 4:2 :0 10 bit,  

HD HEVC Main Profile Level 4.0 High Tier 4:2:2 8 bit,  

HD HEVC Main Profile Level 4.0 High Tier 4:2:2 10 bit,  

HD HEVC Main Profile Level 4.1 High Tier  4:2:2 8 bit,  

HD HEVC Main Profile Level 4.1 High Tier 4:2:2 10 bit,  

HDp50/59.94 HEVC Main Profile Level 4.1 High Tier 4:2:0 
8 bit,  

HDp50/59.94 HEVC Main Profile Level 4.1 High Tier 4:2:0 
10 bit,  

HDp50/59.94 HEVC Main Profile Level 4.1 High Tier 4: 2:2 
8 bit,  

HDp50/59.94 HEVC Main Profile Level 4.1 High Tier 4:2:2 
10 bit,  

UHD HEVC Main 10 Pro file Level 5.1 High Tier 4:2:0 10 
bit,  

UHD HEVC Main 10 Profile Level 5.1 High Tier 4:2:2 10 bit  

 
 
 
 
 

Sets the encoder profile. The profile will 
also affect the allowed bit rate range. 

Profile for HD input Profile Off, 

HD HEVC Main Profile Level 4.0 High Tier 4:2:0 8 bit, 

HD HEVC Main Profile Level 4.0 High Tier 4:2:0 10 bit, 

HD HEVC Main Profile Level 4.1 High Tier 4:2:0 8 bit, 

HD HEVC Main Profile Level 4.1 High Tier 4:2:0 10 bit, 

HD HEVC Main Profile Level 4.0 High Tier 4:2:2 8 bit, 

HD HEVC Main Profile Level 4.0 High Tier 4:2:2 10 bit, 

HD HEVC Main Profile Level 4.1 High Tier 4:2:2 8 bit, 

HD HEVC Main Profile Level 4.1 High Tier 4:2:2 10 bit 

The profile to set when an SD input is 
detected on the SDI input. Visible only if 
Input Detection is set to Auto Detect 
and Configure. If this option is visible, 
the Video Profile cannot be set 
manually. 
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Parameter Values Description 

Profile for 3G input Profile Off, 

HDp50/59.94 HEVC Main Profile Level 4.1 High Tier 4:2:0 8 bit, 

HDp50/59.94 HEVC Main Profile Level 4.1 High Tier 4:2:0 10 bit, 

HDp50/59.94 HEVC Main Profile Level 4.1 High Tier 4:2:2 8 bit, 

HDp50/59.94 HEVC Main Profile Level 4.1 High Tier 4:2:2 10 bit 

The profile to set when a 3G input is 
detected on the SDI input. Visible only if 
Input Detection is set to Auto Detect 
and Configure. If this option is visible, 
the Video Profile cannot be set 
manually. 

Profile for UHD input Profile Off, 

UHD HEVC Main 10 Profile Level 5.1 High Tier 4:2:0 10 bit, 

UHD HEVC Main 10 Profile Level 5.1 High Tier 4:2:2 10 bit 

The profile to set when an UHD input is 
detected on the SDI inputs. Visible only 
if Input Detection is set to Auto Detect 
and Configure. If this option is visible, 
the Video Profile cannot be set 
manually. 

Resolution 1280 x 720,  

1920 x 1080,  

3840 x 2160 

Defines the horizontal and vertical 
resolution of the encoded video. The 
available options depend on the values 
set for Video Input Format and Video 
Profile. 

Down-conversion from 1080i to 720p 
available for HEVC 4:2:0 and H.264 
(both 4:2:0 and 4:2:2) profiles. For down-
conversion, the encoded frame rate is 
the same as the input frame rate. 

Down-conversion is not available in 
Super Low Delay buffer mode. 

Signalling Options SDR (BT.709), UHD SDR (BT.2020), HDR HLG10 (HDR in VUI), 
HDR HLG10 (SDR in VUI), HDR PQ10 

The HDR signalling option to be used. 

Video Bit Rate The valid bit rate range depends on the selected video profile. Defines the bit rate to be used by the 
compressed video component. If Bit 
Rate Tracking Mode is set to Maximize 
Video for the Transport Stream that 
contains the video component, and the 
Bit Rate Weighting of the component is 
set to other than Fixed or Minimal, this 
field is read only. 

Buffer Mode CBR Constant Bit Rate operation. 

Low Delay Reduced encode delay achieved by 
removing pre-processing functions. Bit 
Rate, GOP structure and GOP length 
impact the delay. The IP GOP structure 
will give low delay, but with reduced 
quality.  

Mega Low Delay Encode delay reduced further by 
removing frame-sync in pre-processing. 
Bit Rate, GOP structure and GOP length 
impact the delay. The IP GOP structure 
will provide lower latency than Low 
Delay.  

Super Low Delay Only available for HEVC and a single 
channel: 

The lowest delay is achieved by 
removing GOP structure concepts and 
concentrating on striping of P Frames or 
complete I Frames. This selection will 
provide the best latency delay 
performance. No ANC stream 
processing is available in this mode.  

Aspect Ratio 16:9, 4:3 Does not affect the video encoding but 
rather indicates what the desired aspect 
ratio for the decoded picture (not the 
pixel). If no other mechanism such as 
WSS in the VBI is used, the video output 
image will use this aspect ratio. 
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Parameter Values Description 

GOP Length 4 to 250 Defines the nominal distance in steps of 
video frames between two consecutive I 
frames in the encoded bit-stream. This 
setting is not available when Buffer 
Mode is set to Super Low Delay. 

GOP Structure IP, IBP, IBBP, IBBBP, IBBBBBBBP Sets the number of B frames between 
reference frames. IBBBBBBBP can only 
be used for 720p video format encoded 
with a H.264 video profile. When Buffer 
Mode is set to Super Low Delay, GOP 
Structure is limited to All P or I Frame 
only. 

Closed GOPs Off, On Enables or disables the usage of Group 
of Pictures in which the predicted frames 
can have their reference from outside 
the group. This setting has no effect 
when Super Low Delay Buffer Mode is 
selected. 

Delay  Displays the actual video encoding 
delay. Read only parameter. 

Output Entropy Encoding is automatically used, depending on what coding standard and bit rate is 
selected.  

Table 5.95  Output Entropy Encoding  

Coding Standard Bit Rate  Entropy Encoding 

HEVC single channel Any bit rate CABAC 

HEVC multichannel  Any bit rate CABAC 

H264 single channel Less than 50 Mbps CABAC 

HEVC single channel More than 50 Mbps CAVLC  

H264 multichannel Any bit rate CAVLC 

Video Output  

The following parameters are available on the Output  tab of the Propertie s  wi dget on the 
Service Configuration  page when a video component is selected in the Outputs  widget. The 
same parameters can be accessed through the Advanced/Video/Video 1/Video/Main 
Video/Stream Output  menu on the front panel.  

Table 5.96  Video Output Parameters  

Parameter Values Description 

Embedded PCR Off, On Sets if the PCR is embedded within the video. If it is set to 
other than Off, the PCR PID field of a service will become 
read only and will contain the PID of the current 
component. 

Copyright Off, On Sets the copyright flag in the elementary stream header. 

Original Off, On Sets the original flag in the elementary stream header. 

AR Signalling Output 
Control 

Off, AFD Only, AFD and Bar Data Controls which source is used for embedding aspect ratio 
signalling into user data. If set to Off, no aspect ratio data 
will be resent in the output. AFD sources are: SMPTE 
2016, Video Index, WSS-AFD/WSS, user set Aspect 
Ratio. Bar Data is only SMPTE 2016. This setting is not 
available (not visible) when Super Low Delay Buffer Mode 
is selected. 
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Parameter Values Description 

TC Output Location Off, SEI Message Defines how timecode is put into the output video stream. 
This setting is not available (not visible) when Super Low 
Delay Buffer Mode is selected. 

Closed Captions Off, ATSC (default) Controls if Closed Captions are included in the output 
stream. This setting is not available (not visible) when 
Super Low Delay Buffer Mode is selected. 

Video Component  

The following parameters are available on the Component  tab of the Properties  widget on the 
Service Configuration  page when a video component is selected in the Outputs  widget. The 
same parameters can be accessed through the Output/<output name>/Transport Stream 
ID: <n>/Service List/<service name> /Com ponent List/Slot  <x> Video Stream on PID 

<y>  menu on the front pane l.  

Table 5.97  Video Component Parameters  

Parameter Values Description 

PID 16 to 8190 Sets the packet identifier associated with the component. 

Bit Rate Weighting Fixed, Minimum, 2 to 20 Specifies the weight associated to the component in the 
Bit Rate Tracking algorithm. 

Master TS Off, On Sets the master Transport Stream for the component. 

Source PID Monitoring None, Monitor, Monitor & Redundancy Priority 1 ETR290 monitoring on this PID from an IP input 
can be enabled, and can be set to cause a redundancy 
switch to a spare device if in a system controlled by 
MediaKind control software. Not supported in this release. 

Multichannel Restricti ons  

The first channel must always be set to encode.  If this is set to OFF, then it will not be possible to 
encode any video stream. If there are to be mixed frame rates, the highest frame rate of all 
channels must be present on channel 1.  

¶ It is not possib le t o mix 25 Hz and 29.97 Hz on the same card.  

¶ It is not possible to mix 50 Hz and 59.94 Hz on the same card.  

GOP Structure  

¶ There is no restriction across the channels.  Each channel may have a different GOP structure.  

Bit Rate  

¶ There is no restriction acro ss t he channels. Each channel may have a different bit ra te. If two 
or more channels are in use the bit rate for each channel may not exceed 30 Mbps.  

Number of Channels Per Card:  

¶ It is only possible to encode one UHD stream.  

¶ It is only possible to encode t hree  1080p streams.  

¶ It is possible to encode up to four 7 20p/1080i streams.  

¶ In Super Low Delay mode, it is only possible to encode one channel of HEVC video (any 
resolution).  

¶ In Super Low Delay mode, it is not possible to encode H.264 video.  

Notes:  First R elea se (release 9.29):  
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 The same video format must be pre sent across all channels in this first release.  

 In subsequent releases (release TBD):  

 If the first channel is configured to 720p or 1080p, channels 2 -3 may be configured to be 
either 720p or 1080i . 

 I f the first channel is configured to 1080i, channels 2-3 may only be configured to be 
1080i.  

Available Encoding Profiles/Levels When Using Multiple Channels  

When using multiple channels, the available encoding profiles/levels are dictated by the 
profil e/le vel selected on channel 1. The profiles/levels for ch annels 2 to 4 must come from the 
same group, as shown in the table below.  

Table 5.98  Available Multichannel Encoding Profiles/Levels  

Ch 1 Profile/Level Available Profile/Level for Ch 2-4 

H.264 HD Off 

HD H.264 Main Profile Level 4.0 4:2:0 8 bit, 

HD H.264 Main Profile Level 4.1 4:2:0 8 bit, 

HD H.264 High Profile Level 4.0 4:2:0 8 bit, 

HD H.264 High Profile Level 4.1 4:2:0 8 bit, 

HD H.264 Hi422 Profile Level 4.0 4:2:2 8 bit, 

HD H.264 Hi422 Profile Level 4.0 4:2:2 8 bit 

HD H.264 Hi422 Profile Level 4.0 4:2:2 10 bit, 

HD H.264 Hi422 Profile Level 4.0 4:2:2 10 bit. 

H.264 3G Off 

HDp50/59.94 H.264 High Profile Level 4.1 High Tier 4:2:0 8 bit,  

HDp50/59.94 H.264 HIgh Profile Level 4.2 High Tier 4:2:2 8 bit, 

HDp50/59.94 H.264 Hi422 Profile Level 4.2 High Tier 4:2:2 10 bit. 

HEVC HD Off 

HD HEVC Main Profile Level 4.0 High Tier 4:2:0 8 bit,  

HD HEVC Main Profile Level 4.1 High Tier 4:2:0 8 bit,  

HD HEVC Main Profile Level 4.0 High Tier 4:2:0 10 bit,  

HD HEVC Main Profile Level 4.1 High Tier 4:2:0 10 bit, 

HD HEVC Main Profile Level 4.0 High Tier 4:2:2 8 bit,  

HD HEVC Main Profile Level 4.1 High Tier 4:2:2 8 bit. 

HEVC 3G Off 

HDp50/59.94 HEVC Main Profile Level 4.1 High Tier 4:2:0 8 bit, 

HDp50/59.94 HEVC Main Profile Level 4.1 High Tier 4:2:2 8 bit, 

HDp50/59.94 HEVC Main Profile Level 4.1 High Tier 4:2:0 10 bit, 

HDp50/59.94 HEVC Main Profile Level 4.1 High Tier 4:2:2 10 bit. 

Note:  If channel 1 is set to Off,  then no chan nels  will be able to encode.  

Vertical Bl anking Interval / Ancillary Data  

The following parameters are available on the VBI  tab of the Properties  widget on the Service 
Configuration  page when a video stream is selected in the Outputs  widget. The same 
parame ters  can be accessed through the Advance d/CE - HEVC/Video/Video 1/Input/VBI 
Extraction  menu on the front panel.  

Note:  These setting are not available (not visible) when Super Low Delay Buffer Mode is 
selected.  

Table 5.99  Vertical Blanking Interval / A ncillary Data Parameters  
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Parameter Values Description 

Closed Captions 

Closed Captions 
Source 

Off, SMPTE334 The source for Closed Captions data encoded as part of 
the Video Stream. Only applicable when frame rate is 
29.97 Hz. 

Timecode 

TC Mode Off; External, Zero on Loss; External, Freewheel 
on Loss; Internal 

Controls what mode the Time code (TC) is working in, 
either Off, external source or internally generated. Also 
sets what happens on loss of external source (zero or 
freewheel). 

TC External Source 11 Auto, ANC VITC1, ANC VITC2, ANC LTC Controls the external source of Time Code. Auto will select 
the first source present in order of the drop down list. 

TC Dropframes Off, On, Auto Only displayed when 29.97 Hz family is selected on Input 
tab. Auto configures to external source, or to ON for 
internal source. 

Table 5.100  ARC Parameters  

Parameter Values Description 

Aspect Ratio (AR) Signaling 

SMPTE2016 Off (Default), On Controls whether SMPTE 2016 data can be used as a 
source for AR info. 

AFD Sustain Maintain previously received AFD code 
indefinitely 

Maintain previously received AFD code for 
period specified in Sustain Timeout, then 
drop to default, i.e. code 1000  

Maintain  pre viously received AFD code for 
period specified in Sustain Timeout, then 
switch AFD off  

Control what AFD code goes out when AFD is lost at input. 

Indefinitely: Maintains previously received AFD code 
indefinitely. 

Default after Timeout: Maintains previously received AFD 
code for period specified in Sustain Timeout, then drop to 
default, i.e. code 1000. 

Off after Timeout: Maintains previously received AFD code 
for period specified in Sustain Timeout, then switch AFD 
off. 

AFD Sustain Timeout 0 to 5,10, 20, 50, 100, 120 Control how long in frames previous AFD code is 
maintained. Zero means drop to default immediately on 
loss. 

Input Detection  

The CE -HEVC VCM supports video input detection as described in Chapter 3, Getting Started: How 
to Configure and Use I nput  Detection , with the exception of "Auto Detect and Restore Saved 
Config".  

5.5.3.5.2  Audio Stream Configuration  

Audio Input  

The following parameters are available on the Input  tab of the Properties  widget on the Service 
Configuration  page when an audio component is s elected in the Ou tputs  widget. The same 
parameters can be accessed through the Advanced/CE - HEVC/Audio Module/Audio 
<n>/Input  menu on the front panel.  

Table 5.101  Audio Input Parameters  

Parameter Values Description 

Input Format Uncompressed (LPCM), MPEG Layer II, Dolby 
Digital, Dolby E, AAC 

Sets the input format used by the audio encoder. 
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Parameter Values Description 

Input Source Off, Mute, Test Tone, Embedded 1 to 8, Input 1 -
4 

Sets the source used by the audio encoder. No input is fed 
to the encoder if Off is selected. Mute mutes the incoming 
audio and encodes silence. Test Tone encodes an 1 kHz 
test tone, Embedded 1 to 8 sets the source to an SDI 
embedded audio stream. Input 1-4 are for the digital 
inputs. 

Output On Audio Loss No PID, Silence Specifies the action to take when input is Lost. No PID is 
for dropping the audio PID from the stream, Silence is for 
encode silence. 

NOTE: When No PID is selected, the reference to the PID 
is not removed from the Program Map Table, so a 
Transport Stream analyzer will indicate a ghost PID in the 
output Transport Stream. 

Source Switchout Off, Mute, Test Tone, Embedded 1 to 8, Input 1 -
4 

Specifies which input to output to the reference output on 
the 15-way D-type audio connector. 

Audio Encoding  

The following parameters are available on the Encode  tab of the Properties  widget on the 
Service Configuration  page when an audio component is selected in the Outputs  widget. The 
same parameters can be accessed through the Advanced/CE - HEVC/Audio Module/Aud io 
< n>/Encode  menu on the front panel.  

Note:  When Super Low Delay  is selected, LPCM Pass - thru  or Dolby E Pass - thru  is available.  

Table 5.102  Audio Encoding Standards  

Parameter Options Description 

Coding Standard MPEG Layer 2 MPEG Layer 2 Encode(More than two channel pairs 
require the CE/SWO/VP/M1L2 license) 

Dolby Digital Dolby Digital encode, requires CE/SWO/VP/DOLBYAC3 
license.  

AAC-LC AAC-LC encoding, requires CE/SWO/VP/AAC license. 

HE-AAC HE-AAC or HE-AAC v2 encoding, requires 
CE/SWO/VP/AAC license. 

Pass-thru Pass-thru of the input 

Audio Description Service MPEG-1 Layer II encode of a mono audio track that 
describes action in the video plus a control track. 

MPEG-H MPEG-H Audio Contribution encoding mode. Requires 
CE/SWO/VP/MPEGH license. 

Table 5.103  MPEG Layer 2 Parameters  

Parameter Values Description 

Bit Rate 32, 48, 56, 64, 80, 96, 112, 128, 160, 192, 224, 
256, 320, 384 

Bit Rate of the audio stream 

Coding Mode 1/0 (Left - input), 1/0 (Right - input), 1/0 (L+R)/2, 
1+1 (L/Ch1, R/Ch2), 2/0, 2/0 (Joint), Phase 
Aligned Audio (6 Cannels), Phase Aligned Audio 
(8 Cannels) 

Specifies what channel configuration to use for encoding. 

Embedded PCR On, Off Controls whether PCR is to be embedded in the audio 
PES. 

Au Information Cont Off, AU Info Controls the insertion of private data in the adaptation unit 
of the audio access units (AU). AU Info is defined in ETSI 
TR 101 154. Only AU_PTS is present for audio 
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Parameter Values Description 

Advanced 

Lip Sync Offset -500 to 500 ms Configures a delay to the audio to improve A/V 
synchronization. 

Gain -6 to 6dB Sets the gain in dB for the audio stream. 

Language  The language of the stream when not in dual mono (1+1) 
mode. 

Language (Left)  The language of the left channel when in dual mono (1+1) 
mode. 

Language (Right)  The language of the right channel when in dual mono 
(1+1) mode. 

User Language 1  A custom three-character language code when User 
Language 1 is set in any of the language fields. 

User Language 2  A custom three-character language code when User 
Language 2 is set in any of the language fields. 

MPEG Version MPEG1, MPEG2 Configures if MPEG-1 or MPEG-2 to be ignaled. 

Copyright Off, On Indicates if the material is copyright protected. 

Original Off, On Indicates if source is the original or a copy 

De-emphasis Off, 50/15us, CCITT J.17 To meet the MPEG-1 Layer 2 encoding algorithm 
specification the audio must not have pre-emphasis 
applied. If the input signal does have pre-emphasis 
applied, a de-emphasis filter must be applied prior to 
encoding. 

Table 5.104  Dolby Digital Parameters  

Parameter Values Description 

Bit Rate 56, 64, 80, 96, 112, 128, 160, 192, 224, 256, 
320, 384, 448, 512, 576, 640 

Bit Rate of the audio stream. The available options depend 
on the selected coding mode. 

Coding Mode 1/0 (Left ï input), 1/0 (Right ï input), 1/0 (L+R)/2, 
2/0, 3/2L (5.1 Surround) 

Specifies what channel configuration to use for encoding. 

Metadata Controls 
Coding Mode 

Off, On Override default coding mode with coding mode indicated 
in decoder program configuration or live metadata (if 
present). 

Metadata source type Embedded/Decoded Auto, Serial Port (Program 
1 to 8) 

Selects where live metadata comes from. 

Metadata override 
type 

None, All, Compression Profile, Dialogue 
Normalization, Comp Profile and Dial Norm 

Defines which metadata parameters to override. 

Metadata Reversion 
Mode 

Last Used, Preset Determines which metadata is used upon loss of live 
metadata. 

Metadata preset type 1 to 8 Defines which metadata preset to use if Preset is selected 
for Metadata Reversion Mode. 

Embedded PCR On, Off Controls whether PCR is to be embedded in the audio 
PES. 

Au Information Cont Off, AU Info Controls the insertion of private data in the adaptation unit 
of the audio access units (AU). AU Info is defined in ETSI 
TR 101 154. Only AU_PTS is present for audio 
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Parameter Values Description 

Advanced 

Lip Sync Offset -500 to 500 ms Configures a delay to the audio to improve A/V 
synchronization. 

Gain -6 to 6dB Sets the gain in dB for the audio stream. 

Language  The language of the stream. 

User Language 1  A custom three-character language code when User 
Language 1 is set in the Language field. 

User Language 2  A custom three-character language code when User 
Language 2 is set in the Language field. 

Table 5.105  AAC-LC Parameters  

Parameter Values Description 

Bit Rate 32, 48, 56, 64, 80, 96, 112, 128, 160, 192, 224, 
256, 320, 384, 448, 512 

Bit Rate of the audio stream. The available options depend 
on the selected coding mode. 

Coding Mode 2/0, 3/2L (5.1 Surround) Specifies what channel configuration to use for encoding. 

Embedded PCR On, Off Controls whether PCR is to be embedded in the audio 
PES. 

Au Information Cont Off, AU Info Controls the insertion of private data in the adaptation unit 
of the audio access units (AU). AU Info is defined in ETSI 
TR 101 154. Only AU_PTS is present for audio 

Encapsulation MPEG2 ADTS, MPEG4 LATM/LOAS Specifies the encapsulation used for transmitting AAC 
content. It can be either MPEG-2 Audio Data Transport 
Stream or MPEG-4 Low Overhead Audio Stream based on 
MPEG-4 Low Overhead Audio Transport Multiplex. 

TNS (Temporal Noise 
Shaping) 

Off, On Turns noise shaping on or off. 

Advanced 

Lip Sync Offset -500 to 500 ms Configures a delay to the audio to improve A/V 
synchronization. 

Gain -6 to 6dB Sets the gain in dB for the audio stream. 

Language  The language of the stream. 

User Language 1  A custom three-character language code when  User 
Language 1 is set in the Language field. 

User Language 2  A custom three-character language code when User 
Language 2 is set in the Language field. 

Table 5.106  HE-AAC Parameters  

Parameter Values Description 

Bit Rate 16, 24, 32, 48, 56, 64, 80, 96, 112, 128, 160, 
192, 224, 256 

Bit Rate of the audio stream. The available options depend 
on the selected coding mode. 

Coding Mode 2/0, 3/2L (5.1 Surround) Specifies what channel configuration to use for encoding. 

Embedded PCR On, Off Controls whether PCR is to be embedded in the audio 
PES. 

Au Information Cont Off, AU Info Controls the insertion of private data in the adaptation unit 
of the audio access units (AU). AU Info is defined in ETSI 
TR 101 154. Only AU_PTS is present for audio 
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Parameter Values Description 

Encapsulation MPEG2 ADTS, MPEG4 LATM/LOAS Specifies the encapsulation used for transmitting AAC 
content. It can be either MPEG-2 Audio Data Transport 
Stream or MPEG-4 Low Overhead Audio Stream based on 
MPEG-4 Low Overhead Audio Transport Multiplex. 

TNS (Temporal Noise 
Shaping) 

Off, On Turns noise shaping on or off. 

SBR Signalling Explicit, Implicit Specifies how Spectral Band Replication is signaled. 

Advanced 

Lip Sync Offset -500 to 500 ms Configures a delay to the audio to improve A/V 
synchronization. 

Gain -6 to 6dB Sets the gain in dB for the audio stream. 

Language  The language of the stream. 

User Language 1  A custom three-character language code when User 
Language 1 is set in the Language field. 

User Language 2  A custom three-character language code when User 
Language 2 is set in the Language field. 

Table 5.107  Pass- thru Parameters  

Parameter Values Description 

Embedded PCR On, Off Controls whether PCR is to be embedded in the audio 
PES. 

Au Information Cont Off, AU Info Controls the insertion of private data in the adaptation unit 
of the audio access units (AU). AU Info is defined in ETSI 
TR 101 154. Only AU_PTS is present for audio. 

Advanced 

Lip Sync Offset -500 to 500 ms Configures a delay to the audio to improve A/V 
synchronization. 

Gain -6 to 6dB Sets the gain in dB for the audio stream. 

Language  The language of the stream. 

User Language 1  A custom three-character language code when User 
Language 1 is set the Language field. 

User Language 2  A custom three-character language code when User 
Language 2 is set in the Language field. 

Table 5.108  Audio Description Service Parameters  

Parameter Values Description 

Bit Rate 64 Bit Rate of the audio stream. 

Coding Mode 1/0 (Left ï input) Specifies what channel configuration to use for encoding. 

Embedded PCR On, Off Controls whether PCR is to be embedded in the audio 
PES. 

Au Information Cont Off, AU Info Controls the insertion of private data in the adaptation unit 
of the audio access units (AU). AU Info is defined in ETSI 
TR 101 154. Only AU_PTS is present for audio 



 

AVP 1000, 2000 & 3000  | Version Y www.m ediakind.com  
 

5-116  

Parameter Values Description 

Advanced 

Lip Sync Offset -500 to 500 ms Configures a delay to the audio to improve A/V 
synchronization. 

Gain -6 to 6dB Sets the gain in dB for the audio stream. 

Language  The language of the stream. 

User Language 1  A custom three-character language code when User 
Language 1 is set in the Language field. 

User Language 2  A custom three-character language code when User 
Language 2 is set in the Language field. 

Table 5.109  MPEG-H Audio Parameters  

Parameter Values Description 

Bitrate  
(per channel) 

128, 148 or 168 kbit/s The bitrate per channel for the encoded stream. This value 
will be multiplied by the number of configured channels 
(where stereo requires 2 channels and 5.1 requires 6 
channels). 

Source  Off, Embedded 1-16. (Embedded 9-16, only for 
3G inputs) 

Sets the source used by the audio encoder for this group. 
The group is not used if Off is selected. Embedded 1 to 16 
sets the source to an SDI embedded audio stream. 

Channel Layout 1/0 (L ï input), 1/0 (R ï input), 2/0, 3/2L (5.1 
Surround), 5/2L (7.1 Surround), 10 Channel 
Mono 

Specifies what channel configuration should be reported in 
the MPEG-H metadata. 

Loudness -40 to 0 LKFS (LU) Specifies the input loudness that should be reported in the 
MPEG-H metadata. 

Language  The language of the stream to be reported in the MPEG-H 
metadata. 

Type Dialogue, Non-Dialogue, ADS (Receiver mix), 
ADS (Broadcast mix) 

The type of audio content on this stream. This will be 
reported in the MPEG-H metadata. 

Audio Component  

The parameters listed in the table below are available on the Component  tab of the Propert ies  
widget on the Service  Configuration  page when an audio component is selected in the Outputs  
widget. The same parameters can be accessed through the Output/<output name>/Transport 
Stream ID: <n>/Service List/<service name>/Component List/<component name >  
me nu on the front panel . 

Table 5.110  Audio Component Parameters  

Parameter Values Description 

PID 32 to 8190 Sets the packet identifier associated with the component. 

Bit Rate Weighting Fixed Specifies the weight associated to the component in the 
Bit Rate Tracking algorithm. For audio stream, this is Fixed 
and read only. 

Dolby Metadata Presets  
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Four custom Dolby Metadata Presets can be configured in the Advanced Setup tab of the Device 

Configuration page. T o se t t he preset options, in the Advanced Video Processor Settings drill down 
to Encoder > Slots > Slot <n> -  CE- HEVC >CE - HEVC > Audio Module > Dolby Metadata 
Presets , and select the preset you want to modify. Alternatively, the settings can be reached 
thr ough  th e front panel under Advanced/CE - x/Audio Module/Dolby Metadata Presets . Any 
of these presets can then be applied to any audio channel encoding audio in the Dolby Digital 
format. The table lists the parameters for each preset.  

Table 5.111  Dolby Metadata Preset Parameters  

Parameter Values Description 

Preset name  Name of the preset (for user information) 

Dialogue 
normalization level 

-31 to -1 dB Used by a decoder to determine the level of adjustment 
required to achieve the set level. 

Bitstream mode Main audio service: complete main, music and 
effects, Associated service: visually impaired, 
Associated service: hearing impaired, 
Associated service: dialogue, Associated 
service: commentary, Associated service: 
emergency, Associated service: visually 
impaired, Associated service: karaoke/voiceover 

Flags the type of service in the bitstream. 

Line mode 
compression profile 

None, Film Standard, Film Light, Music 
Standard, Music Light, Speech 

Alters the dynamic range for line output. 

RF mode compression 
profile 

None, Film Standard, Film Light, Music 
Standard, Music Light, Speech 

This alters the dynamic range for RF output. The overall 
level is raised by 11dB. 

Center mix level 0.707 (-3.0 dB), 0.595 (-4.5 dB), 0.500 (-6.0 dB) Indicates the downmix level when there is no centre 
speaker. This is applied to left and right channels only. 

Surround mix level 0.707 (-3.0 dB), 0.500 (-6.0 dB), 0 (-inf dB) Surround downmix level for the front left and right 
channels when consumer has no surround speakers. 

Dolby Surround mode Not Indicated, Not Encoded, Encoded Flags if a two channel encoded stream contains 
information for a Dolby Pro-logic decode (Lt/Rt) 

Audio production 
information exists 

Off, On This indicates whether the Mixing Level and Room Type 
parameters exist within the bit-stream. 

Mixing level 80 to 111 dB Indicates the acoustic sound pressure level of the dialogue 
level during the final audio mixing session. 

Room type Not indicated, Large room X curve monitor, 
Small room flat monitor 

Type and calibration of the mixing room used for the final 
audio mixing session. 

Copyright flag Off, On Indicates if the material is copyright protected 

Original bitstream flag Off, On Indicates if source is the original or a copy 

Enable extended 
bitstream information 

Off, On Flags if additional information is available for downmixing. 

Preferred downmix 
mode 

Not indicated, Lt/Rt downmix preferred, Lo/Ro 
downmmix preferred 

Indicates if the producer would prefer a Lt/Rt or a Lo/Ro 
downmix. Can be over-ridden by the decoder. 

Lt/Rt center mix level 1.414 (+3.0 dB), 1.189 (+1.5 dB), 1.000 (0 dB), 
0.841 (-1.5 dB), 0.707 (-3.0 dB), 0.595 (-4.5 dB), 
0.500 (-6.0 dB), 0 (-inf dB) 

Indicates the required level reduction of the center channel 
when mixed with the L& R channels for a Lt/Rt downmix. 
Similar to 'Center mix level'. 

Lt/Rt surround mix 
level 

0.841 (-1.5 dB), 0.707 (-3.0 dB), 0.595 (-4.5 dB), 
0.500 (-6.0 dB), 0 (-inf dB) 

Indicates the required level reduction of the surround 
channels when mixed for a Lt/Rt downmix. Similar to 
Surround mix level'. 

Lo/Ro center mix level 0.841 (-1.5 dB), 0.707 (-3.0 dB), 0.595 (-4.5 dB), 
0.500 (-6.0 dB), 0 (-inf dB) 

Indicates the required level reduction of the center channel 
when mixed with the L& R channels for a Lo/Ro downmix. 
When present this replaces the value set for the 'Center 
mix level' 
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Parameter Values Description 

Lo/Ro surround mix 
level 

0.841 (-1.5 dB), 0.707 (-3.0 dB), 0.595 (-4.5 dB), 
0.500 (-6.0 dB), 0 (-inf dB) 

Indicates the required level reduction of the center channel 
when mixed for Lo/Ro downmix. When present this 
replaces the value set for the 'Surround mix level'. 

Dolby Surround EX 
mode 

0.841 (-1.5 dB), 0.707 (-3.0 dB), 0.595 (-4.5 dB), 
0.500 (-6.0 dB), 0 (-inf dB) 

Flags if the stream has been encoded in Surround Ex. 
Only used if surround channels are present. 

A/D converter type Standard, HDCD Indicates type of A/D conversion used. 

Digital de-emphasis Off, Auto, On To meet the Dolby Digital encoding algorithm specification 
the audio must not have pre-emphasis applied. If the input 
signal does have pre-emphasis applied, a de-emphasis 
filter must be applied prior to encoding. 

DC high pass filter 
enable 

Off, On Removing the DC component can lead to more efficient 
encoding, but there is a risk that signals that do not reach 
100% PCM may exceed this after filtering and therefore 
must be clipped. 

Bandwidth low-pass 
filter enable 

Off, On Remove high frequency signals before encoding. The filter 
removes frequencies that would not normally be encoded. 

Low-frequency effects 
low pass filter enable 

Off, On Apply a 120 Hz low pass filter prior to an encode. Should 
only be switched off if it is known that there are no 
frequencies above 120 Hz. 

Surround attenuation 
enable 

Off, On Attenuate surround channels by 3 dB before encoding. 
Theatrical and consumer mixing rooms use different levels 
for the surround channels, and this can be used to 
compensate. 

Surround phase shift 
enable 

Off, On Apply a phase shift of 90 degrees to the surround 
channels. This simplifies the decode process for producing 
a 'Lt/Rt' downmix. 

5.5.3.5.3  Splicing Stream Configuration  

Splicing  

The parameters listed in the table below are available on the Splicing  tab of the Properties  
widget on the Service Configuration  page when an SCTE 35 stream is selected in th e Ou tputs  
widget. The same parameters can be accessed through the Advanced/CE - HEVC/Video/Video 
1/Video/Main Video/Splicing  menu on the front panel.  

Table 5.112  Splicing Parameters  

Parameter Values Description 

Splicing Control Off, On VANC Message Only On VANC Message only does not insert splice point, but 
converts the SCTE 104 message to SCTE 35 message in 
the output. 

To enable splicing, a splice point insertion license 
(CE/SWO/DPI) is needed. 

Splice Null Insertion Off, On Used to determine the insertion of NULL SCTE 35 
messages into the output stream if no messages have 
been sent for 500ms. 

Audio Splicing Off, On Used to determine if audio is manipulated at the point that 
the video splice occurs. 

Splicing C ompo nent  

The following parameters are available on the Component  tab of the Properties  widget on the 

Service Configuration  page when an SCTE 35  stream is selected in the Outputs  widget. The 
same parameters can be accessed through the Output/<output name>/T rans port Stream 
ID: <n>/Service List/<service name>/Component List/<component name>  menu on the 
front panel.  
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Table 5.113  Slicing Component Parameters  

Parameter Values Description 

PID 32 to 8190 Sets the packet identifier associated with the component. 

Bit Rate Weighting Fixed Specifies the weight associated to the component in the 
Bit Rate Tracking algorithm. For splicing stream, this is 
Fixed and read only. 

5.5.3.5.4  Teletext Stream Configuration  

This section describ es t he parameters for setting up Teletext.  

Teletext  

This section describes the parameters that have an effect on how Teletext is transmitted.  

The parameters listed are available on the Teletext  tab of the Properties  widget on the Service 
Configuration  page  whe n a Teletext stream is selected in the Outputs  widget. The same 
parameters can be accessed through the Advanced/CE - HEVC/video Group/Video 
1/Input/VBI Extraction/Teletext  menu on the front panel.  

Table 5.114  Teletext Parameters  

Parameter Values Description 

Teletext Source  Off, OP-47 (Max 300kbps), VANC Teletext Controls the source from where Teletext is extracted, 
including encapsulation method where appropriate. 

Min # Teletext Packets 0 to 3  Defines the minimum number of Teletext packets 
generated per field, even if there is no Teletext data. 

Teletext Descriptor Page List / Teletext Descriptor Page 

Teletext Page Type Off, Initial Page, Subtitle Page, Additional 
Information Page, Programme Schedule Page, 
Heading Impaired Subtitle Page. 

The page type of the Teletext descriptor. 

Teletext Page Number  The page number for the page to be set. 

Teletext Page 
Language 

List of languages The language set for the Teletext descriptor. 

Teletext Component  

This secti on d escribes the parameters associated with the component carrying Teletext data.  

The following parameters are available on the Component  tab of the Properties  widget on the 
Service Configuration  page when a Teletext stream is selected in the Outputs  widge t. T he 
same parameters can be accessed through the Output/<output name>/Transport Stream 
ID: <n>/Service Li st/<service name>/Component List/<component name>  menu on the 
front panel.  

Table 5.115  Teletext Compon ent Parameters  

Parameter Values Description 

PID 16 to 8190 Sets the packet identifier associated with the component. 

Bit Rate Weighting Fixed Specifies the weight associated to the component in the 
Bit Rate Tracking algorithm. 

5.5.3.5.5  ANC Stream Configuration  

This section describes the parameters available for setting up ANC streams.  
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Note:  No ANC stream processing is available if the video buffer mode ñSuper Low Delayò is 

selected  

Ancillary Data  

This section describes the parameters that have an effect on what a ncil lary data is extracted and 
how the data is transmitted.  

The following parameters are availa ble on the VBI  tab of the Properties  widget on the Service 
Configuration  page when an ANC stream is selected in the Outputs  widget. The same 
parameters can be ac cessed through the Advanced/CE - HEVC/videoGroup/Video 
1/Input/VBI Extraction  menu on the front p anel.  

Table 5.116  Ancillary Data Parameters  

Parameter Values Description 

Description Control 

VBI Descriptor Mode Standard, Legacy, Philips, User The source for Closed Captions data encoded as part of 
the Video Stream (only applicable when Video Frame Rate 
is 29.97 Hz) 

Closed Captions 

Closed Captions Source Off, VBI lines, SMPTE 334 The source for Closed Captions data encoded as part of 
the Video Stream. Only applicable when frame rate is 
29.97 Hz. 

Timecode 

TC Mode Off, External, Zero on Loss, External, 
Freewheel on Loss, Internal 

Controls what mode the Time code (TC) is working in, 
either Off, external source or internally generated. Also 
sets what happens on loss of external source (zero or 
freewheel). 

TC External Source 12 Auto, ANC VITC1, ANC VITC2, ANC LTC Controls the external source of Time Code. Auto will select 
the first source present in order of the drop down list. 

TC Dropframes Off, On, Auto Only in 525 line operation controls if Time Code takes 
account of drop frames or not. Auto configures to external 
source, or to ON for internal source. 

Generic ANC 

Generic ANC Extraction Off, On Controls whether Generic ANC is extracted from the SDI 
stream or not as per SMPTE 2038-2008. 

Max ANC Bit Rate 100 to 2000 kbps The maximum data rate of the Generic ANC data output. 

ANC Component  

This section describes the parameters associated with the component carrying an cill ary data.  

The following parameters are available on the Component  tab of the Properties  widget on the 

Service Configuration  page when an ANC stream is selected in the Outputs  widget. The same 
parameters can be accessed through the Output/<output name>/ Tran sport Stre am ID: 
<n>/Service List/<service name>/Component List/<component name>  menu on the 
front panel.  

Table 5.117  ANC Component Parameters  

Parameter Values Description 

PID 16 to 8190 Sets the packet identifier associated with the component. 

Bit Rate Weighting Fixed Specifies the weight associated to the component in the 
Bit Rate Tracking algorithm. For audio stream, this is Fixed 
and read only. 
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5.5.3.5.6  PCR Stream Configuration  

The video encoding module can g ener ate a separate PCR stream. The PCR stream contains timing 
reference that can be used for decoding the elementary streams included in the same service as 
the PCR stream itself. To use the PCR stream as a timing reference for decoding, set th e PCR PID 
parame ter associated with the service to the PID assigned to the PCR stream.  

The following parameters are available in Properties  widget on the Service Configuration  page 

when a PCR Stream is selected in the Outputs  widget. The same parameters ca n be accesse d 
th rough the Output/<output name>/Transport Stream ID: <n>/Service List/<service 
name>/Component List/Slot <m> Video 1 PCR stream on PID <n>  menu on the front 
panel.  

Table 5.118  PCR Stream Configu ration Param eter s 

Parameters Values Description 

PID 16 - 8190 The packet identifier assigned to packets carrying the 
program clock reference values. 

Bit Rate Weighting Fixed Not relevant for the PCR component. Read only 
parameter. 

 Configuring Transport Streams  

The sect ion describes the parameters available for Transport Stream configuration.  

5.5.4.1  Transport Stream Configuration  

The Transport Streams generated by the unit are fully compliant with the MPEG -2 Transport 
Stream specification (ISO/IEC 1381 8-1), and consists of serv ices that carry one or more 
components.  

Limitations  

Up to 64 output Transport Streams can be created.  

Each Transport Stream can contain up to 64 services.  

A total of 128 tables can be used, across all Transport Streams and Service s. 

Each Service can ha ve o nly one PCR associated with it.  

For example, at one extreme it is possible to create a single Transport Stream containing 64 
Services, and that Transport Stream contains a total of 128 tables. At the other extreme it is 
possible to create 64 Transport Stre ams, each containing a single Service, and each Transport 
Stream contains only PAT and PMT. Real deployments are anticipated to be somewhere in between 

these extremes.  

5.5.4.1.1  General Transport Stream Settings  

The general Transp ort Stream parameters are availa ble in the Properties  widget on the Service 
Configuration  page if a Transport Stream is selected in the Outputs  widget. The same settings 
are also available through the front panel under Output/<interface name>/<Transport 
St ream name> .  

Table 5.119  General Transport Stream Settings  

Parameter  Values  Description  

Status of Service  Online, Offline, Preview, Retire  Determines the output (Setmode) state of the 
Transport Stream.  

Bit rate  0.01 to 216 Mbps  Bit ra te o f the emission transport stream.  
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Parameter  Values  Description  

Reserved Bit rate  -216 to +216 Mbps  Reserve bit rate in the transport stream that will not 
be consumed by services or components.  

Auto Enable  True; False  Automatically resume emission of the TS if the event 
causing au toma tic disable has cleared.  

Auto Disable  Never; Audio Lost; Video Lost; Audio 
or Video Lost; Any CRITICAL alarm  

Automatically stop emission of the TS in the event of 
the selected event.  

Syntax  ATSC; DVB  Which syntax to be used in the TS, descriptors and  
tab les.  

External Generation  Off  External generation of PSI tables, ATSC only.  

Program Specific Information  

Transport Stream 

ID  
1 to 65535  ID of the transport stream as it appears in the NIT.  

PAT/PMT On; Off  Generate PAT and PMT if selected.  

CAT Off; On Conditional Access Table generation.  

TSTD Off; On  Generation of the TSTD table. Selection only available 
for DVB syntax.  

PAT/PMT Parameters  

PMT Repetition 
Period  

100; 400; 500 milliseconds  How often to transmit the PMT.  

Dolby Digital 
Descriptor  

DVB;  ATSC; DVB & ATSC  Format of the Dolby Digital Descriptor in the PMT, if 
present. Selection only available for DVB syntax.  

Service Information  

Original Network ID  1 to 65535  ID of the originating network. Selection only available 
for DVB syntax.  

NIT  Off;  On Network Identification Table. Selection only available 

for DVB syntax.  

TDT Off; On  Time and Date Table. Selection only available for DVB 
syntax.  

EIT Off; On  Event Information Table generation. Selection only 

available for DVB syntax.  

SDT Off; On  Ser vice  Description Table.  

NIT Parameters  

Network Name  string  Free field string for the Network name to be sent in 
the NIT.  

Network ID  1 to 65535  Identity of the network.  

LCN Off; IEC 62216; NorDig v1; DTG 
default  

Logical Channel Number.  

Send extended NI T 
(S IRG)  

Off; On   

Insert NIT into PAT  Yes; No   

PSIP Information  ATSC Syntax Only.  

MGT Off; On  Master Guide Table generation.  
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Parameter  Values  Description  

STT Off; On  System Time Table generation.  

(T/C)VCT   Terrestrial / Cable Virtual Channel Table generation.  

EIT  Event Informat ion Table generation.  

STT Parameters  

GPS UTC Offset  0-255 seconds  Time in seconds.  

Daylight Saving  Off; On  Daylight Savings Time to be considered.  

(T/C) VCT Parameters  

Delivery  Terrestrial; Cable  Delivery mode  

Modulation Mode  8 VSB; 16 VSB  Modulation  mod e of transmission.  

Carrier Frequency  0 ï 999 999 999 Hz  Carrier frequency of transmission.  

EIT Parameters  

EIT Base PID  16 to 8190  PID of the first EIT.  

Number of EITs  0 to 4  Number of tables in the SI.  

5.5.4.1.2  Additional Settings for IP Output Transport S trea ms  

The IP related Transport Stream parameters are available in the Properties  widget on the 
Service Configuration  page if an IP output Transport Stream is selected in the Outputs  widget.  

Table 5.120  Additi onal  Settings for IP Output Transport Streams  

Parameter Values Description 

IP Bit Rate  Specifies the bit rate of the IP output and includes the 
overhead added by IP encapsulation. Read only parameter. 

TS Packets per IP 
Packet 

1 to 7 Specifies how many Transport Stream packets to encapsulate 
in one IP packet. 

IP Encapsulation UDP, RTP, RTP FEC Column, RTP FEC 
Column and Row 

Specifies what higher layer to encapsulate in IP packets. UDP 
and RTP is self explanatory and means that the Transport 
Stream is first encapsulated in UDP or RTP packets, then an 
IP header is added. If RTP FEC column or RTP FEC Columns 
and Row is selected one (Column) or two (Column and Row) 
RTP streams are output in addition to the RTP streams that 
carry the Transport Stream.  

Number of Rows  The number of rows used in FEC encoding.  

Number of Columns  The number of columns used in FEC encoding.  

Alignment Block Aligned, Non Block Aligned The aligned method used for ProMPEG FEC (SMPTE  
2022-1, 2) 

MGP Settings 1 1Only available in MGP Module Level mode and if the unit is not controlled by MediaKind control software 

MSM Multicast 
Address 

IP v4 multicast address Destination for MGP Status Messages. Transport streams 
sharing this value belong to the same media bundle and are 
switched on or off together. 

MGP State R0 Not In Service, S0 Not in Service, S1 
Activated Spare, R1 On air 

State of the bundle the transport stream belongs to. Read only. 
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Parameter Values Description 

IP Configuration/Destination 1  

Destination IP 
Address 

aaa.bbb.ccc.ddd The destination IP address to use in the IP packet header of 
the IP packets that carry the Transport Stream 

Destination UDP Port 0 to 65535 The destination UDP port to use in the IP packet header of the 
IP packets that carry the Transport Stream 

Source IP Address aaa.bbb.ccc.ddd The source IP address to use in the IP packet header of the IP 
packets that carry the Transport Stream 

Source MAC Address  Read only parameter, not yet supported. 

Source UDP Port 0 to 65535 The source UDP port to use in the IP packet header of the IP 
packets that carry the Transport Stream 

Vlan Header Disabled, Enabled.  

Vlan ID Tag   

Vlan Tag  The VLAN tag to use for the current IP stream.  

Vlan Priority 0 to 7 The priority to be used by the switches to prioritize different 
services. 

Time To Live 0 to 240 TTL value for inclusion in the IP header 

Type Of Service 0 to 255 ToS value for inclusion in the IP header 

Actual source IP 
address, calculated by 
a rule 

aaa.bbb.ccc.ddd The source IP address. Read only parameter 

Actual source MAC 
address, calculated by 
a rule 

 The source MAC address. Read only parameter. 

MGP Settings 1  

Spare IP Address IP v4 address Address used as source for MGP Status Message IP packets, 
generally the IP address assigned to an output interface of a 
peer (backup) unit. 

Serv ice Settings  

The service parameters are available in the Properties  widget on the Service Configuration  
page if a service is selected in the Outputs  widget. The same settings are also available through 
the front panel under Output/<IP interface name>/<Tran spor t Stream name>/Service 
List/<service name> . 

Table 5.121  Service Settings  

Parameter  Values  Description  

Service ID  1 -  65535  

PMT PID  16 to 8190  The PID assigned to the Program Map Table for the 
serv ice.   

PCR PID  16 to 8190  The PID of the packetized elementary stream that 
transmits the PCR for the current service.  

BISS Key  None, (Hidden) selected Key  The assigned security keys for the for Basic 
Interoperable Scrambling System presets.  

SDT Para mete rs  

Provider  The name of the service provider.  
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Parameter  Values  Description  

Name  The service name as it appears in the PMT.  

Service Type  Digital TV, Digital Radio, Teletext, 
Mosaic, Data Broadcast  

The type of service as transmitted in the PMT.  

(T/C) VCT Parameters (ATSC  Onl y)  

Short Name  String  Short description of the service  

Long Name  String  Long description of the service  

Major Channel 
Number  

1 to 99  PSIP major channel number  

Minor Channel 

Number  
1 to 99  PSIP minor channel number  

Service Type  Digital TV; Digital T V (H .264); Digital 
Radio; Data Broadcast  

Type of service. Does not affect encoding.  

Source ID  0 to 65535  Source ID  

Hidden  Yes; No   

Hide Guide  Yes; No   

Error Monitoring (Not supported in this release)  

Continuity Count 
Error Threshold  

 Sets Thresholds f or e rror monitoring of service from IP 
input only.  

Not supported in this release  
Continuity Count 

Error Sampling 
Window  

 

Maximum Valid PID 
Missing Period  

 

5.5.4.2  Internal PSIP Data Insertion  

The Internal Program and System Information Protocol (PSIP) Data In sert ion feature allows the 
user to insert internally generated MPEG Program Specific Information (PSI) and ATSC PSIP data 
into any of the internally created Transport Streams.  

The PSI information includes the following MPEG tables:  

¶ Program Association Tabl e (P AT)  

¶ Program Map Table (PMT)  

The internally generated PSIP data includes the following ATSC tables:  

¶ Conditional Access Table (CAT)  

¶ Master Guide Table (MGT)  

¶ System Time Table (STT)  

¶ Terrestrial/Cable Virtual Channel Table (T/C)VTC  

¶ Event Information Table  (EI T)  

5.5.4.2.1  Operation  

To set up PSIP data insertion, follow the steps below.  
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1.  On the Service Configuration  page, create the Transport Stream you want to add the 

internal PSIP information to.  

2.  Add the required services and components, and adjust the Transport Stre am a nd component 
settings.  

3.  In the Outputs  widget, select the Transport Stream you want to add the PS IP data to. In the 
Properties  widget, set Syntax  to ATSC  and the External Generation to  Off . The Program 
Specific Information  and the PSIP Information  accor dion  panels are now displayed.  

4.  By setting a table On , the appropriate parameters are displayed. To c onfigure PSIP data, set 
PAT/PMT  to On . Set PMT Repetition Period  as required. The default value is 500 ms.  

5.  Conditional Access Table can be activated by sett ing CAT  parameter to On . 

6.  By setting STT  On , GPS UTC Offset  and Daylight Saving  can be configured.  

7.  By setting (T/C)VTC  On , the following parameters can be configured: Delivery  

(Terrestrial / Cable ), Major Channel Number , Modulation Mode , Carrier Frequency . 

8.  By tur ning EIT  On , EIT Base PID  and the number of the Event information Tables can be 
set.  

 

Figure 5.40  Setting Internal PSIP Data Insertion on the GUI  

5.5.4.3  Basic Interoperable Scrambling System (BISS)  

When the CE/ SWO/ BISS license is enabled the encoder can use the Basic Interoperable 
Scrambling System (BISS) to scramble services in the outgoing Transport Stream.  

BISS Mode 1 operation uses a fixed value for the control word to scramble the service in the 
Transport S trea m from the encoder. To descramble the transmission, the decoder needs to have 
the matching contr ol word value.  

BISS is configured by browsing to the service in the Transport Stream configuration for the output. 
Each service can be encrypted using a dif fere nt key, with up to 31 keys being available.  

Once BISS has been enabled at a service level it is possible to select which components in that 
service are scrambled using the key defined at the service level.  
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BISS Mode E operation additionally requires th e en try of an Injected ID. This value is associated 

with the unit rather than an individual service,  so a single entry is made by browsing to Device 
Configuration > Advanced Setup , and selecting Base Unit  in the Advanced Video Processor 
Settings  widget or by Advanced/System/Base Unit/BISS Injected ID (14 hex digits)  on 
the front panel.  

To improve the se curity of the BISS encrypted stream, there are two modes available (referred to 
as BISS security level) which are Normal BISS Encryption (the original imple ment ation) and 
Advanced BISS encryption. By default, Normal BISS Encryption is enabled.  

If Advanced BISS Encryption is required this can be configured by browsing to Device 
Configuration > Advanced Setup > Base Unit  and setting BISS Security Level  to Advan ced 
BISS  encryption.  

5.5.4.4  ProMPEG FEC (SMPTE 2012 - 1, 2)  

5.5.4.4.1  FEC Parameters  

FEC is set up on a per -Transport Stream basis. The following description applies to the graphical 
user interface.  

If the user has the appropriate license installed to use FEC then below are the parameters which 
can be set (with itemised lists of available values where approp riate).  

Table 5.122  FEC Parameters  

Parameter Values Description 

IP Encapsulation UDP UDP encapsulation of TS packets 

RTP RTP encapsulation of TS packets 

RTP/FEC Column UDP/RTP encapsulation of RTP Packets with added one-
dimensional FEC 

RTP/FEC Column and Row UDP/RTP encapsulation of RTP Packets with added two-
dimensional FEC 

Number of Rows 4 - 20 An integer between 4 and 20. See FEC constraints section for 
allowable ranges. 

Number of Columns 1 - 20 An integer between 1 and 20. See FEC constraints section for 
allowable ranges. 

Alignment Block Aligned  

Non Block Aligned  

If the user does not have a license to use FEC then  the available IP Encapsulation options become 
UDP, RTP, RTP/FEC Column (No License) and RTP/FEC Column and Row (No License). If either of 
the ó(No License)ô options is selected then IP Encapsulation will be set to RTP and FEC will not be 
enabled. If s ubsequently the license is enabled for FEC then the ó(No License)ô suffix will be 
removed from the displayed valued of IP Encapsulation  

 

Constraints on FEC Parameters  

To promote interoperability and simplify implementation, limits are specified for values of t he L 
(number of columns) and D (number of rows) parameter s. ProMPEG FEC requires equipment 
manufacturers to support all combinations of values of L and D within these limits. The specified 
limits are:  

Columns Only: ( L x D  <= 100) and (1 <= L <= 20) and  (4 <= D <= 20)  

Rows and Columns: ( L x D  <= 100) and (4 <= L <= 20) and (4 <= D <= 20)  
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Background  

Forward Error Correction or FEC, enables packets lost during transmission over IP networks to be 
recovered by adding extra information to the transmitted data . Th e particular type of FEC used on 
the unit is that specifi ed by (SMPTE 2012 -1, 2).  

The key features of ProMPEG FEC (SMPTE 2012 -1, 2) are:  

¶ Open standard FEC scheme.  

¶ Increased robustness of transmission.  

¶ Increases network reach through FEC on high loss li nks.  

¶ Highly configurable depending on bandwidth vs. robustnes s.  

¶ FEC transmitted separately to media stream.  

¶ Independent of video compression standard (MPEG -2, MPEG -4).  

ProMPEG FEC (SMPTE 2012 -1, 2) can help to solve the problems caused by missing packets. It i s 
an open standard for protection of contribution broadcast real - time transmissions over IP networks 
by facilitating real - time lost packet recovery at the receive units. It permits flexible configurations 
for optimization requirements.  

The scheme uses an R TP layer which adds timing informatio n for sequence correction. FEC packets 

are transmitted in separate IP packets. The FEC packets are calculated by arranging the media 
packets into a matrix. The matrix size defined by columns (L) and rows (D).FEC pac kets  are 
calculated along columns and row s using the XOR function. FEC can be 1D (Column Only) or 2D 
(Column and Row).  

Media and FEC packets are transmitted on separate IP streams with the Column FEC stream offset 
from media stream and have a UDP port numb er w hich is the media port number +2. The  Row 
FEC stream is offset from Media stream and has UDP port number which is the media port number 
+4. This arrangement means that non -enabled FEC receivers can simply ignore FEC streams and 
decode the media packets . 

The FEC data stream is off -set from the  media stream to protect against burst error loss and jitter. 
At the receiver, lost packets recovered using the FEC data packets. The Column FEC protects 
against burst errors and the Row FEC protects against random erro rs. ProMPEG FEC recovers lost 

packets  using column and (optionally) row FEC packets using the XOR function on the remaining 
packets. Depending on the distribution and severity of the pack loss not all errors are recoverable.  

Overhead  

The overhead which  res ults from ProMPEG FEC transmitting extra packets depends on whether 
column or column and row FEC is selected and how many columns and rows there are. (Note that 
L = number of columns, D = number of rows.)  
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Table 5.123  Column FEC  

Overhead (L + (D x L)) / (D x L) = 1 / D + 1 

Worst case 4 rows = 25% 

Best case 20 rows = 5% 

Table 5.124  Column and Row FEC  

Overhead (L + (D x L)) / (D x L) = 1 / D + 1 

Worst case 4 rows = 25% 

Best case 20 rows = 5% 

Block Alignment  

FEC offers two methods of block alignment (also referred to as FEC linearisation) for use when 
generating FEC packets: Non Block Aligned and Block Aligned. Both are guaranteed of being able 
to correct L e rror s, sometimes more. Th e Block Aligned method can however correct 2L+2 errors; 
this never happens with Non -Block Aligned.  

Non -Block Aligned can in theory have a lower latency at the decoder if it can be guaranteed that 
the mode of operation will never ch ange . 

Block Aligned linearization is dealt with in Annex B of the ProMPEG Code of Practice. In Block 
Aligned column FEC packets are sent every Dôth frame and the L Column FEC packets are played 
out every D slot. They are therefore evenly spread over the D* L ma trix per iod.  

Non Block Aligned linearization is dealt with in Annex A of the ProMPEG Code of Practice. In Non 

Block Aligned the matrix is óskewedô for the column calculation. The L column FEC packets are 
played out at the end of every column plus a con stant. For ósquareô matrices (diamonds) where L 
= D then these column packets will emerge at regular intervals. For órectangularô diamonds they 
will not. In the case of a 4 column by 20 row matrix the 4 FEC packets will emerge within 16 slots, 
followed by a ga p of 64 slots before the next 4. It therefore produces a less linear spread of 
packets.  

Receivers which do not have FEC capability can simply ignore the FEC packets and just make use 
of the media packets.  

5.5.4.5  VLAN Tagging  

VLAN tagging can be used to segreg ate IP packe ts from data interfaces.  

5.5.4.5.1  VLAN Creation  

A VLAN is created by specifying the VLAN ID, IP address and the Netmask. All Transport Streams 
which are tagged to this VLAN use the VLAN IP address as its source IP address. Hence the VLAN 
and VLAN ID mus t be  created  before it can be used to tag a Transport Stream.  

To create VLANs, on the Advanced Setup  tab of Device Configuration  page navigate to the 
Encoder > Vlan Tags  folder, select the output you want to assign the VLAN tag to, and click Add  
in the Pro pert ies  pane. Alternatively, on the front panel navigate to Advanced/System/Vlan 
Tags  and set up the VLANs as required. The available options are listed in the following table.  

Table 5.125  VLAN Creation Opt ion s 

Parameter Values Description 

Vlan ID (Create) 2-4094 New VLAN ID to create. 

Vlan IP xxx.xxx.xxx.xxx VLAN IP Address (VLAN tagged Transport Stream will have 
this as its source IP address). 

Vlan Netmask yyy.yyy.yyy.yyy VLAN Netmask. 
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Parameter Values Description 

Vlan Gateway zzz.zzz.zzz.zzz VLAN gateway address for the current VLAN. 

Note:  The VLAN Id and its IP address must be unique across all Ethernet interfaces.  

VLAN Tag Sharing  

Once the VLANs are created, they can be assigned to IP Transport Streams. To do that, navigate 
to Ser vice  Configuration  page, and create a Transport Stream for the appropriate IP output. 
Then, click on the newly created Transport Stream, and in the Propert ies  widget select the 
required VLAN tag. VLANs can also be assigned to Transport Streams in the Outpu ts/I P Output 
<m>/Data Interface Group <n>/Transport Stream ID: <id>/Destination 
List/Destination <k>/Vlan Tag  front panel menu. The following options can b e set:  

Table 5.126  VLAN Tag Sharing Options  

Parameter Values Description 

Vlan Tag None, existing VLAN tag Disables VLAN tagging or assigns the selected VLAN tag to 
the current Transport Stream. 

Vlan Priority 0-7 Priority that can be used to support QoS. 

It is also possible to group multiple Transport Strea ms u nder the same VLAN. To do this, assign 
the same VLAN tag to all of them.  

Note:  On the web user interface, VLANs can be managed through the Serv ice Configuration 
page by clicking on the Manage button next to the Vlan Tag parameter.  

VLAN Deletion  

A VLAN  can  be deleted by changing the VLAN Tag parameter under the Transport Stream to 
None . If a VLAN tag used by any Transport Stream is deleted, the V LAN Tag parameter is set to 
None  in the respective Transport Streams.  

5.6  Support Page  

The Support  page provides info rmation and access to functions that help in maintenance tasks.  

The page consists of the following tabs:  

¶ General  tab  

¶ Versions  tab  

¶ Licenses  tab  

¶ Device Management  tab  

 General Tab  

The General tab contains the Import and Export  and the Log Files  widgets.  
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Figure 5.41  Support Page > General Tab  

5.6.1.1  Import and Export Widget  

The Import and Export  widget lets the user import and export the current configuration in 
different formats. Moreover, it enables the user to u pgra de the encoder through the Upgrade 
Encoder  accordion panel.  

Note:  The format of the files saved through the Support  page is not co mpatible with the 
format of the configurations exported on the Stored Configurations  page.  

5.6.1.2  Log Files Widget  

The Log Files  widg et provides a way to export message logs, basic version information and error 
messages for debug purposes.  

 Version Tab  

The Version  tab displays detailed version information. The information is organized into panel 
tabs. By clicking a tab in the Build  widge t, the very same tab is displayed in the Host  and 
Modules  widgets. In case of a version mismatch on the host or on any of the opti on cards, it is 
clearly indicated in the System  tab and on the tab corresponding to the failing slot.  






